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Notice

ROSEMOUNT (“SELLER”) SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS IN THIS MANUAL OR OMISSIONS FROM
THIS MANUAL. SELLER MAKES NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THIS MANUAL AND, IN NO EVENT, SHALL
SELLER BE LIABLE FOR ANY SPECIAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PRODUCTION,
LOSS OF PROFITS, ETC.

PRODUCT NAMES USED HEREIN ARE FOR MANUFACTURER OR SUPPLIER IDENTIFICATION ONLY AND MAY BE TRADEMARKS/
REGISTERED TRADEMARKS OF THESE COMPANIES.

THE CONTENTS OF THIS PUBLICATION ARE PRESENTED FOR INFORMATIONAL PURPOSES ONLY, AND WHILE EVERY EFFORT HAS
BEEN MADE TO ENSURE THEIR ACCURACY, THEY ARE NOT TO BE CONSTRUED AS WARRANTIES OR GUARANTEES, EXPRESSED OR
IMPLIED, REGARDING THE PRODUCTS OR SERVICES DESCRIBED HEREIN OR THEIR USE OR APPLICABILITY. WE RESERVE THE RIGHT
TO MODIFY OR IMPROVE THE DESIGNS OR SPECIFICATIONS OF SUCH PRODUCTS AT ANY TIME.

SELLER DOES NOT ASSUME RESPONSIBILITY FOR THE SELECTION, USE, OR MAINTENANCE OF ANY PRODUCT. RESPONSIBILITY FOR
PROPER SELECTION, USE, AND MAINTENANCE OF ANY SELLER PRODUCT REMAINS SOLELY WITH THE PURCHASER AND END-USER.

Warranty

1. LIMITED WARRANTY: Subject to the limitations contained in Section 2 herein and except as otherwise expressly provided
herein, Rosemount (“Seller”) warrants that the firmware will execute the programming instructions provided by Seller
and that the Goods manufactured or Services provided by Seller will be free from defects in materials or workmanship
under normal use and care until the expiration of the applicable warranty period. Goods are warranted for twelve (12)
months from the date of initial installation or eighteen (18) months from the date of shipment by Seller, whichever period
expires first. Consumables and Services are warranted for a period of 90 days from the date of shipment or completion of
the Services. Products purchased by Seller from a third party for resale to Buyer (“Resale Products”) shall carry only the
warranty extended by the original manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond
making a reasonable commercial effort to arrange for procurement and shipping of the Resale Products. If Buyer
discovers any warranty defects and notifies Seller thereof in writing during the applicable warranty period, Seller shall, at
its option, promptly correct any errors that are found by Seller in the firmware or Services, or repair or replace F.O.B. point
of manufacture that portion of the Goods or firmware found by Seller to be defective, or refund the purchase price of the
defective portion of the Goods/Services. All replacements or repairs necessitated by inadequate maintenance, normal
wear and usage, unsuitable power sources, unsuitable environmental conditions, accident, misuse, improper installation,
modification, repair, storage or handling, or any other cause not the fault of Seller are not covered by this limited
warranty, and shall be at Buyer's expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer or any
other party except as may be agreed upon in writing in advance by an authorized Seller representative. All costs of
dismantling, reinstallation and freight, and the time and expenses of Seller's personnel for site travel and diagnosis under
this warranty clause shall be borne by Buyer unless accepted in writing by Seller. Goods repaired and parts replaced during
the warranty period shall be in warranty for the remainder of the original warranty period or ninety (90) days, whichever is
longer. This limited warranty is the only warranty made by Seller and can be amended only in a writing signed by an
authorized representative of Seller. Except as otherwise expressly provided in the Agreement, THERE ARE NO
REPRESENTATIONS OR WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, FITNESS FOR
PARTICULAR PURPOSE, OR ANY OTHER MATTER WITH RESPECT TO ANY OF THE GOODS OR SERVICES. It is understood
that corrosion or erosion of materials is not covered by our guarantee.

2. LIMITATION OF REMEDY AND LIABILITY: SELLER SHALL NOT BE LIABLE FOR DAMAGES CAUSED BY DELAY IN
PERFORMANCE. THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY HEREUNDER SHALL BE LIMITED TO
REPAIR, CORRECTION, REPLACEMENT, OR REFUND OF PURCHASE PRICE UNDER THE LIMITED WARRANTY CLAUSE IN
SECTION 1 HEREIN. IN NO EVENT, REGARDLESS OF THE FORM OF THE CLAIM OR CAUSE OF ACTION (WHETHER BASED IN
CONTRACT, INFRINGEMENT, NEGLIGENCE, STRICT LIABILITY, OTHER TORT, OR OTHERWISE), SHALL SELLER'S LIABILITY TO
BUYER AND/OR ITS CUSTOMERS EXCEED THE PRICE TO BUYER OF THE SPECIFIC GOODS MANUFACTURED OR SERVICES
PROVIDED BY SELLER GIVING RISE TO THE CLAIM OR CAUSE OF ACTION. BUYER AGREES THAT IN NO EVENT SHALL
SELLER'S LIABILITY TO BUYER AND/OR ITS CUSTOMERS EXTEND TO INCLUDE INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE
DAMAGES. THE TERM “CONSEQUENTIAL DAMAGES” SHALL INCLUDE, BUT NOT BE LIMITED TO, LOSS OF ANTICIPATED
PROFITS, LOSS OF USE, LOSS OF REVENUE, AND COST OF CAPITAL.
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1 Getting started
Welcome to MON2020—a menu-driven, Windows-based software program designed to
remotely operate and monitor the Rosemount™ XA series of gas chromatographs.

MON2020 operates on an IBM-compatible personal computer (PC) running the
Windows 7® operating system or later.

MON2020 can initiate or control the following gas chromatograph (GC) functions:

• Alarm parameters

• Alarm and event processing

• Analog scale adjustments

• Analyses

• Baseline runs

• Calculation assignments and configurations

• Calibrations

• Component assignments and configurations

• Diagnostics

• Event sequences

• Halt operations

• Stream assignments and sequences

• Valve activations

• Timing adjustments

MON2020 can generate the following reports:

• Analysis (GPA)

• Analysis (ISO)

• Calibration

• Final Calibration

• Validation

• Final Validation

• Hourly Averages

• Monthly Averages

• Daily Averages

• GC Configuration

• Raw Data

• Variable Averages
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• Weekly Averages

• Dew Temperature Calculation (optional)

MON2020 can access and display the following GC-generated logs:

• Alarm Log

• Event Log

• Parameter List

• Maintenance Log

1.1 MON2000 and MON2020
Users familiar with MON2000 or MON2000 Plus will find a few changes when using
MON2020:

• Login security is at the gas chromatograph level instead of at the software level. This
means that you no longer have to log in after starting MON2020—but you do have to
log in to the gas chromatograph to which you are trying to connect. For more
information, see Connect.

• An Administrator role has been added to the list of user roles. This new role has the
highest level of authority and is the only role that can create or delete all other roles
and users. For more information, see Users.

• Multiple users can connect to the same gas chromatograph simultaneously. By default,
the first user to log in to the GC with supervisor authority will have read/write access; all
other users, including other supervisor-level users, will have read access only. This
configuration can be changed so that all supervisor-level users have read/write access
regardless of who logs in first. For more information, see Managing the system.

• Users can display multiple windows within MON2020.

• Automatic re-connection. If MON2020 loses its connection with the GC, it
automatically attempts to reconnect.

• Analytical Train Configuration. Users can configure Analytical Trains for the detectors,
valves and discrete outputs enabled by selecting the checkboxes. The number of
detectors, valves and discrete outputs is depenent on the installed hardware of the GC.

• Analysis Clock Configuration Users can configure/save settings of assigned analytical
trains to analysis.

• Users can view multiple instances of certain windows. To aid in data processing or
troubleshooting, MON2020 is capable of displaying more than one instance of certain
data-heavy windows such as the Chromatogram Viewer and the Trend Data window.

• Enhanced Chromatogram Viewer. The following enhancements have been made to the
Chromatogram Viewer:

— Users can view an unlimited number of chromatograms, in any configuration. For
example, a user can view an archived chromatogram and a live chromatogram. For
more information, see The Chromatogram Viewer.

— The Keep Last CGM option. Upon starting a new run, MON2020 can keep the most
recently completed chromatogram on the graph for reference.
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— Overview window. When zoomed in to a smaller section of a chromatogram, the
user can open a miniature ‘overview’ window that displays the entire
chromatogram, for reference. For more information, see Additional plot
commands.

— Older chromatograms available. MON2020 has access to archived chromatograms
as old as four or five days. For more information, see Display an archived
chromatogram.

— Full screen mode. For more information, see Options for displaying
chromatograms.

— Protected chromatograms. Chromatograms that you designate as protected will
not be deleted. For more information, see Protected chromatograms.

• The Invert Polarity option. This feature reverses a detector’s effect. For more
information, see Invert the polarity of a valve and Invert the polarity of a discrete input.

• Streamlined variables-picking menu. The method for selecting variables for
calculations and other purposes is contained within one simple, self-contained menu.
For more information, see The context-sensitive variable selector.

• GC Time. The GC Status Bar displays the date and time based on the GC’s physical
location, which may be different than the PC’s location. For more information, see Set
the gas chromatograph’s date and time.

• Daylight Savings Time. You have option of enabling a GC’s Daylight Savings Time
feature. Also, there are two options for setting the start and end times for Daylight
Savings Time on the GC. For more information, see Set Daylight Savings.

• Baseline offsetting (700XA and 1500 XA only). In some situations that involve multiple
detectors, the baseline may be displayed either too high on the graph, in which case
the tops of the peaks are cut off, or too low on the graph, so that the bases of the peaks
are cut off. If this occurs, it is possible to offset the baseline either up or down so that
the entire peak can be displayed on the graph. This offset will be applied to all traces—
live, archived, and saved—that are displayed thereafter. For more information, see
Offset the baseline (700XA and1500XA only).

• Microsoft Excel-based Parameter List. The Parameter List has been expanded to offer
multiple pages of information and is Microsoft® Excel-based to allow for data access
outside of MON2020. The document can be imported to and exported from GCs. For
more information, see The parameter list.

• Optional FOUNDATION Fieldbus variables. If your GC is installed with a FOUNDATION
Fieldbus, you can map up to 64 GC variables to monitor using the AMS Suite. For more
information, see Map a FOUNDATION Fieldbus variable.

• Optional local operator interface (LOI) variables. If your GC is installed with an LOI, you
can configure up to 25 GC parameters to monitor using the LOI’s Display mode. For
more information, see Local Operator Interface variables.

• Access to GC-related drawings such as flow diagrams, assembly drawings, and
electrical diagrams.

• Validation runs. During a validation run, the GC performs a test analysis to verify that it
is working properly. For more information, see The validation data tables and Validate
the gas chromatograph.
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1.2 Getting started with MON2020
This section covers such issues as installing, registering, and setting up the software, as
well as configuring MON2020 to meet your specific needs.

1.2.1 System requirements
To achieve maximum performance when running the MON2020 software, ensure your PC
system meets the following requirements.

Compatible operating systems:

• Windows® 7, Windows® 8 or Windows® 10

• Internet Explorer® 9 or higher
— Microsoft Edge

— Mozillla Firefox

— Google Chrome

Minimum hardware specifications:

• 1 gigahertz (GHz) 32-bit or 64-bit processor

• 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit)

• 1 GB available hard disk space

• Super VGA Monitor with 1024 x 768 or higher resolution

• One Ethernet Port for connecting to Gas Chromatographs

• Windows®-compatible printer for printing reports (Optional)

1.2.2 Install MON2020
You must install MON2020 from the USB drive onto your hard drive; you cannot run the
program from the USB.

Double-click the Setup file and follow the on-screen installation instructions.

Upon successful installation, MON2020 creates a shortcut icon on the computer’s
desktop.

Note
MON2020 is not an upgrade to MON2000; therefore, MON2020 should be installed to its
own directory, separate from the MON2000 directory.

Note
You must be logged onto the computer as an administrator to install MON2020.
Windows™ 7 and Windows™ 10 users, even with administrator privileges, will be prompted
by the operating system’s User Account Control feature to allow or cancel the
installation.
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1.2.3 Start MON2020
To launch MON2020, double-click its desktop icon or click the Start button and select
MON2020.

1.2.4 Register MON2020
Each time you start MON2020 it will prompt you to register if you have not already done
so. You can also register by selecting Register MON2020... from the Help menu.

Registering your copy of MON2020 allows you to receive information about free updates
and related products.

Procedure

1. Complete the appropriate fields on the Register MON2020 window.

Note
The software's revision level is located on the back of its USB.

2. Click Next to continue.

3. Choose the desired registration method by clicking the corresponding checkbox.

4. Click Finish.

1.2.5 Set up the data folder
The data folder stores GC-specific files such as reports and chromatograms. The default
location for the data folder is C:\Users\user_account_name\Documents\GCXA Data. If
you want MON2020 to store its data in a different location—on a network drive, for
instance—do the following:

Procedure

1. Move the data folder to its new location.

2. Select Program Settings... from the File menu.

3. The current location of the data folder displays in the Data Folder field.

To change the data folder’s location, click on the Browse button that is located to
the right of the Data Folder field.

4. Use the Browse for Folder window to navigate to the GCXP Data folder’s new
location and click OK.

Note
Another method for changing the folder location is to type the folder’s location into
the Data Folder field and press ENTER. When the “Create the folder?” message
appears, click Yes.

5. The Data Folder field updates to display the new location.
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1.2.6 Set up MON2020 to connect to a gas chromatograph
To configure MON2020 to connect to a GC, do the following:

Procedure

1. Select GC Directory... from the File menu.

If this is the first time that this option was selected, you will get the following error
message:

Figure 1-1: “GC directory file not found” message

If you get the GC directory file not found message, click OK. The GC Directory window
appears and displays a table containing an inventory of the GCs to which MON2020
can connect.

2. If you are configuring the first GC connection for MON2020, there will be only one
generic GC record listed in the window. To add another record, select Add from the
GC Directory window’s File menu. A new row will be added to the bottom of the
table.

3. Click in the GC Name field and enter the name for the GC to which you want to
connect.

4. Optionally, you can click in the Short Desc field and enter pertinent information
about the GC to which you want to connect, such as its location. You can enter up
to 100 characters in this field.

5. By default, Ethernet 1 (RJ45 connection on the backplane) is selected as the
connection method. Other options are Direct and Ethernet 2 (terminal block on the
backplane). Select the correct check box. Multiple connection methods can be
selected. For Ethernet 1 or Ethernet 2, click the button on the bottom of the screen.
The Ethernet Connection Properties for New GC window appears.

a) Enable the radio button for the connection type.

• IP address - numeric value

• Server name - alphabetical value

b) Select the designated port, a shared public Internet connection network
address translation (NAT) using a single IP address assigned to different GCs.

• FTP

• Database

• Chromatogram

• Modbus
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Note
The default address for the GC's RJ-45 port in DHCP mode is 192.168.135.100.

Note
If you type an invalid IP address, you will get an error message when MON2020
attempts to connect to the GC.

6. Click OK. When the Save changes? message appears, click Yes.

7. Repeat steps 2 through 6 for any other GCs to which you want to connect.

8. To delete a GC from the GC Directory table, select the GC and then click Delete
button from the File window.

9. To copy a GC's configuration information into a new row, select the row to be
copied and then select Insert Duplicate from the File window.

10. To insert a row below a GC, select the GC and then select Insert from the File
window.

11. To sort the table alphabetically, select Sort from the Tablewindow or click Sort from
the GC Directory window.

12. To copy the list of GCs to the clipboard to be pasted into another application, select
Copy Table to Clipboard from the Table window.

13. To print the list of GCs, select Print Table... from the Table window.

14. To save the changes and keep the window open click Save from the GC Directory
window. To save the changes and close the window, click OK. When the Save
changes? message appears, click Yes.

For more details about configuring MON2020 connections, see Configure an
Ethernet port.

1.2.7 Export a GC directory
The GC Directory, which contains the list of networked GCs that are currently configured
for your copy of MON2020, can be saved as a DAT file to a PC or other storage media such
as a compact disk or flash drive.

To save the GC Directory to the PC, do the following:

Procedure

1. Click Export.
The Export GC Directory window displays.

2. Select the checkbox for each gas chromatograph whose information you want to
save.

Note
If you want to save the entire list, click Select All.

3. Click OK.
The Export GC Directory File save as dialog displays.

4. Choose a save location.
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The default location is C:\Users\user_account_name\Documents\GCXA Data.

Note
The file is automatically given the name of GC_DIRECTORY_EXPORT.DAT. If you
prefer a different name, type it into the File name field.

5. Click Save.

1.2.8 Import a GC Directory file
A GC Directory file can be used to restore GC directory information to your copy of
MON2020, or it can be used to quickly and easily supply other copies of MON2020 that are
installed on other computers with the profiles of the GCs that are in your network.

To import a GC Directory file, do the following:

Procedure

1. Select GC Directory... from the File menu.

If this is the first time that this option was selected, you will get the following error
message:

Figure 1-2: GC directory file not found" message

If you get the "GC directory file not found" message, click OK. The GC Directory
window appears

2. Click Import.
The Import GC Directory File dialog displays.

3. Locate the GC directory file and select it.

4. Click Open.
The newly configured GC Directory window reappears with the list of networked GCs
displayed in the GC Directory table.

1.2.9 Launch MON2020 from the SNAP-ON for DeltaV
This section assumes that DeltaV is installed on the PC along with MON2020.

Note
To successfully use MON2020 SNAP-ON for DeltaV, you must be familiar with using the
DeltaV digital automation system.

To start MON2020, do the following:
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Procedure

1. Start the DeltaV Explorer by clicking on its desktop icon or by clicking the Start
button and selecting DeltaV → Engineering → DeltaV Explorer.

2. In the Device Connection View, open device icons by clicking once on each icon.
Follow the path of connections until you locate the desired gas chromatograph
icon.

3. Right-click on a connected gas chromatograph icon to display the context menu.

4. Select SNAP-ON/Linked Apps → Launch MON2020.
MON2020 starts and connects automatically to the GC.

1.2.10 Launch MON2020 from the AMS Device Manager
This section assumes that DeltaV and AMS are installed on the PC along with MON2020.

To start MON2020, do the following:

Procedure

1. Start the AMS Device Manager by clicking on its desktop icon or by clicking the Start
button and selecting AMS Device Manager → AMS Device Manager.

2. In the Device Connection View, open device icons by clicking once on each icon.
Follow the path of connections until you locate the desired gas chromatograph
icon.

3. Right-click on a connected gas chromatograph icon to display the context menu.

4. Select SNAP-ON/Linked Apps → Launch MON2020.
MON2020 starts and connects automatically to the GC.
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1.2.11 The MON2020 user interface
MON2020 has two areas of interaction: the Control Area, at the top of the program’s main
window, and the GC Status Bar, located at the bottom of the program’s main window.

Figure 1-3: The MON2020 window

A. Control Area
B. GC Status Bar

The main user interface
The main user interface of the main window contains the menus and icons that allow you
to control MON2020 and the GC to which MON2020 is connected.

Figure 1-4: The Control Area

A. Title bar
B. Toolbar
C. Menu bar
D. Dialog Control Tabs

• Title bar - The Title bar displays the name of the program, as well as the program’s
connection status. MON2020 has the following three overall status modes:

— Not connected - If MON2020 is not connected to a GC, then MON2020 displays in
the Title bar.

— Connected - If MON2020 is connected to a GC, then MON2020 - Connected to and
the name of the GC and the connection type displays in the Title bar.
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— Offline Edit - If MON2020 is in offline edit mode, then MON2020 - Offline Edit < file
name> displays in the Title bar.

• Menu bar - The Menu bar contains the commands that allow you to control and
monitor gas chromatographs.

• Toolbar - The Toolbar contains shortcut icons for the most important and/or most
often used MON2020 commands. From the Toolbar you can do such things as connect
to and disconnect from a GC, view chromatographs, and view help files.

Connect to a gas chromatograph.

Disconnect from a gas chromatograph.

Open a configuration file.

Print a GC configuration report.

View the Timed Events window.

View the Component Data window.

Clear or acknowledge alarms.

Open the CGM Viewer window.

Begin auto sequencing.

Halt auto sequencing.

Open the MON2020 context-sensitive Help.

• Dialog Control Tabs bar - The Dialog Control Tabs bar contains four buttons that allow
you to manage the behavior of all windows that are open in the main window. The four
buttons are Minimize All, Maximize All, Restore All, and Close All. The bar also
displays a button for each open window that allows you to select or deselect that
window.

You can hide or display the Toolbar and the Dialog Control Tabs bar by clicking the
appropriate option from the View menu.
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The GC Status Bar
The GC Status Bar of the main window displays useful information about the status and
functioning of the gas chromatograph to which MON2020 is connected.

The GC Status Bar contains the following sections:

GC The first row displays the name of the GC to which MON2020 is
connected. If MON2020 is not connected to a GC, Not Connected
displays in this row. If MON2020 loses its connection to the GC, Comm
Fail displays in this row, and the program will automatically try to
reconnect. The second row displays status flags such as active alarms
(with red background), unacknowledged alarms (with yellow
background).

Analysis Clock
Name

This field displays the Analysis Clock 1 or Analysis Clock 2, Analysis
Clock N (where N represents the number of the Analysis Clock).
Multiple analyses can run independently to analyze multiple streams at
the same time. The GC can run two or more (maximum four) analyses
at a time. The number of analyses are set at factory per the mechanical
configurations.

Det # A GC can have a maximum of three detectors.

Mode Potential modes are: Idle, Warmstart Mode, Manual Anly, Manual Cal,
Manual Validation, Auto Anly, Auto Cal, Auto Validation, Auto Valve
Timing, Module Validation, CV Check, Manual Purge, Auto Purge, and
Actuation Purge.

Stream The current stream being analyzed.

Next The next stream to be analyzed.

Anly The analysis time.

Cycle The total cycle time, in seconds, between successive analyses.

Run The amount of time, in seconds, that has elapsed since the current
cycle began.

GC System Displays the date and time according to the GC to which MON2020 is
connected. The date and time displayed may be different from your
date and time, depending on the physical location of the GC.

Foundation
Field Bus FFB

Displays the status as In Service or Not In Service.

FID Flame
Status

Displays the status of the FID flame. Options are OFF with red
background, ON with green background, and OVER TEMP with red
background. The FID Flame Status indicator only displays on the GC
Status Bar when the GC to which MON2020 is connected has an FID
detector.

You can hide or display the GC Status Bar by clicking GC Status Bar from the View menu.
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1.2.12 Connect
Before connecting to a GC you must create a profile for it on MON2020. See Set up
MON2020 to connect to a gas chromatograph to learn how to do this.

Also, to connect to a gas chromatograph you must log on to it first. Most of MON2020’s
menus and options are inactive until you have logged on to a GC.

To connect to a GC, do the following:

Procedure

1. There are two ways to start the process:

a) On the Toolbar, click the  icon.

b) Select Connect... from the Chromatograph menu.

The Connect to GC dialog, which displays a list of all the GCs to which you can
connect, appears.

Note
If you want to edit the connection parameters for one or all GCs listed in the Connect
to GC window, click Edit Directory. The GC Directory window appears. See Set up
MON2020 to connect to a gas chromatograph for more information.

2. Click the connection method (Direct, Modem, Ethernet 1, or Ethernet 2) button
beside the GC to which you want to connect.
The Login dialog appears.

3. Enter a user name and user PIN and click OK.
Once connected, the name of the GC appears under the GC column in the GC Status
Bar.

Note
All GCs are shipped with a default user name:. The MON2020 security policy
requires a user password for the first time log in. To add a user password or user
name or for information about creating and edit user names in general, see Users.

Note
If you enter an invalid user name or password, the Login dialog closes without
connecting to the GC.

1.2.13 Disconnect from a gas chromatograph
Disconnecting from a GC automatically logs you off of the GC.

To disconnect from a gas chromatograph, do one of the following:

• On the Toolbar, click .

• Select Disconnect from the Chromatograph menu.
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Note
If you are connected to a GC and want to connect to a different GC, it is not necessary to
disconnect first; simply connect to the second GC, and in the process MON2020
disconnects from the first GC.

1.3 Keyboard commands
You can use the following keyboard keystrokes throughout the program:

Arrow keys Moves cursor:
• Left or right in a data field.

• Up or down in a menu or combo box.

• Up or down (column), left or right (row) through displayed data entries.

Delete • Deletes the character after cursor.

• Deletes selected rows from a table or return row values to the default
settings.

Enter Activates the default control element (e.g., the OK button) in current
window.

Esc Exits application or active window without saving data.

F1 Accesses context-sensitive help topics.

Insert Toggles between insert and type-over mode in selected cell.

Tab Moves to the next control element (e.g., button) in the window; to use Tab
key to move to next data field, select Program Settings... from the File
menu and clear the Tab from spreadsheet to next control check box.

Shift+Tab Moves to previous control element (e.g., button) or data field in window;
see Tab description.

Space Toggles settings (via radio buttons or check boxes).

You can use the following function keys from the main window:

F2 Starts the Auto-Sequencing function. See Auto Sequence for more information.

F3 Halts the GC (e.g., an analysis run) at the end of the current cycle. See Halt an analysis
for more information.

F5 Displays the Timed Events table per specified stream. See The timed events tables for
more information.

F6 Displays the Component Data table per specified stream. See The component data
tables for more information.

F7 Displays the chromatogram for the sample stream being analyzed. See Display a live
chromatogram for more information.

F8 Displays any chromatogram stored in the GC Controller. See Display an archived
chromatogram for more information.
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1.4 Procedures guide
Use the following table to look up the related manual section, menu path and, if
appropriate, the keystroke for a given procedure.

Table 1-1: MON2020 task list

Task or data item Section(s) Menu path (keystroke)

24-hour average, component(s)
measured

Edit averages calculations Application → Calculations →
Averages...

Add a gas chromatograph Set up MON2020 to connect to a gas
chromatograph

File → GC Directory

Alarms, related components The component data tables
Set alarm limits

Discrete outputs

Application → Component Data... [F6]
Application → Limit Alarms → User...

Hardware → Discrete Outputs...

Alarms, stream number(s)
programmed

Set alarm limits Application → Limit Alarms → User...

Analysis time Set the cycle and analysis time Application → Timed Events... [F5]

Print analysis, Average reports Schedule the generation of reports Logs/Reports → Printer Control...

Starting or ending auto-calibration Streams Application → Streams...

Auto-calibration interval Streams Application → Streams...

Auto-calibration start time Streams Application → Streams...

Auto-calibration Streams Application → Streams...

Analytical Train Configuration Analytical Train Configuration Application  → Analytical Train
Configuration

Analysis Clock Configuration Analysis Clock Configuration Application  → Analysis Clock
Configuration

Base pressure used for calculations Streams Application → Streams...

Calibration concentration The component data tables Application → Component Data... [F6]

Calibration cycle time Set the cycle and analysis time Application → Timed Events... [F5]

Calibration runs, number averaged Streams Application → Streams...

Calibration runs, number of Streams Application → Streams...

Calibration stream number Streams Application → Streams...

Change the default C6+ mixture ratio Change the default C6+ mixture ratio Application → Component Data
Table...

Communications Communication Application → Communication...
Application → Ethernet Ports...

Component code and name The component data tables Application → Component Data... [F6]

Component full scale (for output) Configure the system
Analog outputs

Application → System...
Application → System Alarms...

Hardware → Analog Outputs...
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Table 1-1: MON2020 task list (continued)

Task or data item Section(s) Menu path (keystroke)

Component(s) programmed for input Analog outputs
Discrete inputs

Hardware → Analog Inputs...
Hardware → Discrete Inputs...

Component(s) programmed for
output

Set alarm limits
Analog outputs

Discrete outputs

Application → Limit Alarms → User...
Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Component, retention time The component data tables Application → Component Data... [F6]

Component zero (for output) Analog outputs Hardware → Analog Outputs...

Compressibility (on/off) Set standard calculations by stream Application → Calculations →
Control...

Configure the valve timing Configure the valve timing Application → Timed Events...
(Rosemount 700XA and
Rosemount1500XA)
Application → Timed Events... or
Control → Auto Valve Timing...
(Rosemount 370XA)

Current date Set the gas chromatograph’s date and
time

Chromatograph → View/Set GC
Time...

Current time Set the gas chromatograph’s date and
time

Chromatograph → View/Set GC
Time...

Cycle time Set the cycle and analysis time Application → Timed Events... [F5]

Delete alarms Set alarm limits
Alarms

Application → Limit Alarms...
Logs/Reports → Alarms → Alarm
Log...

Delete component from component
list

The component data tables Application → Component Data... [F6]

Delete inhibit, integration, peak width The component data tables Application → Timed Events... [F5]

Delete output(s) Analog outputs
Discrete outputs

Hardware → Analog Outputs...
Hardware → Discrete Outputs...

Enable or disable multi-user write Configure the system Application → System...

Existing alarm(s) Alarms Logs/Reports → Alarms → Alarm
Log...

Full-scale value (for input) Manage your gas chromatograph’s
analog inputs

Hardware → Analog Inputs...

Generate a repeatability certificate Generate a repeatability certificate Logs/Reports → Repeatability
Certificate...

GPM liquid equivalent (on/off) Set standard calculations by stream Application → Calculations →
Control...

Height or area measurement method The component data tables Application → Component Data... [F6]

High alarm Set alarm limits Application → Limit Alarms → User...

Analyzer I.D. Configure the system Application → System...
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Table 1-1: MON2020 task list (continued)

Task or data item Section(s) Menu path (keystroke)

Inhibit on-off times Set the cycle and analysis time Application → Timed Events... [F5]

Input(s) being used Manage your gas chromatograph’s
analog inputs
Discrete inputs

Hardware → Analog Inputs...
Hardware → Discrete Inputs...

Integration on-off times Set the cycle and analysis time Application → Timed Events... [F5]

Low alarm Set alarm limits Application → Limit Alarms → User...

Manage the GC's pressure (with
Electronic Pressure Controls)

Managing the gas chromatograph's
pressure

Hardware → EPC... (Rosemount
370XA)

Mole percent (on/off) Set standard calculations by stream Application → Calculations →
Control...

Normalization (on/off) Set standard calculations by stream Application → Calculations →
Control...

Outputs being used Set alarm limits
Analog outputs

Discrete outputs

Application → Limit Alarms → User...
Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Peak width, on time Set the cycle and analysis time Application → Timed Events... [F5]

Relative density (on/off) Set standard calculations by stream Application → Calculations →
Control...

Response factor The component data tables Application → Component Data... [F6]

Response factor, percent deviation The component data tables Application → Component Data... [F6]

Retention time, percent deviation The component data tables Application → Component Data... [F6]

Spectrum gain Configure spectrum gain events Application → Timed Events... [F5]

Stream number(s) (for output) Set alarm limits
Analog outputs

Discrete outputs

Application → Limit Alarms → User...
Hardware → Analog Outputs...

Hardware → Discrete Outputs...

Stream sequences skipped, number Configure the system
Streams

Application → Streams...
Application → Stream Sequence...

Streams analyzed, number Configure the system
Streams

Application → System...
Application → Streams...

Streams analyzed, sequence Configure the system
Streams

Application → System...
Application → Streams...

Valve on/off times Configure valve events Application → Timed Events... [F5]

Weight percent (on/off) Set standard calculations by stream Application → Calculations →
Control...

Wobbe value (on/off) Set standard calculations by stream Application → Calculations →
Control...

Zero value (for input) Manage your gas chromatograph’s
analog inputs

Hardware → Analog Inputs...
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1.5 Configuration files
Use the File menu to edit, save, and restore configuration files.

1.5.1 Edit a configuration file
To edit a configuration file, do the following:

Procedure

1. Disconnect from the GC.

2. Select Open Configuration File... from the File menu.
The Open dialog displays. Configuration files are saved with the .xcfg extension.

3. Locate and select the configuration file that you want to edit and click Open.
MON2020 opens the file in offline edit mode.

4. Use the Application and Hardware menu commands to edit the configuration file.
For more information on these commands, see Hardware and Application.

5. When finished editing the configuration file, click  to save the changes to the
configuration file and to leave offline edit mode.

1.5.2 Save the current configuration
Configuration files are saved with the .xcfg extension. To save a GC’s current configuration
to a PC, do the following:

Procedure

1. Select Save Configuration (to PC)... from the File menu.
The Save as dialog displays.

2. Give the file a descriptive name or use the pre-generated file name and navigate to
the folder to which you want to save the file.

3. Click Save.

1.5.3 Import a configuration file
 CAUTION

The current configuration will be overwritten, so be sure to save it before importing a new
or previous configuration. See Save the current configuration to learn how to save a
configuration.

 CAUTION

The GC must be in Idle mode while performing this task.

To import a configuration into a GC, do the following:
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Procedure

1. Select Restore Configuration (to GC)... from the File menu.
The Open dialog displays. Configuration files are saved with the .xcfg extension.

2. Locate and select the configuration file that you want to import and click Open.
The file’s data is loaded into the GC.

1.5.4 Restore the GC's factory settings
The GC’s default timed event, component data and validation data tables are created at
the factory and are not accessible by users. To restore these tables to their default values,
do the following:

Important
The GC must be in Idle mode while performing this task. To halt an analysis, see Halt an
analysis.

Procedure

1. Select Restore to Factory Settings... from the File menu.
The following warning message displays:

Figure 1-5: Restore to Factory Settings warning message

2. Click Yes.
MON2020 restores the default values to the GC’s data tables. When the process is
completed, a confirmation message displays.

3. Click OK.

1.6 Configure your printer
Select Print Setup... from the File menu to configure the settings for the printer
connected to your PC. These settings will apply to any print job queued from MON2020,
such as the reports that are configured by the Printer Control. See Schedule the
generation of reports for information.

The settings available depend on the printer model. Refer to the printer manufacture’s
user manual for more information.
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Note
Your new configuration will be cleared, i.e., the settings will return to the default values,
when you exit MON2020. To select a default printer, select Devices and Printers in the
Windows™ Control Panel.

1.7 Online help
Currently, the online help feature contains all user information and instructions for each
MON2020 function as well as the MON2020 system.

To access the online help, do one of the following:

• Press F1 to view help topics related to the currently active dialog or function.

• Select Help Topics from the Help menu to view the help contents dialog.

1.8 Operating modes for MON2020
The Rosemount 370XA GC supports two different operating modes. Each mode allows the
GC to analyze data from a given number of detectors, streams, and methods, as detailed
in below.

Table 1-2: Operating Modes for MON2020

Mode ID Number Detectors Supported Streams Supported Methods Supported

0 1 1 1

1 2 1 1

The Rosemount 700XA and 1500XA GCs use the Application → Analyitical Train
Configuration to configure the detectors, valves, and discrete outputs.

1.9 The Physical Name column
Most MON2020 hardware windows, such as the analog inputs or the valves, contain a
hidden column called Physical Name that lists the default name of the associated GC
device. It might be useful to know a device’s physical name while troubleshooting.

To view the hidden column, do the following:

Procedure

1. Select Program Settings... from the File menu.
The Program Settings window displays.

2. Select the Show Physical Names checkbox.

3. Click OK.
The Physical Name column now will be visible on all windows that have the column,
such as the Heater window or the Valves window.
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1.10 Select the GC’s networking protocol
MON2020 can connect to the GC using one of two networking protocols: PPP or SLIP. If
the version level of the GC’s firmware is 1.2 or lower, MON2020 should be configured to
use the SLIP protocol; otherwise, the PPP protocol should be used.

To select the GC’s networking protocol, do the following:

Procedure

1. Select Program Settings... from the File menu.
The Program Settings window displays.

2. To use the PPP protocol, make sure the Use PPP protocol for serial connection
(use SLIP if unchecked) checkbox is selected; to use the SLIP protocol, make sure
the Use PPP protocol for serial connection (use SLIP if unchecked) checkbox is
not selected.

3. Click OK.

1.11 The context-sensitive variable selector
The MON2020 method for selecting variables for calculations and other purposes is based
on a simple, self-contained system. You may access the context-sensitive variable selector
from several different screens. The variables you see are dependent on the screen from
which you are viewing them. One screen that has a context-sensitive variable selector is
the Averages Calculations screen. To access this screen, go to Application → Calculations
→ Averages..

Figure 1-6: Example of a context-sensitive variable selector

The context-sensitive variable selector consists of a first-level element, called the context
element, that is followed by a series of tiered, dropdown lists. The options available from
the dropdown lists depend upon the context element.

The following example explains how to use the context-sensitive variable selector to select
a gas component:

Procedure

1. Click the first-level dropdown list.
The full list of available categories displays.
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2. Select the category you want to analyze.

3. Click the second-level dropdown list.
The full list of available streams displays.

4. Select the stream you want to analyze.

5. Click the third-level dropdown list.
The full list of available variables displays.

6. Select the variable you want to analyze.

7. Click the fourth-level dropdown list.
The full list of available components displays.

8. Select the component you want to analyze.

9. Click [Done].
The context-sensitive variable selector closes and the variable displays in the
Variable field. In the example shown in Figure 1-6, the Variable field would display: .
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2 Chromatograms
When it comes to viewing and managing chromatograms, MON2020 is flexible and
straightforward. This chapter shows you how to access the Chromatogram Viewer, as well
as how to use the viewer to display, print, and manipulate live, archived (stored on the
GC), or saved (stored on the PC) chromatograms. There is no limit to the number of
archived and saved chromatograms that can be displayed at once. The Chromatogram
Viewer can display all three types of chromatograms together, alone, or in any
combination.

Figure 2-1: The Chromatogram Viewer

A. Chromatogram window
B. Time events table
C. Component data table

A chromatogram displays in the Chromatogram window.

Each trace that displays is color-coded; use the Chromatogram drop-down list to select a
specific trace.

Figure 2-2: Chromatogram drop-down list

The list of GC events associated with the production of the chromatogram, along with
each event’s status and time, displays in the Timed Events table to the right of the
chromatogram display window. The Component Data table, to the lower right of the
chromatogram display window, lists the components measured during the analysis.
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Note
When displaying a live chromatogram, by default, the timed events and component data
tables are configured to scroll to and highlight the next occurring event in the analysis
cycle. To disable this feature, right-click on one of the tables and uncheck the Auto Scroll
option on the pop-up menu.

2.1 The Chromatogram Viewer
Use the Chromatogram Viewer to display and print live, archived, or saved chromatograms.
There is no limit to the number of archived and saved chromatograms that can be
displayed at once; however, to maximize performance, the number of chromatograms
displayed should be limited to 25 or less. The Chromatogram Viewer can display all three
types of chromatograms together, alone, or in any combination.

The Chromatogram Viewer contains a host of information about both current and past GC
analyses, and it contains just as many ways of editing and manipulating that data.

2.1.1 Data displayed in the chromatogram window

Figure 2-3: The Chromatogram window

A. Retention time
B. Peak detection marker
C. Timed event marker

The following elements are displayed in the chromatogram window:

The
chromatogram

A trace is the graphical representation of the detector output from a
single detector; a chromatogram is the collection of all traces and
associated data that are generated by a gas chromatograph’s
detector or detectors. Each trace displays in a different color.
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Retention times The retention time, which displays above each component's peak,
is the time that elapses between the start of an analysis and the
sensing of the maximum concentration of that component by the
detector.

Baselines The baseline extends from the beginning to the end of a peak. You
can turn the baseline on or off by clicking Baselines.

Timed event
markers

These markers, which correspond to events from the Timed Events
table, display on the chromatogram as black vertical lines below the
trace-line. There are three types of timed event markers:
• Valve events display as long vertical lines.

• Integration events display as medium vertical lines.

• Spectrum gain events display as short vertical lines.

Peak detection
markers

These markers display on the chromatogram as black vertical lines
above the trace-line. Each peak has two peak detection markers:
one at its beginning and one at its end.

2.1.2 Display a live chromatogram
To view a live chromatogram, do the following:

Procedure

1. Connect to the GC.

2. Select Chromatogram Viewer... from the Chromatograph menu.

Note
Another way to display the Chromatogram Viewer is to click , which is located on
the Toolbar.

3. From the Chromatogram Viewer window, select the View current CGM check box.

4. If the GC has multiple clocks, select which clock/analysis Chromatogram you would
like to view.

2.1.3 Display an archived chromatogram
Archived chromatograms are stored on the GC, so you must be logged in to access them.

Archived chromatograms are sorted and displayed on four tabbed panes:

Chromatograms This view displays the last five runs for each stream by default.
Click All to display all the files that are stored on the GC and sorted
by time.
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Protected
chromatograms

Protected chromatograms are never deleted from the GC. To
protect a chromatogram, see Protected chromatograms.

Note
Protected chromatogram files have a lock icon ( ) displayed
beside them.

Final Calibration
chromatograms

As long as there is space, MON2020 stores all final calibration
chromatograms; once space runs out, MON2020 deletes the
oldest non-protected final calibration chromatogram for each new
final calibration chromatogram that is created. If multiple final
calibration chromatograms are created on the same day, the last
chromatogram created is archived, unless MON2020 has been
configured to archive all final calibration chromatograms.

Note
See Managing the system to learn how to configure MON2020’s
archiving behavior.

Final Validation
chromatograms

These chromatograms are treated in the same manner as final
calibration chromatogram files.

To view one or more archived chromatograms, do the following:

Procedure

1. From the Chromatograph menu, select Chromatogram Viewer.

2. Click GC Archive.
The Select archive file(s) window appears. The files can be sorted by date, file name,
analysis type, time, or stream number by clicking the appropriate column header.
By default, they are sorted by date, with the newest file listed first.

Note
By default, only recent chromatograms—that is, the last five runs for each stream—
are displayed. To view all archived chromatograms, click All. To return to viewing
only recent chromatograms, click Recent.

3. Select one or more archive files by clicking them.

Use the SHIFT and CTRL keys to make multiple selections.

Note
To save the selected files to the PC without displaying them first, select the
Download and save selected chromatograms checkbox and click Download &
Save.

4. Click Download & Show.
The Select window displays for each chromatogram that contains data from more
than one detector.
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Figure 2-4: The Select window

5. For each chromatogram, double-click Detector 1, Detector 2, or Both from the
Select window.
MON2020 plots the archived chromatogram(s) and the corresponding data displays
in the timed event and component data tables.
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2.1.4 Protected chromatograms
By default, archived chromatograms are not saved indefinitely. Once the GC’s storage
capacity for archived chromatograms has been reached, the oldest archived
chromatograms are deleted to make room for the newest archived chromatograms.

If you have a chromatogram that you would like to preserve, it is possible to protect it.
Protected chromatograms will not be deleted to accommodate newer chromatograms.
MON2020 saves up to 100 protected chromatograms.

Note
Protected chromatograms have a lock icon ( ) displayed beside them.

Note
To protect an archived chromatogram you must be logged in as a supervisor or
administrator.

To protect a chromatogram, do the following:

Procedure

1. Click GC Archive.
The Select Archive File(s) window appears. The chromatograms can be sorted by
date, file name, analysis type, time, or stream number by clicking the appropriate
column header. By default, they are sorted by date, with the newest chromatogram
listed first.

Note
By default, only recent chromatograms—that is, the last five runs for each stream—
are displayed. To view all archived chromatograms, click All. To return to viewing
only recent chromatograms, click Recent.

2. Make sure the Chromatogram tab is selected and then select the appropriate
archived chromatogram by clicking it. Use the SHIFT or CTRL key to make multiple
selections.

3. Click Protect.
The Edit Description window displays.

4. Enter any information that you would like to have associated with the
chromatogram and then click OK.
MON2020 places a lock icon ( ) beside the selected chromatogram to verify its
protected status. You can also click on the Protected Chromatograms tab to view
your newly protected archived chromatogram.
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2.1.5 Display a saved chromatogram
To view a chromatogram that was saved to disk, do the following:

Procedure

1. Click PC File.
The Open dialog appears.

2. Navigate to the desired .xcgm file or .xcmp comparison file and select it.

To make multiple selections, use the SHIFT or CTRL key.

3. Click OK.
The Select window displays for each chromatogram that contains data for more
than one detector.

Figure 2-5: The Select window

4. For each chromatogram, double-click the chromatogram from the Select window.
MON2020 plots the archived chromatogram(s) and the corresponding data displays
in the timed event and component data tables.

2.2 Options for displaying chromatograms
Right-clicking on the graph brings up the following commands:

Command Name Shortcut Description

Zoom In + (NUMPAD) Zooms in on the entire graph.

Note
Another way to zoom in is by clicking and dragging your mouse to select the
region of the graph that you want to zoom in on.

Zoom Out - (NUMPAD) Zooms out from the entire graph.

Zoom X In 6 (NUMPAD) Zooms in on the X axis.

Zoom X Out 4 (NUMPAD) Zooms out from the X axis.
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Command Name Shortcut Description

Zoom Y In 8 (NUMPAD) Zooms in on the Y axis.

Zoom Y Out 2 (NUMPAD) Zooms out from the Y axis.

Save State CTRL + HOME Saves current or archived display settings for the selected chromatogram.

Note
The Save State function is available only when viewing a live or archived
chromatogram.

Restore State HOME Restores the last saved display settings for the selected chromatogram.

Note
Pressing HOME returns the user to the saved state.

Toggle Full Screen F11 Toggles the display of the Chromatogram Viewer’s tables and buttons and
maximizes the chromatogram window.

Cursor to Nearest
Point

F8 Snaps the cursor to the nearest point on the chromatograph in both the X and Y
directions.

Toggle Coarse/Fine
Cursor

F4 Toggles the cursor from coarse and less accurate to fine and more accurate.

Toggle Lines/Dots
Displays

F9 Toggles the chromatographs from lines to dots, or dots to lines.

Toggle Mouse
Position Tip

CTRL + F4 The graph’s cursor follows the movement of the mouse while a hovering tooltip
displays the exact coordinates of the current point.

Toggle Nearest
Position Tip

CTRL + F9 The graph’s cursor follows the movement of the mouse cursor.

Print CTRL + P Prints the chromatogram.

Copy to clipboard CTRL + C Copies from the graph the raw detector data that was used to plot the selected
chromatogram. This data can be pasted into another application such as Microsoft
Word or Microsoft Excel.

Paste from clipboard CTRL + V Plots a range of points copied from another application such as Microsoft Word or
Microsoft Excel.

2.3 Configure the appearance of the
chromatogram
MON2020 allows you to change the appearance of many of the chromatogram’s
elements, such as its X-axis and Y-axis values, the color of the chromatogram’s
background, and the display status of its labels.

2.3.1 The Graph bar
Use the Graph bar buttons to change the display parameters of the chromatogram.

Click Edit from the Graph bar. The Edit Scales window displays.

The following table lists the parameters that can be edited:
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Command Description Default value

X Min Sets the minimum value, in seconds, for the X-axis. 0

X Max Sets the maximum value, in seconds, for the X-axis. This
value is determined by the Timed Events table.

100

Y Min Sets the minimum value for the Y-axis. -10

Y Max Sets the maximum value for the Y-axis. 100

Print Speed Sets the number of inches per second for the X-axis while
printing a chromatogram, similar to an XY plotter.

0

X Intervals Sets the number of intervals to be displayed on the graph
for the X-axis.

10

Y Intervals Sets the number of intervals to be displayed on the graph
for the Y-axis.

11

Display Option Determines whether the chromatograph is displayed as a
solid line or as a dotted line.

Lines

Show labels Toggles the display of the graph labels. Checked

Scroll newest X Determines whether the graph’s window moves to focus
on the most recent data point along the X-axis. This
feature only applies to live chromatograms.

Unchecked
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Figure 2-6: A chromatogram

To see how your changes affect the graph, click Apply. To accept your changes, click OK.

• Click Cursor to toggle the cursor size from coarse movement (less accurate) to fine
movement (more accurate).

• Click Print to print the chromatogram window.

2.3.2 Additional plot commands
In addition to the Graph bar, there are a few other commands available that allow you to
manipulate the look and feel of the graph. To access the additional plot commands menu,
right-click the Chromatogram Viewer anywhere except on the graph or the timed event and
component data tables. The additional commands are:

Set Plot Area
Color

Changes the color of the graph’s background. This may be necessary to
make the chromatograms more visible. The default RGB color values are
236, 233, and 216.

Auto Resize
Series

Scales down the X-axis and the Y-axis to fit the entire chromatogram onto
the window.
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Show Mini
Plot

Toggles the display of a smaller version of the chromatogram in a
separate, smaller, and resizable window. This allows you to keep an
overview of the entire graph at all times, especially when zoomed in.

This window automatically displays whenever you zoom in on the original
chromatogram.

Rearrange
Series

Resizes and offsets two or more traces so that they can both be fully
displayed on the graph. To offset a trace means to raise its Y-axis relative
to the Y-axis of the previous trace so that one trace is not drawn over the
other but instead one trace is drawn above the other.

Trace Offset
Settings

Indicates the amount of offset between two or more traces. To offset a
trace means to raise its Y-axis relative to the Y-axis of the previous trace so
that one trace is not drawn over the other but instead one trace is drawn
above the other.

If two detectors are in use, each set of traces can be offset independently
-- that is, the traces for one detector can be offset relative to each other,
but independent of the traces from the second detector.

2.4 Change how a chromatogram displays
Figure 2-7: The Chromatogram bar

The Chromatogram bar contains a row of buttons that allows you to manipulate a single
chromatogram. Below the row of buttons is the Chromatogram bar's dropdown list,
which contains a list of all of the currently displayed chromatograms/traces. Before you
can work with a chromatogram you must first select it from the dropdown list.
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2.4.1 Edit a chromatogram
You can use the Edit function to change the X and Y offset values for a trace, as well as its
color. These changes may be necessary to make the trace more distinguishable from those
that surround it or to align a trace with a different trace for comparison.

To edit a trace, do the following:

Procedure

1. Select the trace that you want to edit from the Chromatogram pull-down menu.

2. Click Edit.
The Edit Chromatogram dialog appears.

X Offset Enter a positive number to move the trace to the right, or a negative
number to move the trace to the left.

Y Offset Enter a positive number to move the trace up, or a negative number to
move the trace down.

# points Number of data points in the trace. This field is read-only.

Color Assigns a color to the trace.

3. To see how your changes affect the trace, click Apply. To accept your changes, click
OK.

2.4.2 Display chromatogram results
To display a table of calculation results for a chromatogram, do the following:

Procedure

1. From the Chromatogram bar's dropdown list, select the appropriate trace.

2. Click Results.
A window appears displaying the calculation results for the selected trace.

• Click Save to save these results in one of the following formats: tab-delimited (.txt),
comma-delimited (.csv), Microsoft Excel (.xls), HTM (.htm), or XML (.xml).

• Click Clipboard to copy the data to the Windows® clipboard, where it can be pasted
into another document.

• Click Print to print a tab-delimited version of the results.
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2.4.3 Save a chromatogram
To save a chromatogram, do the following:

Procedure

1. From the Chromatogram bar's dropdown list, select the trace that you want to
save.

2. Click Save.

The Save As window displays.

For convenience the file is given an auto-generated file name that includes the
trace’s creation date and time; however, you can give the file any name that you
choose.

3. Click Save.

2.4.4 Remove a chromatogram from the Chromatogram
Viewer
To remove a live trace from the chromatogram window, do one of the following:

• If you want to remove all live traces, click the View current CGM checkbox to uncheck
it.

• If you want to remove a single live trace, click the appropriate detector checkbox
beside the View current CGM checkbox.

To remove a saved or an archived chromatogram from the chromatogram window and to
close the file, do the following:

Procedure

1. From the Chromatogram bar'sdropdown list, select the trace that you want to
remove.

2. Click Remove.
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2.4.5 Initiate a forced calibration
The Forced Cal command uses an archived chromatogram’s raw data to calibrate the GC.
The calculation results are stored in the component data table for the corresponding
stream.

A major benefit of a forced calibration is increased efficiency. Using a previously validated
chromatogram removes the necessity for the GC to perform a calibration and a validation
before performing an analysis.

To perform a forced calibration, do the following:

Procedure

1. From the Chromatogram bar's dropdown list, select the trace that you want to use
to calibrate the GC.

2. Click Forced Cal.

2.4.6 Chromatogram Viewer tables
MON2020 can display two levels of information in the Chromatogram Viewer's timed
events and component data tables:

• All timed events and all components for all open chromatograms.

• Timed events and components for the currently selected chromatogram.

By default, the two tables show only the timed events and components for the currently
selected chromatogram.
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Figure 2-8: Timed events and component data tables showing data for a currently
selected trace

Figure 2-9: Timed events and component data tables showing data for all open traces
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Note
The brackets ([ ]) on the Cur/All button indicate which mode is being displayed in the
tables.

Procedure

1. To view the data for a different chromatogram, select the trace from the
Chromatogram bar's dropdown list.

2. To view all timed events and all components for all open chromatograms, click Cur/
All.

3. To toggle back to viewing only the timed events and components for the currently
selected chromatogram, click Cur/All again.

2.4.7 Open a comparison file
A comparison file contains two or more chromatograms and their associated data. To
open a comparison file, do the following:

Procedure

1. Click PC File. The Open dialog displays.

2. Select XA CMP Files (*.xcmp) from the Files of type dropdown list.

3. Navigate to the folder that contains the comparison file that you want to open and
select the file.

4. Click Open.
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2.4.8 Save a comparison file
A comparison file allows you to save your current view, including all open chromatograms,
for later review and reuse. To save a comparison file, do the following:

Procedure

1. Click Save Cmp.
The Save As dialog appears.

2. Navigate to the folder in which you want to save the file.

Note
For convenience the file is given an auto-generated file name that includes the
current date and time; however, you can give the file any name that you choose.

3. Click Save.

2.5 Miscellaneous commands
The series of checkboxes to the right of the graph have the following functions:

Figure 2-10: Miscellaneous options

Keep last CGM When viewing a live chromatogram, upon starting a new run,
MON2020 keeps the most recently completed chromatogram on the
graph for comparative purposes.

Print at end of
run

Prints the chromatogram to the PC's default printer at the end of the
run and is unchecked by default.

Save at end of
run

Saves the chromatogram to the GC's Data folder at the end of the run
and is unchecked by default.

Show bunched
data

If this box is unchecked, then all of the raw data points are plotted to
the chromatogram window; if this box is checked, which is the default
option, then each point plotted on the graph represents the average
of a group of raw data values. The size of the data group is determined
by the peak width value listed in the Timed Events table.
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2.5.1 The Chromatogram Viewer's Timed Events table

The Chromatogram Viewer displays a compact version of the Timed Events table, located
on the upper right side of the window. The events displayed in the table are sorted by
time. See The timed events tables for more information.

The Timed Event table displays the following data for each event:

Event Type The type of timed event. These events are mapped to the Time Events
window and include Valve, Integration, and Gain events.

Vlv/Det Identifies which valve or detector is involved in the event.

Value Setting of the event; for example, a valve was turned ON, or the gain was set
to 4.

Time (s) The number of seconds into the cycle that the event occurred or will occur.

Timed events from live or archived chromatograms can be edited from the
Chromatogram Viewer by double-clicking on the Timed Events table. The changes will
affect the next analysis run. The following commands are available by right-clicking on the
table:

Auto Scroll When checked, if a live trace has been selected from the
Chromatogram bar's pull-down menu, the Timed Event table will keep
its focus on the event closest in time by highlighting that event in dark
blue.

Save Sheet Allows you to save the table to the PC in one of the following formats:
TXT, CSV, XLS, HTM, or XML.

Copy to
Clipboard

Allows you to copy the table to the clipboard.

This data can be pasted into another application such as Microsoft
Word or Microsoft Excel.

Print Sheet Allows you to print the table to your default printer.

2.5.2 Launch the Timed Events table from the Chromatogram
Viewer
To launch the Timed Events dialog directly, right-click on the Chromatogram Viewer’s Timed
Events table and select Edit Timed Events Table. The Timed Events dialog displays. See The
timed events tables for more information.

Chromatograms Reference Manual
December 2019 2-3-9000-745

42 Rosemount Gas Chromatographs



2.5.3 Edit timed events from the Chromatogram Viewer
To edit timed events from the Chromatogram Viewer, do the following:

Procedure

1. From the Chromatogram bar's dropdown list, select the chromatogram whose
timed events you want to edit.

2. Right-click the Timed Events table and select Edit or double click the Timed
Events table.
The cells that can be edited turn white.

3. Edit the appropriate event.

4. Right-click on the Timed Events table and select Save Changes.
The data are saved, and the table's cells turn blue, indicating that they are read-
only. The changes will affect the next analysis run.

Note
To return to the Timed Events table without saving your changes, select Discard
Changes.
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2.5.4 Use the Chromatogram Viewer’s cursor to update a
Timed Event

Figure 2-11: Chromatogram cursor

The Chromatogram Viewer's cursor (A) can be dragged to any point on the graph, or it can
be relocated by double-clicking within the boundaries of the graph.

As the cursor moves across the chromatogram, the Timed Events table automatically
scrolls to the event that corresponds to the cursor’s coordinates. The cursor’s coordinates
(B) display in the upper left corner of the graph.

The cursor can be useful if you want to change a timed event based on the data displayed
by the chromatogram.

To update a timed event based on the location of the Chromatogram Viewer’s cursor, do
the following:

Procedure

1. Select the live or archived trace that you want to use as the source for changing the
timed event.

2. Drag the cursor to the desired location.

You can track the cursor's location by watching the coordinates that display in the
upper left corner (B). The X-coordinate represents the analysis time in seconds.
When you see the desired time displayed, stop dragging the cursor.

Chromatograms Reference Manual
December 2019 2-3-9000-745

44 Rosemount Gas Chromatographs



Note
To toggle the cursor’s size between coarse movement (less accurate) and fine
movement (more accurate), click the Cursor button on the Graph bar.

3. Go to the Time Events table and right-click on the appropriate event.

4. Select Update Time from Cursor.
The event’s time will be changed to match the cursor’s time (X-coordinate).

5. To save your changes, right-click the Timed Events table and select Save Changes.
The changes will affect the next analysis run.

Note
To return to the Timed Events table without saving your changes, select Discard
Changes.

2.5.5 The Chromatogram Viewer's Component Data table
The Chromatogram Viewer displays a compact version of the Component Data table
beneath the Timed Events table. See The component data tables for more information.

The Component Data table displays the following data for each component:

Component The name of the component.

Det Identifies the detector associated with the component.

Time (s) The retention time for the component.

Retention times for components from live or archived chromatograms can be edited from
the Chromatogram Viewer by double-clicking on the Component Data table. The changes
will affect the next analysis run. The following commands are available by right-clicking on
the table:

Auto Scroll When checked, if a live trace has been selected from the
Chromatogram bar's dropdown list, the Component Data table keeps
its focus on the component closest in time by highlighting it in dark
blue.

Save Sheet Allows you to save the table to the PC in one of the following
formats: .txt, .csv, .xls, .htm, or .xml.

Copy to
Clipboard

Allows you to copy the table to the clipboard . This data can be pasted
into another application such as Microsoft Word or Microsoft Excel.

Print Sheet Allows you to print the table.

2.5.6 Edit retention times from the Chromatogram Viewer
To edit the retention time for a component, do the following:

Procedure

1. Double-click the Component Data table or right-click the table and select Edit
Retention Times.
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The Ret Time column turns white, indicating that its cells are editable.

2. Click the appropriate cell for the component that you want edit, and enter a new
retention time, in seconds. The value must be less than the analysis time.

3. To save your changes, right-click on the table and select Save Changes.
The changes affect the next analysis run.

Note
To return to the Component Data table without saving your changes, select
Discard Changes.

2.5.7 Display raw data from the Chromatogram Viewer
Use the Raw Data button to display the Raw Data table for the selected trace.

Procedure

1. Use the Chromatogram bar's pull-down menu to select a specific trace.

Note
Even though you are selecting a trace, the data that is displayed will be for the
chromatogram, which may include more than one trace.
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2. Click Raw Data.
The Raw Data window displays and shows the raw data for the selected
chromatogram. The following data displays for each peak from the trace:

No. Numerical identifier for the peak, listed by the order of
discovery.

Ret Time Time, in seconds, that the component eluted.

Peak Area The area under the peak.

Peak Height The maximum height of the peak.

Det The detector associated with the peak.

Method Method of peak end detection. Options are:
• 1 (Baseline)

• 2 (Fused Peak)

• 3 (Last Fused Peak)

• 4 (Tangent Skim)

• 100 (Inhibit)

• 300 (Forced Integration)

• 500 (Summation)

Baseline Start The raw detector counts at the start of an integration.

Baseline End The raw detector counts at the end of an integration.

Integ. Start Time, in seconds, when integration started.

Integ. Stop Time, in seconds, when integration stopped.

Peak Width Half
Height

The width of the peak taken at half of the peak’s height.

Partial Peak If Yes, then the Partial Peak value is used in the summation
calculation; if No, then the Partial Peak value is not used in the
summation calculation.

2.6 Set the gas chromatograph’s date and time
When MON2020 connects to a gas chromatograph, the Status bar displays the gas
chromatograph’s date and time.

Note
The date and time displayed for the GC may be different from your date and time,
depending on the physical location of the GC.

To set the gas chromatograph’s date and time, do the following:

Procedure

1. Select View/Set Date Time... from the Chromatograph menu.
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The View/Set Date Time window displays.

2. Use the drop-down menus to set the date and time.

To enable or adjust daylight savings, see Set Daylight Savings.

3. Click OK.

2.6.1 Set Daylight Savings
Daylight Savings Time is the practice of temporarily advancing clocks so that afternoons
have more daylight and mornings have less. Typically clocks are adjusted forward one hour
near the start of spring and are adjusted backward in autumn. Since the use of Daylight
Savings Time is not universal, you have the option of enabling or disabling it in MON2020.

To configure MON2020 to use Daylight Savings Time, do the following:

Procedure

1. Select View/Set Date Time... from the Chromatograph menu.
The View/Set Date Time window displays.

Note
Make sure the GC is set to the current date and time before enabling the Daylight
Savings feature.

2. Click the Enable Daylight Savings checkbox.
The Daylight Savings section will be enabled, giving you the following two options
for setting the start and end times for Daylight Savings:

• Week format. You can specify on which week day, of what week, and of what
month Daylight Savings Time to start and end.

• Month/Day format. You can specify the exact day of the month and the month
number for which you want Daylight Savings Time to start and end.

Note
These formats can be used interchangeably; for example, the Week format can be
used to specify the start date, and the Month/Day format can be used to specify the
end date.
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Figure 2-12: The Daylight Savings options

A. Week format
B. Start time
C. Month/day time
D. End time
E. Advance time
F. Set back time

3. Set the start date for Daylight Savings Time.

4. Set the start time and the advance time.

5. Set the end date for Daylight Savings Time.

6. Set the end time and the setback time.

7. Click OK to implement your changes and close the View/Set Date Time window.

Note
To implement your changes without closing the View/Set Date Time window, click
Save.

Note
Daylight Savings Time should be configured each time the feature is enabled;
thereafter, each year MON2020 will automatically compute the start and end times
based on the initial configuration.
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3 Hardware
Many of a gas chromatograph’s hardware components—such as its heaters, valves, and
discrete outputs—can be easily managed through MON2020 by clicking Hardware on the
menu bar.

This chapter shows you how to view and administer each of a gas chromatograph’s major
hardware components.

This chapter also shows you how to view an inventory of all of a gas chromatograph’s
installed hardware components.

3.1 Heater configuration
MON2020 allows you to do the following from the Heaters window:

• Name each heater.

• Monitor the heaters' performance.

• Set a target temperature.

3.1.1 Set the temperature of the gas chromatograph’s heaters
You can set a heater’s desired temperature or fix its power output by selecting Heaters…
from the Hardware menu. Use the Switch drop-down menuv to select each heater to set
to one of the following modes:

Auto Allows you to set the desired temperature for the heater.

Fixed On Allows you to set the power output for the heater without regard to
temperature.

Not Used Removes the heater from service.
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3.1.2 Rename a heater
To assign an identifying label to a heater, do the following:

Procedure

1. Select Heaters… from the Hardware menu.
The Heaters window displays.

2. Double-click on the appropriate row under the Label column for the heater that you
want to name.

3. Type in a descriptive name for the heater. This name must be unique; two heaters
cannot share the same label.

4. Click OK.

3.1.3 Set a heater’s voltage type
To set a heater’s voltage type, do the following:

Procedure

1. Select Heaters… from the Hardware menu.

2. Click on the appropriate Heater Type cell and select AC or DC from the drop-down
list.

3. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

3.1.4 Monitor the temperature of a heater
To check a heater’s temperature, select Heaters… from the Hardware menu.

The current temperature of each heater displays under the Temperature column, and
updates in real time. The percentage of the GC’s power output that is being used by each
heater displays under the Current PWM column.

3.1.5 Monitor the operational status of a heater
To check a heater’s status, select Heaters… from the Hardware menu.

The status of each heater displays under the Status column. There are four possible
statuses, and their meanings are as follows:

OK The heater’s control card is installed and is working correctly.

Not Installed The heater’s control card is not installed.

Out of Control The heater is running and is in the process of reaching its temperature
set point.

Error The GC cannot communicate with the heater.
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3.1.6 Set the desired temperature
To set the desired temperature for a heater, do the following:

Procedure

1. Select Heaters… from the Hardware menu.
The Heaters window displays.

2. For each heater that you want to set, select Hadware → Heaters → Auto from the
pull-down menu from the appropriate row under the Switch column.

3. For each heater that you want to set, double-click on the appropriate row under the
Setpoint column, and enter the desired temperature, in degrees Celsius. You can
enter a value between 20and 500.

Note
Heaters 1 and 2 should never exceed 302 °F (150 °C).

4. To exclude a heater from the warm start process, select its Ignore Warm Start
check box.

Note
A warm start occurs when the GC restarts after having been shut down during an
auto sequence analysis run. The GC activates the Heaters and waits until they reach
their setpoints and the temperature stabilizes; the GC then resumes the auto
sequence run.

5. The appropriate rows under the PID Gain, PID Integral, and PID Derivative columns
can also be edited by double-clicking and entering a new value. The value ranges for
each column is as follows:

PID Gain 0 - 500

PID Integral 0 - 500

PID Derivative 0 - 50,000

Note
You should not deviate from the default settings for these variables, which were
determined by experienced personnel.

6. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the
heaters’ statuses, click Save. The current temperature of each heater displays in the
Temperature column and is updated in real time.
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3.1.7 Set PWM output
Note
Pulse-width modulation (PWM) is a technique for providing intermediate amounts of
electrical power between fully on and fully off.

A heater needs voltage to operate. The amount of voltage that is delivered to a heater can
be controlled manually when the heater is set to Fixed On mode. Setting a heater to Fixed
On mode can be useful when troubleshooting heater issues.

 CAUTION

Fixed On mode is not recommended for general GC operations. Switching a heater to Fixed
On mode removes its ability to maintain a constant temperature because the power
delivered to the heater will not fluctuate based on the temperature setpoint, but will
instead remain at the level set by you.

To set a heater’s PWM Output, do the following:

Procedure

1. Select Heaters… from the Hardware menu.
The Heaters window displays.

2. For each heater that you want to set, select Fixed On from the appropriate row
under the Switch column.

3. For each heater that you want to set, double-click on the appropriate row under the
Fixed PWM Output column, and enter the desired percentage of output. You can
enter a decimal value between 0 and 100.

4. Click OK to save the changes and close the window, .

Note
To save the changes and leave the window open so that you can monitor the
heaters’ status, click Save. The current temperature of each heater displays in the
Temperature column and is updated in real time.

3.1.8 Take a heater out of service
To remove a heater from service, do the following:

Procedure

1. Select Heaters… from the Hardware menu.
The Heaters window displays.

2. For each heater that you want to set, select Not Used from the appropriate row
under the Switch column.
The row turns turquoise, indicating that it is no longer in service.

3. To save the changes and close the window, click OK.
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Note
To save the changes without closing the window, click Save.

3.2 Valve configuration
MON2020 allows you to do the following from the Valves window:

• Assign identifying labels to each valve.

• Monitor valve operation.

• Control the operation modes for each valve.

3.2.1 Rename a valve
Give each valve a descriptive label to avoid confusing one valve for another. To assign an
identifying label, do the following:

Procedure

1. Select Valves… from the Hardware menu.
The Valves window displays.

2. Double-click on the appropriate row under the Label column for the valve that you
want to name.

Note
The valves are labeled Valve 1 - Valve N by default, where N equals the total
number of valves available to the GC.

3. Type in a new descriptive name for the valve.

4. Click OK.
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3.2.2 Set a valve’s operational mode
A valve has three operational modes: Auto, On, and Off.

• Setting the valve to Off means that the valve turns off and remains off until the
operational mode is changed.

• Setting the valve to Auto means that the valve turns on and off according to the Timed
Events table.

• Setting the valve to On means that the valve turns on and remains on until the
operational mode is changed.

Note
The GC’s switch panel overrides MON2020’s valve settings.

To set a valve’s operational mode, do the following:

Procedure

1. Select Valves… from the Hardware menu.
The Valves window displays.

2. Select the desired mode from the drop-down menu under the Switch column for
the valve.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the valve’s
progress, click Save. The current state of the valve displays in the State column, and
is updated in real time.

3.2.3 Monitor the operational status of a valve
To check a valve’s status, select Valves… from the Hardware menu.

The status of each valve displays under the Status column. There are five possible status
readings, and their meanings are as follows:

OK The valve is installed and is working correctly.

Not Installed The valve is not installed.

Under/Over
Current Error

Unable to switch the solenoid on or off. There is a potential
problem with the solenoid.

Error The Heater/Solenoid board is installed but the GC cannot
communicate with it.

3.2.4 Invert the polarity of a valve
The Invert Polarity option reverses the effect of switching a valve on or off. By default, the
Invert Polarity option is unchecked. This means that switching the valve to ON activates it,
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and switching the valve to OFF deactivates it. Checking the Invert Polarity box means that
switching a valve to ON deactivates it, and switching the valve to OFF activates it.

To set the polarity of a valve, do the following:

Procedure

1. Select Valves… from the Hardware menu.
The Valves window displays.

2. If the Invert Polarity checkbox is selected, switching a valve to ON deactivates it,
and switching a valve to OFF activates it. Deselect the checkbox if you want
switching the valve ON to activate it and switching the valve OFF to deactivate it.

3.2.5 Set the usage mode for a valve
A valve’s usage mode determines its general function, or role, during an analysis run. A
valve can be assigned one of the following usage modes:

• Unused

• FID H2 Valve (700XA and 1500XA only)

• Stream

• Analyzer01 ... Analyzer016

The usage mode is set at the factory and under ordinary circumstances it should not be
changed.

To set the usage mode for a valve, do the following:

Procedure

1. Select Valves… from the Hardware menu.
The Valves window displays.

2. Select the desired mode from the dropdown list under the Usage column for the
valve.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the valve’s
progress, click Save. The current state of the valve displays in the State column, and
is updated in real time.

3.3 Managing the gas chromatograph's pressure
MON2020 allows you to do the following from the Hardware → EPC menu (for
Rosemount 370XA GCs only):

• Change the carrier pressure set point

• Monitor the EPC's status

• Switch EPC modes
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3.3.1 Change the carrier pressure set point
Note
This feature only works with the Rosemount 370XA GCs only.

Procedure

1. Select Hardware → EPC menu.
The EPC window opens.

2. Double-click the Set Point field and enter the desired value.

Note
If the field does not become active after double-clicking it, make sure the Switch
field is set to Auto.

3. Click OK.
The new set point will be accepted and the EPC window will close.

3.3.2 Check the status of the EPC
Note
This feature only works with Rosemount 370XA GCs.

Select Hardware → EPC menu. The EPC window opens.

Check the Status column to learn the current state of the EPC:

State Description

OK EPC is working normally and controlling the pressure to the set point.

Pressure Low The carrier pressure is too low.

Out of range The EPC is not able to control the pressure to the desired set point.
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3.3.3 Switch to a different EPC mode
Note
This feature only works with the 370XA.

Procedure

1. Select EPC on the Hardware menu.
The EPC window opens.

2. Click the Switch field.
A dropdown list opens.

3. Select the appropriate mode.

Option Description

Auto Let's the GC control and maintain its pressure at the desired set point.

Fixed On Allows you to control the power output for the EPC valve by entering a
value, in the Fixed PWM Output field.

Not Used Shuts off the EPC.

4. Click OK.
The EPC switches modes and the EPC window closes.

3.4 Detectors
Use the Detectors window to monitor the activity and status of the GC’s detectors.

To view the Detectors window, select Detectors… from the Hardware menu.

Note
Before making any modifications to this window, halt the analysis. See Halt an analysis for
more information.

Note
Blue cells display read-only data; white cells display editable data.

The following data displays for each detector:

Det # Numerical identifier for the detector to which the following
data applies.

Detector Options, which depend on your GC’s configuration, are TCD,
FPD FPD G2 (integral FPD), FID or FID G2 (integral FID).

Flame Temp RTD Select the appropriate RTD from the drop-down list. The RTD
measures the temperature of the FID flame.

H2 Valve Optional carrier shut-off valve

Flame Ignition Select Manual if you want to control the ignition of the FID;
select Auto if you want the GC to control the ignition of the FID.
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Ignition Attempts Indicates the number of times the GC will try to light the flame.
If an Auto FID ignition sequence fails to light the flame after the
specified number of attempts, the GC will close the hydrogen
valve, switch the ignition parameter to Manual, and set an
active alarm.

Wait Time Bet Tries Indicates the amount of time, in seconds, the GC will wait
between ignition attempts.

Igniter On Duration Indicates the length of time that the igniter will remain on.

Flame On Sense Temp The flame ignites when the butner internal temperature
exceeds the value set in this field.

Flame Out Sense Temp The flame is extinguished when the burner internal
temperature falls below the value set in Flame On Sense Temp.

FPD Flame Status DI Allows you to select from a list of available digital inputs. The
digital input that is selected will receive the FPD’s flame status
value.

Preamp Val Detector count. Read-only. See Auto-zero (Auto-Zero) for more
information.

Flame Temperature Temperature of the burner flame as read by the RTD. Read-
only.

Flame Status Options are: Off, On, and Over Temperature. Read-only.

H2 Valve Cur State Options are: Open and Closed. Read-only.

Scaling Factor Preamp calibration factor.

Igniter Status Options are: Off and On. Read-only.

Electrometer Voltage Output at first stage of FID/FPD preamp. Read-only.

Pre Amplifier Voltage Output at second stage of FID/FPD preamp. Read-only.

Polarizing Voltage Igniter voltage. Read-only.

Gain Status Options are: Low and High.

Status Options are: OK, Not Installed, and Internal Error. Read-only.

3.4.1 Gain High
The FID/FPD gain status displays on the Hardware → Detectors, which can be either Low
or High.

Procedure

1. If the gain status is Low and you want to set it to High, click Gain High button.

2. If the gain status is High and you want to change it to Low, click Gain Low.

Related information

Detectors
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3.4.2 Ignite the burner flame
If the Flame Ignition field on the Detectors window is set to Manual, and if the Flame
Status field is set to Off, do the following to restart the flame:

Procedure

1. Click Open H2 Valve.
The H2 Valve Cur State field changes to Open.

2. Click Ignite.
The Flame Status field changes to On when the internal flame temperature exceeds
the value set in the Flame On Sense Temp field.

Note
If the Flame Ignition field is set to Auto, the GC will automatically restart the flame
if it goes out.

Related information

Detectors

3.4.3 Open H2 Valve
To manually ignite the FID/FPD, the H2 valve must open.

Procedure

1. Click Hardware → Detectors and set the Flame Ignition field is set to Manual

2. Select the Open H2 Valve button.

3. The H2 Valve Cur State field changes to Open.

Related information

Detectors

3.4.4 Null Electrometer
The FID/FPD Detector's NULL Electrometer feature is used to reset the electromer.

Procedure

1. Click Hardware → Detectors.

2. Click the NULL Electrometer button to reset the FID/FPD electrometer.

Related information

Detectors
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3.4.5 Offset the baseline (700XA and1500XA only)
Note
In GC Firmware version 2.1.X and later, the bridge is automatically balanced by the
firmware.

In some situations that involve TCD detectors the baseline may be displayed either too
high on the graph, in which case the tops of the peaks are cut off, or too low on the graph,
so that the bases of the peaks are cut off. If this occurs it is possible to offset the baseline
either up or down so that the entire peak can be displayed on the graph. This offset will be
applied to all traces—live, archived and saved—that are displayed thereafter.

To offset the baseline, do the following:

Procedure

1. Select Detectors… from the Hardware menu.
The Detectors window displays.

2. Select the appropriate detector. It may be necessary to return to the Chromatogram
Viewer to learn which detector is the source of the trace that needs to be offset.

3. Balance the preamp:
• To lower the baseline, click Lower Baseline (N). Each time this button is clicked,

N is incremented by -1. For example, if this is the first time the button has been
clicked, Lower Baseline(0) is incremented to Lower Baseline(-1), and the
baseline is lowered one step. If Raise Baseline(N) was clicked previously, then
that button is incremented by -1 first, until it reaches RaiseBaseline(0); at that
point, Lower Baseline(N) is incremented by -1.

Note
To reset the baseline to its original setting, click Raise Baseline(N) and Lower
Baseline(N) until they read Raise Baseline(0) and Lower Baseline(0).

• To raise the baseline, click Raise Baseline(N). Each time this button is clicked, N
is incremented by 1. For example, if this is the first time the button has been
clicked, Raise Baseline(0) is incremented to Raise Baseline(1), and the baseline
is raised one step. If Lower Baseline(N) was clicked previously, then that button
is incremented by 1 first, until it reaches Lower Baseline(0); at that point, Raise
Baseline(N) is incremented by 1.

Note
To reset the baseline to its original setting, click Right(N) and Left(N) until they
read Raise Baseline(0) and Lower Baseline(0).

4. After the baseline has been raised or lowered to your satisfaction, click OK.
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3.4.6 Auto-zero
To automatically adjust the baseline, click Auto-Zero. This only applies to FID or FPD
detectors.

Related information

Detectors

3.4.7 Setting the Detector Gain
The Detector window displays the detector's gain status, which can be either Low or High.

Procedure

1. If the detector's gain status is Low and you want to set it to High, click Gain High.

2. If the detector's gain status is High and you want to change it to Low, click Gain
Low.

3.4.8 Resetting the Electrometer
To reset the detector's electrometer, do the following.

Procedure

1. From the Hardware → Detector menu, click NULL Electrometer..

2. Click OK to apply your edits.

3.5 Discrete inputs
You can use MON2020 to assign labels to the GC’s discrete inputs and to control the
discrete inputs’ operational modes. The number of discrete inputs available depends on
the GC.

3.5.1 Rename a discrete input
Give each discrete input a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:

Procedure

1. Select Discrete Inputs… from the Hardware menu.
The Discrete Inputs window displays.

2. Double-click on the appropriate row under the Label column for the discrete input
that you want to rename.

Note
The discrete inputs are labeled Discrete Input 1 - Discrete Input N by default,
where N equals the total number of discrete inputs available to the GC.

3. Type in a new descriptive name for the discrete input.
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4. Click OK.

Note
Several of the discrete inputs on the 700XA/1500XA GCs are pre-defined and
mapped by default to System Alarms. Renaming these discrete inputs does not
remove the underlying system alarm. You will need to disable the associated
system alarm before renaming the discrete input. View System Alarms describes
how to edit system alarms.

On the 700XA, the following discrete inputs are mapped to System Alarms by
default.

Discrete Input DI Description System Alarm Name

1 Sample Flow Switch 1 No Sample Flow 1

2 Sample Flow Switch 2 No Sample Flow 2

6 Pressure Switch 1 Low Carrier Pressure 1

7 Pressure Switch 2 Low Carrier Pressure 2

On the 1500XA, the following discrete inputs are mapped to System Alarms by
default.
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Discrete Input DI Description System Alarm Name

1 Sample Flow Switch 1 No Sample Flow 1

2 Sample Flow Switch 2 No Sample Flow 2

3 Loss Of Purge Loss Of Purge

6 Pressure Switch 1 Low Carrier Pressure 1

7 Pressure Switch 2 Low Carrier Pressure 2

3.5.2 Set a discrete input’s operational mode
A discrete input has three operational modes: Auto, On, and Off.

• Setting the discrete input to Off means that it will interpret all incoming signals as OFF,
despite the true nature of the signal.

• Setting the discrete input to Auto means that it will analyze the incoming signal to
determine whether it is ON or OFF.

• Setting the discrete input to On means that it will interpret all incoming signals as ON,
despite the true nature of the signal.

To set a discrete input’s operational mode, do the following:

Procedure

1. Select Discrete Input… from the Hardware menu.
The Discrete Input window displays.

2. Select the desired mode from the drop-down list under the Switch column for the
discrete input.

3. To save the changes and leave the window open so that you can monitor the
discrete input’s progress, click Save. The current state of the discrete input displays
in the State column, and is updated in real time.

4. To save the changes and close the window, click OK.
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3.5.3 Monitor the operational status of a discrete input
Procedure

To check a valve’s status, select Discrete Input… from the Hardware menu.
The status of each discrete input displays under the Status column. There are three
possible status readings, and their meanings are as follows:

OK The discrete input is installed and is working correctly.

Not Installed The discrete input is not installed.

Error The Heater/Solenoid board is installed but the GC cannot communicate
with it.

3.5.4 Invert the polarity of a discrete input
The Invert Polarity option reverses the way a voltage signal is interpreted by the discrete
input. By default, the Invert Polarity option is set to Normally Open, which means that a
high voltage signal is interpreted by the discrete input as ON, and a low voltage signal is
interpreted by the discrete input as OFF. Setting Invert Polarity to Normally Closed
means that a high voltage signal is interpreted by the discrete input as OFF, and a low
voltage signal is interpreted by the discrete input as ON.

To set the polarity of a discrete input, do the following:

Procedure

1. Select Discrete Input… from the Hardware menu.
The Discrete Inputs window displays.

2. Select Normally Open or Normally Closed from the drop-down menu under the
Invert Polarity column.

3.6 Discrete outputs
You can use MON2020 to assign labels to the GC’s discrete outputs and to control the
discrete outputs’ operational modes. The number of discrete outputs available depends
on the GC.

3.6.1 Rename a discrete output
Give each discrete output a descriptive label to avoid confusing one unit for another.

To assign an identifying label, do the following:

Procedure

1. Select Discrete Outputs… from the Hardware menu.
The Discrete Outputs window displays.

2. Double-click on the appropriate row under the Label column for the discrete output
that you want to rename.
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Note
The discrete outputs are labeled Discrete Output 1 - Discrete Output N by default,
where N equals the total number of discrete outputs available to the GC.

3. Type in a new descriptive name for the discrete output.

4. Click OK.

3.6.2 Set a discrete output’s operational mode
A discrete output has three operational modes: Auto, On, and Off.

• Setting the discrete output to Off means that the discrete output will turn off and
remain off until the operational mode is changed.

• Setting the discrete output to Auto means that the discrete output will turn on and off
according to the Timed Events table or the Discrete Outputs table.

• Setting the discrete output to On means that the discrete output will turn on and
remain on until the operational mode is changed.

To set a discrete output’s operational mode, do the following:

Procedure

1. Select Discrete Output… from the Hardware menu.
The Discrete Output window displays.

2. Select the desired mode from the drop-down menu under the Switch column for
the discrete output.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the
discrete output’s progress, click Save. The current state of the discrete output
displays in the State column, and is updated in real time.

3.6.3 Monitor the operational status of a discrete output
Procedure

To check a discrete output’s status, select Discrete Output… from the Hardware menu.
The status of each discrete output displays under the Status column. There are three
possible status readings, and their meanings are as follows:

OK The discrete output is installed and is working correctly.

Not Installed The discrete output is not installed.

Error The Heater/Solenoid board is installed but the GC cannot communicate
with it.
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3.6.4 Set the usage mode for a discrete output
A discrete output’s usage mode determines which signals are routed to it via the Limited
Alarm and Discrete Alarm functions. A discrete output can be assigned one of the
following usage modes:

• DO

• Common Alarm

• FID/FPD H2 valve

• Stream

• Analyzer01
…

• Analyzer016

• Calibration

• Calibration on Analysis Clock(N)

• Maintenance

• Calibration or Maintenance

• Validation

• Calibration or Validation or Maintenance

To set the usage mode for a discrete output, do the following:

Procedure

1. Select Discrete Output… from the Hardware menu.
The Discrete Output window displays.

2. Select the desired mode from the drop-down menu under the Usage column for
the discrete output.

Options are:

• Calibration on Analysis Clock 1

• Maintenance

• Calibration or Maintenance on Analysis Clock 1

• Validation on Analysis Clock 1

• Calibration or Validation or Maintenance on Analysis Clock 1

• Calibration on CC2

• Calibration or Maintenance on CC2

• Validation on CC2

• Calibration or Validation or Maintenance on CC2

• Calibration on CC3

• Calibration or Maintenance on CC3
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• Validation on CC3

• Calibration or Validation or Maintenance on CC3

• Calibration on CC4

• Calibration or Maintenance on CC4

• Validation on CC4

• Calibration or Validation or Maintenance on CC4

3. If you select DO for Usage, then you must also set the Start Time and Duration.

a) Click on the appropriate row under the Start Time column and enter the
time that the digital output should be turned on.

b) Click on the appropriate row under the Duration column and enter the
amount of time (in Hour:Minute:Second format) that the digital output
should remain on.

c) Click on the appropriate row under the Interval column and enter the
amount of time, in hours, that should pass before the digital output turns on
again.

4. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the
discrete output’s progress, click Save. The current state of the discrete output
displays in the State column, and is updated in real time.
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3.6.5 Invert the polarity of a discrete output
To set the polarity of a discrete output:

Procedure

1. Select Discrete Output... from the Hardware menu.
The Discrete Outputs window displays.

2. Check or uncheck the box under the Invert Polarity column.
With Invert Polarity unchecked:

DO current value Normally open terminals Normally closed terminals

On Closed Open

Off Open Closed

With Invert Polarity checked:

DO current value Normally open terminals Normally closed terminals

On Open Closed

Off Closed Open

3.7 Manage your gas chromatograph’s analog
inputs
With MON2020 you can control analog inputs in the following ways:

• Assign identifying labels.

• Assign scale ranges.

• Calibrate analog inputs for zero and full scale values.

• Code

• Analog Input 4-20 mA external loop power

Note
Electrical current signals ranging from 4 to 20 mA (±10%) are accepted as analog inputs.

3.7.1 Rename an analog input
Give each analog input a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:

Procedure

1. Select Analog Inputs… from the Hardware menu.
The Analog Inputs window displays.
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2. Double-click on the appropriate row under the Label column for the analog input
that you want to rename.

Note
The analog input devices are labeled Analog Input 1 and Analog Input N by default,
where N equals the total number of analog inputs available to the GC.

3. Type in a new descriptive name for the analog input.

4. Click OK.

3.7.2 Set an analog input’s operational mode
An analog input has the following operational modes:

• Var_Standard: The analog input will be set automatically, based on the signal it
receives.

• Var_Namur_NE43: Namur_NE43 uses the 3.8 to 20.5 mA signal range for
measurement information, with ≥21 mA or ≤3.6 mA to indicate diagnostic failures.

• Setting the switch to Fixed means that the analog input will be set to the value that you
enter in the appropriate row under the Fixed Value column. This is the default setting.

To set an analog input’s operational mode, do the following:

Procedure

1. Select Analog Inputs… from the Hardware menu.
The Analog Input window displays.

2. Select the desired mode from the drop-down menu under the Switch column for
the analog input.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog
input, click Save. The current value of the analog input signal displays in the Current
Value column, and is updated in real time.

3.7.3 Set the scale values for an analog input device
To set the zero scale and full scale, which are used when converting the analog input value,
do the following:

Procedure

1. Select Analog Input… from the Hardware menu.
The Analog Input window displays.

2. Double-click on appropriate row under the Zero Scale column and enter a zero
scale value.

3. Double-click on appropriate row under the Full Scale column and enter a full scale
value.
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4. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog
input, click Save.

3.7.4 Assign an Analog Inputs code
Sets the unique code for each available analog input system variable.

The same code value is outputted via Modbus to differentiate the analog inputs.

Procedure

1. Use the Hardware → Analog Input menu.

2. Select the Code column and enter the code for the analog input.

3.7.5 Set the type of analog input signal
The GC’s analog inputs can receive a 4-20 mA current. To set the type of signal generated
by the analog input device, do the following:

Procedure

1. Select Analog Inputs… from the Hardware menu.
The Analog Inputs window displays.

2. Select Switch and use the pull-down menu to choose the input type.

• Setting the switch to Variable means that the analog input will be set
automatically, based on the signal it receives.
— Options are: Var_Std

— Var_Namur_NE43

• Setting the switch to Fixed means that the analog input will be set to the value
that you enter in the appropriate row under the Fixed Value column.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog
input’s progress, click Save. The type of signal being generated displays in the mA/
Volts column, and is updated in real time.

3.7.6 Monitor the status of an analog input
To check an analog input’s status, select Analog Input… from the Hardware menu.

The operational status of each analog input displays under the Status column. There are
three possible status readings, and their meanings are as follows:

OK The analog input is installed and is working correctly.
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Not Installed The analog input is not installed.

Error The analog input is installed, but the GC cannot communicate with it.

This window also displays other types of data, such as the following:

mA The type of analog input signal being received.

mA If mA displays in the mA column, then this column displays the amount of
current being received, in milliamperes.

Cur Val The current value of the analog input signal.

3.7.7 Calibrate an analog input
To calibrate an analog input, do the following:

Procedure

1. Select Analog Input… from the Hardware menu.
The Analog Input window displays.

2. Click the analog input that you want to calibrate.

3. Set the analog input’s Zero Scale by entering its minimum anticipated value.

4. Set the analog input’s Full Scale by entering its maximum anticipated value.

5. Click AutoCal…(F4) or press F4.
The Analog Input Calibration Assistant runs.

6. Click Next.
Step 2 of the Analog Input Calibration Assistant displays.

7. Click Next.
Step 3 of the Analog Input Calibration Assistant displays.

8. Click Next.
Step 4 of the Analog Input Calibration Assistant displays.

9. Click Finish.
The calibration is complete.

3.8 Analog outputs
With MON2020 you can control the analog outputs in the following ways:

• Assign identifying labels.

• Assign scale ranges.

• Calibrate analog outputs for zero and full scale values.

• Analog Input 4-20 mA external loop power

3.8.1 Rename an analog output
Give each analog output a descriptive label to avoid confusing one unit for another. To
assign an identifying label, do the following:
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Procedure

1. Select Hardware → Analog Outputs… from the menu.
The Analog Outputs window displays.

2. Double-click on the appropriate row under the Label column for the analog output
that you want to rename.

Note
The analog output devices are labeled Analog Output 1 - Analog Output N by
default, where N equals the total number of analog outputs available to the GC.

3. Type in a new descriptive name for the analog output.

4. Click OK.

3.8.2 Set an analog output’s operational mode
An analog output has the following operational modes:

• Var_Standard: Setting the switch to Var_Standard means that the analog output will
be proportional to the variable selected in from the Variables column.

• Var_Namur_NE43: Namur_NE43 uses the 3.8 to 20.5 mA signal range for
measurement information, with ≥21 mA or ≤3.6 mA to indicate diagnostic failures.

• Fixed: Setting the switch to Fixed means that the analog output will be set to the value
that is entered in the appropriate row under the Fixed Value column. This is the default
setting.

To set an analog output’s operational mode, do the following:

Procedure

1. Select Analog Output… from the Hardware menu.
The Analog Output window displays.

2. Select the desired mode from the drop-down menu under the Switch column for
the analog output.

3. Click the drop-down menu in the Variable column.

4. Double click the Variable name and click to configure the selected opton.
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5. Click Save to save the changes and leave the window open so that you can monitor
the analog output.

Note
To save the changes and close the window, click OK. The current value of the analog
output displays in the Cur Val column, and is updated in real time.

3.8.3 Set the scale values for an analog output device
To set the zero scale and full scale, which are used when converting the analog output
value, do the following:

Procedure

1. Select Analog Output… from the Hardware menu.
The Analog Output window displays.

2. Click on appropriate row under the Zero Scale column and enter a zero scale value.

3. Click on appropriate row under the Full Scale column and enter a full scale value.

4. Click OK to save the changes and close the window.
To save the changes and leave the window open so that you can monitor the analog
output’s progress, click Save.

3.8.4 Map a system variable to an analog output
To select the system variable on which to base the signal level of the analog output, do the
following:

Procedure

1. Select Hardware → Analog Output… from the menu.
The Analog Output window displays.

2. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

For a demonstration of how to use the context-sensitive variable selector, see The
context-sensitive variable selector.

3. Click OK to save the changes and close the window.

Note
To save the changes and leave the window open so that you can monitor the analog
output’s progress, click Save.
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3.8.5 Monitor the status of an analog output
To check an analog output device’s status, select Analog Output… from the Hardware
menu.

The operational status of each analog output displays under the Status column. There are
three possible status readings, and their meanings are as follows:

OK The analog output device is installed and is working correctly.

Not Installed The analog output device is not installed.

Error The Heater/Solenoid board is installed but the GC cannot communicate
with it.

This window also displays other types of data, such as the following:

mA The amount of current being generated in milliamperes.

Loop Power Loop power can be configured as Internal or External ,
• Internal – This uses internal power from GC power supply and this is

default setting.

• External – This uses external power supply

The 4-20 mA loop current is changed by varying the opposition
(resistance) to current flow on the loop. Used to measure the process
variables.

Current
Value

The current scaled value of the analog output signal.

Related information

Hardware menu

3.8.6 Calibrate an analog output
To automatically calibrate an analog output, do the following:

Procedure

1. Select Analog Output… from the Hardware menu.
The Analog Outputs window displays.

2. Click the analog output that you want to calibrate.

3. Click AutoCal…(F4) or press F4.
The Analog Output Calibration Assistant runs.

4. Select the checkbox for the unit of measure you want to use for the calibration and
then click Next.
Step 2 of the Analog Output Calibration Assistant displays.

5. Enter the Zero Scale Adjustment value and then click Next.
If the value entered is within tolerance, it is accepted and Step 3 of the Analog
Output Calibration Wizard displays. If the value is not within tolerance, an error icon
( ) appears beside the field. Tolerance is set to ±1 mA of the analog output’s default
zero adjustment setting, which is 4 mA. Enter a different value and try again.
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6. Enter the Full Scale Adjustment value and then click Next.
If the value entered is within tolerance, it is accepted and Step 4 of the Analog
Output Calibration Wizard displays. If the value is not within tolerance, an error icon
( ) appears beside the field. Tolerance is set to ±1 mA of the analog output’s default
full adjustment setting, which is 20 mA. Enter a different value and try again.

7. Click Finish.
The calibration is complete.

Related information

Hardware menu

3.9 Installed Hardware
MON2020 can compile an inventory table of all hardware that is installed on the GC. To
view this table, select Installed Hardware… from the Hardware menu.

The type of hardware installed is listed under the Device Description column. The other
types of information available on this screen are the following:

IO Function Describes the function of the device.

Slot Number Describes the location of the hardware in the GC. The slot number
refers to the card cage assembly, which is located in the GC’s
Electronics enclosure. For the Rosemount 700XA and Rosemount
1500XA, the slots are labeled:
• Expansion Slot 1

• Expansion Slot 2

• Slot 1

• Slot 2

• Slot 3

• Slot 4

• Base IO

• Foundation Field Bus

• LOI

• Expansion Slot 3

• Expansion Slot 4

• FID1

• FPD1

• Slot 5

• FPD G2 Slot 1

• FPD G2 Slot 2

• FID G2 Slot 1
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• FID G2 Slot 2

• EPC G2 Slot

• FPD G2 Slot 3

• FPD G2 Slot 4

• FID G2 Slot 3

• FID G2 Slot 4

There are no slots in the 370XA, therefore this column will display
Analyzer for all hardware.

Revision The revision number of the backplane.

Device
Description

Describes data for a field device.
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4 Application
Many of the variables that a gas chromatograph uses during an analysis run—such as timed
events, stream sequence, and calculation types—can be easily managed through
MON2020.

This chapter explains how to do the following:

• View and edit general information about the GC to which MON2020 is connected, such
as name, model, and default stream sequence.

• View and edit component data, validation data, and timed event tables.

• View and change control, average, and user-defined calculations.

• View and edit limit alarm data.

• View and change stream data.

• View and edit the stream sequence.

• View and edit communication and ethernet port data.

• View and map LOI status variables.

• View and map the FOUNDATION fieldbus process variables.

4.1 System
Use this feature to select the default GC stream sequence and to set or edit system-wide
variables such as the GC's name, serial number, and system description.

The following information displays on this window:

Name Description

Analyzer Name Defines the GC name that a the Status Bar on the main window when MON2020 is
connected to the GC. Can contain up to twelve characters.

System description A place to record miscellaneous reference information to fur identify the currently
connected system. Can contain up to twenty-eight characters

Site Id Holds customer-defined identification information.

Company Name The name of the company that operates the GC.

Location The physical location of the GC.

Model The model number of the GC.

Serial No. Serial number of the GC. This is a unique identifier that is given to the GC at the factory.

Firmware Version Revision level of firmware of the GC and its associated firmware checksum.

Standard Component Table
Version for GPA

Indicates which version of the GPA's standard component table is being used.

Standard Component Table
Version for ISO

Indicates which version of the standard component table is being used.
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Name Description

CGM FCAL Archive Sets he storage behavior for final calibration chromatograms. The options are:
1. Keep Last FCAL Per Day - the last final calibration chromatogram of the day.

2. Keep All FCAL Per Day - Saves all final calibration chromatograph.

CGM FVAL Archive Sets the storage behavior for final validation chromatograms. The options are:
1. Keep Last FVAL Per Day - Saves only the la validation chromatogram of the day.

2. Keep FVAL Per Day - Saves all final validation chromatograms.

Date Format Defines how the date will be displayed. Th are:
• MM$$DD$$YYYY

• MM$DD$YY

• DD$MM$YYYY

• DD$MM$YY

• YYYY$MM$DD

• YY$MM$DD

$ is the Date Field Separator

Date Field Separator Defines the text symbol that will be used as the separator when displaying he options are:
• /

• -

• .

Time Format Defines how will be displayed. The options are:
• HH:M

• HH:MM

Time Notation Defines the cycle of time to use when displaying the time: The options are:
• 12 Hr

• 24 Hr

Synchronize with FF Timing Sets the GC's time to match the Foundation Fieldbus' time. Enabled by selecting the
checkbox.

Show Advanced System
Variables

Determines whether advanced system variables will be displayed along with basic system
variables. Advanced system variables can be customized and may include:
• Anaylzer Name

• System Description

• Company Name

• Location

• Chromatograph ID

Allow Multiple Writers Determines whether all supervisor-level users that connect to the GC have write access,
or just the first supervisor-level user to connect. Options are True and False.

Maintenance Mode Switches the GC to maintenance d triggers an alarm that the GC is down for maintenance.
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Name Description

Max Warm start Delay This is the maximum time, (in Hours) after a GC recovers power failure during normal
operation, that the GC will wait for and electronic pressure controller to reach their
respective set and stabilize before triggering the Warm start Failure alarm.

Energy Value Check If enabled, the GC analyzes the calibration gas as an unknown stream and computes its
energy value. The GC then compares this value to the Cal Gas Cert CV and determines if
the calibration gas' energy value is within the CV Check Allowed Deviation. If it isn't, the
GC triggers the Energy Value Invalid alarm.
The following conditions must be met before the GC can perform a EV Check:

• The EV Check flag in the System window must be enabled.

• At least one stream must be set up in the Streams window as a calibration stream and
the Auto flag for this stream must be enabled.

The EV Check is performed under any of the following circumstances:

• During a warm start that follows a power failure during normal operation. The GC
waits for the heater and electronic pressure controller to reach their respective set
points and stabilize. It then analyzes the calibration gas as an unknown stream and
identifies the peaks. If all the component peaks are identified, the GC computes the
calibration gas' energy value and performs the EV Check.

• After a successful calibration, the GC computes the gas' energy value with the new
response factors and performs the EV Check.

Sales Order Number The sales number for the GC. When contacting Customer Support, you may be asked to
provide this number to the Customer Support agent.

Calibration Retry on Failure A calibration fails, the GC will re-run the calibration sequence.

Calibration Repeatability
Check

If enabled, the GC will check of the repeatability of calibration runs to the limits specified
in ISO6974-6:2002(E), Table 1. If the calibration fails to meet the conditions set forth in
the table, then the calibration is deemed to have failed and the GC will rerun the
calibration sequence.

Metrology Type Shows the metrology type that the GC is configured for.

GC Id This field can be used to store a unique text string that will be associated with the GC and
that can be displayed on reports.

Identification Number This field can be used to store a unique text string that will be associated with the GC and
that can be displayed on reports.

Configuration Checksum at
Lockout

The checksum of the configuration fields that is calculated when the security switch is
locked.

Current Configuration
Checksum

The GC will periodically recalculate and update the configuration checksum. This current
value will be the latest calculated value.

Checksum Update Time The time that the configuration checksum was last updated.

Chromatograph ID A three character string value which is unique across all installed GCs. The first character
must be a letter, and the second and third characters may be either numbers or letters.
Special characters are not allowed in the Chromatograph ID.

Chromatograph Site ID A float value; you can set any float value to differentiate the GCs.
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Name Description

Keep Last Good Average A checkbox column.
1. If you uncheck this option, then a zero value will be logged in the archive records

during times when the alarm is not averaging.

2. If you check this option st average value will be logged in the archive records when
the alarm is not averaging. In this case, the number of samples is set to zero while
the average archive records.

Ext. Modbus® Calibration
Archive Data

A dropdown list with the following options (the selected option will be used by the
Calibration and Final Calibration data types in the Modbus Map Editor for the 700XA series
registers):

1. Circular Buffer (default): If you select this archived calibration, data will be logged as
a circular buffer and will store a maximum of 35 calibration records.

2. Contract Day: If you select this option, the calibration data will be for each contract
day and will store a maximum of one month of calibration data. This option will be
selected for El Paso type applications.

GC Mode (370XA only). Allows you to select an operating mode for the GC.

Modbus® Stream Alarm Bit
Association

(370XA only). Modbus® Stream Alarm Bit Association defines the behavior of how stream
specific alarms are encoded into Analysis Stream → Active Low Alarm Status and
Analysis Stream  → Active High Alarm Status system variables. Possible values for this
column:
• 0 - SIM2251 Emulation - [Default] status (active or inactive). If you select this option,

the only one stream will be displayed. The first alarm configured for a particular
stream in the Limit Alarms screen will be conveyed through Bit 0 Status (active or
inactive). The second alarm configured for a particular stream will be conveyed
through Bit 1, and so on. The status for up to 32 limit alarms per stream can be
transmitted if a 32 bit register is used.

• 1 - Limit Alarm Row Position -The row position in the Limit Alarms screen determines
which bit is used to convey status. If you select this the statuses of up to 32 alarms
selected in the Limit Alarms screen will be displayed. Status (active or inactive) of
Limit Alarm 1 is conveyed it 0. Status (active or inactive) of Limit Alarm 2 is conveyed
through Bit 1, so on. The status for up to 32 limit alarms per stream can be
transmitted if a 32 bit register is used.

Default Stream Sequence (370XA only). Sets the default sequence to be used by the indicated detector during
auto-sequencing. To create a new stream sequence or to edit an already-created
sequence, click Stream Sequence.

Calculate Checksum Click Calculate Checksum to calculate the current configuration checksum of the input
file and the number of bytes the file contains.

1. Press Calculate Checksum at the bottom of the System window to compute a 32-bit
checksum of the configuration that can be compared to the Configuration Checksum
at Lockout field to determine if the analyzer's configuration has been modified.

2. The checksum that is calculated is stored in the Current Configuration Checksum field
and the date and time of the calculation is stored in the Checksum Update Time field.
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Note
If you receive a Configuration checksum calculation failed error message after
pressing Calculate Checksum, contact your local Rosemount Customer Care
Representative.

Related information

Application
Create a stream sequence for a detector
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4.2 The component data tables
MON2020 allows you to view and edit the component data tables. The number of
available component data tables depends on the GC unit configuration.

To assign a component data table to a stream, see Link a valve with a stream.

Procedure

1. To view a component data table, select Component Data... from the Application
menu.

The Component Data Tables window appears, displaying a list of available
component data tables.

Note
You can also access the component data tables by pressing F6 or by clicking  from
the Toolbar.

2. Select the table that you want to view.

The selected component data table displays.

Note
To see a different table, select it from the Choose table dropdown list.

Note
To sort the list of components by detector, and then by retention time, click Sort
RT.

4.2.1 Edit a component data table
Note
Table cells with a white or yellow background are editable; table cells with a turquoise
background are not editable.

To edit a cell, do the following:

Procedure

1. Click the Cell.
Depending on the cell type, you are either required to select a value from a
dropdown list, or you can type in the value directly.

2. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

The following table lists all of the editable parameters available on the Component
Data Table window. The standard values for these parameters were taken from the
second editions of the Orifice Metering of Natural Gas and Other Related Hydrocarbon
Fluids and the Compressibility Factors of Natural Gas and Other Related Hydrocarbon
Gases.
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Component This drop-down list contains the complete catalog of
available components for the selected stream.

Usr Std Indicates the source of the component:
• Usr - The component was edited or defined by the user.

• Std - The component was selected from the standard list
of components and no changes were made to its standard
data.

Det # The component’s detector number.

Ret Time Time in seconds before the apex of the component’s peak
will appear. The retention time can be set from 0 to 3600
seconds.

 CAUTION

Ensure that the component retention times do not exceed
the analysis time, as defined by the Timed Events table.
MON2020 does not automatically prevent the user from
defining excessive component retention times.

Resp Factor A component’s response factor is equal to the raw data of
the component’s peak divided by the component’s
concentration. The maximum value is 1.0E+38.

Calib Type MON2020 can perform six types of calibrations:
• Single-Level - Uses the standard calibration in which the

response factor is needed to determine the mole
percentage during the calibration.

• Fixed - During the calibration, the response factor is not
updated.

• Relative - Calibration in which a reference component is
used to compute the mole percentage.

• Multi-Level - Uses a polynomial equation to compute the
mole percentage during the calibration. Values must be
entered in the Multi-level Calib a, Multi-level Calib b,
Multi-level Calib c, and Multi-level Calib d cells.

• 2-pt Calib - Uses an exponential power fit using two
different points to address non-linear detector response.
Two calibration gases - Low and High with different
calibration concentrations are required. By doing a single-
level (or linear) calibration on these individual streams,
the GC computes the coefficients for the 2-pt exponential
power fit. To set up an Analysis/Validation stream to use
2-pt calibration, see Set up an Analysis/Validation stream
to use 2 point calibration (700XA and 1500XA only).
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• From CDT X (X = 1 to 8) - Allows you to copy calibration
factors (Response Factor and Retention Time) from
another CDT. This is used when two or more calibration
gases are required to generate response factors and
retention times for all the components that are to be
analyzed. At the end of a successful calibration, response
factors and retention time will be copied from the
alternate CDT.

Calib Conc The amount, in mole %, parts per million (ppm), parts per
billion (ppb), or mg/m3 of the component that is present in
the calibration gas.

Unit Indicates the unit of measure used when calculating and
displaying the component’s calibration concentration.
Options are Mole%, ppm, ppb, and mg/m3.

Cal Conc
Uncertainty

For the 370XA only, uncertainty values from the calibration
gas's certificate. Default value is 2.

Anly Meth Defines how the component concentration is computed. The
analysis method can take one of the following values:
• Area - Calculates the component concentration by

dividing the peak area by the response factor.

• Height - Calculates the component concentration by
dividing the peak height by the response factor.

• Fixed - The component concentration equals the
component's calibration concentration displayed in the
Calib Conc column of the component data table. No
calculation is performed using the response factor.

• By Difference - All components except one (n) are added
up and then subtracted from 100%. n is 100 - (sum of all
other components).

• Analog Input - The GC reads the analog input channel,
scales the raw milliampere value to engineering values
that were set in the Analog Inputs window, and uses this
value as the component concentration. No calculation is
performed using the response factor.

RT Secs Dev The maximum acceptable deviation time, in seconds, of the
new retention time from the current retention time.

RT Upd Meth Determines when the retention time will be updated.
Options are:
• Cal - Updates the retention time only during the final

calibration run.

• Anly - Updates after each analysis.

Resp Fact % The maximum acceptable percent of deviation between the
new response factor and the current response factor.
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Gross Dry BTU Gross energy content per cubic foot (ft3), assuming no water
is present.

Net Dry BTU Net energy content per cubic foot, assuming no water is
present.

Gross Dry BTU per
lb

Gross energy content per pound, assuming no water is
present.

HV Sup MJ/m3 Gross heating value in megajoules per cubic meter.

HV Inf MJ/m3 Net heating value in megajoules per cubic meter.

HV Sup MJ/kg Gross heating value in megajoules per kilogram.

HV Inf MJ/kg Net heating value in megajoules per kilogram.

Sum Factor Pri Used to calculate the compressibility factor. See Streams for
more information.

Sum Factor Sec Used to calculate the compressibility factor. (the ratio of the
actual volume of a real gas to the volume predicted by the
ideal gas at the same temperature and pressure).

CV Superior
KJ/mol - Pri

Gross caloric value per kilojoule/mol (kJ/mole %).

CV Inferior Pri Net caloric value per kilojoule/mol (kJ/mole %).

CV Superior
KJ/mol - Sec

Gross caloric value per kilojoule/mole (kJ/mole %).

CV Inferior Sec Net caloric value per kilojoule (kJ/mole %).

Hydrogen Atoms Displays the number of hydrogen atoms for a component.

Gals/1000 SCF Liquid equivalent volume in gallons/1000 ft3.

Reid Vapor The component’s vapor pressure in pounds per square inch
(psia) at 100.0 °F (38 °C)

Lbs/Gallon Liquid density for the component at base conditions.

Rel Dens Gas The relative density of the gas phase for the component at
base conditions.

Rel Dens Liquid The relative density of the liquid phase for the component at
base conditions.

Mole Weight The molecular weight of the component, which is used to
calculate the weight percent of each component in the
sample.

Carbon Weight The molecular weight of the carbon atoms in the
component.

AGA 8 Component The name of the component according to the American Gas
Association, which is used in the AGA 8 compressibility
calculation.
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Ref Comp The component not found in the calibration gas but in the
sample gas for indirect calibration. If none, normal (direct)
calibration is used.

Not editable unless the calibration type is set to Relative.

Rel Resp Fact A fixed multiple of the response factor of the component
found in the sample gas for indirect calibration.

Not editable unless the calibration type is set to Relative.

Rel Dens Liquid
15C

The relative density in kilograms per cubic meter (kg/m3) of
the liquid phase for the component at 15 °C.

Molar Mass The mass of one mole of the component.

Multi-level Calib a Third-order polynomial coefficient for multi-level
calibrations.

Not editable unless the calibration type is set to Multi-Level.
See Multi-Level Calibration.

Multi-level Calib b Second-order polynomial coefficient for multi-level
calibrations.

Not editable unless the calibration type is set to Multi-Level.

Multi-level Calib c First-order polynomial coefficient for multi-level calibrations.

Not editable unless the calibration type is set to Multi-Level.

Multi-level Calib d Zero-order polynomial coefficient for multi-level calibrations.

Not editable unless the calibration type is set to Multi-Level.

Component Code
(UK)

An index number that corresponds to the standard
component numbers taken from the American Gas
Association. Up to 20 components can be defined per data
table.

Component Code
(US)

An index number that corresponds to the standard
component numbers taken from the American Gas
Association. Up to 20 components can be defined per data
table.

2 Pt Calib Low CDT The component data table associated with a low calibration
gas (700XA and 1500XA only).

2 Pt Calib High
CDT

The component data table associated with a high calibration
gas (700XA and 1500XA only).

2 Pt Exp Value calculated from the 2 pt Calib Low CDT and the 2 Pt
Calib High CDT (700XA and 1500XA only). See Set up an
Analysis/Validation stream to use 2 point calibration (700XA
and 1500XA only) for more information on 2-pt. calibration.

Related information

Add a Component to a Component Data Table
Remove component from CDT
View raw data
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View standard values
Enter Energy Value
Change the default C6+ mixture ratio

4.2.2 Editing a calibration certificate details

Procedure

1. To access the Calibration Certificate Details screen, you may either click the Edit
Calib Certificate Details button in the Component Data Table window (see The
component data tables or press F8.
The Calibration Certificate Details window opens.

2. Enter the calibration certificate number and expiration date.

3. Click OK to save your changes and close the Calibration Certificate Details window.
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4.2.3 Editing energy value

Procedure

1. To access the Edit Energy Value window, you may either click the Edit Energy Value
button in the Component Data window (see The component data tables) or press
F7.
The Edit Energy Value window opens.

2. Choose a table from the Choose Table dropdown list.

3. Enter the Cal Gas Energy Value and the Energy Deviation Limit in the appropriate
fields.

The Calculated Cal Gas Energy Value field cannot be edited.

4. Click Save to save your changes without closing the Edit Energy Value window. Click
OK to save your changes and close the Edit Energy Value window. Click Cancel to
close the Edit Energy Value window without saving your changes.
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4.2.4 View the standard values for a component
If you have changed component’s values, it is still possible to view the standard values for
that particular component. To view the standard values for a component, do the
following:

Procedure

1. Select Component Data... from the Application menu.
The Component Data Tables window appears, displaying a list of available
component data tables.

Note
You may also access the component data tables by pressing F6 or by clicking  from
the Toolbar.

2. Select the table that you want to view.
The selected component data table displays.

Note
To sort the list of components by detector and then by retention time, click Sort RT.

3. Click Std Values (F3).
The Standard Component Values window displays.

4. When you are finished viewing the window, click Close.

4.2.5 Display raw data from the Component Data table
To view the raw data for the displayed component data table, do the following:

Procedure

1. Select Component Data... from the Application menu.
The Component Data window displays.

2. Click Raw Data (F4) or press F4.
The Select dialog displays, listing the streams that are associated with the
component data table.

3. Double-click the desired stream.

The Raw Data window appears, listing the peak raw data from the last run of the
stream represented by the component data table.

The following data displays for each peak:

Peak No. Numerical identifier for the peak, listed by the order of
discovery.

Ret Time Time, in seconds, that the component eluted.

Peak Area The area under the peak.

Peak Height The maximum height of the peak.

Det The detector associated with the peak.
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Method Method of peak end detection. Options are:
• 1 (Baseline): Baseline termination occurs when the absolute

values of twelve successive slope calculations are less than
the slope sensitivity.

• 2 (Fused Peak): A fused peak is found if a peak onset is
detected subsequent to the discovery of a peak crest and
before the baseline termination is detected.

• 3 (Last Fused Peak): The last peak in a group of fused
peaks.

• 4 (Tangent Skim): Baseline termination occurs when the
current level is lower than the Start Baseline value and the
slope at the point is negative and smaller in magnitude than
the average slope from the beginning of the peak.

• 100 (Inhibit): An Inhibit On event in the Timed Events table
caused the peak to be terminated.

• 300 (Forced Integration): An Integration Off event in the
Timed Events table caused the peak to be terminated.

• 500 (Summation): A Summation Off event in the Timed
Events table caused the peak detection logic to sum
together the peak areas under multiple peaks between the
Summation On and Summation Off events and to add an
entry for an artificial peak with its area set to the composite
area under the constituent peaks.

Baseline Start The raw detector counts at the start of an integration. For
example, if the peak starts at 10 seconds, then the raw
detector counts at 10 seconds becomes the Baseline Start
value.

Baseline End The raw detector counts at the end of an integration. For
example, if the peak ends at 35 seconds, then the raw detector
counts at 35 seconds becomes the Baseline End value.

Integration
Start

Time, in seconds, when integration started.

Integration End Time, in seconds, when integration stopped.

Peak Width @
Half Height

The width of the peak taken at half of the peak’s height.

Partial Peak If Yes, then the Partial Peak value is used in the summation
calculation; if No, then the Partial Peak value is not used in the
summation calculation.

4. Click Close to return to the Component Data window.
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4.2.6 Change the default C6+ mixture ratio
The C6+ component that is detected by the GC is actually a mixture of up to four heavy
hydrocarbons - from hexane and above. When the energy value and other physical
properties are calculated for the mixture, the GC assumes a ratio of heavy hydrocarbon
components is used for the C6+ value. By default, there are four pre-defined ratios:

Component C6/C7/C8 percentages

C6+ 47/35/17 47.466/35.34/17.194

C6+ GPA 2261-99 60.0/30.0/10.0

C6+ 57/28/14 57.143/28.572/14.285

C6+ 50/50/0 50.0/50.0/0

To define a different ratio, do the following:

Procedure

1. Select Component Data on the Application menu.
The Component Data window opens.

Note
You can also click F6 to open the Component Data window.

2. Click the C6+ component field, which displays one of the four ratios described
above.
A dropdown list opens.

3. Select C6+ (User Def.) from the dropdown list.

4. Click Edit Percentage (F5).
The C6+ User Def. window opens.

5. Enter a composition percentage for each component.
The Total Percentage, which must equal 100 and is displayed on the window's title
bar, updates with the sum of the four ratios.

6. Click OK.
The Component Data window closes. The edited row on the component data table is
updated based on the new ratio.

7. Click Save to accept the changes without closing the window; click OK to accept the
changes and to close the window.

4.2.7 Set up an Analysis/Validation stream to use 2 point
calibration (700XA and 1500XA only)
Procedure

1. In the component data table (CDT) associated with the Analysis/Validation stream,
perform the following:

a) Change the Calibration Type for a component to 2 Pt Calib.
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b) Change the 2 Pt Calib Low CDT to select CDT associated with Low
calibration gas.

c) Change the 2 Pt Calib High CDT to select CDT associated with High
calibration gas.

2. Run Single Stream on the stream associated with the Low calibration gas until the
readings stabilize.

3. Run Forced Calibration on the Low stream.

4. Run Normal Calibration on the Low stream.

5. Run Single Stream on the stream associated with the High calibration gas until the
readings stabilize.

6. Run Forced Calibration on the High stream.

7. Run Normal Calibration on the High stream.
If the Normal Calibrations on the Low and High streams in Step 4 and Step 7 are
successful, the GC is ready to analyze the Analysis/Validation stream using 2-pt
calibration constants that are gathered during the Low and High calibration runs.

For more information about how 2 pt. calibration works, see How a 2 point
calibration works.

How a 2 point calibration works
This section explains what happens in MON2020 and the GC when you select 2 pt.
calibration.

1. When the GC does a calibration on the Low stream, it copies the response factor
(RF) and calibration concentration (CC) for each component to the columns marked
Multi-Level Calib a and Multi-Level Calib b in the CDT associated with the Analysis/
Validation stream.

2. When the GC does a calibration on the High stream, it copies the RF and CC for each
component to the columns marked Multi-Level Calib c and Multi-Level Calib d in
the CDT associated with the Analysis/Validation stream.

3. It then computes 2-pt Exponent and RF values for each component using the
following formulas and stores them in the 2pt_exp and Response Factor columns
in the CDT.
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4. The Retention Time for each component in the Analysis/Validation CDT is an
average of the retention time from the Low and High CDTs.

5. During analysis/validation, the concentration is calculated using the formula:

4.2.8 Add a component to a component data table
Note
Modbus registers use row indices instead of component names to extract component-
based results. If you add a component in the Component Data Table, the row indices for all
the components that elute after the added component shift down by one position.
Similarly, if you delete a component, the row indices for all the components after the
deleted component shift up by one position. Modbus registers mapped to per-component
analysis results should be adjusted so that they use the correct row index.

To add a component to a component data table, do the following:

Procedure

1. Select Component Data... from the Application menu.
The Component Data Tables window appears, displaying a list of available
component data tables.

Note
You can also access the component data tables by pressing F6 or by clicking  from
the Toolbar.

2. Select the table that you want to view.
The selected component data table displays.

Note
To sort the list of components by detector, and then by retention time, click Sort
RT.

3. To add the new component below the currently selected component, click Insert
after.

4. To save the changes and close the window, click OK.
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Note
To save the changes without closing the window, click Save.

4.2.9 Remove a component from a component data table
To remove a component from a component data table, do the following:

Procedure

1. Select Component Data... from the Application menu.
The Component Data Tables window appears, displaying a list of available
component data tables.

Note
You can also access the component data tables by pressing F6 or by clicking  from
the Toolbar.

2. Select the table that you want to view.
The selected component data table displays.

Note
To sort the list of components by detector, and then by retention time, click Sort
RT.

3. Select the component that you want to remove.

4. Click Delete.

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.3 The timed events tables
Use this function to view and/or edit the timed events tables assigned to and used by
particular gas streams. The number of available timed events depends on the GC unit
configuration. The standard GC application contains eight timed events tables. The 370XA
contains two timed events table.

Note
See Launch the Timed Events table from the Chromatogram Viewer for more information
about editing timed events from the Chromatogram Viewer. To assign a timed events
table to a stream, see Link a valve with a stream.

Procedure

1. Select Timed Events... from the Application menu. The Timed Events Tables selector
window appears, displaying a list of available timed events tables.

Note
You can also access the timed event tables by pressing F5 or by clicking  from the
Toolbar.

Note
If only one timed events table is available, it displays immediately, bypassing the
Timed Events Tables selector window.
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2. Select the table that you want to view.
The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Choose the Analysis Train associated with timed event.

4. To see a different timed events table, select it from the Choose table dropdown list.

Related information

Edit timed events from the Chromatogram Viewer
Link a valve with a stream

4.3.1 Configure valve events
Valve-related events are grouped on the upper left side of the Timed Events window. To
edit valve-related events, do the following:

Procedure

1. Select Timed Events... from the Application menu.
The Timed Events Tables selector window appears, displaying a list of available
timed events tables.

Note
You can also access the timed event tables by pressing F5 or by clicking  from the
Toolbar.

Note
If only one timed events table is available, it will display immediately, bypassing the
Timed Events Tables selector window.

2. Select the table that you want to view.
The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Click the cell that you want to edit.
Depending on the cell type, you are either required to select a value from a
dropdown list, or you can type in the value directly. The following list describes the
valve-related parameters that are available on the Timed Events window.

Type The type of device associated with the event. You have the following
choices:
• Valve # - Valve number.

• DO # - A discrete output.

• Strm Sw - Switches to the next stream in the sequence.
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• FID Gain - Changes the gain of the FID detector. Available options
are Low and High.

• FID Auto Zero - Resets the baseline of the FID detector.

• Cal Gas Save - Sets the start or end time for the Cal-Gas Saver™

feature.

• Hardware Inhibit - Set to Off to start to look for a peak; set to On to
stop looking for a peak for the valve, discrete output nuumber, or
detector number.

Valve/D
O # /Det
#

Use the drop-down menu to select the specific valve or discrete output
that should be used for the event.

This column does not apply if Strm Sw was selected from the Type
column.

State Turns the valve or discrete output on or off, or sets the FID to high or
low.

This column does not apply if Strm Sw was selected from the Type
column.

Time Indicates the time, in seconds, that the event should occur during the
analysis. Enter a value between 0.0 and 3600.0.

Note
Event times must be less than the analysis time.

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.3.2 Configure integration events
Integration-related events are grouped on the upper right side of the Timed Events
window. To edit integration-related events, do the following:

Procedure

1. Select Timed Events... from the Application menu.
The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note
You can also access the timed event tables by pressing F5 or by clicking  from the
Toolbar.

Note
If only one timed events table is available, it displays immediately, bypassing the
Timed Events Tables selector window.

2. Select the table you want to view.
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The selected Timed Events Tables displays.

Note
To sort events by time, click the appropriate Sort button.

3. Double-click the cell that you want to edit.
Depending on the cell type, you will either be required to select a value from a drop-
down list, or you will be able to type in the value directly. The following list
describes the integration-related parameters that are available on the timed events
window.

Type The type of integration event. You have the following options:
• Inhibit: Set to Off to start to look for a peak; set to On to stop looking

for a peak.

• Integrate: Set to On and Off to set a region in which the area under the
trace is computed as a peak regardless of peak onset discovery. The
resulting area is added to the raw data as a peak with the retention time
set to the integration off time.

• Summation: Set to On and Off to set a region in which the area of all
peaks found will be added together to create a single summed value.
The peaks that contribute to the summation are marked as partial
peaks in the raw data table, and the summation total is added to the
raw data as a new peak with the retention time set to the summation
off time.

• Slope Sens: The peak starts when the slope of six consecutive points is
greater than the slope sensitivity value that is displayed in the Value
column; the peak ends when the slope of six consecutive points is less
than the slope sensitivity value that is displayed in the Value column.

• Peak Width: Each point displayed on the graph represents the average
of N raw data points, where N is the value displayed in the
corresponding Value column.

• Single Base: Determines how the baseline is drawn under a peak.
— Off: The baseline is drawn from the point of peak onset to the point

of peak termination. This is not necessarily horizontal and if fact
usually has a slight slope. (Default)

— Bgn: Draws a horizontal baseline from the point of peak onset to a
point above or below the peak termination.

— End: Draws a horizontal baseline from a point above or below the
peak onset to the point of peak termination.

• Fused Ovrrd: Determines how the baseline is drawn when two or more
peaks are fused together.
— Off: A single baseline is drawn from the onset of the first peak of the

fused group to the termination of the last peak of the group.
(Default)

Application Reference Manual
December 2019 2-3-9000-745

100 Rosemount Gas Chromatographs



— On: Causes a separate baseline to be drawn for each peak in the
fused group.

• Negative Peak: Determines whether peak detection will detect inverted
peaks, which are peaks that point downward from the baseline. At any
given moment you can detect positive or negative peaks but not both
at once.
— Off: Detect positive peaks. (Default)

— On: Detective negative peaks.

• SW Auto Zero: Re-zeros the baseline of the trace at the specified time
for the specified detector. Used after a FID gain change event or a
spectrum gain change event.

Note
The Single Base and Fused Override events can act together to
produce multiple horizontal baselines, at different heights, for a fused
peak group.

Det # The ID number of the detector that will be affected by the event. Valid
values are:
• 1 - 4 (1500XA)

• 1 - 3 (700XA with integral FPD)

Value The values available depend on the integration type selected from the
Type column.
• Slop Sens: Enter the number of points, between 1 and 99999, to be

used.

Note
The peak starts when the slope of six consecutive points is greater than
the slope sensitivity value that is displayed in the Value column; the
peak ends when the slope of six consecutive points is less than the
slope sensitivity value that is displayed in the Value column.

• Peak Width: Enter the number of points, between 1 and 99, to be used.

• Single Baseline: Select Off, End, Bgn.

• SW Auto Zero: No options.

• All other integration types: Select On or Off.

Time Indicates the time, in seconds, that the event should occur during the
analysis. Enter a value between 0.0 and 3600.0.

Note
Event times must be less than the analysis time.

4. To save the changes and close the window, click OK.
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Note
To save the changes without closing the window, click Save.

4.3.3 Configure spectrum gain events
The spectrum gain feature graphically magnifies the size of a chromatogram’s peaks. The
data itself is not affected, only the presentation of the data. This feature can be useful for
viewing peaks that are otherwise too small to examine or so large that the top of the peak
can not be seen.

Spectrum gain-related events are grouped on the lower left side of the Timed Events
window. To edit spectrum gain-related events, do the following:

Procedure

1. Select Timed Events... from the Application menu.
The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note
You can also access the timed event tables by pressing F5 or by clicking  from the
Toolbar.

Note
If only one timed events table is available, it displays immediately, bypassing the
Timed Events Tables selector window.

2. Select the table that you want to view.
The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Click n the cell that you want to edit.
Depending on the cell type, you are either required to select a value from a
dropdown list, or you can type in the value directly. The following list describes the
spectrum gain-related parameters that are available on the timed events window.

Det # The ID number of the detector that will be affected by the event. Select 1 or
2.

Gain Enter a value between 0 and 64. This is the exponent value in the following
expression: 2gain value. For example, a value of 0 means no gain is applied; a
value of 5 means the gain is increased to 32 times it’s original value.

Time Indicates the time, in seconds, that the event should occur during the
analysis. Enter a value between 0.0 and 3600.0.

Note
Event times must be less than the analysis time.

4. To save the changes and close the window, click OK.
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Note
To save the changes without closing the window, click Save.

4.3.4 Set the cycle and analysis time
To set the cycle and analysis time, do the following:

Procedure

1. Select Timed Events... from the Application menu.
The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note
You can also access the timed event tables by pressing F5 or by clicking  on the
toolbar.

Note
If only one timed events table is available, it displays immediately, bypassing the
Timed Events Tables selector window.

2. Select the table that you want to view. The selected timed events table displays.
The Analysis Time section is located on the lower right side of the Timed Events
window.

Note
To sort events by time, click the appropriate Sort button.

3. Click the Analysis Time cell and enter a value, in seconds, between 0 and 3600.

4. Click the Cycle Time cell and enter a value, in seconds, between 0 and 3620.

Note
The cycle time must be at least 10 seconds greater than the analysis time.

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.3.5 Add an event to the Timed Events Table
To add an event to one of the Valve Events, Integrate Events, or Spectrum Gain Events
tables on the Timed Events window, do the following:

Procedure

1. Select Timed Events... from the Application menu.
The Timed Events Tables selector window appears, displaying a list of available timed
events tables.
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Note
You can also access the timed event table by pressing F5 or by clicking  on the
toolbar.

Note
If only one timed events table is available, it will displays immediately, bypassing
the Timed Events Tables selector window.

2. Select the table you want to view.
The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. To add the event below the currently selected event, click Insert after.
The new event is added to the table.

4. Define the event as necessary, and enter a new Time for the event.

5. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.3.6 Remove an event from the Timed Event Table
To remove an event from one of the Valve Events, Integrate Events, or Spectrum Gain
Events tables on the Timed Events window, do the following:

Procedure

1. Select Timed Events... from the Application menu.
The Timed Events Tables selector window appears, displaying a list of available timed
events tables.

Note
You can also access the timed event tables by pressing F5 or by clicking  on the
toolbar.

Note
If only one timed events table is available, it displays immediately, bypassing the
Timed Events Tables selector window.

2. Select the table you want to view.
The selected timed events table displays.

Note
To sort events by time, click the appropriate Sort button.

3. Select the event you want to delete.

4. Click the appropriate Delete button.
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4.4 The validation data tables
Use the validation data table to hold information about the composition of the gas that is
used in the validation run. During a validation run, the GC performs a test analysis of a gas
with a known component composition to verify that the GC is working properly.

To add a component to the validation data table, do the following:

Procedure

1. Select Validation Data from the Application menu. The Validation Data window
displays.

Note
If No Validation Data Table (VDT) is in use (or configured), then MON2020 shows NO
VDT table in use message. Go to Streams screen and configure the Validation
stream by setting the Usage as Validate.

2. If the appropriate table is not displayed, select it from the Choose Table dropdown
list.

3. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

4. To update the nominal value automatically when component data is updated,
check Link with Component Data.

5. Enter the component’s concentration percentage in the appropriate cell under the
Nominal Value column.

To ensure accuracy, this value, which is compared to the GC’s analysis results at the
end of the validation run, should be taken from the documentation provided with
the gas cylinder.

6. Enter a value in the appropriate Percent Deviation cell.

Example

If you enter 10 in this field, and the GC’s analysis result for the component differs
from the component’s Nominal Value by ±10% or more, then an alarm is generated.
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7. To copy a component variable to the next empty row, click C + Copy (F8).

The component is incremented to the next available component—for example,
from ammonia to benzene. The Nominal Value and Percent Deviation values are
also copied.

Note
You can select and copy more than one component at a time.

If there are no components available, instead of copying the component, MON2020
displays the following message:

8. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.5 Calculations
MON2020’s Calculations submenu allows you to activate and define how the output of
standard or user-defined chromatograph analysis data is used in various calculations.

You can configure the following types of calculations:

• Control - Allows you to designate, by streams, the standard calculations that should be
performed from the analysis data.

• Averages - Allows you to designate, by streams and components, averages of standard
calculations GC should perform.

• User Defined - Allows you to create and edit customized calculations using analysis
data. See Custom calculations for more information.

• Dewpoint - This optional feature allows you to calculate dewpoint temperatures and to
estimate the cricondentherm, which is the temperature above which no liquid will
form at any pressure.

• Metrology Options - This feature is only available if the Metrology Type inside the GC
is set to GOST. On this screen, you can edit the RF Deviation Check and the RF Stability
Check.
— RF Deviation Check - Allows you to select Standard or GOST. The Standard method

checks response factor (RF) deviation as a percentage change from the previous
calibration. The GOST method computes the range of RF during the calibration and
compares it to the permissible range per GOST 32371.7-2008
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— RF Stability Check - Allows you check the periodic accuracy of the analyzer per
Equation 15 GOST 31371.7-2008. If you select Enable and run the calibration, the RF
Range is compared to a narrower permissible range per Equation 15 GOST
31371.7-2008.

4.5.1 Set standard calculations by stream
To designate, by streams, the standard calculations—for example, mole percent, liquid
volume, gas density, Wobbe index, etc.—that should be performed from the analysis data,
do the following:

Procedure

1. Select Applications → Calculations → Control....
The Control Calculations window appears.

2. Select a check box for a given stream to turn the calculation ON for that stream;
click to clear the check box for a given stream to turn the calculation OFF for that
stream.

You can use the arrow keys to move from one stream cell to another, and you can
press the space bar to toggle the calculation on or off.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

Note
To save the information on this screen to a tab-delimited text file, right-click the
table and select Save Sheet from the right-click menu.

Note
To copy the information on this screen to the clipboard so that it can be pasted into
another application, such as Microsoft® Word or Microsoft® Excel, right-click the
table and select Copy to clipboard from the right-click menu. The Streams and
Calibration data is exported to the clipboard.

Note
To print the information on this screen, right-click the table and select Print Sheet
from the right-click menu.

4.5.2 Edit averages calculations
To designate, by streams and components, averages of standard calculations the GC
should perform, do the following:

Procedure

1. Select Applications  → Calculations  → Averages....
The Averages Calculations window appears.

2. Select a new variable by clicking on the appropriate dropdown list under the
Variable column.
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For a demonstration of how to use the context-sensitive variable selector, see The
context-sensitive variable selector.

Note
The averages will be assigned in the default Modbus® map in the order that they
appear in the table.

3. Select the type of average to be calculated from the Average Type dropdown list.
You have the following options:

Unused An average is not be calculated for the variable.

Hourly Averages are calculated every hour at the time displayed in the Reset
Time field from the Averages Reset section.

24 Hour Averages start and stop once a day at the time displayed in the Reset
Time field from the Averages Reset section.

Weekly Averages start and stop once a week at the time displayed in the Reset
Time field and on the day entered in the Weekday field, from the
Averages Reset section.

Monthly Averages will start and stop once a month at the time displayed in the
Reset Time field and on the day of the month entered in the Day field,
from the Averages Reset section.

Variable Averages will start and stop for the duration entered in the Hours
column starting from the reset time.

Everyrun No average is stored; instead, the current value at the end of the run is
stored.

4. To set a custom start and stop time for a particular calculation, set the Average
Type for the calculation to Variable and enter the desired time in the Hours cell.

Note
The custom Hours setting overrides the Reset Time setting.

5. Set the appropriate Restart Flag to one of the following options:

NO The current average is not reset.

CUR When CUR is selected and saved from the drop-down menu, the current
average is cleared (reset immediately) and a new average calculation starts.
It is used during debugging or troubleshooting to exclude bad runs from
averages.

6. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

Note
To save the information on this screen to a tab-delimited text file, right-click the
table and select Save Sheet from the right-click menu.
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Note
To copy the information on this screen to the clipboard so that it can be pasted into
another application, such as Microsoft Word or Excel, right-click on the table and
select Copy to clipboard from the right-click menu.

Note
To print the information on this screen, right-click the table and select Print Sheet
from the right-click menu.

Also see View Archives, Copy Stream Settings, and Copy Component Settings.

4.5.3 View an archive of averages for a given variable
To view an archive of averages for a given variable, do the following:

Procedure

1. Select Applications → Calculations → Averages....
The Averages Calculations window appears.

2. Click on the desired variable to view its history.

3. Click Archive.
The archive data screen appears.

Note
To copy the information in this table to the clipboard so that it can be pasted into
another application such as Microsoft Word or Excel, select the cells that you want
to copy and then press CTRL + C to copy the information to the clipboard.

4.5.4 Copy an average calculation configuration
To copy the average calculation configuration from a highlighted row and apply them to
the next row, do the following:

Procedure

1. Select Applications → Calculations → Averages....
The Averages Calculations window appears.

2. Select the row that you want to copy.

3. Click S + Copy.

The stream is copied to the next row and incremented to the next available stream
—for example, from Stream 2 to Stream 3.

Note
You can select and copy more than one stream at a time.

If there are no streams available, instead of copying the stream, MON2020 displays
the following message:
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4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.5.5 Copy component settings
To copy the component settings from a highlighted row and apply them to the next row,
do the following:

Procedure

1. Select Applications → Calculations → Averages....
The Averages Calculations window appears.

2. Select the row that contains the component that you want to copy.

3. Click C + Copy. The component is copied to the next row and incremented to the
next available component—for example, from ammonia to benzene.

Note
You can select and copy more than one component at a time.

If there are no components available, instead of copying the component, MON2020
displays the following message:

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.5.6 User-Defined Calculations
Prerequisites

You can use a previously-created user-defined calculation when building new calculations
by doing the following:

Procedure

1. From the Application → Calculations → User-defined... → Edit (F2) menu, click the
System Variables dropdown list.

2. Click the Calculations arrow and select User Defined Calculations from the drop-
down list that contains the full list of available calculations.

3. Select the User-Defined Variable from the Variables drop-down list.

4. Click Done. The User Calculations selection menu closes. The selected system
variable displays in the System Variables drop-down box and in the Expression Editor.
See Custom calculations in the MON2020 for information on user-defined
calculations.

4.5.7 Set the dewpoint calculation
This feature applies to C9+ GCs only. You can use this window to edit the options for
calculating the dew point.

Procedure

1. Select Application → Calculations → Dewpoint.
The DewPoint Calculation window opens.

2. Click the row with the component data table you want to edit.
The larger Dewpoint Calculations window opens.
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3. Select the unit of measurement from the Unit Type dropdown list. The options are:
• BarA

• PSIA

4. Select the dewpoint calculation method from the Method dropdown list. The
options are:
• PR - Peng Robinson

• RKS - Redlich Kwong Soave

5. Select the type of pressure from the Pressure dropdown list. The options are:
• Absolute

• Gauge

6. If you selected Gauge in the Pressure field, enter the atmospheric pressure in the
Atm. Pressure field.

7. Select the type for the first source from the Source 1 dropdown list. The options
are:
• Fixed: If you select this option, you can enter a number in the Pressure 1 field or

you can enter the number via Modbus.

• Analog Input 1 or Analog Input 2: If you select one of these options, MON2020
automatically enters the number from the Current Value field in the Analog
Input window.
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Note
See Manage your gas chromatograph’s analog inputs for more information
about analog inputs.

8. If you selected Fixed in the Source 1 field, enter a number in the Pressure 1 field.

9. If you want to calculate more than one pressure, repeat steps 7 and 8 for Source 2.

Note
You may enter up to four pressure values.

10. For each component in the Dewpoint Component column, select a component to
be analyzed in the Analysis Component column. The options are:
• C2's

• Propane

• Propylene

• C4's

11. For each component, enter the percentage of the Dewpoint Component that is
made up of the corresponding Analysis Component in the Contribution column.

Write the percentage as a decimal value between 0.000000 and 1.000000.

Note
The default values are correct for a C9+ analysis, in which all of the C9+ is assumed
to be n-Nonane.

12. When you have finished entering the information for each component you want to
measure, click Save to save your changes.

13. Click OK to close the Dewpoint Calculations window.

To close the Dewpoint Calculations window without saving your changes, click
Cancel. If you make changes and then click Cancel, the Unsaved Data dialog box
opens.

If you change your mind and want to save your changes, click Yes. If you don't want
to save your changes, click No. To return to the Dewpoint Calculations window, click
Cancel.
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4.6 Set the calculation method to GPA or ISO
MON2020 can be configured to perform GPA calculations, ISO calculations, or both.

To set which type of calculation method MON2020 should use, do the following:

Procedure

1. Select Applications → Calculations → Configuration....
The Calculations Configuration window displays.

2. Select the method from the Calculation Method dropdown list.

The options are:

• GPA

• ISO

• GPA & ISO (Rosemount 700XA and Rosemount 1500XA only)

3. Select an ISO Version.

The options are:

• ISO6976: 1995

• ISO6976: 2016

4. Select a unit of measure from the Base Pressure Units dropdown list.

The options are:

• PSIA

• BarA

• kPaA

5. If you set the calculation method to GPA or GPA & ISO, you can also set the
following options:

• GPA Calculator Units (U.S. or S.I.)

• GPA Pressure Display (PSIA, BarA, or kPaA)
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6. If you set the calculation method to ISO or GPA & ISO, you can also set the following
options:

• ISO Pressure Display (BarA or kPaA)

• Primary Temperatures

— 0C/0C

— 0C/15C

— 0C/20C

— 15C/0C

— 15C/15C

— 15C/20C

— 20C/0C

— 20C/15C

— 20C/20C

— 25C/0C

— 25C/15C

— 25C/20C

— 0C/15.55C

— 15C/15.55C

— 20C/15.55C

— 25C/15.55C

— 15.55C/0C

— 15.55C/15C

— 15.55C/15.55C

— 15.55C/20C

Note
Updating this field also updates the primary values—Sum Factor Pri, CV Superior
Pri and CV Inferior Pri—that display in the Component Data table.

• Secondary Temperatures (same options as Primary Temperatures)

Note
Updating this field also updates the secondary values—Sum Factor Sec, CV
Superior Sec and CV Inferior Sec—that display in the Component Data table.

• Primary CV Units

— kilojoules per cubic meter (kJ/m3)

— kilocalories per cubic meter (kCal/m3)

— kilowatt hours per cubic meter (kWhrs/m3)
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— megajoule per cubic meter (MJ/m3)

— megajoule per kilogram (MJ/kg)

— megajoule per mole (MJ/mole)

• Secondary CV Units (same options as Primary CV Units)

• AGA 8 Method
— AGA8 1994 (Detail)

— AGA8 2017 (Detail)

— AGA8 2017 (GERG-2008)

7. Click OK to accept the changes and close the window.

Note
Click Save to accept the changes without closing the window.

4.7 Set alarm limits
Use this function to set threshold limits for GC analysis data. When a limit is exceeded, an
alarm is activated and logged. See View the alarm log for information on Alarm Logs.

To set an alarm limit for a variable, do the following:

Procedure

1. Select Applications → Limit Alarms....
The Limit Alarms window displays.

2. Select a new variable by clicking on the appropriate dropdown list under the
Variable column.

For a demonstration of how to use the context-sensitive variable selector, see The
context-sensitive variable selector.

3. To change the alarm type, click the appropriate cell under the Type column.

You have the following the options:

• Off - Turns off the alarm.

• All - Use high and low limits to activate alarms. Enter the lower limit value in the
appropriate cell under the Low Limit column. Enter the upper limit value in the
appropriate cell under the High Limit column.

• High - If the status value of the variable rises above the value set in the
corresponding High Limit column, the high limit alarm is activated.

• Low - If the status value of the variable falls below the value set in the
corresponding Low Limit column, the low limit alarm is activated.

4. If you want a discrete output to activate when the alarm triggers, click on the
appropriate cell under the DO # to Set column and select it from the dropdown list.

5. If you want to inhibit averaging when the alarm triggers, select the Inhibit Avg
checkbox.
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6. To customize the text of the alarm message, enter the new text in the appropriate
cell under the User Alarm Text column.
When the alarm triggers, this text will display under the Alarm Message column on
the Unack/Active Alarms window.

7. To configure the Alarm Delay, enter the duration of the alarm condition, in seconds,
before the Halt command should be executed. Valid values are between 0 and
1800.

8. To apply the current limit alarm conditions to the stream, click S + Copy.
The conditions are applied to the next available stream--for example, from Stream 2
to Stream 3.

If there are no streams available, instead of copying the stream, MON2020 displays
the following message:

9. To apply the current alarm conditions to the next available component, click C +
Copy.

The alarm limit conditions are copied to the next available component--for
example, from ammonia to benzene.

If there are no more components available, instead of copying the component,
MON2020 displays the following message:

10. If you want the GC to halt after the current analysis when an alarm is triggered, do
the following:

a) Select the Halt on Alarm? checkbox.

b) Enter a value in the Delay column for the length of time, in seconds, that the
alarm condition should exist before the alarm is displayed.

You can enter a value between 0 and 1800.

11. Select the checkbox to enable the Associated Analysis Clock 1 alarm(s).

12. Select the checkbox to enable the Associated Analysis Clock 2 alarm(s).
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13. Select the checkbox to enable the Associated Analysis Clock 3 alarm(s).

14. Select the checkbox to enable the Associated Analysis Clock 4 alarm(s).

15. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

Related information

Create a stream sequence for a detector

4.8 Discrete alarms
To edit discrete alarms, do the following:

Procedure

1. Select Discrete Alarms... from the Applications menu.
The Discrete Alarms window displays.

2. Click the Variable cell. Select the discrete input of interest under Discrete Inputs →
Current Value.

3. If you want a discrete output to activate when the alarm triggers, click on the
appropriate cell under the DO # to Set column and select it from the dropdown list.

4. If you want to inhibit averaging when the alarm triggers, select the Inhibit Avg
checkbox.

5. To enable the alarm, select the checkbox under the Is Alarm Enabled? column; to
disable the alarm, deselect the checkbox under the Is Alarm Enabled? column.

6. To halt the GC after the current analysis when an alarm is triggered, select the Halt
on Alarm? checkbox.

7. To set the amount of time that should pass between the recognition of an alarm
condition and the display of the alarm, enter a value between 0 and 1800 in the
Delay column.

8. Select the Associated Analysis Clock 1? checkboxes to configure the discrete
alarms for Analysis Clock 1.

9. Select the Associated Analysis Clock 2? checkboxes to configure the discrete
alarms for Analysis Clock 2.

10. To customize the text of the alarm message, enter the new text in the appropriate
cell under the Alarm Message column.
When the alarm triggers, this text displays under the Alarm Message column on the
Unack/Active Alarms window.

11. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.9 View System Alarms
To edit system alarms, do the following:

Procedure

1. Select System Alarms... from the Applications menu.
The System Alarms window displays.

2. If you want a discrete output to activate when the alarm triggers, click the
appropriate cell under the DO # to Set column and select it from the dropdown list.

3. If you want to inhibit averaging when the alarm triggers, select the Inhibit Avg
checkbox.

4. To enable the alarm check the checkbox under the Is Alarm Enabled? column; to
disable the alarm, uncheck the checkbox under the Is Alarm Enabled? column.

5. To set the amount of time that should pass between the recognition of an alarm
condition and the display of the alarm, enter a value between 0 and 1800 in the
Delay column.

6. To halt the GC after the current analysis when an alarm is triggered, check the Halt
on Alarm? checkbox.

7. Select the checkbox to enable the Associated Analysis Clock 1 alarm(a).

8. Select the checkbox to enable the Associated Analysis Clock 2 alarm(s).

9. Select the checkbox to enable the Associated Analysis Clock 3 alarm(s).

10. Select the checkbox to enable the Associated Analysis Clock 4 alarm(s).

11. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.10 Streams
Use this feature to configure and validate the streams.

MON2020 allows you to do the following:

• Assign component data tables, validation data tables, timed events tables and
associated Analysis Clock to a particular stream.

• Designate a stream for analysis, validation, or calibration.

• Control automatic calibration or validation parameters, such as the total number of
runs, runs to be averaged, starting times, and time between automatic calibrations and
baseline runs.

4.10.1 Create a stream sequence for a detector
A stream sequence defines the order of stream analysis for a detector. You can create
three sequences; each can be activated by a digital input device or via a Modbus link. To
create or edit a stream sequence, do the following:
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Procedure

1. Select Stream Sequence... from the Application menu.
The Stream Sequence window displays.

2. Each stream sequence table can contain up to three sequences - a primary, or
default, sequence and two auxiliary sequences.

3. Double-click the appropriate cell under the Strm Seq Name column to give your
new sequence a name or to edit the name of an existing sequence. Type in the new
name.

4. To define which discrete input should activate the sequence, select it from the
dropdown list of the appropriate cell under the Seq Activate DI column.

Note
No two sequences can be activated by the same discrete input.

5. To define the order of analysis, double-click the appropriate cell under the Seq of
Strms column and enter the numbers for the streams, separated by commas, that
should be analyzed.

Example

For example 1,2 would continuously analyze stream 1 followed by stream 2. A
sequence of 1,1,1,2 would analyze stream 1 three times and then analyze stream 2
every fourth time in the sequence.

6. For each Analysis Clock, configure the different stream sequence from the
Application → Analysis Clock Configuration screen.

7. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.10.2 Designate how a stream is used
To assign a function to a stream, do the following:

Procedure

1. Select Streams... from the Application menu.
The Streams window opens.

2. For the appropriate stream, select one of the following options from the Usage
column:

• Unused - Not used

• Cal - Calibration

• Analy - Analysis

• Validate - Validation

If you select Cal or Validation, you can also edit the following parameters:
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Auto If checked, the calibration or validation will be automatic.

Total Runs The number of runs, from 1 to 10, to make for each calibration.

Avg Runs The number of most-recent calibration runs to average; for
instance, if five calibration runs are performed and Avg Run is set
to 3, then the last three runs of the five will be used to average
the calibration results.

Start Time The time the first automatic calibration should be performed.

Interval The number of hours between automatic calibrations.

Stream Valve Options are Unused, Calibration, Stream 1, Stream 2, Stream 3.

Stream Valve
ON to Select

If this option is checked the GC will purge the sample through the
sample loop when the stream valve is set to ON; if this option is
not checked the GC will purge the sample through the sample
loop when the stream valve is set to OFF.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.10.3 Link a valve with a stream
Multiple streams can be linked to the same valve to allow for different uses of that stream
—for example, the calibration gas can be assigned to both calibration and validation runs.

Procedure

1. Select Streams... from the Application menu.
The Streams window opens.

2. Go to the Stream Valve column for the corresponding stream and select the
appropriate valve from the dropdown list.

You can view details about the valves in the dropdown list in the Valves window.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4. If the sample stream is selected when the valve is on, check the corresponding
Stream Valve On to Select checkbox; if the sample stream is selected when the
valve is off, uncheck the corresponding Stream Valve On to Select checkbox.

4.10.4 Assign a data table to a particular stream
To assign a component data table, a validation data table, or a timed events table to a
stream, do the following:
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Procedure

1. Select Streams... from the Application menu.
The Streams window opens.

2. For the appropriate stream, if Usage is set to Cal or Analy, select a component data
table from the CDT column and a timed events table from the TEV column.

3. For the appropriate stream, if Usage is set to Validate, select a component data
table from the CDT column, a timed events table from the TEV column, and a
validation data table from the VDT column.

4. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.

4.10.5 Change the base pressure for a stream
Base pressure is used for the GPA/AGA physical properties calculations.

Note
The base pressure for the ISO calculation is always 101.325 kPaA.

To change the base pressure for a stream, do the following:

Procedure

1. Select Streams... from the Application menu.

The Streams window opens.

2. For the appropriate stream, double-click on the corresponding cell under the Base
Pressure column and enter a new value.

Note
The GPA/AGA calculations can also be done at up to three additional optional
pressures. Use the Optional Pressure 1, Optional Pressure 2, and Optional
Pressure 3 columns for this purpose.

3. To save the changes and close the window, click OK.

Note
To save the changes without closing the window, click Save.
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4.10.6 Add a customized sequence to a stream
Use the Edit Custom Logic window to create a customized sequence of events that can be
executed during stream switching.

You can create up to eight customized sequences.

You must create two sub-sequences: one to activate the stream and the other to
deactivate the stream. Set up the cycle time so that while in auto sequence mode there is
adequate time for the stream with custom logic to activate and deactivate.

To add a customized sequence to a stream:

Procedure

1. Select Streams from the Application menu.
The Streams window opens

2. For the chosen stream, select Custom Logic # from the dropdown list in the Stream
Valve column.

The Edit Custom Logic button becomes active.

3. Click Edit Custom Logic.

The Edit Custom Logic window opens.
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4. Add events to the Events - Activate Stream table and the Events - Deactivate
Stream table.

a) Select a row in the table.

b) Click Insert After.
A row is added to the table.

c) Select the event Type.

The event Type options are:

• Valve #: Select a stream valve to turn on or off.

• DO#: Select a discrete output (DO) to turn on or off.

• Delay: Introduce a delay in seconds.

• Check Status: Select a discrete input and a desired state for the discrete
input. If the desired state is not present, a Sample Fluid Unavailable alarm
is triggered.

• Check Analog Input Low: MON2020 reads the analog input and
generates an alarm if the analog input's value is lower than the threshold
set in the associated State/Value column.

• Check Analog Input High: MON2020 reads the analog input and
generates an alarm if the analog input's value is higher than the threshold
set in the associated State/Value column.

Note
The Check Status, Check Analog Input Low, and Check Analog Input High
events are only available for activating the stream.

d) Select the Valve/DO#:

The Valve/DO# is the name of the analog input or discrete output to activate
or deactivate.

e) Select the State/Value.

The State/Value is the desired state or value at which you want the stream to
activate or deactivate.

5. When you have finished entering all the events, click OK to save your changes and
close the Edit Custom Logic window.

6. Click OK to save the changes to the Streams window and close it.

The Custom Logic sequence is executed before starting the analysis if:

• The Purge stream for 60 seconds checkbox is selected on the Single Stream, Calibration,
or Validation window.

• You start a single stream analysis, a calibration, or a validation from Idle mode on a
stream that has custom logic applied and

If several delays are set up in the Custom Logic sequence, then the delays will be executed
before executing the next Custom Logic event.
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If you start the GC in auto sequence mode:

• When the stream that has Custom Logic is the next stream to be turned on, the
customized sequence of activation events will be executed when the current stream's
Stream SW event is reached.

• When the current stream is a stream that has Custom Logic and the next stream is a
different stream, the customized sequence of deactivation events will be executed
when the current stream's Stream SW event is reached.

4.11 Analytical Train Configuration
Use the Analytical Train Configuration for multiple Analysis Clocks to assign the Valve, DO
and Detectors to each Train and then that Train is assigned to respective Analysis Clock.

Note
This feature is not available for Rosemount 370XA GCs.

To configure the settings,

Procedure

1. Assign the usage of Valves and DO to Analyzer# on Hardware → Valves, Hardware
→ Detectors and Hardware → Discrete Outputs screens.

2. Open the Application → Analytical Train Configuration screen

3. Click Discrete Output and Valves buttons. Assign the respective Discrete Outputs,
Valve, and Detectors to each Analytical Train. The Valves and DO’s are assigned
with Usage as Analyzer# displayed on this screen and, for Detectors, it displays all of
the available Detectors on this screen. You cannot configure the same Detector,
Valve or DO to multiple Trains.

4. On the Application → Timed Event screen, filter the configured events as per Train
selection by selecting Train# checkbox.

Reference Manual Application
2-3-9000-745 December 2019

MON2020 125



4.12 Analysis Clock Configuration
Use this feature to configure a single analysis or multiple analyses.

Note
This feature is not available for Rosemount 370XA GCs.

One Analysis can be considered as one virtual GC that has an independent Sample Loop,
Analytical Path and Timed Event tables.

Multiple analyses can run independently to analyze multiple streams at the same time.
The number of analyses are set at factory per the mechanical configurations.

Mechanical
configurations

Description

Trains 1 - 6 The configured Trains that are used by the Analysis

Default Stream
Sequence

Sets the default sequence to be used by the indicated Analysis during auto-
sequencing. To create a new stream sequence or to edit an already-created
sequence, click Stream Sequence .

Purge Duration The amount of time, in seconds, to purge the stream before starting an
analysis, calibration, or validation run. The default value is 60 SEC. Purging
allows sample gas to flow through the sample loop prior to beginning the
run.

Energy Value
Check

If enabled, the GC analyzes the calibration gas as an unknown stream and
computes its energy value. The GC then compares this value to the Cal Gas
Cert CV and determines if the calibration gas' energy value is within the CV
Check Allowed Deviation. If it isn't, the GC triggers the Energy Value Invalid
alarm. The following conditions must be met before the GC can perform a EV
Check:
• The EV Check flag in the System window must be enabled.

• At least one stream must be set up in the Streams window as a calibration
stream and the Auto flag for this stream must be enabled.

The EV Check is performed under any of the following circumstances:
• During a warm start that follows a power failure during normal operation.

The GC waits for the heater and electronic pressure controller to reach
their respective set points and stabilize. It then analyzes the calibration
gas as an unknown stream and identifies the peaks. If all the component
peaks are identified, the GC computes the calibration gas' energy value
and performs the EV Check.

• After a successful calibration, the GC computes the gas' energy value with
the new response factors and performs the EV Check

1. Press Insert to add a new Analysis.

2. Press Delete to delete an Analysis.

Related information

Analytical Train Configuration
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4.13 Method Switching
The purpose of the Method Switching screen is to change the component data table (and
associated cal gas) as you measure different percentages of your target gas. The Method
Switching function tells the GC which component data table (CDT) to use when the
measured gas is at a certain percentage.

This screen is only available for the Rosemount 700XA and Rosemount 1500XA GC. To
access the Method Switching screen, select Application → Method Switching... menu.

To enable the method switching functionality from this screen, select the checkbox.

By default, this screen shows the available number of methods or CDTs (see The
component data tables). For example, if four CDTs are supported, the screen will display
four rows.

Note
Choose Analysis Clock - Option to select the Analysis Clock for GC's configured for more
than one analysis clock.
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The screen contains the following three columns.

Name Description

Component Data table Number of the component data table: CDT 1 to CDT 4. These names are fixed.

Key Component This column shows a dropdown list of components associated with the CDT.
For example, for the first row, it will display a list of components from the CDT 1
table.

Change Level The change level is a value between 0 and 100. At the end of the analysis, if the
calculated Mole % value of the component in the first row is greater than the
value in the Change Level column, the GC uses CDT 1 to process the results for
the next analysis. If the first key component does not exceed the value in the
Change Level column, the system checks to see if the Mole % value of the
second key component exceeds the value in the second row of the Change
Level column. If this is the case, the system uses CDT 2 to process the results for
the next analysis. If the Mole % value does not exceed the Change Level value in
the second row, the system compares the Mole % value of the third component
to the value in the third column of the Change Level.
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4.14 Communication
Use this window to configure the GC's ports. To access the Communication settiings, select
Application  → Communication menu.

The following table lists the Communication window's parameters:

Note
During Modbus® serial communications, MON2020 can differentiate between RTU or
ASCII protocols; however, the data bit, stop bit, and parity settings still need to be
manually configured.

Name Description

Label The name of the group of settings.

ModBus Id Identification number of the Modbus device associated with the port.

Baud Rate The baud rate setting. Options are: 1200, 2400, 9600, 19200, 38400, and
57600. For high performing PCs, set the baud rate to 38400. If you
experience a communications failure at this rate, set the baud rate to
9600. Baud rate settings less than 9600 may result in information delivery
that is unacceptably slow.

Data Bits The number of data bits. Options are 7 and 8 (default).

Stop Bit The number of stop bits. Options are 1 (default) and 2.

Parity The parity check method. Options are None (default), Even and Odd.

RTS OFF Delay Comm Port handshaking RTS delay time.

RTS ON Delay Comm Port handshaking RTS delay time.

Response Delay The Response Delay time before checking for an active Clear to Send (RTS/
CTS).

MAP File Points to the file that contains the registers that should be used.

Port Allows you to set the type of protocol to be used for the port: RS232,
RS422 or RS485 or Ethernet.
If the port is set to RS422 or RS485, additional configuration steps are
required; see Connect directly to a PC using the GC's serial port for more
information.

If Ethernet prococol is configured, the Default_Map is selected.

Related information

Create or edit registers
Create a MAP file
Assign a variable to a register
View or edit scales
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4.14.1 Create or edit registers
You can map GC data to Modbus registers and generate MAP files, which can then be
associated with communications ports.

For a list of variable assignments made to all registers, consult the Communication section
of the GC Config Report, which can be accessed from the Logs/Reports menu.

To map GC data to Modbus registers, do the following:

Procedure

1. Select Communication... from the Application menu.
The Communication window appears.

2. Click Registers.
The Modbus Map Editor window appears.

3. To view or edit registers that are contained in an existing MAP file, click the Select
MAP File dropdown list and select the appropriate file.
The registers will load into the table.

Note
Not all parts of a MAP file can be edited. The parts that can be edited are white; the
read-only parts are turquoise.

4. To edit a cell, double-click it.

You can edit the following parameters:

Register
Number

Displays the number for the Modbus registers that will be polled
by a connected data acquisition system.

Data Type Describes the type of data that is stored in the register.

Options are:
• BOOLEAN: Has two states ON (1) or OFF (0).

• INT: 16-bit unsigned integer.

• LONG: 32-bit signed integer

Note
If the Modbus data type is Usr Modbus, each long value uses
two registers; if the data type is SIM2251, each long value uses
a single register.

• ULONG: 32-bit unsigned integer

• FLOAT: 32-bit floating point.

Note
If the Modbus data type is Usr Modbus, each floating point
value uses two registers; if the data type is SIM2251, each
floating point value uses a single register.

• Bitmap(INT)
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• Bitmap(LONG)

• SCALED_FP1
...

• SCALED_FP32

If one of the scaled floating point options is chosen, the Zero Scale
and Full Scale values for that option will display in the appropriate
column cells.

SIM_2251 registers use only the FLOAT data type.

Variable(s) Displays the variable(s) whose value is to be stored in the register.
To change the variable, see Assign a variable to a register.

Record
Number

The Record Number is enabled for Archive type of variables. The
User selects which archive record’s data needs to output over
Modbus®. Record number 1 is referred as recent record and
maximum value is referred as oldest record.

Access Determines whether the register will be read-only (RD_ONLY) or
read/write (RD_WR).

Format The date and time format for related variables.

Options are:
• MMDDYY

• DDMMYY

• YYMMDD

• hhmmss

• hhmm

• DD

• MM

• YY

• YYYY

• WW

• hh

• mm

• ss

5. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available component
(e.g., incrementing from ammonia to benzene), per the GC application. An error
message displays when the last available component is reached.

6. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.
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This feature also increments the Stream value to the next available stream (e.g.,
incrementing from Stream 2 to Stream 3), per the GC application. An error message
displays when the last available stream is reached.

7. To delete a row, click Delete Row.

8. To insert a row, click Insert Row.

9. To check for conflicting register assignments, click Check.

MON2020 will check the table and if it encounters a conflict it displays the following
message:

Review the table to locate the conflicting registers and change one.

10. To save the MAP file, do the following:

a) Click Save.
MON2020 validates the table for errors—for instance, ensuring that no two
registers share a register number. If any errors are found MON2020 displays
the appropriate error message. When no errors are found, the Save As
window displays.

b) Click OK.

4.14.2 Create a MAP file
Procedure

1. Select Application → Communication... from the menu.
The Communication window appears.

2. Click Registers.

The Modbus Map Editor window appears.

3. Click New.

4. Create a new MAP file name.

5. From the Register Type drop-down list, select the type of PLC emulation protocol
you want to use.

You have two options: User_Modbus, which is a PLC emulation Modbus protocol
that can use scaling to convert floating point numbers to integers, and SIM_2251,
which emulates the Daniel 2500 communication protocol and is a simulation of the
2251 GC controller.

6. Click Ok.
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7. If you want to base a new MAP file on an existing MAP file, you have two options:
• a. Click Open from PC.

b. Select the file you want to import and click Open.

• Select an existing MAP file from the drop-down list. Click Save As.

8. To edit a cell, double-click it.

You can edit the following parameters:

Register
Number

Displays the number for the Modbus registers that will be polled by
a connected data acquisition system.

Data Type Describes the type of data that is stored in the register.

Options are:
• BOOLEAN: Has two states ON (1) or OFF (0).

• INT: 16-bit unsigned integer.

• LONG: 32-bit signed integer

Note
If the Modbus data type is Usr Modbus, each long value uses
two registers; if the data type is SIM2251, each long value uses
a single register.

• ULONG: 32-bit unsigned integer

• FLOAT: 32-bit floating point.

Note
If the Modbus data type is Usr Modbus, each floating point
value uses two registers; if the data type is SIM2251, each
floating point value uses a single register.

• Bitmap(INT)

• Bitmap(LONG)

• SCALED_FP1
...

• SCALED_FP32

If one of the scaled floating point options is chosen, the Zero Scale
and Full Scale values for that option will display in the appropriate
column cells.

SIM_2251 registers use only the FLOAT data type.

Variable(s) Displays the variable(s) whose value is to be stored in the register.
To change the variable, see Assign a variable to a register.

Record
Number

Select the Archive Record’s data needed to output over Modbus®.
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Note
Record number 1 is referred as recent record and max value is
referred as oldest record.

Select archive type of variables and their maximum records as
shown in the table.

Archive type Maximum records supported (as default)

Analysis 20

Calibration 35

Final Calibration 35

Validation 35

Final Validation 35

Hourly Averages 168

Daily Averages 35

Weekly Averages 53

Monthly Averages 12

Access Determines whether the register will be read-only (RD_ONLY) or read/
write (RD_WR).

Format Use the Format drop-down menu to configure the date/time. Options
are:
• MMDDYY

• DDMMYY

• YYMMDD

• hhmmss

• hhmm

• DD

9. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available component
(e.g., incrementing from ammonia to benzene), per the GC application. An error
message displays when the last available component is reached.

10. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.
This feature also increments the Stream value to the next available stream (e.g.,
incrementing from Stream 2 to Stream 3), per the GC application. An error message
displays when the last available stream is reached.

11. To delete a row, click Delete Row.
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12. To insert a row, click Insert Row.

13. To check for conflicting register assignments, click Check.

MON2020 checks the table, and if it encounters a conflict, it displays the following
message:

Review the table to locate the conflicting registers and change one.

14. To save the MAP file to a PC, do the following:

a) Click Save.
MON2020 validates the table for errors—for instance, ensuring that no two
registers share a register number. If any errors are found, MON2020 displays
the appropriate error message. When no errors are found, the Save As
window displays.

b) To save the MAP file to a PC, click Save File to PC.

c) Click OK.

4.14.3 Assign a variable to a register
To assign a variable to a register, from the Modbus Map Editor window, double-click the
appropriate Variable(s) cell and select a new variable.

For a demonstration of how to use the context-sensitive variable selector, see The context-
sensitive variable selector.
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4.14.4 View or edit scales
MON2020 uses scales to convert floating point values to integers.

MON2020 supports 32 different scales that are labelled SCALED_FP1 through
SCALED_FP32. The Data Type column on the Modbus Map Editor window displays the type
of scale, if any, that is being used for a particular register. If a scale is being used, the Zero
Scale and Full Scale columns display the lower and upper values for the chosen scale.

To view the list of scales, select Application → Communication... → Registers and click
Edit Scales from the Modbus Map Editor window. The Edit Scales window displays all of the
scales, along with each scales lower and upper values.

Use the following formula to calculate the variable’s integer value:

where:

• RF

• = Full Scale, range

• RZ = Zero Scale, range

• SF = Full Scale, scale

• SZ = Zero Scale, scale

• Dfp = Floating Point value

For example:

• RF = 65535

• RZ = 0

• SF = 100 (from SCALED_FP1)

• SZ = 0 (from SCALED_FP1)

• Dfp = 97.13 (scaled percent for methane)

•

To edit or create your own scale, do the following:

Procedure

1. Select Application → Communication...  → Registers → Edit Scales from the
Modbus Map Editor window.
The Edit Scales window displays.

2. Double-click the appropriate cell and enter a new value.

3. To configure bitmap intergers (16 bit), long, (32 bit), Boolean, an floting data
points, see Create a MAP file, Step 8.

4. Click OK to save the changes and close the window.
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4.15 Configure an Ethernet port
To configure an Ethernet port, select Ethernet Ports... from the Application menu. The
Ethernet Ports window displays.

The following list describes the Ethernet ports’ parameters:

Ethernet 1 IP Address IP address to use to connect to the GC's RJ-45 Ethernet port.

Ethernet 1 Subnet Mask Subnet mask for the IP address of the GC's RJ-45 Ethernet port.

Ethernet 1 Gateway Gateway address for the GC's RJ-45 Ethernet port.

Ethernet 2 IP Address IP address to use to connect to the GC's wired Ethernet port.

Ethernet 2 Subnet Mask Subnet mask for the IP address of the GC's wired Ethernet
port.

Ethernet 2 Gateway Gateway address for the GC's wired Ethernet port.

LOI IP Address IP address for the GC's LOI.

4.16 Local Operator Interface variables
Use this window to select and configure up to 25 GC parameters that you would like to
monitor using the LOI’s Display mode.

To set an LOI parameter, do the following:

Procedure

1. If the GC is configured with more than one Analysis Clock, use the Choose Analysis
Clock drop-down menu and select an analysis clock from the list.

2. Select LOI Status Variables... from the Application menu.
The LOI Status Variables window appears.

3. Select a variable by clicking on the appropriate drop-down list under the Variable
column.

Note
For a demonstration of how to use the context-sensitive variable selector, see The
context-sensitive variable selector.

4. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.

This feature also increments the Stream value to the next available stream—for
instance, incrementing from Stream 2 to Stream 8, per the GC application.

5. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available component
—incrementing from ammonia to benzene, per the GC application.

6. Enter a value in the Precision column to indicate the number of decimal places to
display for this particular variable.
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The range of possible Precision values is between 0 and 6.

7. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

4.17 Map a FOUNDATION Fieldbus variable
To map a GC variable to a FOUNDATION Fieldbus process variable (PV), do the following:

Procedure

1. Take the GC out of service from the host.

2. Open MON2020 and select FFB PV Mappings... from the Application menu.
The FFB PV Mappings window displays.

3. Select a new variable by clicking on the appropriate drop-down list under the
Variable column.

Note
For a demonstration of how to use the context-sensitive variable selector, see The
context-sensitive variable selector.

Note
The PV Value column displays the current value of the GC variable indicated in the
Variable column.

Note
The PV Status column indicates the state of the data displayed in the PV Value
column. If the data was generated under predictable conditions without any alarms,
then the statuses for all mapped process variables are Good; if the data was
generated under unpredictable conditions—that is, if any alerts were triggered
during the analysis cycle—then the statuses for all mapped process variables are
Bad, because the GC cannot guarantee the results of the analysis.

4. To copy the stream settings from a highlighted row and apply them to the next row,
click S + Copy.

This feature also increments the Stream value to the next available stream—for
instance, incrementing from Stream 2 to Stream 8, per the GC application.

5. To copy the component settings from a highlighted row and apply them to the next
row, click C + Copy.

This feature also increments the Component value to the next available component
—incrementing from ammonia to benzene, per the GC application.

6. If necessary, enter a date or time format into the Date/Time Format column.

7. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.
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5 Logs and reports
The options in the Logs/Reports menu allow you to do the following:

• View alarm, system, and event logs.

• Keep a maintenance record.

• Keep a parameter record.

• View relevant drawings and diagrams.

• View and print trend data.

• Create or view a Repeatability Certificate.

• View the GC Configuration report.

• View archived analysis, calibration, and averages reports.

• Configure how and when certain reports are printed.

• View and print a stream's Molecular Weight Vs Response Factor.

5.1 Alarms
Use this menu to view and/or clear unacknowledged and active alarms, as well as to view
the Alarm Log.

• Unack/Active Alarms

• Alarm Log

• Clear/Ack All Active Alarms

5.1.1 View unacknowledged and active alarms
To view unacknowledged and active alarms, select Logs/Reports → Alarms → Unack/
Active Alarms.... The Unack/Active Alarms window displays.

Note
Double-clicking on the GC Status Bar from the main window also displays the Unack/Active
Alarms window.

There are three display options for viewing alarms on this window:

• To view both unacknowledged alarms and active alarms, check All Alarms. This is the
default display option.

• To view unacknowledged alarms only, check Unacknowledged Alarms.

• To view active alarms only, check Active Alarms.

The Unack/Active Alarms window supplies the following data for each alarm:

Status Indicates whether the alarm has been acknowledged or not.

State Indicates whether the alarm is ACTIVE or INACTIVE.
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Date Indicates the date and time at the GC when the alarm condition began.

Alarm Message Describes the alarm condition.

Type Indicates whether a high limit or low limit alarm was triggered:
• HI means a high limit alarm was triggered.

• LO means a low limit alarm was triggered.

Limit Indicates the value that was set as the trigger for the alarm.

Value Indicates the current status value being output by the device.

Name Indicates the name of the variable that triggered the alarm.

Note
Discrete alarms do not display Type, Limit, or Value data.

5.1.2 Acknowledge and clear alarms
There are three ways to acknowledge and clear alarms:

• To acknowledge and clear alarms without viewing them, select Logs/Reports →
Alarms → Clear/Ack All Active Alarms.

• Another method to acknowledge and clear alarms without viewing them is to click 
from the Toolbar.

• To view the alarms before acknowledging and clearing them, select Logs/Reports →
Alarms → Unack/Active Alarms... . The Unack/Active Alarms window provides several
options:
— To acknowledge an alarm, select it and then click Ack Selected (F2).

Note
An alarm continues to display as an active alarm until that value is no longer in the
alarm state.

— To acknowledge all the alarms displayed on the window, click Ack All (F3).

— To acknowledge all the alarms displayed on the window and then remove them
from the table, click Clear/Ack All (F4).

Note
If an alarm is cleared before the condition has been resolved, MON2020 redisplays
the alarm entry as an active alarm.
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5.1.3 View the alarm log
The Alarm Log records every alarm triggered from the GC. The Alarm Log window gives
you the option of viewing the total list of alarms, or a date-filtered list.

To view the Alarm Log, select Logs/Reports → Alarms → Alarm Log.... The Alarm Log
window displays.

The Alarm Log window supplies the following data for each alarm:

Date Time Indicates the date and time at the GC when the alarm condition began.

Alarm Message Describes the alarm condition.

State Indicates whether the alarm is SET (active) or CLR (inactive).

Type If applicable, indicates whether a high limit or low limit alarm was
triggered:
• High means a high limit alarm was triggered.

• Low means a low limit alarm was triggered.

Limit If applicable, indicates the value that was set as the trigger for the
alarm.

Value If applicable, indicates the current status value being output by the
device.

Unit If applicable, unit of measurement for the displayed values.

Name Indicates the name of the variable that triggered the alarm.

User Indicates which user made the change.

Note
Discrete alarms do not display Type, Limit, or Value data.

To view a list of alarms, do the following:

Procedure

1. To view all alarms, select the All checkbox. Otherwise, select the Select Range
checkbox and use the Start Date and End Date dropdown lists to select a date
range.

2. Click Read Records.
The list of alarms displays with the most recent alarm at the top and the oldest
alarm at the bottom. The alarms are also sorted and color-coded by time so that
alarms that occurred simultaneously are grouped together.

3. Click Save to save the list.

The list can be saved in the following formats:

• Tab-Delimited (.txt)

• Comma-Delimited (.csv)

• Microsoft Excel (.xls)

• HTML File (.html)
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• XML File (.xml)

4. Click Close to close the window.

5.2 The maintenance log
Use this function to manually record and track maintenance activities performed on a
given GC unit.

To view the maintenance log, select Maintenance Log... from the Log/Reports menu.

5.2.1 Add an entry to the maintenance log
Use this window to manually record and track maintenance activities performed on a
given GC unit.

To view the maintenance log, select Maintenance Log on the Log/Reports menu.

To add an entry to the maintenance log, do the following:

Procedure

1. Select Maintenance Log... from the Log/Reports menu.
The Maintenance Log window displays. Log entries are sorted with the most recent
on top

2. Click Insert At Top.
A new row appears on the maintenance log table. The Date field contains the GC’s
current date and time, and is editable.

3. Double-click the Message cell and enter the relevant information for the log entry.

Note
To edit an old log entry, click it and the cell becomes editable.

4. Click OK to save the changes and close the window.

Note
To save the changes and keep the window open, click Save.
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5.2.2 Delete an entry from the maintenance log
To delete an entry from the maintenance log, do the following:

Procedure

1. Select Maintenance Log... from the Log/Reports menu.
The Maintenance Log window displays.

2. Select the entry that you want to delete.

3. Click Delete.
The entry is removed from the maintenance log.

4. Click OK to save the changes and close the window, .

Note
To save the changes and keep the window open, click Save.
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5.3 The parameter list
Use this feature to keep a record of the hardware components and associated parameters
for a given GC.

The parameter list is a Microsoft Excel ® document that can be viewed and edited from
MON2020. Before attempting to edit the document, be sure to review it first to get an
idea of what sorts of data it contains.

The parameter list may contain one or all of the following pages:

• Cover Sheet

• Spare Parts

• TE Rework

• App Data

• Programming

• Modbus® Config

• Strm Composition and Application

• Col Data

• Cal Std Data

• Stamp
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5.3.1 View and edit the parameter list
To view and edit the parameter list, do the following:

Procedure

1. Select Parameter List... from the Logs/Reports menu.

The Parameter List window displays.

2. Make your changes to the parameter list.

3. Use the scroll tabs to view the data.

Parameter list tabs:

• Cover Sheet

• Spare Parts

• TE Rework

• App Data

• Programming

• Modbus® Config

• Strm Composition and Application

• Col Data

• Cal Std Data

• Stamp

4. Click OK to save the changes and close the window.

Note
To save the changes and keep the window open, click Save.
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5.3.2 Adding a parameter list file to the GC
The parameter list is a Microsoft Excel® document and is therefore saved with the .xls
extension.

To import a parameter list, do the following:

Procedure

1. Select Parameter List... from the Logs/Reports menu.
The Parameter List window displays.

2. Click Add File to GC.
The Open dialog displays.

3. Locate and select the Parameter List that you want to import.

4. Click Open, and the document is imported and displayed in the Parameter List
window.

5. Click OK to save the changes and close the window.
This version of the parameter list will now be displayed by default.

Note
To save the changes and keep the window open, click Save.

5.3.3 Export a Parameter List
Prerequisites

To export the Parameter List, do the following:

Procedure

1. Click Save File to PC. The Save as dialog opens.

2. Navigate to the folder to which you want to save the file.

3. Click Save. The Parameter List will be saved with the .xls extension.

4. To save the changes and keep the window open, click Save.

5. To save the changes and close the window, click OK. This Parameter List displays by
default whenever Parameter List is selected on the Logs/Reports menu.

Logs and reports Reference Manual
December 2019 2-3-9000-745

146 Rosemount Gas Chromatographs



5.4 Drawings and documents
Use this feature to access GC-related drawings and documents such as flow diagrams, the
GC's sales order, assembly drawings, and electrical diagrams. These items can be stored on
the GC in the following formats:

• PDF

• TIFF

• GC Trend file (.xtrd)

• XA CGM file (.xcgm)

• XA Comparison file (.xcpm)

• GC Configuration file (.xcfg)
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5.4.1 View drawings or documents
To view a drawing, do the following:

Procedure

1. Select Drawings/Documents... from the Logs/Reports menu.
The Drawings/Documents window displays.

2. Select the drawing to view from the drop-down list.

Note
If no list displays under the Drawings/Documents label, and there is no + beside the
label, then this GC does not contain any documents.

3. Click File Viewer (F3).
The drawing displays.

4. Click Close to exit the window and to return to the Drawings/Documents window.

5.4.2 Add files to the GC
To add files, such as new or updated drawings, to the GC, do the following:

Procedure

1. Select Drawings/Documents... from the Logs/Reports menu.
The Drawings/Documents window displays.

2. Click Add File(s) to GC.
The Open dialog displays.

3. Locate and select the file to add to the GC.

4. Click Open.
The file is saved to the GC, and the Drawings/Documents list is updated.

5.4.3 Delete files from the GC
To delete drawings from the GC, do the following:

Procedure

1. Select Drawings/Documents... from the Logs/Reports menu.
The Drawings/Documents window displays.

2. Select the file to delete from the GC.

3. Click Delete File from GC.
The Confirm message displays.

4. Click Yes.
The file is deleted from the GC, and the Drawings/Documents list is updated.
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5.5 The event log
Use this function to track the changes that are made to the various tables within the GC.

To view the event log, select Logs/Reports → Event Log.... The Event Log window displays.

The Event Log window gives you the option of viewing the total list of change events, or a
date-filtered list of events. The Event Log window supplies the following data for each
event:

User ID Indicates which user made the change.

Date Indicates the date at the GC when the event occurred.

Time Indicates the time at the GC when the event occurred.

Event Message Provides a description of the event.

Old Value If applicable, indicates the value in the cell before the change.

New Value If applicable, indicates the value in the cell after change.

To view the list of change events, do the following:

Procedure

1. To view all events, select the All checkbox. Otherwise, select the Select Range
checkbox and use the Start Date and End Date dropdown lists to select a date
range.

2. Click Read Records.
The list of events display with the most recent event at the top and the oldest event
at the bottom. The events are also sorted and color-coded by time so that events
that occurred simultaneously are grouped together.

3. To save the list, click Save.

The list can be saved in the following formats:

• Tab-Delimited (.txt)

• Comma-Delimited (.csv)

• Microsoft Excel (.xls)

• HTML File (.html)

• XML File (.xml)

5.6 Reports
This function allows you to immediately display, print, or store pre-configured reports of
GC analysis data. Data is reported in real-time from the GC or from saved files.

5.6.1 Report types
MON2020 can generate the following types of reports:
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Analysis Displays a list of the components that were detected, based on raw
data. Displays a list of calculations for each component, based on the
table located at Application → Calculations → Control.... See Set
standard calculations by stream for more information.

There are two types of analysis reports: Analysis (GPA) and Analysis
(ISO). See Figure 5-1 for a sample Analysis (GPA) report. See Figure 5-2
for an example Analysis (ISO) report.

Calibration Displays a list of the components that were detected, along with each
component’s calibration concentration, raw data value, new response
factor, and new retention time. See Figure 5-3 for a sample report.

Final
Calibration

The Final Calibration report displays the list of components along with
each component’s old and new response factors and each
component’s old and new retention times, based on the averaged
data. See Figure 5-4 for a sample report.

Validation For the most recent validation cycle, displays the nominal value,
allowed percent deviation, and the measured value of each variable in
the Validation Data table. See Figure 5-5 for a sample report.

Note
If the actual deviation is beyond the allowed amount, then the row will
be flagged with an asterisk (*).

Final Validation For the most recent validation run, shows the nominal value, allowed
percent deviation, and the average value of each variable in the
Validation Data table. See Figure 5-6 for a sample report.

Note
If the actual deviation is beyond the allowed amount, then the row is
flagged with an asterisk (*).

Export Data Generates a report from the configured variables. See Generate Export
Data Report for more information.

Raw Data Displays a list of data for each peak that was detected during the run,
including the retention time, peak area, and peak height. See Figure
5-8 for a sample report.

Every Run Displays a configurable list of calculations after each run. See Edit
averages calculations for more information.

Hourly Displays a configurable list of average calculations each hour,
beginning at the time set in the Average Calculations window at
Application → Calculations → Averages... . See Edit averages
calculations for more information.

24 Hour Displays a configurable list of average calculations each day, beginning
at the time set in the Average Calculations window at Application →
Calculations → Averages... . See Edit averages calculations for more
information.

Weekly Displays a configurable list of average calculations each week,
beginning on the day set in the Average Calculations window at
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Application → Calculations → Averages... . See Edit averages
calculations for more information.

Monthly Displays a configurable list of average calculations each month,
beginning on the day of the month set in the Average Calculations
window at Application → Calculations → Averages... . See Edit
averages calculations for more information.

Variable Displays a configurable list of average calculations every hour at the
time entered in the Hours column in the Average Calculations window
at Application → Calculations → Averages.... See Edit averages
calculations for more information.

Auto Valve
Timing
(Rosemount
370XA only)

Displays an Auto valve Timing report.

Module
Validation
(Rosemount
370XA only)

Displays a Module Validation report.

Each report begins with the following header information:

Date-Time The GC’s date and time when the report was generated.

Analysis Time The duration, in seconds, of the analysis. Can be configured at
Application → Timed Events.... See Set the cycle and analysis time
for more information.

Cycle Time The duration, in seconds, between two consecutive analyses. Can be
configured at Application → Timed Events.... See Set the cycle and
analysis time for more information.

Firmware
revision

The firmware revision, checksum, date and value is displayed.

Stream The stream that was analyzed. Selected as part of the report
generation process. See View a saved report for more information.

Mode Displays the operational status of the detector.

Cycle Start Time The date and time that the cycle started.

Analyzer Name of the GC that generated the data used for the report.

Stream Sequence The identification and order of the streams that were analyzed. Can
be configured at Application → Stream Sequence.... See Create a
stream sequence for a detector for more information.

Company: Company name assosiacted with the GC.

Firmware
Revision,
Checksum:

Displays the installed firmware version, the checksum and date the
log was generated.
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Note
If you get an FTP error when trying to save a report, it may be an issue with your firewall
blocking the FTP messages between the GC and MON2020. Your IT department needs to
open the following TCP ports in the firewall.
• TCP Ports 10,000 - 13,000 (MON2020 proprietary protocol)

• TCP Ports 20, 21, 22 (SSH, FTP)

• TCP Port 502 (Modbus)

• TCP Port 990 (Secure Connection)
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Figure 5-1: Analysis (GPA) sample report
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Figure 5-2: Analysis (ISO) sample report
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Figure 5-3: Calibration sample report
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Figure 5-4: Final Calibration sample report

Figure 5-5: Validation sample report
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Figure 5-6: Final Validation sample report
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Figure 5-7: Variable Averages Report
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Figure 5-8: Raw Data sample report
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Figure 5-9: Dew Point Calculations
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5.6.2 View reports from live data
To view a report created from the most recent data, do the following:

Procedure

1. Select Report Displays... from the Log/Reports menu.
The Report Display window appears.

Note
By default, the Update automatically checkbox is selected. This means that when
viewing a report based on the most recent data, the report refreshes as new data is
created, based on the type of report that you select. For example, in the Report
Display window, if you select Analysis (GPA), the report display refreshes each time
the GC finishes an analysis of the selected stream. The refresh function displays the
newly generated report and deletes the previous report (unless already saved to
disk).

2. Select the type of report to generate and display.

For explanations of each report type, see Report types.

3. Select the appropriate stream.

To see a currently analyzed stream report then you can select the 0 - Current
Analysis field from Stream list.

4. Click Start (F2), or press F2.
The report is generated and displayed.

Note
If the report doesn’t appear right away, check the status of the report generation
process in the status bar, which is below the row of buttons on the report window.

Note
To change the font size, click Font +/-. There are five preset font sizes available.
Continue to click Font +/- to cycle through the sizes until you are satisfied with the
report’s readability.

Note
For Average reports, by default it displays three records. Change the setting from
File → Program Settings → Number of Average records displayed in report to
four or five, then MON2020 shows that many records in report.

5. To save the file, click Save.

The report can be saved in the following file formats: .txt, .rpt, .htm, .html, .mht.
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5.6.3 View a saved report
To view a saved report, do the following:

Procedure

1. Select Report Displays... from the Log/Reports menu.
The Report Display window appears.

2. Click File Viewer (F3).
The Report file viewer window displays.

3. Click Open.
The Open dialog displays.

4. Locate and select the report that you want to view.

Reports may be found in the following file formats: TXT, RPT, HTM, HTML, and MHT.

5. Click Open.
The report displays.

Note
To change the font size, click Font +/-. There are five preset font sizes available.
Continue to click Font +/- to cycle through the sizes until you are satisfied with the
report’s readability.

Note
To print the report, click Print.

5.6.4 Exporting Reports for Ultrasonic SOS
This feature in MON2020 allows exporting reports for Ultrasonic Meter Spead of Sound
(SOS). The report can be saved from Report Display or Archive Report screens.

Procedure

1. Open Logs/Reports → Report Display.

2. Click Analysis report type.

3. Select Start (F2) to display an Analysis report.

4. Click Save to display the Save dialog.

5. Use the Save as Type drop-down menu and select Comma-Delimated (CUI/
MeterLink Compatible) (*.csv).

6. The report is exported as an Excel® file compatible with Ultrasonic Meters. format.

7. Repeat Step 1 through Step 6 for a Calibration Report and a Validation Report.
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5.7 Generate reports from archived data
Use the Archive Report commands to generate analysis, calibration, and average reports
from archived GC runs.

5.7.1 Generate analysis and calibration reports from archived
data
To generate and view an analysis or calibration report from archived data, do the
following:

Procedure

1. Select Logs/Reports → Archive Report → Analysis/Calibration/Validation....
The Analysis/Calibration/Validation Archive Report window displays.

2. Select a report type from the Report dropdown list.

For an explanation of each report type, see Report types.

3. Select a stream from the Stream dropdown list.

By default, the Archive Records table displays all records for the selected report
type and stream.

Note
To date-filter the list of records, select the Time Period checkbox and use the Start
Date and End Date dropdown lists to select a date range.

4. Select the record(s) that you want to view.

To select several records, hold down CTRL and select each record. To select several
records in a row, select the first record and then hold down Shift and select the last
record in the series.

5. Click Start (F2).
The report displays. If more than one record was selected, each report displays after
that previous report on the same page.

Note
To change the font size, click Font +/-. There are five preset font sizes available.
Continue to click Font +/- to cycle through the sizes until you are satisfied with the
report’s readability.

Note
To print the report, click Print.

6. To save the file, click Save.

The report can be saved in the following file formats: .txt, .htm, .html, and .mht.

5.7.2 Generate an Average report from archived data
To generate and view an average report from archived data, do the following:
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Procedure

1. Select Logs/Reports → Archive Report → Average....
The Average Archive Report window displays.

2. Select a report type from the Report drop-down list.

For an explanation of each report type, see Report types.

3. Select a stream from the Stream drop-down list.

By default, the List of Averages table displays all variables for the selected report type
and stream.

Note
To date-filter the list of records, select the Time Period checkbox and use the Start
Date and End Date drop-down boxes to select a date range.

4. From the Archive Record Selection field, select the Number of most recent
records and enter a number value. Or, select the Time Period check box and use
the Start Date and End Date drop-down boxes to select a date range.

5. Click Start (F2) or press F2.

Note
To change the font size, click Font+/-. There are five preset font sizes available.
Continue to click Font +/- to cycle through the sizes until you are satisfied with the
report’s readability.

To print the report, click Print

6. To save the file, click Save.

The report can be saved in the following file formats:

• .txt

• .htm

• .html

• .mht

5.7.3 Generate Export Data Report
Use the Logs and Reports → Archive Report → Export Data menu to create an archive
report.
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Procedure

1. Select the Variables pull-down to configure the variables exported in the report.

Options are:

• Analysis Stream

• Final Calib Stream

• Final Calib Analysis Stream

• Hardware

• Application

2. Click the Record Selection radio button to export either All Records or a Time
Period for the data.

3. Select the Report Type

Options are:

• Analysis

• Final Calibration

• Hourly

• Daily (24 Hour)
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• Weekly

• Monthly

• Hour + Daily

4. Use the Report Header Information field and type a report Header title and a
Description. The description column is used as column headers in the Export Data
Report.

5. Click S + Copy to copy the stream settings from a highlighted row and apply them
to the next row,

6. Click C + Copy to copy the settings from a highlighted row and apply them to the
next row.

7. Click Delete to delete a rows.

8. Click Insert After to insert variable rows after an entry or Insert rowa above an entry.

9. Click Create Report (F2) or press F2 to create the report.

10. Click OK to save the report settings without generating the report and return to the
MON2020 home page.

11. Click Cancel to abort the report and return to the MON2020 home page.

Related information

Archive Report
Logs and Reports menu

5.7.4 Schedule the generation of reports
MON2020 can automatically generate and print each report according to the following
schedule:

Analysis (GPA) An analysis report is available to print after an analysis run, final
calibration run, or final validation run.

Note
If ISO is set in the Calculations Configuration screen, Analysis (ISO) is
listed under the Report Name column instead of Analysis (GPA); if
GPA & ISO is set in the Calculations Configuration screen, then both
Analysis (ISO) and Analysis (GPA) are listed under the Report Name
column.

Calibration A calibration report is available to print after a calibration run or final
calibration run is completed.

Final
Calibration

A final calibration report is available to print after a final calibration run
is completed.

Validation A validation report is available to print after validation or final
validation run is completed.

Final Validation A final validation report is available to print after a final validation run
is completed.
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Every Run An every run report is available to print after an analysis run is
completed.

Hourly A report is available to print each time an hourly average calculation is
run.

24 Hour A report is available to print each time a 24 hour average calculation is
run.

Weekly A report is available to print each time a weekly average calculation is
run.

Monthly A report is available to print each time a monthly average calculation
is run.

Variable A report is available to print each time a variable average calculation is
run.

Raw Data A raw data report is available to print after an analysis run, calibration
run, final calibration run, validation run, or final validation run is
completed.

To configure MON2020 to generate and print a report of your choosing based on that
report’s schedule of availability, do the following:

Procedure

1. Select Printer Control... from the Logs/Reports menu.
The Printer Control window displays.

Note
MON2020 must be connected to the GC for the report to be printed.

2. To print a report after a run, check the appropriate checkbox from the Print After
Completion? column.

3. To print a report at a fixed interval, check the appropriate checkbox from the Print
At Fixed Interval? column.

a) Enter a start time in the Start Time column.

b) Enter an interval, in hours, in the Interval column.

4. Use the columns numbered 1 through 20 to select the streams that you want to use
for data collection.

5. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

5.8 Trend data
This function allows you to view, print, or save graphical representations, or trend lines, of
accumulated analysis data from the GC.
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5.8.1 View live trend data
Note
You cannot view a live trend if the corresponding analysis record does not exist in the GC’s
memory.

To view live trend data, do the following:

Procedure

1. Select Trend Data... from the Logs/Reports menu.
The Trend Data window displays.

2. Click Trend.

The Select Variables for Trending window displays.

3. Select the analysis or calibration records that you want to trend from the Select
Analysis/Calibration Variables section. Click > to move your selection to the Selected
Variables queue.

4. If applicable, select the type of average record that you want to trend from the
Select Average Variables section. Click > to move your selection to the Selected
Variables queue.

Note
To remove a selection from the Selected Variables queue, click Remove. To
remove all selections from the Selected Variables queue, click Remove All. To save
the list of variables to a PC, click Save. To open the list of variables from the PC, click
Open.

5. Click the All Records checkbox from the Trend Record Selection section to use all
data for the trend report, or click the Time Period checkbox and select a Start Date
and End Date for the data to be used.

6. Click Trend.

MON2020 reads the data from the GC and then closes the Select Variables for
Trending window and plots the trend data on the graph section of the Trend Data
window.

Each trend record is color-coded; use the Trend dropdown list to select a specific
trend record.
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5.8.2 View saved trend data
Trend data files are saved with the. xtrd file extension. To view a saved trend file, do the
following:

Procedure

1. Select Trend Data... from the Logs/Reports menu.
The Trend Data window displays.

2. Click PC File.
The Open Trend File window displays.

3. Select the file that you want to view and click Open.
The trend graph displays.
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5.9 Trend graph options
Right-clicking the graph brings up the following commands and keyboard shortcuts:

Zoom In Numpad Shortcut: +

Zooms in on the entire graph.

Note
Another way to zoom in is by clicking and dragging your mouse to
select the region of the graph that you want to zoom in on.

Zoom Out Numpad Shortcut: -

Zooms out from the entire graph.

Zoom X In Numpad Shortcut: 6

Zooms in on the X-axis.

Zoom X Out Numpad Shortcut: 4

Zooms out from the X-axis.

Zoom Y In Numpad Shortcut: 8

Zooms in on the Y-axis.

Zoom Y Out Numpad Shortcut: 2

Zooms out from the Y-axis.

Note
When the Selected Data checkbox is selected, the small table to the
right of the graph displays the trend data for the visible area of the
graph when zooming in and out.

Save State Shortcut: CTRL + HOME

Saves current or archived display settings for the selected trend
graph.

Note
The Save State function is available only when viewing a live or
archived trend graph.

Restore State Shortcut: HOME

Restores the last saved display settings for the selected trend graph.

Note
Pressing HOME returns the user to the saved state.

Toggle Full Screen Shortcut: F11

Maximizes the display of the graph in the Trend Data window.

Cursor to Nearest
Point

Shortcut: F8

Snaps the cursor to the nearest point on the trend graph in both the
X and Y directions.
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Toggle Coarse/
Fine Cursor

Shortcut: F4

Toggles the cursor from coarse and less accurate to fine and more
accurate.

Toggle Lines/Dots
Displays

Shortcut: F9

Toggles the trend graph from lines to dots, or dots to lines.

Toggle Mouse
Position Tip

Shortcut: CTRL + F4

The graph’s cursor follows the movement of the mouse while a
hovering Tooltip displays the exact coordinates of the current point.

Toggle Nearest
Position Tip

Shortcut: CTRL + F9

The graph’s cursor follows the movement of the mouse cursor.

Print Shortcut: CTRL + P

Prints the trend graph.

Copy to clipboard Shortcut: CTRL + C

Copies from the graph the raw detector data that was used to plot
the selected trend graph. This data can be pasted into another
application such as Microsoft Word® or Microsoft Excel®.

Paste from
clipboard

Shortcut: CTRL + V

Plots a range of points copied from another application such as
Microsoft Word® or Microsoft Excel®.

5.10 Properties of the trend graph

5.10.1 The trend graph bar
Use the graph bar buttons to change the display parameters of the graph.

Figure 5-10: The graph
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Click Edit to view or change the display properties of the X and Y axes. The Edit Graph
window displays.

The following list defines the parameters that can be edited:

Point Sets the X-axis values to points. For the purposes of this graph, each sample run
is considered a data point. Therefore, if 2500 sample runs were used to generate
the trend graph, then there are 2500 data points.
• X Min - Sets the minimum value for the X-axis to the point number of the first

sample you want to use in the plot. Default value is 0.

• X Max - Sets the maximum value for the X-axis to the point number of the
last sample you want to use in the plot. Default value is N - 1, where N is the
total number of points in the graph. Therefore, if there are 2500 points, then
the X Max would be 2499.

Note
The X-axis value for the first sample, or point, in the trend graph is 0, not 1. The
X-axis value for the final point in the trend graph is N - 1, where N is the total
number of points in the graph.

Date
Time

Sets the X-axis values to the particular GC dates and times of each sample runs.
• From - Sets the minimum value for the X-axis to the date of the first sample

you want to use in the plot.

• To - Sets the maximum value for the X-axis to the date of the last sample you
want to use in the plot.

The primary Y-axis, which is on the left side of the graph, is the default axis for displaying
trend graphs. The secondary Y-axis, which is on the right side of the graph, can be used to
display a second graph whose minimum and maximum values are different than the
minimum and maximum values of the first graph.

Note
If three or more graphs are displayed, by default, the first graph is plotted with the primary
Y-axis; the second graph is plotted using the secondary Y-axis; all other graphs are plotted
on the primary Y-axis.

Y-xis Display
Format

• Percent - Sets the Y-axis values to a percentage of the Y Max value.

• Value - Sets the Y-axis values to the sample run values.

The default value is 0.

Y Min Sets the minimum value for the Y axis.

Y Max Sets the maximum value for the Y axis.

Y Intervals Sets the number of intervals to be displayed on the graph for the
Y-axis.

Print Speed Sets the number of inches per second for the X-axis while printing a
chromatogram, similar to an XY plotter.

X Intervals Sets the number of intervals to be displayed on the graph for the X-
axis.
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The default value is 10.

Display Option Determines whether the trend is displayed as a solid line or as a
dotted line.

The default value is Lines.

Show labels Determines whether each axis is labeled.

The default value is Checked.

Scroll newest X Determined whether the graph’s window moves to focus on the most
recent data point along the X-axis.

The default value is Checked.

To accept your changes, click OK.

Click Cursor to toggle the cursor size from coarse movement (less accurate) to fine
movement (more accurate).

Click Print to print the graph window.

5.11 The Trend bar
The Trend bar contains a row of buttons that allows you to manipulate a single trend trace.
Below the row of buttons is the Trace dropdown list, which contains a list of all of the
currently displayed traces that make up the trend graph (see Figure 5-10). Before you can
work with a trend trace you must first select it from the dropdown list.

5.11.1 Edit a trend graph
You can use the Edit window to change the X and Y offset values for a graph, change its
color, and also set which Y-axis should be used when plotting it. These changes may be
necessary to make the trend more distinguishable from those that surround it, or to
position a graph in relation to a different graph for comparison.

To edit a trend trace, do the following:

Procedure

1. From the Trend drop-down list, select the graph that you want to edit.

2. Click Edit.
The Edit Trend dialog displays.

X-Offset Enter a positive number to move the trend to the right or a
negative number to move the trend to the left.

Y-Offset Enter a positive number to move the trend up or a negative
number to move the trend down.

Color Assigns a color to the trend.

Add Trace to: Sets which Y-axis should be used when plotting the graph. See The
trend graph bar for more information.

3. Click OK to accept your changes.
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5.11.2 Enter a description for a trend graph
To add or change description text for a trend graph, do the following:

Procedure

1. From the Trend bar, click Desc.
The Edit Description window displays.

2. Type or edit a description and then close the window.

5.11.3 Save a trend
To save a trend, do the following:

Procedure

1. From the Trend dropdown list, select the trace that you want to save.

2. Click Save.
The Save Trend File window displays.

Note
To save all currently displayed trend traces into one file, click Save All.

Note
For convenience the file is given an auto-generated file name that includes the
current date and time; however, you can give the file any name that you choose.

3. Click Save.

5.11.4 View associated trend data
For each data point in a trend graph, it may be possible to view the associated report or
chromatogram.

Note
The associate report most likely exists, but the existence of the associated chromatogram
depends on the age of the trend. If the trend is more than a few days old it is likely that its
associated chromatogram has been deleted to make space for newer chromatograms.

Procedure

1. Move the cursor to the desired trend point on the graph.

2. To view the associate report, click Archive Report.
If the report exists, it will be displayed. If the report does not exist, the Archive
records information is not available!! error message displays.

3. To view the associate chromatogram, click Archive Chromatogram.
If the chromatogram exists, it will be displayed. If the it does not exist, the Archive
chromatogram information is not available!! error message displays.
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5.11.5 Remove a trend graph from view
To remove a trend graph from the graph display, do the following:

Procedure

1. From the Trend dropdown list, select the graph that you want to remove.

2. Click Remove.

5.11.6 Refresh a trend graph
Procedure

1. From the Trend pull-down menu, select the trace that you want to refresh.

2. Click Refresh.
The trend graph is updated with any new data that was compiled since the most
recent refresh.

5.11.7 Display trend data
The data used to plot the trend graphs displays in the table to the right of the graph
display area.

The trend data table contains the following columns:

TRD Indicates the identification number of the trend graph. Useful if more than one
trend is being displayed. The first trend that is displayed is #1, and so on.

Pt # For the purposes of trend graphs, each sample run is considered a data point.
Therefore, if 2500 sample runs were used to generate the trend graph, then there
are 2500 data points.

Note
The first sample, or point, is counted as 0, not 1. The final point is counted as N -
1, where N is the total number of points in the graph.

Value The data point’s value.

Data The GC’s date when the sample was run and the value was calculated.

Time The GC’s time when the sample was run and the value was calculated.

To view all trend data, click Cur/All. To view trend data for the trend graph selected from
the Trend drop-down list, click Cur/All again.

The second trend data table is useful when zooming in to or out of the graph. When the
Selected Data checkbox is selected, this table displays the trend data for the visible area of
the graph. As the example shows, the table indicates that the trend data for five samples
are visible after zooming in to the graph.
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Figure 5-11: The Trend Data window

The table contains the following columns:

TRD Indicates the identification number of the trend graph. Useful if more than
one trend is being displayed. The first trend that is displayed is #1, and so on.

Average Indicates the average data point value of the selected samples.

Minimum The lowest data point value of the selected samples.

Maximum The highest data point value of the selected samples.

Samples The number of samples that were selected and that are displayed in the
graph window.

Procedure

1. Click Trend to configure the parameters for a trend file.

2. Click PC File to display the Open Trend File dialog and navigate to a saved file on
your PC.

3. Click Close to exit the Trend Data screen and return to the MON2020 Home page.
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5.12 Edit/create a repeatability certificate
The following table lists the fields in a repeatability certificate.

Name Description

Variable Select to configure the certificate variable. Options
are: Analysis Stream, Final Calib Stream, Final Calib
Analysis Stream, Hardware, Application,, or Final
Validation.

Plot If selected, a graph will be added to the report.

Description The name that will be used to denote the selected
variable on the report.

Ambient Limit
(RepeatabilityType)

The maximum allowed variation of the selected
variable. If the variation of the selected variable is
greater than the limit, the variable will fail the
repeatability test.

Chamber Limit
(RepeatabilityType)

The maximum allowed variation of the selected
variable. If the variation of the selected variable is
greater than the limit, the variable will fail the
repeatability test.

Range Min Value Based on the Average Value and the Limit, this is the
lowest valid value that can be generated. If a value
lower than this is generated, the result of the
repeatability test for this variable is FAIL.

Range Max Value Based on the Average Value and the Limit, this is the
highest valid value that can be generated. If a value
higher than this is generated, the result of the
repeatability test for this variable is FAIL.

Units Unit of measure for the associated limit value.

Calculation Method Determines how the limit will be treated when
calculating the data. Absolute: The limit will be
subtracted from the average value to determine the
minimum value, and the limit will be added to the
average value to determine the maximum value. % of
Avg: The limit will be divide by 100 to create a
percentage value that will be applied to the average
value to calculate the minimum and maximum
values.

To edit or create a repeatability certificate:

Procedure

1. In the Repeatability Certificate window (under the Log/Reports menu), click Insert
After.
A row is added to the Select Variables table.

2. Select a variable from the Variable column.

You can select a maximum of 100 variables.
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Note
To copy a variable and increment the stream by one, select the variable and press S
+ Copy. For example, if you select Stream 1_Mole%_Propane and press S + Copy,
Stream 2_Mole%_Propane is added to the table.

Note
To copy a variable and increment the component by one, based on the list of
components in the component data table, select the variable and press C + Copy.
For example, if you select Stream 1_Mole%_Propane and press C + Copy, Stream
1_Mole%_ iButane will be added to the table.

Figure 5-12: Example Repeatability Certificate

Logs and reports Reference Manual
December 2019 2-3-9000-745

178 Rosemount Gas Chromatographs



5.13 Generate a repeatability certificate
The report is generated as a PDF, so if your computer does not have the Adobe Reader
installed, MON2020 prompts you to install it.

A Read-only user can generate a Repeatability Certificate Report but can't modify any of the
fields that are used to generate the report. A Regular user or higher can generate a
Repeatability Certificate Report and can modify the fields that are used to generate the
report.

Procedure

1. Select Log/Reports → Repeatability Certificate from the menu.

The Repeatability Certificate window opens.

2. To include all data in the report, select the All Records check box; to include a
limited set of data in the report, select the Time Period check box and then select a
Start Date and an End Date.

3. To run the test with ambient limit, select the Ambient Limit Type. To run the test
with chamber limit, select the Chamber Limit Type.

4. Select the Result Criteria as a Variance or Standard Deviation Std. Dev (k=2).

5. Use the Test Information fields to track data related to the generation of the
certificate.

Note
This information will be displayed on the report beneath a Test Notes heading.

6. Click Create Report (F2). The data in the Select Variables table are saved, and the
certificate is generated and displayed in Acrobat Reader. A table of repeatability
values is displayed first and then each variable that you selected to be plotted has its
own graph.

Table 5-1: Repeatability Values

Name Description

Limit Type This value is taken from the (Ambient or Chamber)
Limit value that you entered in the Repeatability
Certificate window.

Units Unit of measure for the associated Limit value.

Average Value The average of all the data collected during the test.

Range Min Value Based on the Average Value and the Limit, this is the
lowest valid value that can be generated. If a value
lower than this is generated, the result of the
repeatability test for this variable is FAIL.

Range Max Value Based on the Average Value and the Limit, this is the
highest valid value that can be generated.
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Table 5-1: Repeatability Values (continued)

Name Description

Result Criteria The result of the repeatability test. Select Variance or
Standard Deviation Std. Dev (k=2).

Is computed using the formula:

If Calculation Method is set to % of Avg, the tested
repeatability is computed in percentage.

Standard Deviation Standard deviation shows the variation in
measurement over the entire data set. A low standard
deviation indicates that the measurement is close to
the average reading whereas a high standard
deviation shows that the reading fluctuates from the
average value. Standard deviation is caluculated
using the formula:

Result Displays the Pass or Fail results. If a value higher than
the Average Value limit is generated, the Result of
the repeatability test for the variable is FAIL.

Note
To save the data in the Select Variables table without generating the report, click
OK. The next time you open the Repeatability Certificate window, the table is
populated with the saved data.

Enable the Export Data checkbox to Open the exported data file as XML Files in
Microsoft Excel® or, drag and drop to Microsoft Excel®.

5.14 Export a repeatability certificate to Excel
Procedure

1. To generate an XML file of a Repeatability report, check Export Data.

Note
By default, the exported data are generated in data.xml under GC specific folders.

2. To select a different file or folder, click Select File. To open it in Excel, click Select
File and drag and drop the file to Excel or open Excel, set the file type as XML, and
then open the file.
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5.15 Generate a GC Configuration report
A GC Configuration report displays the current settings for the GC. This section explains
how to produce a GC Configuration report and provides an example for reference.

To generate a GC Configuration report, do the following:

Procedure

1. Select GC Config Report... from the Logs/Reports menu.
The GC Config Report window displays.

2. Select the checkbox for each option that you want to include in the report.

Note
To select all the options, click Select All (F9). To clear all options, click Clear All
(F10).

3. Select the type of output you want for the report.

• File: Saves the report as a .txt file.

• Printer (with formfeeds): If multiple reports are selected, this option will add
page breaks in between reports.

• Printer (without formfeeds): If multiple reports are selected, after one report is
finished, the next report will continue to print on the same page.

• Screen: Opens the report in a new window within MON2020.

Note
When choosing a Printer option, if you want to use a printer different from the one
that you usually use, deselect the Use default printer checkbox and when the
report is ready, the printer configuration window displays.

Note
When choosing the File option, the Save window displays, allowing you to name the
text file and choose a location in which to save it.

4. Click Start (F2).
MON2020 generates the customized report and prints or saves it, according to the
output option you selected.

Note
A GC Configuration report that includes all options can take several minutes to
generate and save. If you press Esc or click Cancel in the Progress dialog box,
MON2020 stops generating the report after the current option is completed.
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Page from a sample GC Configuration report
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5.16 Reset Archive Data
Use this feature to delete archived data and reset the gas chromatograph memory.

To delete archived data and reset the GC memory, do the following:

Procedure

1. Select Reset Archive Data... from the Logs/Reports menu.
The Reset Archive Data window displays.

2. Select the types of data that you want to delete.

Note
To select all the options, click Select All. To clear all options, click Deselect All.

3. Click Reset CGM Database to reset the CGM database and delete all the archived
CGMs.

This operation should only be performed at the direction of an Emerson Customer
Care Representative.

4. For Rosemount 370XA GCs, click the Erase IMB button to erase the Intellegent
Module Board memory.

Note
Only select the Erase IMB function at the direction of an Emerson Customer Care
Representative.

5. Click Reset.
MON2020 displays a confirmation dialog.
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6. Click Yes.
MON2020 clears the GC’s memory. New archived records begin accumulating
again as analysis and calibration runs occur.

5.17 The molecular weight vs. response factor
graph
The Molecular Weight Vs. Response Factor window generates a graph according to Appendix
B in GPA 2198-03 Selection, Preparation, Validation, Care, and Storage of Natural Gas and
Natural Gas Liquids Reference Standard Blends. This graph can be useful in checking valve
function and consists of the following information:

• Log (Molecular Weight) vs. Log (Response Factor): plots the values for the selected
calibration.

• A trend line (best fit straight line);.

Note
The ideal trend line would be linear.

• R-squared correlation coefficient.

Note
The closer RSq is to 1, the better.

This graph is only available for calibration streams, which can be selected from the Stream
dropdown list. By default, the newest final calibration data is used to generate the graph,
but any archived final calibration file can be used by selecting it from the Final Calibration
Record dropdown list.

To print the graph, click Print.
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5.18 H(s) Archive
The Logs/Reports → H(s) Archive stores the superior dry primary calorific value (CV) for
up to two years. The heating values measurement analysis is dependent on the gas
composition and is only available for Rosemount 770XA Gas Chromatographs.

To collect the records:

Procedure

1. Use the pull-down menus and select the Start Date and Start Time.

2. Use the pull-down menus and select the End Date and End Time'

3. Click Read Records.

The records displays with the Date Time, Stream, and H(s) values data.

4. Right click on the table to save or print the records.
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6 Control Menu
The options in the Control drop down list allow you to manage analysis runs as well as
calibration, validation, and baseline runs. Control menu commands also allow you to stop
an analysis run immediately or, at the end of the run.

6.1 Auto Sequence
This is the normal mode for an online GC. Use this function to start continuous GC analysis
runs that follow a predefined stream sequence. See Create a stream sequence for a
detector for detailed instructions on configuring the predefined sequence.

Note
If an analysis run is in progress, it must be stopped before auto sequencing can be started.
See Stop an analysis for more information.

Note
If auto calibration or auto validation is enabled then they will be performed as part of the
auto sequence.

To initiate auto-sequencing, do the following:

Procedure

1. There are three ways of initiating auto sequencing:

a) Select Control → Auto Sequence… → Single Stream.

b) Press F2.

c) Click on the Toolbar.

The Start Auto Sequence dialog displays.
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2. Select Analysis Clock, for GC's configured with more than one Analysis Clock.

3. Decide whether to enable purging, then select or deselect the Purge stream for 60
seconds checkbox as necessary.

Note
Purge duration can be configured in the 700XA and 1500XA. See Purge Duration
in Analysis Clock Configuration.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.
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4. Click OK and auto sequencing starts.

Use the Mode column on the GC Status Bar to monitor the status of the analysis
run.

6.2 Analyze a single stream
If an analysis run is in progress, it must be stopped before single stream analysis can be
started. See Stop an analysis for more information.

Note
If auto calibration or auto validation is enabled then they will be performed as part of the
auto sequence.

To start an analysis run on a single calibration or sample stream, do the following:

Procedure

1. Select Single Stream… from the Control menu.
The Start Single Stream Analysis dialog displays.

2. Select Analysis Clock to display the analysis clock related streams in Stream list.

3. Select a stream from the Stream menu.

4. Decide whether to enable purging, then select or deselect the Purge stream for 60
seconds checkbox as necessary.

Note
Purge duration can be configured in the 700XA and 1500XA. See Purge Duration in
Analysis Clock Configuration.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

5. Check or uncheck the Continuous operation checkbox to set or disable repetitive
analysis. The checkbox is selected by default.

If you select Continuous operation the stream selected will continue until halted.

6. Click OK.
The analysis starts. Use the Mode column on the GC Status Bar to monitor the
status of the analysis run.
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6.3 Calibrate the gas chromatograph
Calibration runs are determined by the component data table (CDT) and Streams settings.
See The component data tables and Create a stream sequence for a detector for detailed
instructions on how to edit these settings.

To calibrate a GC, do the following:

Procedure

1. Select Control → Calibration….
The Calibration dialog displays.

Note
If the GC is in Auto Sequence mode, calibration does not start until two or more
analysis runs have been completed. This delay is required to complete the current
analysis and the analysis of the stream currently purging through the valve.

2. Select Analysis Clock to display the analysis clock related streams in Stream list.

3. Select a Stream.

4. Decide whether to enable purging; then select or deselect the Purge stream for 60
seconds checkbox as necessary.

Note
Purge duration can be configured in the 700XA and 1500XA. See Purge Duration in
Analysis Clock Configuration.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

5. Select the desired calibration type.

• Select Normal to perform a manual calibration in which the component data
table for the selected stream(s) will be updated with calibration data unless the
data is outside the acceptable deviations, as listed on the component data table.
For more information, see The component data tables.

• Select Forced to perform a manual calibration in which the component data
table for the selected stream(s) will be updated with calibration data even if that
data is outside the acceptable deviations, as listed on the component data table.
For more information, see The component data tables.

Note
A forced calibration updates the component data table's response factors even if
there are issues with the analysis; therefore, manually check the results of the
calibration before returning the unit to service.

6. Click OK.
The calibration starts. Use the Mode column on the GC Status Bar to monitor the
status of the operation.
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6.4 Validate the gas chromatograph
During a validation run, the GC performs a test analysis to verify that it is working properly.
The test analysis is performed on a gas whose component concentrations are already
known; if the GC’s results deviate significantly from the predetermined data, an alarm is
generated. Validation runs are determined by the validation data table and streams
settings. See The validation data tables and Create a stream sequence for a detector for
detailed instructions on how to edit these settings.

To validate the GC, do the following:

Procedure

1. Select Control → Validation….
The Validation dialog displays.

Note
If the GC is in Auto Sequence mode, validation does not start until two or more
analysis runs have been completed. This delay is required to complete the current
analysis and the analysis of the stream currently purging through the valve.

2. Select Analysis Clock to display the analysis clock related streams in Stream list.

3. Select a Stream.

4. Decide whether to enable purging, then select or unselect the Purge stream for 60
seconds checkbox as necessary.

Note
Purge duration can be configured in the 700XA and 1500XA. See Purge Duration in
Analysis Clock Configuration.

Purging allows sample gas to flow through the sample loop for 60 seconds prior to
beginning the first analysis. The checkbox is selected by default.

5. Click OK.
The validation starts. Use the Mode column on the GC Status Bar to monitor the
status of the operation.

6.5 Configure the valve timing
Use this feature to set and adjust the valve timing.

Note
Auto valve timing is only available with the Rosemount™ 370XA Gas Chromatograph.

The function of valve timing is to switch the analytical flow path after the peak of a lighter
component has left a column, but before the next component comes out. The first image
below shows the valve timing occurring in-between the C6+ and n-Pentane peaks
correctly on a standard 4-minute C6+ application. The second image shows what happens
when the valve timing is too early and cuts off some of the first peak. The third image
shows what happens when the valve timing is too late and cuts of some of the second
peak. In the last two examples, not all of the component will reach the detector at the
expected time, and therefore will not be measured correctly.
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Table 6-1: The effect of valve timing on component leaks.

Correct timing Early valve timing error Late valve timing error

Historically, a technician monitors the peak areas of the two affected peaks while making
changes to the valve timing, and determine the correct timing using personal judgment.
The intention of the auto valve timing (AVT) process is to automatically make the
adjustments and monitor the peak areas to determine the correct valve timing
automatically, reducing the load on the technician to just selecting when to initiate the
AVT process.

The AVT is a process that runs on the calibration gas stream. The process consists of the
following activities:

• Correctly identify all the component peaks.

• Adjust the timed events based on peak retention times.

• Automatically adjust the valve time.

• Run a calibration cycle after the adjustments have been made.

• Check the range and order of response factors.

Procedure

1. Select Control Auto Valve Timing to open the Start Auto Valve Timing dialog.

2. If you are installing a new module, select the Factory Defaults checkbox;
otherwise, select the Use Current checkbox.

3. Click OK.
The AVT process will run. When it completes, it will generate and display an Auto
Valve Timing report.
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Figure 6-1: Auto Valve Timing sample report
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6.6 Auto valve timing alarms
Alarm Name Description Example

Excessive AVT Adjustment If the valve timing adjustment exceeds
the limit set in the Configuration
dialog, this alarm is triggered and the
retention times, and timed events are
set back to their pre-adjustment
settings. The valve number(s) that did
not find an ideal time are reported
with the alarm.

Exc AVT Adj: 2,3

AVT Timed Event Adjustment If an adjustment of a timed event by
the AVT process results in a timed
event being within 0.5 seconds of
another timed event, this alarm is
triggered and the retention times and
timed events are set back to their pre-
adjustment values. The timed event
and the time of the event are reported
with the alarm.

AVT Timed Event Adj: 32 sec

AVT Missing Peak If any of the component peaks cannot
be found during any of the calibration
gas analysis runs, this alarm is
triggered and the retention times and
timed events are set back to their pre-
adjustment values. The peak that
could not be identified is reported with
the alarm.

AVT Missing Peak: Nitrogen

Related information

Configure the valve timing
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6.7 Halt an analysis
To stop the current analysis at the end of its cycle, do the following:

Procedure

1. There are three ways to halt an analysis run:

a) Select Halt… from the Control menu.

b) Press F3.

c) Click  on the Toolbar.
A confirmation message displays.

Figure 6-2: Confirmation message

2. Select the Analysis Clock to halt.

3. Click Yes.
The analysis stops at the end of the current cycle. Use the Mode column on the GC
Status Bar to monitor the status of the operation. When the analysis has halted, the
Mode value is Idle.
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6.8 Stop an analysis
This function forces the system into Idle mode. If Stop Now is performed while an analysis
is in progress, the components may continue to elute from the columns. No analysis data
is generated.

Do not perform a Stop Now unless absolutely necessary. Whenever possible, use the Halt
function.

To immediately stop an analysis run, do the following:

Procedure

1. Select Control → Stop Now….
A confirmation message displays.

Figure 6-3: Confirmation message

2. Select the Analysis Clock to Stop Now.

3. Click Yes.
The current analysis stops.
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7 Tools
The options in the Tools dropdown list allow you to do the following:

• Manage users.

• Upgrade the firmware

• Cold boot and restart the GC

• Modbus® Map Editor

• Modbus® Test program - used to confirm that data is being accurately relayed from the
gas chromatograph to the PC.

• Diagnostics

• Adjust the sensitivity of the LOI keys.

• Install upgrades to the GC

• Run, view, and Save diagnostic data

For Rosemount 370XA Gas Chromatograph, the following options are available:

• Module Validation

• Force Module Update

• Edit Module Validation Allowable Deviations

• AVT Timed Event Adjustments

• AVT Valve Selections

• AVT Settings

7.1 Users
Use the User Administration commands to create or delete users, change passwords, and
to monitor PC-to-GC connections.

Login security is at the gas chromatograph level instead of at the software level. This
means that you have to log in to the gas chromatograph to which you are trying to
connect. This also means that if you create a new user, that user is only valid for the GC to
which you are connected. You cannot connect to any other GC unless you create the same user
on it first.

MON2020 recognizes the following four user types, or roles, each with an increasing level
of access to functionality:

Read-only A read-only user has the lowest level of access and can view data but
cannot make any changes. A read-only user can change his or her
password only.

Regular A regular user has all of the privileges of a read-only user, as well as the
ability to acknowledge and clear alarms. A regular user can also control
the GC through MON2020’s Control menu. A regular user can change
his or her password only and cannot create or delete other users.
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Super User A super user has all of the privileges of a regular user, as well as the
ability to manage and control the GC through MON2020’s Application
and Hardware menus. A super user can change his or her password only
and cannot create or delete other users.

Administrator An administrator has complete access to all of MON2020’s commands
and functions, as well as the ability to manage all other users by creating
or deleting user accounts and changing passwords.

Note
Each GC ships with two administrator accounts. Contact your Customer Care
Representative to obtain account information. For the first-time logon, a password is
required.

The following table lists in detail the functions and commands that are available to each
user role:

Menu Commands Admin User Super User Regular User Read-Only User

File GC Directory Y Y Y Y

Open Configuration
File

Y Y Y Y

Save Configuration (to
PC)

Y Y Y Y

Restore Configuration
(toGC)

Y Y Y Y

Program Settings Y Y Y Y

Print Setup Y Y Y Y

Exit Y Y Y Y

Chromatograph Connect Y Y Y Y

Disconnect Y Y Y Y

Chromatogram Viewer Y Y Y Y

Chromatogram -
Forced Cal

Y Y N N

View/Set Date Time
Time

Y Y Read-only Read-only

Hardware Heaters Y Y Read-only Read-only

Valves Y Y Read-only Read-only

EPC Y Y Read-only Read-only

Detectors Y Y Read-only Read-only

Discrete Inputs Y Y Read-only Read-only

Discrete Outputs Y Y read-only read-only

Analog Inputs Y Y Read-only Read-only

Analog Outputs Y Y Read-only Read-only
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Menu Commands Admin User Super User Regular User Read-Only User

Installed Hardware Read-only Read-only Read-only Read-only

Application System Y Y Read-only Read-only

Component Data Y Y Read-only Read-only

Timed Events Y Y Read-only Read-only

Calculations - Control Y Y Read-only Read-only

Calculations - Averages Y Y Read-only Read-only

Calculations - User
Defined:
• Calculation - Dew

Point

• Calculation -
Configuration

• Calculation -
Metrology Options

Y Y Read-only Read-only

Limit Alarms Y Y Read-only Read-only

Discrete Alarms Y Y Read-only Read-only

System Alarms Y Y Read-only Read-only

Streams Y Y Read-only Read-only

Analytical Train
Configuration

Y Y Read-only Read-only

Analysis Clock
Configuration

Y Y Read-only Read-only

Stream Sequence Y Y Read-only Read-only

Method Switching Y Y Read-only Read-only

Communication Y Y Read-only Read-only

Ethernet Ports Y Y Read-only Read-only

LOI Status Variables Y Y Read-only Read-only

FFB PV Mappings Y Y Read-only Read-only

Logs/Reports Alarms Y Y Y Read-only

Unack/Active Alarms Y Y Y Read-only

Alarm Logs Read-only Read-only Read-only Read-only

Clear/Ack Alarms Y Y Y N

Maintenance Log Y Y Y N

Parameter List Y Y Y N

Drawings/Documents Y Y Y N

Event Log Read-only Read-only Read-only Read-only

Report Display Read-only Read-only Read-only Read-only
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Menu Commands Admin User Super User Regular User Read-Only User

Archive Report Read-only Read-only Read-only Read-only

Analysis/Calibration/
Validation

Y Y Y N

Average Y Y Y N

Export Data Y Y Y N

Printer Control Y Y Y Read-only

Trend Data Read-only Read-only Read-only Read-only

Repeatability
Certificate

Y Y Y N

GC Config Report Y Y Y N

Reset Archive Data Y N N N

Molecular Wt Vs
Response Factor

Y Y Y Read-only

H(s) Archive Y Y Y Read-only

Control Auto Sequence Y Y Y N

Single Stream Y Y Y N

Calibration Y Y Y N

Validation Y Y Y N

Auto Valve Timing Y Y Y N

Halt Y Y Y N

Stop Now Y Y Y N

Tools Users Y N N N

User Administration Y N N N

Change User Password Any Own Own Own

Upgrade Firmware Y N N N

Cold Boot Y N N N

Restart GC Y N N N

Modbus Map Editor Y N N N

Diagnostics Y N N N

Module Validation Y N N N

Force Module
Validations Settings

Y N N N

Edit Module Validation
Allowabble Deviations

Y N N N

AVT Timed Event
Adjustments

Y N N N
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Menu Commands Admin User Super User Regular User Read-Only User

AVT Valve Selections Y N N N

LOI Key Sensitivity Y N N N

Save Diagnostic Data Y N N N

View Diagnostic Data Y N N N

7.1.1 Create a user
Note
You must be logged in as an administrator.

To create a user, do the following:

Procedure

1. Select Tools → Users → User Administration....
The User Administration window appears, displaying a list of current users and their
role levels.

2. To add a user, click Add User.

The Add User window displays.

3. Enter the appropriate information into the text fields.

4. Click OK.
MON2020 creates the new user and adds it to the User table on the User
Administration window.

7.1.2 Export a list of user profiles
To save a list of users, along with their role levels and passwords, do the following:

Procedure

1. Select Tools → Users → User Administration....
The User Administration window appears, displaying a list of current users and their
role levels.

2. Click Export File.
The Export User File window displays.

3. Navigate to where you want to save the file, if necessary.

4. Type in a file name or use the pre-generated name provided.

5. Click Save.

7.1.3 Import a list of user profiles
To load a list of users, along with their role levels and passwords, do the following:

Procedure

1. Select Tools → Users → User Administration....
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The User Administration window appears, displaying a list of current users and their
role levels.

2. Click Import File.

The Import User File window displays.

3. Navigate to where the file is located, if necessary.

Note
User files have the .xusr extension.

4. Click on the file to be loaded.

5. Click Open. The users are added to the User Administration window.

7.1.4 Edit a user profile
Note
You must be logged in as an administrator.

To edit a user’s name, role level, or password, do the following:

Procedure

1. Select Tools → Users → User Administration....
The User Administration window appears, displaying a list of current users and their
role levels.

2. Select the user whose role you want to edit and click Edit User.
The Edit User window displays.

3. Change the appropriate information as required.

4. Click OK.
MON2020 makes the requested changes and returns to the User Administration
window.

7.1.5 Remove a user
Prerequisites

Note
You must be logged in as an administrator to remove a user.

To remove a user, do the following:

Procedure

1. Select Tools → Users → User Administration....
The User Administration window appears, displaying a list of current users and their
role levels.

2. Select the user you want to delete and click Remove User.
A confirmation message displays.
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3. Click Yes.
MON2020 deletes the user and returns to the User Administration window.

7.1.6 Change a user’s password
A user without administrator-level access can only change his or her own password.

Procedure

1. Select Tools → Users → Change User Password....
The Change User Password window displays.

2. Enter the appropriate information in the text fields and click OK.
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7.1.7 Reset the administrator password
To reset an administrator password, do the following:

Procedure

1. Start MON2020 and select Users → Reset Administrator User / Password.

Note
If MON2020 was already started, be sure to disconnect from all GCs before
attempting to reset the administrator password.

The following warning displays:

Figure 7-1: Password reset warning message

2. Click Yes.
The Connect to GC window displays.

3. Click the Ethernet button that corresponds to the GC whose password you want to
reset.
MON2020 connects to the GC and generates a password reset request ID for the
default user Emerson. If Emerson does not exist, it is created. The MON2020 -
Password Reset window displays.

4. Click Copy to Clipboard and email the password reset request ID to
GC.CSC@emerson.com. We will send you a password reset key.

5. After you receive the password reset key, return to the Connect to GC window and
again click the Ethernet button that corresponds to the GC whose password you
want to reset.
The Login window displays.

6. Enter the User Name, Emerson, and the password reset key and click OK.
MON2020 connects to the GC. To change the password, see Change a user’s
password.

7. The MON2020 security policy requires a user to change the password immediately
after login. After changing the password successfully, login with the new password.

Related information

Password security level
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7.1.8 Password security level
Procedure

1. Select Tools → User Administration.

2. Make a selection to Add, Remove, or Edit user profiles.

3. Click Password Security Level . Options are:

• Low

• Medium

• High

4. Use Export File or Import File to save or importUser's profiles

Related information

Password security level

7.1.9 Find out who is connected to the gas chromatograph
To ascertain which users are connect to the GC, select Tools → Users → Logged on
Users.... The Logged on Users window displays with a list of the users who are currently
logged on to the GC, along with each user’s IP address.

7.2 Upgrade the firmware
This command allows you to download upgrades to the GC’s firmware.

To upgrade the firmware, do the following:

Procedure

1. Select Upgrade Firmware... from the Tools menu.
The Upgrade Firmware window displays. The Currently Installed Versions section
details the status of the currently-installed applications.

2. Click Open.
The Open File dialog displays.

3. Locate and select the desired .zip file and click Open.
The .zip file’s content information displays in the Upgrade section of the Upgrade
Firmware window. The Information column alerts you to the new files that should
be selected and downloaded to the GC.

Note
If the upgrade file contains a program that is newer than what is currently installed
on the GC, it is automatically selected to download.

4. Select the check boxes for the files that you want and click Upgrade.

While the files are transferring, you can monitor their status in the Upgrade
Progress section.
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Note
If you want to halt the upgrade, click Cancel Upgrade. The Upgrade Progress stops
and the new files are not downloaded to the GC.

When the upgrade completes successfully, a confirmation message displays.

5. Click OK.
MON2020 disconnects from the GC, and the GC reboots.
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7.3 Cold Boot
Prerequisites

Cold booting the GC clears all its stored analysis files and logs and resets all the tables to
the default settings.

This is a necessary step, for example, towards refurbishing the GC or CPU board.

To cold boot the GC, do the following:

Procedure

1. Select Cold Boot... from the Tools menu. A warning message displays, stating Are
you sure you want to cold-boot the GC? The GC will lose its configuration and historical
data! Are you sure you want to continue?

2. Click Yes. The GC will initiate the cold boot process. Once the process has
completed, you will get the following confirmation message, which states, The GC
will reboot. MON2020 connection with GC will go away when you press OK. Reconnect
to the GC in 3 minutes.

3. Click OK to reboot the GC.

7.4 Restart the GC
Use this feature to restart the GC.

Procedure

1. Select Restart GC from the Tools menu. MON2020 displays the Are you sure you
want to Restart the GC? dialog.

2. Click Yes to restart the GC or click NO to cancel and close the dialog.

7.5 Modbus Map Editor
Prerequisites

Use this window to map GC data to Modbus™ registers and generate MAP files, which can
then be associated with communications ports.

For a list of variable assignments made to all registers, consult the Communication section
of the PC Config Report.

To map GC data to Modbus registers, do the following:

Procedure

1. Select Communication from the Application menu. The Communication window
opens.

2. Click Registers. The Modbus Map Editor window opens.

3. To view or edit registers that are contained in an existing MAP file, click the Select
MAP File drop-down list and select the appropriate file. The registers will load into
the table.
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4. To edit a cell, double-click it. You can edit the following parameters:

• To copy the component settings from a highlighted row and apply them to the
next row, click C + Copy. This feature also increments the Component value to
the next available component (e.g., incrementing from Ammonia to Benzene),
per the GC application.

• An error message displays when the last available component is reached.

Name Description

Register Number Displays the number for the Modbus register that will be polled by a connected
data acquisition system.

Data Type Describes the type of data that is stored in the register. SIM_2251 and
User_Modbus options are:
• BOOLEAN

• INT

• LONG

• FLOAT

• Bitmap(INT)

• Bitmap(LONG)

• SCALED_FP1 ... SCALED_FP32

If one of the scaled floating point options is chosen, the Zero Scale and Full
Scale values for that option will display in the appropriate column cells. The
default User_Modbus data type is FLOAT, which means the value is not
converted to an integer and is stored in two adjacent registers. Data types
other than FLOAT require only one register per variable.

Variable(s) Displays the variable(s) whose value is to be stored in the register. To change
the variable, see Assign Variable to Register.

Record Number The Record Number is enabled for Archive type of variables. The User selects
which archive record’s data needs to output over Modbus®. Record number 1 is
referred to as the recent record and maximum value is referred to as the oldest
record.

Access Determines whether the register will be read-only (RD_ONLY) or read/write
(RD_WR).

Format Defines the date and time using the drop-down menu. Select DDMMYY,
MMDDYY, YYMMDD, hhmmss, hhmm, DD, MM, YY, YYYY, WW, hh, mm, or ss.

Zero Scale Used when converting the analog output value to mA.

Full Scale Used when converting the analog output value mA.

7.6 The Modbus Test program
Use the Modbus program to poll the GC’s Modbus registers (or registers from another
device) to confirm that data is accurately relayed from the gas chromatograph to the PC.
Then, as necessary, assign data types to the returned data. See Assign scale ranges to
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User_Modbus registers for more information. You can save all settings to a file for future
reference.

You can use this program to facilitate software debugging or for special installations. With
this program, you can troubleshoot any device that employs registers, including the GC,
an ultrasonic meter, or a flow computer.

Traditionally, Modbus registers are polled by using a data collection system. To facilitate
installation and debugging, the Modbus program emulates a Modbus master.

 CAUTION

Only one Modbus master should be connected to a single serial link at a time.

This section provides detailed instructions for using the Modbus program. Use this
program only if you are familiar with Modbus communication protocol and the operation
of MON2020.

Related information

Assign Scale Ranges to Registers
Port Setup
Get Modbus data
Transmit single data type
Transmit data using a template
Log data
Save Modbus data
Print Modbus data
Modbus Comm Errors

7.6.1 Modbus protocol comparison
The GC and the Modbus test program can accommodate two different Modbus protocols:
SIM_2251 and User_Modbus. Some settings depend on which Modbus protocol is used.

The protocol you need depends ultimately on the hardware used for data acquisition from
the GC Modbus register contents.

The following comparison should help clarify the differences between the two protocols as
well as the utility of each.

Table 7-1: Comparing SIM_2251 and User_Modbus Protocols

SIM_2251 User_Modbus

A modified protocol that allows a floating point number to
be assigned to a single register so that it can be
transmitted over Modbus via 2251 emulation slave type.
All Gas Custody Transfer GCs are shipped with the
SIM_2251 Modbus Interface.

Standard Gould protocol that accommodates PLC
Emulation LO-HI or HI-LO word order for 32-bit values.
The GC uses the LO-HI order.

Most register contents are predefined.
The pre-configured maps conform to the SIM_2251
register designations. See Pre-defined Modbus® Map Files
for pre-defined Modbus map files.

Predefined Boolean (coils)
User-defined Numeric (registers)
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Table 7-1: Comparing SIM_2251 and User_Modbus Protocols (continued)

SIM_2251 User_Modbus

Data types are predefined for the following register ranges:

1001-2999 discrete, coils

3001-4999 16-bit integers

5001-6999 32-bit integers

7001-8999 IEEE 32-bit floats

9000-9999 Any data type

Data types are user-defined

0 - 9999 discrete, coils

0 - 9999 16-bit integers

For transmitting 32-bit data, two contiguous registers can
be used.

When using the Modbus test program, set Register Mode
to SIM2251 to view register contents.

When using the Modbus test program, set Register Mode
to PLC- LH or PLC-HL to view register contents.

It is not necessary to assign scales to registers. It may be necessary to assign scales to registers in order to
convert floating point values to whole integer
representations.

7.6.2 Set communication parameters
To determine or reset the communications parameters used by the Modbus® Test
program, do the following:

Procedure

1. Select Modbus Test... from the Tools menu.
The Modbus Test Program window displays. The current port settings display in the
window’s title bar. If MON2020 is connected to a GC through an Ethernet, then the
Modbus Test program uses the Ethernet connection.

2. Click Port Setup.
The Port Setup window appears.

3. Make the appropriate configuration changes to match the settings for the link you
are trying to test. The following table lists the typical setting for each parameter:

Parameter RTU ASCII Comments

Port COM1 or COM2 COM1 or COM2 For serial connection only

Baud Rate 9600 9600 For serial connection only

Data Bits 8 7 For serial connection only

Parity None Even For serial connection only

Stop Bits 1 1 For serial connection only

Flow Control None None For serial connection only

Read Timeout 1000 ms 1000 ms N/A

Try 2 2 Retry when an error is
detected on the frame

Register Mode (SIM_2251) or PLC-LH
(User_Modbus)

(SIM_2251) or PLC-LH
(User_Modbus)

N/A
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4. Click OK.

7.6.3 Obtain Modbus® data
To read or write register contents to the GC, or any other device, do the following:

Note
To learn the variable names that are assigned to the Modbus registers before retrieving
the data, generate a GC Config Report and review the Communication section.

Procedure

1. In the Slave Addr field, type the COM ID of the GC. The Modbus program will accept
a slave address value of 1 to 247.

To use Broadcast mode, which directs the Modbus program to poll all known
devices, enter 0 in the Slave Addr field. Each device interprets this poll attempt as
an instruction to read and take action; however, a response message may not be
received by the Modbus program.

2. Select the desired read or write option from the Function dropdown list.

Function Code Description Broadcast

1 (Read Coil) Reads one or more coil values.

2 (Read Input Status) Reads one or more input status values.

3 (Read Multiple Regs) Reads one or more register values.

4 (Read Input Regs) Reads one or more input register values.

5 (Set Single Coil) Set (write) one coil value

6 (Set Single Reg) Set (write) one register value

15 (Set Multiple Coils) Set (write) multiple coil values

16 (Set Multiple Regs) Set (write) multiple register values

3. Type the starting register value in the Data Addr field.

Note
When the register mode is set to SIM_2251, the data type is set automatically by
the Modbus program, based on the specified data address.

4. In the Quantity field, type the number of registers to be retrieved.

The Modbus test program accepts a quantity value of 1 to 2016. The requested
number of registers cannot exceed the amount contained by the selected message
block but you can retrieve a partial block. You cannot cross a message block
boundary.

Also, in Standard Modbus mode each register is 16 bits. Therefore, integers
(SHORT) consist of one register while floats (FLOAT) and long integers (LONG)
consist of two registers.
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Note
Boolean registers are not user-defined (for either SIM_2251 or User_Modbus) and
primarily contain alarm flags useful for debugging. To view the contents of Boolean
registers, select the 1 (Read Coil) function code.

Numeric registers for User_Modbus can be user-defined. To view the contents of
numeric registers, select the 3 (Read Regs) function code.

5. Type the desired repeat count, which is the number of times the Modbus program
should read or set the specified registers before ceasing transmission, in the Repeat
field.

The Modbus program will accept a repeat value of 1 to 9999. A value of –1 produces
an infinite polling loop that can be terminated by clicking Stop.

7.6.4 Transmit a single data type
To assign a data type to a group of registers you will read or edit, do the following:

Note
To learn the variable names that are assigned to the Modbus registers before retrieving
the data, generate a GC Config Report (see Generate a GC Configuration report) and review
the Communication section.

Procedure

1. In the Slave Addr field, type the COM ID of the GC.

The Modbus test program accepts a slave address value of 1 to 247.

To use Broadcast mode, which directs the Modbus test program to poll all known
devices, enter 0 in the Slave Addr field. Each device interprets this poll attempt as
an instruction to read and take action; however, a response message may not be
received by the Modbus test program.

Note
Changes are applied to the corresponding register value at each device.

2. Select the desired read or write option from the Function pull down menu.

Function Code Description Broadcast

1 (Read Coil) Reads one or more coil values.

2 (Read Input Status) Reads one or more input status values.

3 (Read Multiple Regs) Reads one or more register values.

4 (Read Input Regs) Reads one or more input register values.

5 (Set Single Coil) Set (write) one coil value

6 (Set Single Reg) Set (write) one register value

15 (Set Multiple Coils) Set (write) multiple coil values

16 (Set Multiple Regs) Set (write) multiple register values
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3. Type the starting register value in the Data Addr field.

Note
The data type is set automatically by the Modbus test program, based on the
specified data address.
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4. In the Quantity field, type the number of registers to be retrieved.

The Modbus test program will accept a quantity value of 1 to 2016. The requested
number of registers cannot exceed the amount contained by the selected message
block but you can retrieve a partial block. You cannot cross a message block
boundary.

Also, in Standard Modbus mode each register is 16 bits. Therefore, integers
(SHORT) consist of 1 register while floats (FLOAT) and long integers (LONG) consist
of 2 registers.

Note
Boolean registers are not user-defined (for either SIM_2251 or User_Modbus) and
primarily contain alarm flags useful for debugging. To view the contents of Boolean
registers, select the 1 (Read Coil) function code.

Numeric registers for User_Modbus can be user-defined. To view the contents of
numeric registers, select the 3 (Read Regs) function code.

5. Type the desired repeat count, which is the number of times the Modbus program
should read or set the specified registers before ceasing transmission, in the Repeat
field.

The Modbus test program accepts a repeat value of 1 to 9999. A value of –1
produces an infinite polling loop that can be terminated by clicking Stop.

6. Select the Use <data type> to decode registers radio button in the Data Type box.

7. Select a data type from the dropdown list.

Note
If SIM2215 Register mode is used, the radio buttons in the Data Type box are
disabled. The following list displays the default data types for each block of
SIM_2251 registers:

1000 – 2999 Boolean

3000 – 4999 Integer

5000 – 6900 Long

7000 – 8999 Float

9000 - 9999 Any data type

Note
To ensure the best data type assignments, review a saved GC Config Report.

8. Click Transmit to retrieve the selected registers (i.e., the specified data addresses)
from the GC.

The transmitted/received packet data displays in the Packet Input-Output window.

9. Click Stop to end the transmission of the data and to return to the Modbus
Function Selection options.
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7.6.5 Transmit data using a template
Templates are best used when decoding mixed data types because the template contains
data that the Modbus program can use to determine which data type should be assigned
to which register.

To create a new template or to use an existing template, do the following:

Note
To learn the variable names that are assigned to the Modbus registers before retrieving
data, generate a GC Config Report and review the Communication section.

Procedure

1. In the Slave Addr field, type the COM ID of the GC.

The Modbus program accepts a slave address value of 1 to 247.

To use Broadcast mode, which directs the Modbus program to poll all known
devices, enter 0 in the Slave Addr field. Each device interprets this poll attempt as an
instruction to read and take action; however, a response message may not be
received by the Modbus program.

Note
Changes are applied to the corresponding register value at each device.

2. Select the desired read or write option from the Function pull down menu.

Function Code Description Broadcast

1 (Read Coil) Reads one or more coil values.

2 (Read Input Status) Reads one or more input status values.

3 (Read Multiple Regs) Reads one or more register values.

4 (Read Input Regs) Reads one or more input register
values.

5 (Set Single Coil) Set (write) one coil value

6 (Set Single Reg) Set (write) one register value

15 (Set Multiple Coils) Set (write) multiple coil values

16 (Set Multiple Regs) Set (write) multiple register values

3. Type the starting register value in the Data Addr field.

Note
The data type is set automatically by the Modbus program, based on the specified
data address.
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4. In the Quantity field, type the number of registers to be retrieved.

The Modbus program will accept a quantity value of 1 to 2016. The requested
number of registers cannot exceed the amount contained by the selected message
block but you can retrieve a partial block. You cannot cross a message block
boundary.

Also, in Standard Modbus mode each register is 16 bits. Therefore, integers
(SHORT) consist of 1 register while floats (FLOAT) and long integers (LONG) consist
of 2 registers.

Note
Boolean registers are not user-defined (for either SIM_2251 or User_Modbus) and
primarily contain alarm flags useful for debugging. To view the contents of Boolean
registers, select the 1 (Read Coil) function code.

Numeric registers for User_Modbus can be user-defined. To view the contents of
numeric registers, select the 3 (Read Regs) function code.

5. Type the desired repeat count, which is the number of times the Modbus program
should read or set the specified registers before ceasing transmission, in the Repeat
field. The Modbus program will accept a repeat value of 1 to 9999. A value of –1
produces an infinite polling loop that can be terminated by clicking Stop.

6. Depending on your intent, select Use template to decode registers or Use
template to decode logs.
The Record No. field becomes active if Use template to decode logs is selected.

7. Enter the desired record number in the Record No field.

To verify which record number should be entered, consult the Modbus
specifications for your device.

The following table describes the relationship between templates and record
numbers:

Data Type Setting Other Setting(s) Result

Use template to decode registers • Enter Data Addr value.

• Enter Quantity value.

Read Quantity fields (i.e., the number
of fields specified by the Quantity
setting) from the specified address of
the register (Data Addr).

Use template to decode logs Enter Record No. value. Read all fields associated with the
Record No.

• Enter Data Addr value.

• Enter 0 for the Record No. value.

Read all fields in all records for the
specified log register (Data Addr).

8. Click Edit Template.
The Template File window displays with a new template.

9. To open an existing template file, click Open.
The Select Template Configuration File dialog displays.

10. Locate and select the template file, and then click Open.
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Template files are saved with the .cfg extension.

11. To edit the template, select a data type for each desired offset.

12. To change all offsets to the same data type, change the first offset to the desired
data type, and then click Auto Reset.
The data type for the remainder of the offsets switch to the data type of the first
offset.

13. To save the displayed file to disk, click Save As....
The Select Template Configuration File dialog appears. Type in a filename and click
Save.

14. Click OK to apply your selections and return to the main window.

7.6.6 Set the log parameters
The Log Data window allows you to log the polled data to a specified file.

Note
The log data function is not necessary to transmit Modbus data. To disable this function,
clear the Enable Logging ‘Data’ Registers and Values checkbox in the Log Data window.

To set the log parameters for the Modbus program, do the following:

Procedure

1. Click Log Data.
The Log Data window displays.

2. Select the Enable Logging ‘Data’ Registers and Values checkbox to enable data
logging and to activate the Log Data Parameters section.

3. Select a Logging Mode from the dropdown list.

You have the following options:

• Continuous mode records the polled data continuously until the connection is
terminated or data logging is disabled by clearing the Enable Logging ‘Data’
Registers and Values check box.

• Sampling mode records the polled data based on the time interval that you set
in the Time Interval between consecutive logs text box. Time intervals can be
set in seconds, minutes, or hours.

4. Select a type of logging.

You have the following options:

• Append adds this log to the file specified, preserving previously logged data.

• Reset deletes the previously-logged data and saves only this new log.

5. Click Save As....
The Save As window displays. The file can be saved as a tab-delimited text file or a
Microsoft Excel file. Type in a filename and click Save.

Reference Manual Tools
2-3-9000-745 December 2019

MON2020 217



7.6.7 Save Modbus data
To save the data table to a separate file, do the following:

Procedure

1. Click Save Data.
The Save ‘Data’ Displayed As dialog appears. The file can be saved as a tab-delimited
text file, an HTML file, or a Microsoft Excel file.

2. Type in a filename and click Save.

7.6.8 Print Modbus data
To print Modbus data, click Print Data. The standard print dialog displays.

MON2020 prints the report to your previously configured printer. See Configure your
printer for more information about changing printers.

7.6.9 Assign scale ranges to User_Modbus registers
By assigning scale ranges, floating point data can be converted to integer values. This is an
optional task that applies to applications using the User_Modbus protocol.

Use the Register command described in View or edit scales to assign scale ranges.

7.6.10 Communication errors
The Modbus® program’s Error Log is maintained in a circular buffer that holds up to 512
entries.

The Modbus program tracks the errors for a given session but does not store them. When
you exit the Modbus program, all errors are cleared.

To view any communication errors that occurred during the data transfer, do the
following:

Procedure

1. Click Error....
The Error window appears.

Note
Double-click a Description cell to scroll through the displayed text.

2. To view all errors that have occurred in this session, click Update.

3. To delete all entries to date, click Clear.
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7.6.11 View Modbus® Trace logs
To view Modbus logs, do the following:

Procedure

1. Select View Diagnostic Data... from the Tools menu.

Note
You need to be disconnected from the GC to perform this function. If you are not,
you are asked if you want to disconnect and open the configuration file. Click Yes.

2. The Open dialog displays. The default location is the same location as the current
Open configuration file.

3. Locate and select the latest configuration and diagnostic data file that you want to
open and click Open.

Note
If none exists, see Save diagnostic data on how to create data files.

A Diagnostic Data dialog opens.
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4. Double-click Modbus Trace file of interest. The file contains the raw protocol data.
See the figure below. RX is what the GC receives, and TX is what the GC transmits.

7.7 View diagnostics
To view the Diagnostics window, select Diagnostics... from the Tools menu.

MON2020 provides a Diagnostics window that displays diagnostic information about the
following software boards’ revision and voltage levels:

• CPU Board

• Preamp board

• Heater/Solenoid board

• Base IO board

This information can be useful when troubleshooting maintenance issues and in deciding
if further action is required.

7.8 Module Validation
When you install a new analytical module in the Rosemount 370XA and turn on the power,
MON2020 automatically recognizes that a new module has been installed and starts the
Module Validation wizard. You may also initiate module validation at any time by going to
Tools → Module Validation from either the MON2020 interface or the gas
chromatograph's local operator interface (LOI).

Prerequisites

Only available for Rosemount 370XA GCs.

The Module Validation wizard takes you through the following steps:

Procedure

1. Enter the calibration concentration.
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This information is in the Calibration Gas Composition ticket.

2. Enter the uncertainty percentage for each component in the calibration gas.

This information is in the Calibration Gas Composition ticket.
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3. Warm up the oven, run the carrier gas through the analytical paths, and cycle the
analytical valves to rapidly purge the system.

4. Analyze the calibration gas as an unknown, storing the response factors and
retention factors in the new analytical module and ensuring that the measured
composition is within the uncertainty percentage specified for the calibration gas
(entered in step 2).

5. Calibrate the analyzer with the calibration gas to generate updated response factors
and retention times.

6. Start the auto sequence process.
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See Auto Sequence.

At any time during this process, you can monitor the status of the Change Module process
by viewing the Module Validation report. See Report types.

If any step in the module validation process fails, the analyzer generates a Module
Validation Failure alarm and goes idle.

7.8.1 Forcing a module update
 CAUTION

Only perform this task if you are instructed to do so by Rosemount factory or service
personnel. This command is used in the factory to write module-specific characteristics
such as calibration factors and oven settings into the analytical module. If this is
performed in the field, the factory settings programmed into the analytical module are
overwritten.

To force a module update, go to Tools → Force Module Update. This does the following:

Procedure

1. Copies the response factors, retention times, oven temperature, and pressure
settings from the analyzer's CPU board into the intelligent module board inside the
analytical module. The factory configuration stored in the analytical module is
overwritten with the new factors.

2. The module serial number from the analytical module is cached in the analyzer's
CPU board. This ensures that the analyzer will no longer see the analytical module
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as a new module and thus will not perform the module validation process when the
analyzer is power cycled.

See Module Validation.

7.8.2 Module Validation Settings
This feature is only valid for the Rosemount 370XA Gas Chromatograph.

These values are set at the factory based on the analytical application and configuration of
the GC. Only make adjustments to the values in these fields at the direction of your
Emerson Customer Care representative.

The Module settings include:

• Minimum time to purge Analytical paths (in minutes)

• Maximum number of runs of Module Validation

7.8.3 Edit Module Validation Allowable Deviations
The component values are set at the factory based on the analytical application and
configuration of the GC. Only make adjustments to the values in this field at the direction
of Emerson Customer Care personnel.

1. Right click the component's Allowed Deviation and enter a valve.
The Allowable Deviations for the components are measured as a percentage

2. Click Save to apply the changes.

3. Click OK to exit and return to the MON2020 Home screen.

4. Click Cancel to abort the changes and return to the MON2020 Home screen.

7.9 AVT Timed Event Adjustments
These values are set at the factory based on the analytical application and configuration of
the GC. Only make adjustments to the values in this screen at the direction of Emerson
Customer Care personnel.

The screen lists the Component Data and fields for Dependent Timed Events, Ideal RF
Ratio, Reference Component with a drop-down selection menu, and Ideal RF Limit
percent.

7.10 AVT Valve Selections
These Auto Valve Timing (AVT) values are set at the factory based on the analytical
application and configuration of the GC. Only make adjustments to the values in this field
at the direction of Emerson support personnel.

This AVT valve selections are based on:

• 1-Sample, 4-Backflush, 3-Dual Column
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• Timing to be Adjusted - options are None, On or Off

• Early Valve Cut Component - Unused, Component Data list

• Late Valve Cut Component - Read only

• Peak Area Change Limit - Percent

1. Click Save to save the edits.

2. Click OK to return to the MON2020 Home screen without makes changes to the
GC.

3. Click Cancel to discard the changes and to return to the MON2020 Home screen.

7.11 AVT Settings
These values are set at the factory based on the analytical application and configuration of
the GC. Only make adjustments to the values in this field at the direction of Emerson
support personnel.

1. Use the AVT Settings to configure the AVT parameters. Options are:
• Valve Timing Adjustment - UOM is seconds

• Maximum Adjustment Limit - UOM is seconds

• EVC # of Area Repeats - number of iterations of valve timing adjustments where
the Area of the peak does not change before the valve timing time is confirmed.

• Use Repeat # for Valve Timing - apply the number of EVC Area repeats

• Backup Time - UOM is seconds

2. Click Save to save the edits.

3. Click OK to return to the MON2020 Home screen without makes changes to the
GC.

4. Click Cancel to discard the changes and to return to the MON2020 Home screen.

7.12 Adjust the sensitivity of the LOI Keys
Note
This feature is not available for Rosemount 370XA gas chromatographs.

To adjust the sensitivity of the LOI keys, do the following:

Procedure

1. Select LOI Key Sensitivity from the Tools menu.
The LOI Key Sensitivity window displays.

2. Adjust the sensitivity for a key by sliding the bar up or down.

Raising the bar increases the sensitivity or the key; lowering the bar decreases the
sensitivity.
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Note
To manipulate all of the sliders together, select the Apply same key sensitivity to
all keys check box.

Note
Click Restore Factory Defaults to return the sliders to their original settings.

3. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

7.13 Set the I/O card type
Note
This feature is not available for Rosemount 370XA gas chromatographs.

To set the card type for an optional communications (COM) card, do the following:

Procedure

1. Select I/O Cards... from the Tools menu.
The I/O Cards window displays.

2. Select the card type for the I/O card from the drop-down list.

Options are:

• None (Default)

• Analog Output Module

• Communication Module RS-232

• Communication Module RS-422/RS-485

• Discrete Output Module

• Discrete Input Module

• Analog Input Module

3. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

4. Restart the GC after saving the changes.

5. Click Cancel to discard the changes and return to the MON2020 Home screen.

7.14 Save diagnostic data
MON2020 provides methods to save and send configuration files and diagnostic data to a
user-defined email address. This can be helpful when seeking guidance with
troubleshooting. Diagnostic data consists of Stream CGM, Final Calibration CGM, Final
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Calibration Report, Final Validation CGM, Final Validation Report, Protected CGM, and
Modbus Trace.

Stream CGM is the last stream chromatogram for each stream. The CGMs are listed in the
ascending order of stream numbers.

Final Calibration CGM is the final Calibration chromatogram of the last calibration for the
available calibration streams. The CGMs are listed in the ascending order of calibration
stream numbers.

Final Calibration Report is described under Report types. The report(s) are listed in the
ascending order of calibration stream numbers.

Final Validation CGM is the final validation chromatograms of the last final validation for
the available validation streams. The CGMs are listed in the ascending order of validation
stream numbers.

Final Validation Report is described under Report types. The report(s) are listed in the
ascending order of validation stream numbers.

Protected CGM is the chromatogram(s) that is preserved. See Protected chromatograms.

Modbus Trace is the Modbus communication log reports. The ports are listed in ascending
order of the port numbers. Each port can have a maximum of two files.

To create the diagnostic data file, do the following:

Procedure

1. Select Save Diagnostic Data... from the Tools menu.

Note
You need to be connected to the GC to perform this operation.

The Save dialog displays. The default file name is similar to current Save
Configuration with and Diagnostic Data added. The default save location is the same
location as the current Save Configuration. You are able to change location and/or
filename as with current Save Configuration - see Save the current configuration.

2. Click Save.
After the information is saved to the PC, a window pops up asking if you want to
Email config file and diagnostic data?

3. Click Yes.
Your email client launches with the configuration file and diagnostic data attached.

7.15 View diagnostic data
To view a Diagnostic Data file, do the following:

Procedure

1. Select View Diagnostic Data... from the Tools menu.

Note
You need to be disconnected from the GC to perform this function. If you are not,
you are asked if you want to disconnect and open the configuration file. Click Yes.
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2. The Open dialog displays. The default location is the same location as the current
Open configuration.

3. Locate and select the configuration and diagnostic data file that you want to open
and click Open.
A Diagnostic Data dialog opens.

4. Select the data of interest and click Open.

5. Click Save.
After the information is saved to the PC, a dialog diplays asking if you want to Email
config file and diagnostic data?

6. Click Yes.
Your email client launches with the configuration file and diagnostic data attached.
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A Custom calculations
To create or edit a customized calculation using GC analysis data, do the following:

Procedure

1. Select Applications → Calculations → User Defined....
The User Defined Calculations window appears, containing a list of all the user-
defined calculations that are available to the GC.

2. Double-click the Label cell and enter a name for the calculation you are about to
create.

Note
If you want to enter a short description for the new calculation, double-click the
Comment cell and enter it there.
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3. Click Edit.

The Edit User-defined Calculation window displays.

Figure A-1: The Edit User-defined Calculation window

A. Calculation Steps viewer
B. Command buttons
C. Expression editor
D. Calculator
E. Edit Constants and Variables creator
F. Output display

In MON2020, building a calculation is similar to building a simple program. You
have constants and two types of variables available, as well as two calculation-
building commands. You can also add comments that will be ignored by the
application but that can help you explain the logic and structure of the calculation
you are designing.

The following is a description of the design elements of the Edit User-defined
Calculation window:

Calculation
Steps
viewer (A)

This element displays the line-by-line construction of the calculation as it is being
built. The following commands allow you to interact with this area:
• Click Clear All to clear the content of the Calculation Steps viewer.

• Click Clear Line to clear the content of the selected line.
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Note
If the selected line is an If-Then statement, then the entire condition is cleared. If
the cursor is on an else or endif condition, a message box is displayed to confirm
that the whole If-Then block is deleted.

• Click Delete Line to delete the selected line.

Note
If the selected line is the beginning of a conditional statement, then the entire If-
Then block is deleted along with the expressions that constitute the If-Then
construct. If the selected line is part of the conditional If-Then construct—that is,
the line only has Else or Endif in it - a message box is displayed to confirm that the
whole If-Then block is deleted.

• Click Copy to copy the selected line to the clipboard. You cannot copy keywords
such as else or endif.

• Click Paste to paste the content of the clipboard into a selected line. If the line
already has a calculation in it, it is cleared before the content of the clipboard is
pasted into it.

Command
buttons (B)

This section displays three buttons you can use to insert commands.
• Insert Comment - Adds a comment to the calculation. Each comment is

preceded by //.

• Insert Condition - Adds an If-Then statement to the calculation.

• Insert Expression - Adds a mathematical expression to the calculation.

Expression
editor (C)

This section is the work area where the comment, condition or expression is built
before being added to the Calculation Steps viewer. There are four modes of the
Expression editor, depending upon what action is being performed: No Action
mode, Insert Comment mode, Insert Condition mode, and Insert Expression mode.

The following commands allow you to interact with the Expression editor:
• Click Clear to clear the content of the entire line. The line itself is not deleted.

• Click Delete Item to delete the currently active token. Each mathematical
function, numeric data, and mathematical operation is treated as a token. The
token to the right of the current cursor location is treated as the currently active
token.

• Click Evaluate Exp to check the validity of the expression. If any errors are
detected in the syntax, then an error is reported in the Output window.

Note
This button is only active when the line being edited is an expression.

• Click Done to evaluate the expression and copy it to the Calculations Steps
viewer. If there are any errors in the expression, they are reported in the Output
window.
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Calculator
(D)

This section contains calculator functions that can be used to build a mathematical
expression. This section can be divided into two parts:

Figure A-2: Calculator functions

• Section 1 - This section contains the following keys:

x^y x to the power of y

SQRT Square root

abs Absolute value

sin Sine

cos Cosine

tan Tangent

log10 Logarithm to the base 10

log2 Logarithm to the base 2

ln Logarithm to the base e

and Logical AND

or Logical OR

xor Logical XOR

( Open bracket

) Close bracket

• Section 2 - This section contains the traditional calculator keys and can be used
with your keyboard’s Numpad, if it has one.

Note
Make sure to engage your keyboard’s Numlock before using the Numpad.
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Constants
and
Variables
Creator (E)

This section contains dropdown lists and buttons that allow you to create and select
constants and variables that can be added to your mathematical expressions.
• Constants - Allows you to select constants from a dropdown list.

• Temporary Variables - Allows you to select temporary, user-created variables
from a dropdown list.

• System Variables - Allows you to select system variables.

• Edit Temporary Variables - Allows you to create variables.

• Edit Constants - Allows you to create system-wide constants that can be used in
user-defined calculations.

Output
display (F)

Displays status information.

4. Use the following procedures to build your calculation:

• Insert a comment: Insert a comment

• Insert a conditional statement: Insert a conditional statement

• Insert an expression: Insert an expression

• Create a constant: Create a constant

• Create a temporary variable: Create a temporary variable

• Insert a system variable: Insert a system variable

5. To see the result of the calculation, click Calculate.
The results display in the Output window.

6. To validate the calculation for errors, click Evaluate.
The results of the validation check display in the Output window.

7. To save the calculation and close the Edit User-defined Calculation window, click OK.
You return to the Edit User-defined Calculation window.

8. To save the changes on the Edit User-defined Calculation window and close it, click
OK.

A.1 Insert a comment
To add a comment to the calculation, do the following:

Procedure

1. Click on the Insert dropdown list and select Insert Comment.
A new line is added to the Calculation Steps viewer, and the Expression Editor
switches to Edit Comment mode.

2. Enter the comment into the Edit Comment text box and then click Done.
The comment is added to the Calculation Steps viewer.
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A.2 Insert a conditional statement
Figure A-3: An example of a conditional statement

The Expression editor in Edit Condition mode allows you to build a conditional statement:

Figure A-4: The Expression editor in Edit Condition mode

Expressions are built using the Expression editor in Edit Expression mode.

To add a conditional statement, do the following:

Procedure

1. Click Insert Condition.
A new line is added to the Calculation Steps Viewer, and the Expression editor
switches to Edit Condition mode.

2. Add a condition.

Note
You can use constants, temporary variables, system variables, and the calculator
functions to build the condition. For information on inserting system variables, see
Insert a system variable. For information on creating variables, see Create a
temporary variable. For information on creating constants, see Create a constant.

To insert a constant or temporary variable to the left of the condition, select it from
the respective dropdown list.

To select a constant or temporary variable on the right side of the condition, click
the arrow on the right side of the condition, click + to expand the list, and select
from the respective list.
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Figure A-5: Edit Condition area

3. Select a relational operator from the dropdown list.

You have the following options:

< Less than

<= Less than or equal

> Greater than

>= Greater than or equal

== Equal

!= Not equal
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4. To add a variable or constant to the expression, click the Variable/Constant
dropdown list and select the appropriate item.

Figure A-6: The Variable/Constant drop-down list

For information on creating variables, see Create a temporary variable. For
information on creating constants, see Create a constant.

5. Click Done.
MON2020 validates the statement and if there are no errors, it adds it to the
Calculation Steps viewer.

Postrequisites

To complete the conditional statement, use the Expression editor in Edit Expression mode
to add the necessary mathematical expressions.
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A.3 Insert an expression
A mathematical expression has the following structure:

Variable = Regular expression

Figure A-7: Edit Expression area

To add an expression to a conditional statement or calculation, do the following:

Procedure

1. Click on the Insert dropdown list and select Insert Expression.
A new line is added to the Calculation Steps viewer, and the Expression editor
switches to Edit Expression mode.

2. Select a variable from the Variable dropdown tree view.

You can select either a temporary variable or you can set the expression you are
building as the final result of your new user-defined calculation. For instance, if the
user-defined calculation you are building is called User Calc 1, then you can select
User Calc 1 from the Final Result tree view. For information on creating variables,
see Create a temporary variable.

3. Add a regular expression.

To select a temporary variable on the left side of the expression, click + to expand
the list and select from the respective list. To insert a constant or temporary variable
to the right of the expression, select it from the respective dropdown list. You can
use constants, temporary variables, system variables, and the calculator functions
to build the expression. For information on inserting system variables, see Insert a
system variable. For information on creating variables, see Create a temporary
variable. For information on creating constants, see Create a constant.

4. Click Done.
MON2020 validates the statement, and if there are no errors, it adds it to the
Calculation Steps viewer.
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A.4 Create a constant
To create a constant that you can use in building a calculation, do the following:

Procedure

1. From the Edit User-defined Calculation window, click Edit Constants.
The Edit Constants window displays, showing all the constants that have been
created so far for the GC.

2. Click Insert before.
A new row is added to the USER_CALC_CONSTANTS table.

Note
To delete a constant, select it in the USER_CALC_CONSTANTS table and click
Delete.

3. Double-click the Label cell and enter a name for the constant.

Note
To edit any cell, double-click it.

4. Double-click the Value cell and enter a value for the constant.

5. Use the Comment cell to store information that is relevant for the constant.

6. Click OK to save the changes and close the window.

Note
To save the changes without closing the window, click Save.

A.5 Create a temporary variable
To create a temporary variable that you can use in building a calculation, do the following:

Procedure

1. From the Edit User-defined Calculation window, click Edit Temporary Variables.
The Edit Temporary Variables window displays, showing all the temporary variables
that have been created so far for the user-defined calculation.

2. Click Insert.
A new row is added to the table.

Note
To delete a variable from this window, select it in the table and click Delete.

3. Double-click the Name cell and enter a name for the variable.

4. Use the Comment cell to store information that is relevant for the variable.

5. Click OK to save the changes and close the window.

To save the changes without closing the window, click Save.
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A.6 Insert a system variable
To insert a system variable into the Expression or Condition editor, do the following:

From the Application → Calculations → User-defined... → Edit (F2) menu, click the
System Variables drop-down list.

For a demonstration of how to use the context-sensitive variable selector, see The context-
sensitive variable selector.

The selected system variable displays in the System Variables drop-down list and in the
Expression or Condition editor.

Figure A-8: The Expression editor
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B Pre-defined Modbus® Map Files

B.1 Definitions of Terms
Register: Modbus register number

Data type: The following data types are supported:

1. INT - 16-bit integer value

2. FLOAT - 32-bit IEEE single precision floating point value

3. Bitmap (INT) - 16 Boolean values packed into a single 16-bit integer. Each bit
represents one Boolean value.

4. Long - 32-bit long integer value

5. Bitmap (long) - 32 Boolean values packed into a 32-bit long integer. Each bit
represents one Boolean value.

6. SCALED_FP_1 ... SCALED_FP_32 - Scaled floating point data type is also referred to
as Ranged Integers. A 32-bit floating point value is converted to a 16-bit integer. For
more details, refer to Edit Scales.

Variable: System variable that is mapped to a Modbus register.

Record #: This field is applicable only for Archive Average System Variables. The record #
tells the GC which historical average value to retrieve. For example, Record #1 refers to the
most recent average, Record #2 refers to the second most recent average and so on.

Access: Can either be Read only or Read-Write. A small fraction of GC system variables can
be updated from a Modbus Master. Writable registers have to be set to RD_WR in the
mapping before they can be written from a Modbus Master.

Format: This field is applicable for system variables that hold date/time. Date/time is
internally stored in a 32-bit Unix time_t format. The format field is used to convert the
date/time to human readable form. The available format modifiers are:

• MM - 2 digit month (1-12)

• DD - 2 digit day of the month (1-31)

• YY - 2 digit year (0-99)

• YYYY - 4 digit year (1970 - 2038)

• hh - 2 digit hour in 24 hour format (0-23)

• mm - 2 digit minutes (0-59)

• SS - 2 digit seconds (0-59)

• MMDDYY - 6 digit date. If the date is January 4, 2010, the register reads 010410. If the
date is November 7, 2012, the register reads 110712.

• DDMMYY - 6 digit date. If the date is January 4, 2010, the register reads 040110. If the
date is November 7, 2012, the register reads 071112.
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• YYMMDD - 6 digit date. If the date is April 17, 2007, the register reads 070417. If the
date is January 31, 2014, the register reads 140131.

• hhmmss - 6 digit time in 24 hour format

• hhmm - 4 digit time in 24 hour format

B.2 SIM_2251 map file (with GPA results)
Register # Data Type Variable Record # Access Format

3001 INT Last Analy_Component Code(US)[1 - Component 1] RD_ONLY

3002 INT Last Analy_Component Code(US)[2 - Component 2] RD_ONLY

3003 INT Last Analy_Component Code(US)[3 - Component 3] RD_ONLY

3004 INT Last Analy_Component Code(US)[4 - Component 4] RD_ONLY

3005 INT Last Analy_Component Code(US)[5 - Component 5] RD_ONLY

3006 INT Last Analy_Component Code(US)[6 - Component 6] RD_ONLY

3007 INT Last Analy_Component Code(US)[7 - Component 7] RD_ONLY

3008 INT Last Analy_Component Code(US)[8 - Component 8] RD_ONLY

3009 INT Last Analy_Component Code(US)[9 - Component 9] RD_ONLY

3010 INT Last Analy_Component Code(US)[10 - Component 10] RD_ONLY

3011 INT Last Analy_Component Code(US)[11 - Component 11] RD_ONLY

3012 INT Last Analy_Component Code(US)[12 - Component 12] RD_ONLY

3013 INT Last Analy_Component Code(US)[13 - Component 13] RD_ONLY

3014 INT Last Analy_Component Code(US)[14 - Component 14] RD_ONLY

3015 INT Last Analy_Component Code(US)[15 - Component 15] RD_ONLY

3016 INT Last Analy_Component Code(US)[16 - Component 16] RD_ONLY

3017 INT Last Analy_Component Code(US)[1 - Component 1] RD_ONLY

3018 INT Last Analy_Component Code(US)[2 - Component 2] RD_ONLY

3019 INT Last Analy_Component Code(US)[3 - Component 3] RD_ONLY

3020 INT Last Analy_Component Code(US)[4 - Component 4] RD_ONLY

3021 INT Last Analy_Component Code(US)[5 - Component 5] RD_ONLY

3022 INT Last Analy_Component Code(US)[6 - Component 6] RD_ONLY

3023 INT Last Analy_Component Code(US)[7 - Component 7] RD_ONLY

3024 INT Last Analy_Component Code(US)[8 - Component 8] RD_ONLY

3025 INT Last Analy_Component Code(US)[9 - Component 9] RD_ONLY

3026 INT Last Analy_Component Code(US)[10 - Component 10] RD_ONLY

3027 INT Last Analy_Component Code(US)[11 - Component 11] RD_ONLY

3028 INT Last Analy_Component Code(US)[12 - Component 12] RD_ONLY
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Register # Data Type Variable Record # Access Format

3029 INT Last Analy_Component Code(US)[13 - Component 13] RD_ONLY

3030 INT Last Analy_Component Code(US)[14 - Component 14] RD_ONLY

3031 INT Last Analy_Component Code(US)[15 - Component 15] RD_ONLY

3032 INT Last Analy_Component Code(US)[16 - Component 16] RD_ONLY

3033 INT Run Time(1/30th Sec) RD_ONLY

3034 INT Last Analy_Stream Number RD_ONLY

3035 INT Last Analy_CDT Stream Mask RD_ONLY

3036 INT Current Time (time_t) RD_WR MM

3037 INT Current Time(time_t) RD_WR DD

3038 INT Current Time (time_t) RD_WR YY

3039 INT Current Time (time_t) RD_WR hh

3040 INT Current Time (time_t) RD_WR mm

3041 INT Last Analy_Start Time RD_ONLY MM

3042 INT Last Analy_Start Time RD_ONLY DD

3043 INT Last Analy_Start Time RD_ONLY YY

3044 INT Last Analy_Start Time RD_ONLY hh

3045 INT Last Analy_Start Time RD_ONLY mm
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Register # Data Type Variable Record # Access Format

3046 Bitmap(INT) 0:Unused,

1:Unused,

2:System Alarm_Alarm On - Last Analysis_Analog Input 1
Low Signal,

3:System Alarm_Alarm On - Last Analysis_Analog Input 1
High Signal,

4:System Alarm_Alarm On - Last Analysis_Analog Input 2
Low Signal,

5:System Alarm_Alarm On - Last Analysis_Analog Input 2
High Signal,

6:Unused,

7:Unused,

8:System Alarm_Alarm On - Last Analysis_Analog Output 1
Low Signal,

9:System Alarm_Alarm On - Last Analysis_Analog Output 1
High Signal,

10:System Alarm_Alarm On - Last Analysis_Analog Output
2 Low Signal,

11:System Alarm_Alarm On - Last Analysis_Analog Output
2 High Signal,

12:System Alarm_Alarm On - Last Analysis_Analog Output
3 Low Signal,

13:System Alarm_Alarm On - Last Analysis_Analog Output
3 High Signal,

14:Analyzer Failure,

15:Unused

RD_ONLY

3047 Bitmap(INT) 0:System Alarm_Alarm On - Current Analysis_Power
Failure,

1:Calibration Failed,

2:Preamp Failure,

3:Unused,

4:Unused,

5:Unused,

6:Unused,

7:Unused,

8:Unused,

9:Unused,

10:Unused,

11:Unused,

12:Unused,

13:Unused,

14:Unused,

15:Unused

RD_ONLY

3048 INT 1 – Stream 1_Active Low Limit Alarms RD_ONLY

3049 INT 1 - Stream 1_Active High Limit Alarms RD_ONLY
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Register # Data Type Variable Record # Access Format

3050 INT 2 - Stream 2_Active Low Limit Alarms RD_ONLY

3051 INT 2 - Stream 2_Active High Limit Alarms RD_ONLY

3052 INT 3 - Stream 3_Active Low Limit Alarms RD_ONLY

3053 INT 3 - Stream 3_Active High Limit Alarms RD_ONLY

3054 INT 4 - Stream 4_Active Low Limit Alarms RD_ONLY

3055 INT 4 - Stream 4_Active High Limit Alarms RD_ONLY

3056 INT 5 - Stream 5_Active Low Limit Alarms RD_ONLY

3057 INT 5 - Stream 5_Active High Limit Alarms RD_ONLY

3058 INT New Data Flag RD_WR

3059 INT Analy/Calib Flag RD_ONLY

5001 LONG Last Analy_Cycle Time (1/30th sec) RD_ONLY

5002 LONG Last Cal_Cycle Time (1/30th sec) RD_ONLY

7001 FLOAT Last Analy_Mole %[1 - Component 1] RD_ONLY

7002 FLOAT Last Analy_Mole %[2 - Component 2] RD_ONLY

7003 FLOAT Last Analy_Mole %[3 - Component 3] RD_ONLY

7004 FLOAT Last Analy_Mole %[4 - Component 4] RD_ONLY

7005 FLOAT Last Analy_Mole %[5 - Component 5] RD_ONLY

7006 FLOAT Last Analy_Mole %[6 - Component 6] RD_ONLY

7007 FLOAT Last Analy_Mole %[7 - Component 7] RD_ONLY

7008 FLOAT Last Analy_Mole %[8 - Component 8] RD_ONLY

7009 FLOAT Last Analy_Mole %[9 - Component 9] RD_ONLY

7010 FLOAT Last Analy_Mole %[10 - Component 10] RD_ONLY

7011 FLOAT Last Analy_Mole %[11 - Component 11] RD_ONLY

7012 FLOAT Last Analy_Mole %[12 - Component 12] RD_ONLY

7013 FLOAT Last Analy_Mole %[13 - Component 13] RD_ONLY

7014 FLOAT Last Analy_Mole %[14 - Component 14] RD_ONLY

7015 FLOAT Last Analy_Mole %[15 - Component 15] RD_ONLY

7016 FLOAT Last Analy_Mole %[16 - Component 16] RD_ONLY

7017 FLOAT Last Analy_Weight %[1 - Component 1] RD_ONLY

7018 FLOAT Last Analy_Weight %[2 - Component 2] RD_ONLY

7019 FLOAT Last Analy_Weight %[3 - Component 3] RD_ONLY

7020 FLOAT Last Analy_Weight %[4 - Component 4] RD_ONLY

7021 FLOAT Last Analy_Weight %[5 - Component 5] RD_ONLY

7022 FLOAT Last Analy_Weight %[6 - Component 6] RD_ONLY
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Register # Data Type Variable Record # Access Format

7023 FLOAT Last Analy_Weight %[7 - Component 7] RD_ONLY

7024 FLOAT Last Analy_Weight %[8 - Component 8] RD_ONLY

7025 FLOAT Last Analy_Weight %[9 - Component 9] RD_ONLY

7026 FLOAT Last Analy_Weight %[10 - Component 10] RD_ONLY

7027 FLOAT Last Analy_Weight %[11 - Component 11] RD_ONLY

7028 FLOAT Last Analy_Weight %[12 - Component 12] RD_ONLY

7029 FLOAT Last Analy_Weight %[13 - Component 13] RD_ONLY

7030 FLOAT Last Analy_Weight %[14 - Component 14] RD_ONLY

7031 FLOAT Last Analy_Weight %[15 - Component 15] RD_ONLY

7032 FLOAT Last Analy_Weight %[16 - Component 16] RD_ONLY

7033 FLOAT Last Analy_HV Gross BTU Dry RD_ONLY

7034 FLOAT Last Analy_HV Gross BTU Sat RD_ONLY

7035 FLOAT Last Analy_GPA Real Rel Den Gas RD_ONLY

7036 FLOAT Last Analy_GPA Z Factor RD_ONLY

7037 FLOAT Last Analy_GPA Wobbe Index RD_ONLY

7038 FLOAT Last Analy_Total Unnormalized Conc RD_ONLY

7039 FLOAT Last Analy_Gal/1000 SCF C2+ RD_ONLY

7040 FLOAT Calc Result[1 - User Cal 01] RD_ONLY

7041 FLOAT Calc Result[2 - User Cal 02] RD_ONLY

7042 FLOAT Calc Result[3 - User Cal 03] RD_ONLY

7043 FLOAT Calc Result[4 - User Cal 04] RD_ONLY

7044 FLOAT Calc Result[5 - User Cal 05] RD_ONLY

7045 FLOAT Unused RD_ONLY

7046 FLOAT Unused RD_ONLY

7047 FLOAT Unused RD_ONLY

7048 FLOAT Unused RD_ONLY

7049 FLOAT Unused RD_ONLY

7050 FLOAT Unused RD_ONLY

7051 FLOAT Unused RD_ONLY

7052 FLOAT Unused RD_ONLY

7053 FLOAT Unused RD_ONLY

7054 FLOAT Last Analy_HV Gross BTU Act RD_ONLY

7055 FLOAT Avg[1 - Average 1] RD_ONLY

7056 FLOAT Avg[2 - Average 2] RD_ONLY
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Register # Data Type Variable Record # Access Format

7057 FLOAT Avg[3 - Average 3] RD_ONLY

7058 FLOAT Avg[4 - Average 4] RD_ONLY

7059 FLOAT Avg[5 - Average 5] RD_ONLY

7060 FLOAT Avg[6 - Average 6] RD_ONLY

7061 FLOAT Avg[7 - Average 7] RD_ONLY

7062 FLOAT Avg[8 - Average 8] RD_ONLY

7063 FLOAT Avg[9 - Average 9] RD_ONLY

7064 FLOAT Avg[10 - Average 10] RD_ONLY

7065 FLOAT Avg[11 - Average 11] RD_ONLY

7066 FLOAT Avg[12 - Average 12] RD_ONLY

7067 FLOAT Avg[13 - Average 13] RD_ONLY

7068 FLOAT Avg[14 - Average 14] RD_ONLY

7069 FLOAT Avg[15 - Average 15] RD_ONLY

7070 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7071 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7072 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7073 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7074 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7075 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7076 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7077 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7078 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7079 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7080 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7081 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7082 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7083 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7084 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7085 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7086 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7087 FLOAT Last FCalib_HV Gross BTU Act RD_ONLY

7088 FLOAT Last FCalib_HV Gross BTU Dry RD_ONLY

7089 FLOAT Last FCalib_HV Gross BTU Sat RD_ONLY

7090 FLOAT Last FCalib_GPA Wobbe Index RD_ONLY
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Register # Data Type Variable Record # Access Format

7091 FLOAT Last FCalib_GPA Real Rel Den Gas RD_ONLY

7092 FLOAT Last FCalib_GPA Z Factor RD_ONLY

7093 FLOAT Last FCalib_Gal/1000 SCF C2+ RD_ONLY

7094 FLOAT Last FCalib_Total Unnormalized Conc RD_ONLY

7095 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7096 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7097 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7098 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7099 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7100 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7101 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7102 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7103 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7104 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7105 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7106 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7107 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7108 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7109 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7110 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7111 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7112 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7113 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7114 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7115 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7116 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7117 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7118 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7119 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7120 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7121 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7122 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7123 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7124 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY
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Register # Data Type Variable Record # Access Format

7125 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7126 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7127 FLOAT Avg[1 - Average 1] RD_ONLY

7128 FLOAT Avg[2 - Average 2] RD_ONLY

7129 FLOAT Avg[3 - Average 3] RD_ONLY

7130 FLOAT Avg[4 - Average 4] RD_ONLY

7131 FLOAT Avg[5 - Average 5] RD_ONLY

7132 FLOAT Avg[6 - Average 6] RD_ONLY

7133 FLOAT Avg[7 - Average 7] RD_ONLY

7134 FLOAT Avg[8 - Average 8] RD_ONLY

7135 FLOAT Avg[9 - Average 9] RD_ONLY

7136 FLOAT Avg[10 - Average 10] RD_ONLY

7137 FLOAT Avg[11 - Average 11] RD_ONLY

7138 FLOAT Avg[12 - Average 12] RD_ONLY

7139 FLOAT Avg[13 - Average 13] RD_ONLY

7140 FLOAT Avg[14 - Average 14] RD_ONLY

7141 FLOAT Avg[15 - Average 15] RD_ONLY

7142 FLOAT Avg[16 - Average 16] RD_ONLY

7143 FLOAT Avg[17 - Average 17] RD_ONLY

7144 FLOAT Avg[18 - Average 18] RD_ONLY

7145 FLOAT Avg[19 - Average 19] RD_ONLY

7146 FLOAT Avg[20 - Average 20] RD_ONLY

7147 FLOAT Avg[21 - Average 21] RD_ONLY

7148 FLOAT Avg[22 - Average 22] RD_ONLY

7149 FLOAT Avg[23 - Average 23] RD_ONLY

7150 FLOAT Avg[24 - Average 24] RD_ONLY

7151 FLOAT Avg[25 - Average 25] RD_ONLY

7152 FLOAT Avg[26 - Average 26] RD_ONLY

7153 FLOAT Avg[27 - Average 27] RD_ONLY

7154 FLOAT Avg[28 - Average 28] RD_ONLY

7155 FLOAT Avg[29 - Average 29] RD_ONLY

7156 FLOAT Avg[30 - Average 30] RD_ONLY

7157 FLOAT Avg[31 - Average 31] RD_ONLY

7158 FLOAT Avg[32 - Average 32] RD_ONLY
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Register # Data Type Variable Record # Access Format

7159 FLOAT Avg[33 - Average 33] RD_ONLY

7160 FLOAT Avg[34 - Average 34] RD_ONLY

7161 FLOAT Avg[35 - Average 35] RD_ONLY

7162 FLOAT Avg[36 - Average 36] RD_ONLY

7163 FLOAT Max[1 - Average 1] RD_ONLY

7164 FLOAT Max[2 - Average 2] RD_ONLY

7165 FLOAT Max[3 - Average 3] RD_ONLY

7166 FLOAT Max[4 - Average 4] RD_ONLY

7167 FLOAT Max[5 - Average 5] RD_ONLY

7168 FLOAT Max[6 - Average 6] RD_ONLY

7169 FLOAT Max[7 - Average 7] RD_ONLY

7170 FLOAT Max[8 - Average 8] RD_ONLY

7171 FLOAT Max[9 - Average 9] RD_ONLY

7172 FLOAT Max[10 - Average 10] RD_ONLY

7173 FLOAT Max[11 - Average 11] RD_ONLY

7174 FLOAT Max[12 - Average 12] RD_ONLY

7175 FLOAT Max[13 - Average 13] RD_ONLY

7176 FLOAT Max[14 - Average 14] RD_ONLY

7177 FLOAT Max[15 - Average 15] RD_ONLY

7178 FLOAT Max[16 - Average 16] RD_ONLY

7179 FLOAT Max[17 - Average 17] RD_ONLY

7180 FLOAT Max[18 - Average 18] RD_ONLY

7181 FLOAT Max[19 - Average 19] RD_ONLY

7182 FLOAT Max[20 - Average 20] RD_ONLY

7183 FLOAT Max[21 - Average 21] RD_ONLY

7184 FLOAT Max[22 - Average 22] RD_ONLY

7185 FLOAT Max[23 - Average 23] RD_ONLY

7186 FLOAT Max[24 - Average 24] RD_ONLY

7187 FLOAT Max[25 - Average 25] RD_ONLY

7188 FLOAT Max[26 - Average 26] RD_ONLY

7189 FLOAT Max[27 - Average 27] RD_ONLY

7190 FLOAT Max[28 - Average 28] RD_ONLY

7191 FLOAT Max[29 - Average 29] RD_ONLY

7192 FLOAT Max[30 - Average 30] RD_ONLY
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Register # Data Type Variable Record # Access Format

7193 FLOAT Max[31 - Average 31] RD_ONLY

7194 FLOAT Max[32 - Average 32] RD_ONLY

7195 FLOAT Max[33 - Average 33] RD_ONLY

7196 FLOAT Max[34 - Average 34] RD_ONLY

7197 FLOAT Max[35 - Average 35] RD_ONLY

7198 FLOAT Max[36 - Average 36] RD_ONLY

7199 FLOAT Min[1 - Average 1] RD_ONLY

7200 FLOAT Min[2 - Average 2] RD_ONLY

7201 FLOAT Min[3 - Average 3] RD_ONLY

7202 FLOAT Min[4 - Average 4] RD_ONLY

7203 FLOAT Min[5 - Average 5] RD_ONLY

7204 FLOAT Min[6 - Average 6] RD_ONLY

7205 FLOAT Min[7 - Average 7] RD_ONLY

7206 FLOAT Min[8 - Average 8] RD_ONLY

7207 FLOAT Min[9 - Average 9] RD_ONLY

7208 FLOAT Min[10 - Average 10] RD_ONLY

7209 FLOAT Min[11 - Average 11] RD_ONLY

7210 FLOAT Min[12 - Average 12] RD_ONLY

7211 FLOAT Min[13 - Average 13] RD_ONLY

7212 FLOAT Min[14 - Average 14] RD_ONLY

7213 FLOAT Min[15 - Average 15] RD_ONLY

7214 FLOAT Min[16 - Average 16] RD_ONLY

7215 FLOAT Min[17 - Average 17] RD_ONLY

7216 FLOAT Min[18 - Average 18] RD_ONLY

7217 FLOAT Min[19 - Average 19] RD_ONLY

7218 FLOAT Min[20 - Average 20] RD_ONLY

7219 FLOAT Min[21 - Average 21] RD_ONLY

7220 FLOAT Min[22 - Average 22] RD_ONLY

7221 FLOAT Min[23 - Average 23] RD_ONLY

7222 FLOAT Min[24 - Average 24] RD_ONLY

7223 FLOAT Min[25 - Average 25] RD_ONLY

7224 FLOAT Min[26 - Average 26] RD_ONLY

7225 FLOAT Min[27 - Average 27] RD_ONLY

7226 FLOAT Min[28 - Average 28] RD_ONLY
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Register # Data Type Variable Record # Access Format

7227 FLOAT Min[29 - Average 29] RD_ONLY

7228 FLOAT Min[30 - Average 30] RD_ONLY

7229 FLOAT Min[31 - Average 31] RD_ONLY

7230 FLOAT Min[32 - Average 32] RD_ONLY

7231 FLOAT Min[33 - Average 33] RD_ONLY

7232 FLOAT Min[34 - Average 34] RD_ONLY

7233 FLOAT Min[35 - Average 35] RD_ONLY

7234 FLOAT Min[36 - Average 36] RD_ONLY

7235 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7236 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7237 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7238 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7239 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7240 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7241 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7242 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7243 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7244 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7245 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7246 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7247 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7248 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7249 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7250 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7251 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7252 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7253 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7254 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7255 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7256 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

7257 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7258 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7259 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7260 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY
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7261 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7262 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7263 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7264 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7265 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7266 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7267 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7268 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7269 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7270 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7271 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

7272 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

7273 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

7274 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

7275 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

7276 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

7277 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

7278 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

7279 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

7280 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

7281 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

7282 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

7283 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

7284 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

7285 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

7286 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

7287 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

7288 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

7289 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

7290 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

7291 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

7292 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

7293 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

7294 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY
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7295 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

7296 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

7297 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

7298 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

7299 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

7300 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

7301 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

7302 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

7303 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

7304 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

7305 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

7306 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

7307 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

7308 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

7309 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

7310 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

7311 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

7312 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

7313 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

7314 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

7315 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

7316 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

7317 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

7318 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

7319 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

7320 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

7321 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

7322 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

7323 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

7324 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

7325 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

7326 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

7327 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

7328 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY
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7329 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

7330 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

7331 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

7332 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

7333 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

7334 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

7335 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

7336 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

7337 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

7338 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

7339 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

7340 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

7341 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

7342 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

7343 FLOAT Archive_Avg[1 - Average 1] 2 RD_ONLY

7344 FLOAT Archive_Avg[2 - Average 2] 2 RD_ONLY

7345 FLOAT Archive_Avg[3 - Average 3] 2 RD_ONLY

7346 FLOAT Archive_Avg[4 - Average 4] 2 RD_ONLY

7347 FLOAT Archive_Avg[5 - Average 5] 2 RD_ONLY

7348 FLOAT Archive_Avg[6 - Average 6] 2 RD_ONLY

7349 FLOAT Archive_Avg[7 - Average 7] 2 RD_ONLY

7350 FLOAT Archive_Avg[8 - Average 8] 2 RD_ONLY

7351 FLOAT Archive_Avg[9 - Average 9] 2 RD_ONLY

7352 FLOAT Archive_Avg[10 - Average 10] 2 RD_ONLY

7353 FLOAT Archive_Avg[11 - Average 11] 2 RD_ONLY

7354 FLOAT Archive_Avg[12 - Average 12] 2 RD_ONLY

7355 FLOAT Archive_Avg[13 - Average 13] 2 RD_ONLY

7356 FLOAT Archive_Avg[14 - Average 14] 2 RD_ONLY

7357 FLOAT Archive_Avg[15 - Average 15] 2 RD_ONLY

7358 FLOAT Archive_Avg[16 - Average 16] 2 RD_ONLY

7359 FLOAT Archive_Avg[17 - Average 17] 2 RD_ONLY

7360 FLOAT Archive_Avg[18 - Average 18] 2 RD_ONLY

7361 FLOAT Archive_Avg[19 - Average 19] 2 RD_ONLY

7362 FLOAT Archive_Avg[20 - Average 20] 2 RD_ONLY
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7363 FLOAT Archive_Avg[21 - Average 21] 2 RD_ONLY

7364 FLOAT Archive_Avg[22 - Average 22] 2 RD_ONLY

7365 FLOAT Archive_Avg[23 - Average 23] 2 RD_ONLY

7366 FLOAT Archive_Avg[24 - Average 24] 2 RD_ONLY

7367 FLOAT Archive_Avg[25 - Average 25] 2 RD_ONLY

7368 FLOAT Archive_Avg[26 - Average 26] 2 RD_ONLY

7369 FLOAT Archive_Avg[27 - Average 27] 2 RD_ONLY

7370 FLOAT Archive_Avg[28 - Average 28] 2 RD_ONLY

7371 FLOAT Archive_Avg[29 - Average 29] 2 RD_ONLY

7372 FLOAT Archive_Avg[30 - Average 30] 2 RD_ONLY

7373 FLOAT Archive_Avg[31 - Average 31] 2 RD_ONLY

7374 FLOAT Archive_Avg[32 - Average 32] 2 RD_ONLY

7375 FLOAT Archive_Avg[33 - Average 33] 2 RD_ONLY

7376 FLOAT Archive_Avg[34 - Average 34] 2 RD_ONLY

7377 FLOAT Archive_Avg[35 - Average 35] 2 RD_ONLY

7378 FLOAT Archive_Avg[36 - Average 36] 2 RD_ONLY

7379 FLOAT Archive_Max[1 - Average 1] 2 RD_ONLY

7380 FLOAT Archive_Max[2 - Average 2] 2 RD_ONLY

7381 FLOAT Archive_Max[3 - Average 3] 2 RD_ONLY

7382 FLOAT Archive_Max[4 - Average 4] 2 RD_ONLY

7383 FLOAT Archive_Max[5 - Average 5] 2 RD_ONLY

7384 FLOAT Archive_Max[6 - Average 6] 2 RD_ONLY

7385 FLOAT Archive_Max[7 - Average 7] 2 RD_ONLY

7386 FLOAT Archive_Max[8 - Average 8] 2 RD_ONLY

7387 FLOAT Archive_Max[9 - Average 9] 2 RD_ONLY

7388 FLOAT Archive_Max[10 - Average 10] 2 RD_ONLY

7389 FLOAT Archive_Max[11 - Average 11] 2 RD_ONLY

7390 FLOAT Archive_Max[12 - Average 12] 2 RD_ONLY

7391 FLOAT Archive_Max[13 - Average 13] 2 RD_ONLY

7392 FLOAT Archive_Max[14 - Average 14] 2 RD_ONLY

7393 FLOAT Archive_Max[15 - Average 15] 2 RD_ONLY

7394 FLOAT Archive_Max[16 - Average 16] 2 RD_ONLY

7395 FLOAT Archive_Max[17 - Average 17] 2 RD_ONLY

7396 FLOAT Archive_Max[18 - Average 18] 2 RD_ONLY
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7397 FLOAT Archive_Max[19 - Average 19] 2 RD_ONLY

7398 FLOAT Archive_Max[20 - Average 20] 2 RD_ONLY

7399 FLOAT Archive_Max[21 - Average 21] 2 RD_ONLY

7400 FLOAT Archive_Max[22 - Average 22] 2 RD_ONLY

7401 FLOAT Archive_Max[23 - Average 23] 2 RD_ONLY

7402 FLOAT Archive_Max[24 - Average 24] 2 RD_ONLY

7403 FLOAT Archive_Max[25 - Average 25] 2 RD_ONLY

7404 FLOAT Archive_Max[26 - Average 26] 2 RD_ONLY

7405 FLOAT Archive_Max[27 - Average 27] 2 RD_ONLY

7406 FLOAT Archive_Max[28 - Average 28] 2 RD_ONLY

7407 FLOAT Archive_Max[29 - Average 29] 2 RD_ONLY

7408 FLOAT Archive_Max[30 - Average 30] 2 RD_ONLY

7409 FLOAT Archive_Max[31 - Average 31] 2 RD_ONLY

7410 FLOAT Archive_Max[32 - Average 32] 2 RD_ONLY

7411 FLOAT Archive_Max[33 - Average 33] 2 RD_ONLY

7412 FLOAT Archive_Max[34 - Average 34] 2 RD_ONLY

7413 FLOAT Archive_Max[35 - Average 35] 2 RD_ONLY

7414 FLOAT Archive_Max[36 - Average 36] 2 RD_ONLY

7415 FLOAT Archive_Min[1 - Average 1] 2 RD_ONLY

7416 FLOAT Archive_Min[2 - Average 2] 2 RD_ONLY

7417 FLOAT Archive_Min[3 - Average 3] 2 RD_ONLY

7418 FLOAT Archive_Min[4 - Average 4] 2 RD_ONLY

7419 FLOAT Archive_Min[5 - Average 5] 2 RD_ONLY

7420 FLOAT Archive_Min[6 - Average 6] 2 RD_ONLY

7421 FLOAT Archive_Min[7 - Average 7] 2 RD_ONLY

7422 FLOAT Archive_Min[8 - Average 8] 2 RD_ONLY

7423 FLOAT Archive_Min[9 - Average 9] 2 RD_ONLY

7424 FLOAT Archive_Min[10 - Average 10] 2 RD_ONLY

7425 FLOAT Archive_Min[11 - Average 11] 2 RD_ONLY

7426 FLOAT Archive_Min[12 - Average 12] 2 RD_ONLY

7427 FLOAT Archive_Min[13 - Average 13] 2 RD_ONLY

7428 FLOAT Archive_Min[14 - Average 14] 2 RD_ONLY

7429 FLOAT Archive_Min[15 - Average 15] 2 RD_ONLY

7430 FLOAT Archive_Min[16 - Average 16] 2 RD_ONLY
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7431 FLOAT Archive_Min[17 - Average 17] 2 RD_ONLY

7432 FLOAT Archive_Min[18 - Average 18] 2 RD_ONLY

7433 FLOAT Archive_Min[19 - Average 19] 2 RD_ONLY

7434 FLOAT Archive_Min[20 - Average 20] 2 RD_ONLY

7435 FLOAT Archive_Min[21 - Average 21] 2 RD_ONLY

7436 FLOAT Archive_Min[22 - Average 22] 2 RD_ONLY

7437 FLOAT Archive_Min[23 - Average 23] 2 RD_ONLY

7438 FLOAT Archive_Min[24 - Average 24] 2 RD_ONLY

7439 FLOAT Archive_Min[25 - Average 25] 2 RD_ONLY

7440 FLOAT Archive_Min[26 - Average 26] 2 RD_ONLY

7441 FLOAT Archive_Min[27 - Average 27] 2 RD_ONLY

7442 FLOAT Archive_Min[28 - Average 28] 2 RD_ONLY

7443 FLOAT Archive_Min[29 - Average 29] 2 RD_ONLY

7444 FLOAT Archive_Min[30 - Average 30] 2 RD_ONLY

7445 FLOAT Archive_Min[31 - Average 31] 2 RD_ONLY

7446 FLOAT Archive_Min[32 - Average 32] 2 RD_ONLY

7447 FLOAT Archive_Min[33 - Average 33] 2 RD_ONLY

7448 FLOAT Archive_Min[34 - Average 34] 2 RD_ONLY

7449 FLOAT Archive_Min[35 - Average 35] 2 RD_ONLY

7450 FLOAT Archive_Min[36 - Average 36] 2 RD_ONLY

7451 FLOAT Archive_Avg[1 - Average 1] 3 RD_ONLY

7452 FLOAT Archive_Avg[2 - Average 2] 3 RD_ONLY

7453 FLOAT Archive_Avg[3 - Average 3] 3 RD_ONLY

7454 FLOAT Archive_Avg[4 - Average 4] 3 RD_ONLY

7455 FLOAT Archive_Avg[5 - Average 5] 3 RD_ONLY

7456 FLOAT Archive_Avg[6 - Average 6] 3 RD_ONLY

7457 FLOAT Archive_Avg[7 - Average 7] 3 RD_ONLY

7458 FLOAT Archive_Avg[8 - Average 8] 3 RD_ONLY

7459 FLOAT Archive_Avg[9 - Average 9] 3 RD_ONLY

7460 FLOAT Archive_Avg[10 - Average 10] 3 RD_ONLY

7461 FLOAT Archive_Avg[11 - Average 11] 3 RD_ONLY

7462 FLOAT Archive_Avg[12 - Average 12] 3 RD_ONLY

7463 FLOAT Archive_Avg[13 - Average 13] 3 RD_ONLY

7464 FLOAT Archive_Avg[14 - Average 14] 3 RD_ONLY
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7465 FLOAT Archive_Avg[15 - Average 15] 3 RD_ONLY

7466 FLOAT Archive_Avg[16 - Average 16] 3 RD_ONLY

7467 FLOAT Archive_Avg[17 - Average 17] 3 RD_ONLY

7468 FLOAT Archive_Avg[18 - Average 18] 3 RD_ONLY

7469 FLOAT Archive_Avg[19 - Average 19] 3 RD_ONLY

7470 FLOAT Archive_Avg[20 - Average 20] 3 RD_ONLY

7471 FLOAT Archive_Avg[21 - Average 21] 3 RD_ONLY

7472 FLOAT Archive_Avg[22 - Average 22] 3 RD_ONLY

7473 FLOAT Archive_Avg[23 - Average 23] 3 RD_ONLY

7474 FLOAT Archive_Avg[24 - Average 24] 3 RD_ONLY

7475 FLOAT Archive_Avg[25 - Average 25] 3 RD_ONLY

7476 FLOAT Archive_Avg[26 - Average 26] 3 RD_ONLY

7477 FLOAT Archive_Avg[27 - Average 27] 3 RD_ONLY

7478 FLOAT Archive_Avg[28 - Average 28] 3 RD_ONLY

7479 FLOAT Archive_Avg[29 - Average 29] 3 RD_ONLY

7480 FLOAT Archive_Avg[30 - Average 30] 3 RD_ONLY

7481 FLOAT Archive_Avg[31 - Average 31] 3 RD_ONLY

7482 FLOAT Archive_Avg[32 - Average 32] 3 RD_ONLY

7483 FLOAT Archive_Avg[33 - Average 33] 3 RD_ONLY

7484 FLOAT Archive_Avg[34 - Average 34] 3 RD_ONLY

7485 FLOAT Archive_Avg[35 - Average 35] 3 RD_ONLY

7486 FLOAT Archive_Avg[36 - Average 36] 3 RD_ONLY

7487 FLOAT Archive_Max[1 - Average 1] 3 RD_ONLY

7488 FLOAT Archive_Max[2 - Average 2] 3 RD_ONLY

7489 FLOAT Archive_Max[3 - Average 3] 3 RD_ONLY

7490 FLOAT Archive_Max[4 - Average 4] 3 RD_ONLY

7491 FLOAT Archive_Max[5 - Average 5] 3 RD_ONLY

7492 FLOAT Archive_Max[6 - Average 6] 3 RD_ONLY

7493 FLOAT Archive_Max[7 - Average 7] 3 RD_ONLY

7494 FLOAT Archive_Max[8 - Average 8] 3 RD_ONLY

7495 FLOAT Archive_Max[9 - Average 9] 3 RD_ONLY

7496 FLOAT Archive_Max[10 - Average 10] 3 RD_ONLY

7497 FLOAT Archive_Max[11 - Average 11] 3 RD_ONLY

7498 FLOAT Archive_Max[12 - Average 12] 3 RD_ONLY
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7499 FLOAT Archive_Max[13 - Average 13] 3 RD_ONLY

7500 FLOAT Archive_Max[14 - Average 14] 3 RD_ONLY

7501 FLOAT Archive_Max[15 - Average 15] 3 RD_ONLY

7502 FLOAT Archive_Max[16 - Average 16] 3 RD_ONLY

7503 FLOAT Archive_Max[17 - Average 17] 3 RD_ONLY

7504 FLOAT Archive_Max[18 - Average 18] 3 RD_ONLY

7505 FLOAT Archive_Max[19 - Average 19] 3 RD_ONLY

7506 FLOAT Archive_Max[20 - Average 20] 3 RD_ONLY

7507 FLOAT Archive_Max[21 - Average 21] 3 RD_ONLY

7508 FLOAT Archive_Max[22 - Average 22] 3 RD_ONLY

7509 FLOAT Archive_Max[23 - Average 23] 3 RD_ONLY

7510 FLOAT Archive_Max[24 - Average 24] 3 RD_ONLY

7511 FLOAT Archive_Max[25 - Average 25] 3 RD_ONLY

7512 FLOAT Archive_Max[26 - Average 26] 3 RD_ONLY

7513 FLOAT Archive_Max[27 - Average 27] 3 RD_ONLY

7514 FLOAT Archive_Max[28 - Average 28] 3 RD_ONLY

7515 FLOAT Archive_Max[29 - Average 29] 3 RD_ONLY

7516 FLOAT Archive_Max[30 - Average 30] 3 RD_ONLY

7517 FLOAT Archive_Max[31 - Average 31] 3 RD_ONLY

7518 FLOAT Archive_Max[32 - Average 32] 3 RD_ONLY

7519 FLOAT Archive_Max[33 - Average 33] 3 RD_ONLY

7520 FLOAT Archive_Max[34 - Average 34] 3 RD_ONLY

7521 FLOAT Archive_Max[35 - Average 35] 3 RD_ONLY

7522 FLOAT Archive_Max[36 - Average 36] 3 RD_ONLY

7523 FLOAT Archive_Min[1 - Average 1] 3 RD_ONLY

7524 FLOAT Archive_Min[2 - Average 2] 3 RD_ONLY

7525 FLOAT Archive_Min[3 - Average 3] 3 RD_ONLY

7526 FLOAT Archive_Min[4 - Average 4] 3 RD_ONLY

7527 FLOAT Archive_Min[5 - Average 5] 3 RD_ONLY

7528 FLOAT Archive_Min[6 - Average 6] 3 RD_ONLY

7529 FLOAT Archive_Min[7 - Average 7] 3 RD_ONLY

7530 FLOAT Archive_Min[8 - Average 8] 3 RD_ONLY

7531 FLOAT Archive_Min[9 - Average 9] 3 RD_ONLY

7532 FLOAT Archive_Min[10 - Average 10] 3 RD_ONLY

Pre-defined Modbus® Map Files Reference Manual
December 2019 2-3-9000-745

260 Rosemount Gas Chromatographs



Register # Data Type Variable Record # Access Format

7533 FLOAT Archive_Min[11 - Average 11] 3 RD_ONLY

7534 FLOAT Archive_Min[12 - Average 12] 3 RD_ONLY

7535 FLOAT Archive_Min[13 - Average 13] 3 RD_ONLY

7536 FLOAT Archive_Min[14 - Average 14] 3 RD_ONLY

7537 FLOAT Archive_Min[15 - Average 15] 3 RD_ONLY

7538 FLOAT Archive_Min[16 - Average 16] 3 RD_ONLY

7539 FLOAT Archive_Min[17 - Average 17] 3 RD_ONLY

7540 FLOAT Archive_Min[18 - Average 18] 3 RD_ONLY

7541 FLOAT Archive_Min[19 - Average 19] 3 RD_ONLY

7542 FLOAT Archive_Min[20 - Average 20] 3 RD_ONLY

7543 FLOAT Archive_Min[21 - Average 21] 3 RD_ONLY

7544 FLOAT Archive_Min[22 - Average 22] 3 RD_ONLY

7545 FLOAT Archive_Min[23 - Average 23] 3 RD_ONLY

7546 FLOAT Archive_Min[24 - Average 24] 3 RD_ONLY

7547 FLOAT Archive_Min[25 - Average 25] 3 RD_ONLY

7548 FLOAT Archive_Min[26 - Average 26] 3 RD_ONLY

7549 FLOAT Archive_Min[27 - Average 27] 3 RD_ONLY

7550 FLOAT Archive_Min[28 - Average 28] 3 RD_ONLY

7551 FLOAT Archive_Min[29 - Average 29] 3 RD_ONLY

7552 FLOAT Archive_Min[30 - Average 30] 3 RD_ONLY

7553 FLOAT Archive_Min[31 - Average 31] 3 RD_ONLY

7554 FLOAT Archive_Min[32 - Average 32] 3 RD_ONLY

7555 FLOAT Archive_Min[33 - Average 33] 3 RD_ONLY

7556 FLOAT Archive_Min[34 - Average 34] 3 RD_ONLY

7557 FLOAT Archive_Min[35 - Average 35] 3 RD_ONLY

7558 FLOAT Archive_Min[36 - Average 36] 3 RD_ONLY

7560 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7561 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7562 FLOAT Current Value[3] RD_ONLY

7563 FLOAT Current Value[4] RD_ONLY

7564 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7565 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7566 FLOAT Current Value[3] RD_ONLY

7567 FLOAT Current Value[4] RD_ONLY
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7621 FLOAT 1 - Stream 1_Start Time RD_ONLY YYMMDD

7622 FLOAT 1 - Stream 1_Start Time RD_ONLY hhmmss

7623 FLOAT 1 - Stream 1_Mole %[1 - Component 1] RD_ONLY

7624 FLOAT 1 - Stream 1_Mole %[2 - Component 2] RD_ONLY

7625 FLOAT 1 - Stream 1_Mole %[3 - Component 3] RD_ONLY

7626 FLOAT 1 - Stream 1_Mole %[4 - Component 4] RD_ONLY

7627 FLOAT 1 - Stream 1_Mole %[5 - Component 5] RD_ONLY

7628 FLOAT 1 - Stream 1_Mole %[6 - Component 6] RD_ONLY

7629 FLOAT 1 - Stream 1_Mole %[7 - Component 7] RD_ONLY

7630 FLOAT 1 - Stream 1_Mole %[8 - Component 8] RD_ONLY

7631 FLOAT 1 - Stream 1_Mole %[9 - Component 9] RD_ONLY

7632 FLOAT 1 - Stream 1_Mole %[10 - Component 10] RD_ONLY

7633 FLOAT 1 - Stream 1_Mole %[11 - Component 11] RD_ONLY

7634 FLOAT 1 - Stream 1_Mole %[12 - Component 12] RD_ONLY

7635 FLOAT 1 - Stream 1_Mole %[13 - Component 13] RD_ONLY

7636 FLOAT 1 - Stream 1_Mole %[14 - Component 14] RD_ONLY

7637 FLOAT 1 - Stream 1_Mole %[15 - Component 15] RD_ONLY

7638 FLOAT 1 - Stream 1_Mole %[16 - Component 16] RD_ONLY

7639 FLOAT 1 - Stream 1_Mole %[17 - Component 17] RD_ONLY

7640 FLOAT 1 - Stream 1_Mole %[18 - Component 18] RD_ONLY

7641 FLOAT 1 - Stream 1_Mole %[19 - Component 19] RD_ONLY

7642 FLOAT 1 - Stream 1_Mole %[20 - Component 20] RD_ONLY

7643 FLOAT 1 - Stream 1_HV Gross BTU Dry RD_ONLY

7644 FLOAT 1 - Stream 1_GPA Real Rel Den Gas RD_ONLY

7645 FLOAT 1 - Stream 1_GPA Z Factor RD_ONLY

7646 FLOAT 1 - Stream 1_Total Unnormalized Conc RD_ONLY

7647 FLOAT Unused RD_ONLY

7648 FLOAT Unused RD_ONLY

7649 FLOAT Unused RD_ONLY

7650 FLOAT Unused RD_ONLY

7651 FLOAT 2 - Stream 2_Start Time RD_ONLY YYMMDD

7652 FLOAT 2 - Stream 2_Start Time RD_ONLY hhmmss

7653 FLOAT 2 - Stream 2_Mole %[1 - Component 1] RD_ONLY

7654 FLOAT 2 - Stream 2_Mole %[2 - Component 2] RD_ONLY
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7655 FLOAT 2 - Stream 2_Mole %[3 - Component 3] RD_ONLY

7656 FLOAT 2 - Stream 2_Mole %[4 - Component 4] RD_ONLY

7657 FLOAT 2 - Stream 2_Mole %[5 - Component 5] RD_ONLY

7658 FLOAT 2 - Stream 2_Mole %[6 - Component 6] RD_ONLY

7659 FLOAT 2 - Stream 2_Mole %[7 - Component 7] RD_ONLY

7660 FLOAT 2 - Stream 2_Mole %[8 - Component 8] RD_ONLY

7661 FLOAT 2 - Stream 2_Mole %[9 - Component 9] RD_ONLY

7662 FLOAT 2 - Stream 2_Mole %[10 - Component 10] RD_ONLY

7663 FLOAT 2 - Stream 2_Mole %[11 - Component 11] RD_ONLY

7664 FLOAT 2 - Stream 2_Mole %[12 - Component 12] RD_ONLY

7665 FLOAT 2 - Stream 2_Mole %[13 - Component 13] RD_ONLY

7666 FLOAT 2 - Stream 2_Mole %[14 - Component 14] RD_ONLY

7667 FLOAT 2 - Stream 2_Mole %[15 - Component 15] RD_ONLY

7668 FLOAT 2 - Stream 2_Mole %[16 - Component 16] RD_ONLY

7669 FLOAT 2 - Stream 2_Mole %[17 - Component 17] RD_ONLY

7670 FLOAT 2 - Stream 2_Mole %[18 - Component 18] RD_ONLY

7671 FLOAT 2 - Stream 2_Mole %[19 - Component 19] RD_ONLY

7672 FLOAT 2 - Stream 2_Mole %[20 - Component 20] RD_ONLY

7673 FLOAT 2 - Stream 2_HV Gross BTU Dry RD_ONLY

7674 FLOAT 2 - Stream 2_GPA Real Rel Den Gas RD_ONLY

7675 FLOAT 2 - Stream 2_GPA Z Factor RD_ONLY

7676 FLOAT 2 - Stream 2_Total Unnormalized Conc RD_ONLY

7677 FLOAT Unused RD_ONLY

7678 FLOAT Unused RD_ONLY

7679 FLOAT Unused RD_ONLY

7680 FLOAT Unused RD_ONLY

7681 FLOAT 3 - Stream 3_Start Time RD_ONLY YYMMDD

7682 FLOAT 3 - Stream 3_Start Time RD_ONLY hhmmss

7683 FLOAT 3 - Stream 3_Mole %[1 - Component 1] RD_ONLY

7684 FLOAT 3 - Stream 3_Mole %[2 - Component 2] RD_ONLY

7685 FLOAT 3 - Stream 3_Mole %[3 - Component 3] RD_ONLY

7686 FLOAT 3 - Stream 3_Mole %[4 - Component 4] RD_ONLY

7687 FLOAT 3 - Stream 3_Mole %[5 - Component 5] RD_ONLY

7688 FLOAT 3 - Stream 3_Mole %[6 - Component 6] RD_ONLY
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7689 FLOAT 3 - Stream 3_Mole %[7 - Component 7] RD_ONLY

7690 FLOAT 3 - Stream 3_Mole %[8 - Component 8] RD_ONLY

7691 FLOAT 3 - Stream 3_Mole %[9 - Component 9] RD_ONLY

7692 FLOAT 3 - Stream 3_Mole %[10 - Component 10] RD_ONLY

7693 FLOAT 3 - Stream 3_Mole %[11 - Component 11] RD_ONLY

7694 FLOAT 3 - Stream 3_Mole %[12 - Component 12] RD_ONLY

7695 FLOAT 3 - Stream 3_Mole %[13 - Component 13] RD_ONLY

7696 FLOAT 3 - Stream 3_Mole %[14 - Component 14] RD_ONLY

7697 FLOAT 3 - Stream 3_Mole %[15 - Component 15] RD_ONLY

7698 FLOAT 3 - Stream 3_Mole %[16 - Component 16] RD_ONLY

7699 FLOAT 3 - Stream 3_Mole %[17 - Component 17] RD_ONLY

7700 FLOAT 3 - Stream 3_Mole %[18 - Component 18] RD_ONLY

7701 FLOAT 3 - Stream 3_Mole %[19 - Component 19] RD_ONLY

7702 FLOAT 3 - Stream 3_Mole %[20 - Component 20] RD_ONLY

7703 FLOAT 3 - Stream 3_HV Gross BTU Dry RD_ONLY

7704 FLOAT 3 - Stream 3_GPA Real Rel Den Gas RD_ONLY

7705 FLOAT 3 - Stream 3_GPA Z Factor RD_ONLY

7706 FLOAT 3 - Stream 3_Total Unnormalized Conc RD_ONLY

7707 FLOAT Unused RD_ONLY

7708 FLOAT Unused RD_ONLY

7709 FLOAT Unused RD_ONLY

7710 FLOAT Unused RD_ONLY

7711 FLOAT 4 - Stream 4_Start Time RD_ONLY YYMMDD

7712 FLOAT 4 - Stream 4_Start Time RD_ONLY hhmmss

7713 FLOAT 4 - Stream 4_Mole %[1 - Component 1] RD_ONLY

7714 FLOAT 4 - Stream 4_Mole %[2 - Component 2] RD_ONLY

7715 FLOAT 4 - Stream 4_Mole %[3 - Component 3] RD_ONLY

7716 FLOAT 4 - Stream 4_Mole %[4 - Component 4] RD_ONLY

7717 FLOAT 4 - Stream 4_Mole %[5 - Component 5] RD_ONLY

7718 FLOAT 4 - Stream 4_Mole %[6 - Component 6] RD_ONLY

7719 FLOAT 4 - Stream 4_Mole %[7 - Component 7] RD_ONLY

7720 FLOAT 4 - Stream 4_Mole %[8 - Component 8] RD_ONLY

7721 FLOAT 4 - Stream 4_Mole %[9 - Component 9] RD_ONLY

7722 FLOAT 4 - Stream 4_Mole %[10 - Component 10] RD_ONLY
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7723 FLOAT 4 - Stream 4_Mole %[11 - Component 11] RD_ONLY

7724 FLOAT 4 - Stream 4_Mole %[12 - Component 12] RD_ONLY

7725 FLOAT 4 - Stream 4_Mole %[13 - Component 13] RD_ONLY

7726 FLOAT 4 - Stream 4_Mole %[14 - Component 14] RD_ONLY

7727 FLOAT 4 - Stream 4_Mole %[15 - Component 15] RD_ONLY

7728 FLOAT 4 - Stream 4_Mole %[16 - Component 16] RD_ONLY

7729 FLOAT 4 - Stream 4_Mole %[17 - Component 17] RD_ONLY

7730 FLOAT 4 - Stream 4_Mole %[18 - Component 18] RD_ONLY

7731 FLOAT 4 - Stream 4_Mole %[19 - Component 19] RD_ONLY

7732 FLOAT 4 - Stream 4_Mole %[20 - Component 20] RD_ONLY

7733 FLOAT 4 - Stream 4_HV Gross BTU Dry RD_ONLY

7734 FLOAT 4 - Stream 4_GPA Real Rel Den Gas RD_ONLY

7735 FLOAT 4 - Stream 4_GPA Z Factor RD_ONLY

7736 FLOAT 4 - Stream 4_Total Unnormalized Conc RD_ONLY

7737 FLOAT Unused RD_ONLY

7738 FLOAT Unused RD_ONLY

7739 FLOAT Unused RD_ONLY

7740 FLOAT Unused RD_ONLY

7741 FLOAT 5 - Stream 5_Start Time RD_ONLY YYMMDD

7742 FLOAT 5 - Stream 5_Start Time RD_ONLY hhmmss

7743 FLOAT 5 - Stream 5_Mole %[1 - Component 1] RD_ONLY

7744 FLOAT 5 - Stream 5_Mole %[2 - Component 2] RD_ONLY

7745 FLOAT 5 - Stream 5_Mole %[3 - Component 3] RD_ONLY

7746 FLOAT 5 - Stream 5_Mole %[4 - Component 4] RD_ONLY

7747 FLOAT 5 - Stream 5_Mole %[5 - Component 5] RD_ONLY

7748 FLOAT 5 - Stream 5_Mole %[6 - Component 6] RD_ONLY

7749 FLOAT 5 - Stream 5_Mole %[7 - Component 7] RD_ONLY

7750 FLOAT 5 - Stream 5_Mole %[8 - Component 8] RD_ONLY

7751 FLOAT 5 - Stream 5_Mole %[9 - Component 9] RD_ONLY

7752 FLOAT 5 - Stream 5_Mole %[10 - Component 10] RD_ONLY

7753 FLOAT 5 - Stream 5_Mole %[11 - Component 11] RD_ONLY

7754 FLOAT 5 - Stream 5_Mole %[12 - Component 12] RD_ONLY

7755 FLOAT 5 - Stream 5_Mole %[13 - Component 13] RD_ONLY

7756 FLOAT 5 - Stream 5_Mole %[14 - Component 14] RD_ONLY
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7757 FLOAT 5 - Stream 5_Mole %[15 - Component 15] RD_ONLY

7758 FLOAT 5 - Stream 5_Mole %[16 - Component 16] RD_ONLY

7759 FLOAT 5 - Stream 5_Mole %[17 - Component 17] RD_ONLY

7760 FLOAT 5 - Stream 5_Mole %[18 - Component 18] RD_ONLY

7761 FLOAT 5 - Stream 5_Mole %[19 - Component 19] RD_ONLY

7762 FLOAT 5 - Stream 5_Mole %[20 - Component 20] RD_ONLY

7763 FLOAT 5 - Stream 5_HV Gross BTU Dry RD_ONLY

7764 FLOAT 5 - Stream 5_GPA Real Rel Den Gas RD_ONLY

7765 FLOAT 5 - Stream 5_GPA Z Factor RD_ONLY

7766 FLOAT 5 - Stream 5_Total Unnormalized Conc RD_ONLY

7767 FLOAT Unused RD_ONLY

7768 FLOAT Unused RD_ONLY

7769 FLOAT Unused RD_ONLY

7770 FLOAT Unused RD_ONLY

7771 FLOAT 6 - Stream 6_Start Time RD_ONLY YYMMDD

7772 FLOAT 6 - Stream 6_Start Time RD_ONLY hhmmss

7773 FLOAT 6 - Stream 6_Mole %[1 - Component 1] RD_ONLY

7774 FLOAT 6 - Stream 6_Mole %[2 - Component 2] RD_ONLY

7775 FLOAT 6 - Stream 6_Mole %[3 - Component 3] RD_ONLY

7776 FLOAT 6 - Stream 6_Mole %[4 - Component 4] RD_ONLY

7777 FLOAT 6 - Stream 6_Mole %[5 - Component 5] RD_ONLY

7778 FLOAT 6 - Stream 6_Mole %[6 - Component 6] RD_ONLY

7779 FLOAT 6 - Stream 6_Mole %[7 - Component 7] RD_ONLY

7780 FLOAT 6 - Stream 6_Mole %[8 - Component 8] RD_ONLY

7781 FLOAT 6 - Stream 6_Mole %[9 - Component 9] RD_ONLY

7782 FLOAT 6 - Stream 6_Mole %[10 - Component 10] RD_ONLY

7783 FLOAT 6 - Stream 6_Mole %[11 - Component 11] RD_ONLY

7784 FLOAT 6 - Stream 6_Mole %[12 - Component 12] RD_ONLY

7785 FLOAT 6 - Stream 6_Mole %[13 - Component 13] RD_ONLY

7786 FLOAT 6 - Stream 6_Mole %[14 - Component 14] RD_ONLY

7787 FLOAT 6 - Stream 6_Mole %[15 - Component 15] RD_ONLY

7788 FLOAT 6 - Stream 6_Mole %[16 - Component 16] RD_ONLY

7789 FLOAT 6 - Stream 6_Mole %[17 - Component 17] RD_ONLY

7790 FLOAT 6 - Stream 6_Mole %[18 - Component 18] RD_ONLY
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7791 FLOAT 6 - Stream 6_Mole %[19 - Component 19] RD_ONLY

7792 FLOAT 6 - Stream 6_Mole %[20 - Component 20] RD_ONLY

7793 FLOAT 6 - Stream 6_HV Gross BTU Dry RD_ONLY

7794 FLOAT 6 - Stream 6_GPA Real Rel Den Gas RD_ONLY

7795 FLOAT 6 - Stream 6_GPA Z Factor RD_ONLY

7796 FLOAT 6 - Stream 6_Total Unnormalized Conc RD_ONLY

7797 FLOAT Unused RD_ONLY

7798 FLOAT Unused RD_ONLY

7799 FLOAT Unused RD_ONLY

7800 FLOAT Unused RD_ONLY

7801 FLOAT 7 - Stream 7_Start Time RD_ONLY YYMMDD

7802 FLOAT 7 - Stream 7_Start Time RD_ONLY hhmmss

7803 FLOAT 7 - Stream 7_Mole %[1 - Component 1] RD_ONLY

7804 FLOAT 7 - Stream 7_Mole %[2 - Component 2] RD_ONLY

7805 FLOAT 7 - Stream 7_Mole %[3 - Component 3] RD_ONLY

7806 FLOAT 7 - Stream 7_Mole %[4 - Component 4] RD_ONLY

7807 FLOAT 7 - Stream 7_Mole %[5 - Component 5] RD_ONLY

7808 FLOAT 7 - Stream 7_Mole %[6 - Component 6] RD_ONLY

7809 FLOAT 7 - Stream 7_Mole %[7 - Component 7] RD_ONLY

7810 FLOAT 7 - Stream 7_Mole %[8 - Component 8] RD_ONLY

7811 FLOAT 7 - Stream 7_Mole %[9 - Component 9] RD_ONLY

7812 FLOAT 7 - Stream 7_Mole %[10 - Component 10] RD_ONLY

7813 FLOAT 7 - Stream 7_Mole %[11 - Component 11] RD_ONLY

7814 FLOAT 7 - Stream 7_Mole %[12 - Component 12] RD_ONLY

7815 FLOAT 7 - Stream 7_Mole %[13 - Component 13] RD_ONLY

7816 FLOAT 7 - Stream 7_Mole %[14 - Component 14] RD_ONLY

7817 FLOAT 7 - Stream 7_Mole %[15 - Component 15] RD_ONLY

7818 FLOAT 7 - Stream 7_Mole %[16 - Component 16] RD_ONLY

7819 FLOAT 7 - Stream 7_Mole %[17 - Component 17] RD_ONLY

7820 FLOAT 7 - Stream 7_Mole %[18 - Component 18] RD_ONLY

7821 FLOAT 7 - Stream 7_Mole %[19 - Component 19] RD_ONLY

7822 FLOAT 7 - Stream 7_Mole %[20 - Component 20] RD_ONLY

7823 FLOAT 7 - Stream 7_HV Gross BTU Dry RD_ONLY

7824 FLOAT 7 - Stream 7_GPA Real Rel Den Gas RD_ONLY
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7825 FLOAT 7 - Stream 7_GPA Z Factor RD_ONLY

7826 FLOAT 7 - Stream 7_Total Unnormalized Conc RD_ONLY

7827 FLOAT Unused RD_ONLY

7828 FLOAT Unused RD_ONLY

7829 FLOAT Unused RD_ONLY

7830 FLOAT Unused RD_ONLY

7831 FLOAT 8 - Stream 8_Start Time RD_ONLY YYMMDD

7832 FLOAT 8 - Stream 8_Start Time RD_ONLY hhmmss

7833 FLOAT 8 - Stream 8_Mole %[1 - Component 1] RD_ONLY

7834 FLOAT 8 - Stream 8_Mole %[2 - Component 2] RD_ONLY

7835 FLOAT 8 - Stream 8_Mole %[3 - Component 3] RD_ONLY

7836 FLOAT 8 - Stream 8_Mole %[4 - Component 4] RD_ONLY

7837 FLOAT 8 - Stream 8_Mole %[5 - Component 5] RD_ONLY

7838 FLOAT 8 - Stream 8_Mole %[6 - Component 6] RD_ONLY

7839 FLOAT 8 - Stream 8_Mole %[7 - Component 7] RD_ONLY

7840 FLOAT 8 - Stream 8_Mole %[8 - Component 8] RD_ONLY

7841 FLOAT 8 - Stream 8_Mole %[9 - Component 9] RD_ONLY

7842 FLOAT 8 - Stream 8_Mole %[10 - Component 10] RD_ONLY

7843 FLOAT 8 - Stream 8_Mole %[11 - Component 11] RD_ONLY

7844 FLOAT 8 - Stream 8_Mole %[12 - Component 12] RD_ONLY

7845 FLOAT 8 - Stream 8_Mole %[13 - Component 13] RD_ONLY

7846 FLOAT 8 - Stream 8_Mole %[14 - Component 14] RD_ONLY

7847 FLOAT 8 - Stream 8_Mole %[15 - Component 15] RD_ONLY

7848 FLOAT 8 - Stream 8_Mole %[16 - Component 16] RD_ONLY

7849 FLOAT 8 - Stream 8_Mole %[17 - Component 17] RD_ONLY

7850 FLOAT 8 - Stream 8_Mole %[18 - Component 18] RD_ONLY

7851 FLOAT 8 - Stream 8_Mole %[19 - Component 19] RD_ONLY

7852 FLOAT 8 - Stream 8_Mole %[20 - Component 20] RD_ONLY

7853 FLOAT 8 - Stream 8_HV Gross BTU Dry RD_ONLY

7854 FLOAT 8 - Stream 8_GPA Real Rel Den Gas RD_ONLY

7855 FLOAT 8 - Stream 8_GPA Z Factor RD_ONLY

7856 FLOAT 8 - Stream 8_Total Unnormalized Conc RD_ONLY

7857 FLOAT Unused RD_ONLY

7858 FLOAT Unused RD_ONLY
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7859 FLOAT Unused RD_ONLY

7860 FLOAT Unused RD_ONLY

7861 FLOAT 9 - Stream 9_Start Time RD_ONLY YYMMDD

7862 FLOAT 9 - Stream 9_Start Time RD_ONLY hhmmss

7863 FLOAT 9 - Stream 9_Mole %[1 - Component 1] RD_ONLY

7864 FLOAT 9 - Stream 9_Mole %[2 - Component 2] RD_ONLY

7865 FLOAT 9 - Stream 9_Mole %[3 - Component 3] RD_ONLY

7866 FLOAT 9 - Stream 9_Mole %[4 - Component 4] RD_ONLY

7867 FLOAT 9 - Stream 9_Mole %[5 - Component 5] RD_ONLY

7868 FLOAT 9 - Stream 9_Mole %[6 - Component 6] RD_ONLY

7869 FLOAT 9 - Stream 9_Mole %[7 - Component 7] RD_ONLY

7870 FLOAT 9 - Stream 9_Mole %[8 - Component 8] RD_ONLY

7871 FLOAT 9 - Stream 9_Mole %[9 - Component 9] RD_ONLY

7872 FLOAT 9 - Stream 9_Mole %[10 - Component 10] RD_ONLY

7873 FLOAT 9 - Stream 9_Mole %[11 - Component 11] RD_ONLY

7874 FLOAT 9 - Stream 9_Mole %[12 - Component 12] RD_ONLY

7875 FLOAT 9 - Stream 9_Mole %[13 - Component 13] RD_ONLY

7876 FLOAT 9 - Stream 9_Mole %[14 - Component 14] RD_ONLY

7877 FLOAT 9 - Stream 9_Mole %[15 - Component 15] RD_ONLY

7878 FLOAT 9 - Stream 9_Mole %[16 - Component 16] RD_ONLY

7879 FLOAT 9 - Stream 9_Mole %[17 - Component 17] RD_ONLY

7880 FLOAT 9 - Stream 9_Mole %[18 - Component 18] RD_ONLY

7881 FLOAT 9 - Stream 9_Mole %[19 - Component 19] RD_ONLY

7882 FLOAT 9 - Stream 9_Mole %[20 - Component 20] RD_ONLY

7883 FLOAT 9 - Stream 9_HV Gross BTU Dry RD_ONLY

7884 FLOAT 9 - Stream 9_GPA Real Rel Den Gas RD_ONLY

7885 FLOAT 9 - Stream 9_GPA Z Factor RD_ONLY

7886 FLOAT 9 - Stream 9_Total Unnormalized Conc RD_ONLY

7887 FLOAT Unused RD_ONLY

7888 FLOAT Unused RD_ONLY

7889 FLOAT Unused RD_ONLY

7890 FLOAT Unused RD_ONLY

7891 FLOAT 10 - Stream 10_Start Time RD_ONLY YYMMDD

7892 FLOAT 10 - Stream 10_Start Time RD_ONLY hhmmss
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7893 FLOAT 10 - Stream 10_Mole %[1 - Component 1] RD_ONLY

7894 FLOAT 10 - Stream 10_Mole %[2 - Component 2] RD_ONLY

7895 FLOAT 10 - Stream 10_Mole %[3 - Component 3] RD_ONLY

7896 FLOAT 10 - Stream 10_Mole %[4 - Component 4] RD_ONLY

7897 FLOAT 10 - Stream 10_Mole %[5 - Component 5] RD_ONLY

7898 FLOAT 10 - Stream 10_Mole %[6 - Component 6] RD_ONLY

7899 FLOAT 10 - Stream 10_Mole %[7 - Component 7] RD_ONLY

7900 FLOAT 10 - Stream 10_Mole %[8 - Component 8] RD_ONLY

7901 FLOAT 10 - Stream 10_Mole %[9 - Component 9] RD_ONLY

7902 FLOAT 10 - Stream 10_Mole %[10 - Component 10] RD_ONLY

7903 FLOAT 10 - Stream 10_Mole %[11 - Component 11] RD_ONLY

7904 FLOAT 10 - Stream 10_Mole %[12 - Component 12] RD_ONLY

7905 FLOAT 10 - Stream 10_Mole %[13 - Component 13] RD_ONLY

7906 FLOAT 10 - Stream 10_Mole %[14 - Component 14] RD_ONLY

7907 FLOAT 10 - Stream 10_Mole %[15 - Component 15] RD_ONLY

7908 FLOAT 10 - Stream 10_Mole %[16 - Component 16] RD_ONLY

7909 FLOAT 10 - Stream 10_Mole %[17 - Component 17] RD_ONLY

7910 FLOAT 10 - Stream 10_Mole %[18 - Component 18] RD_ONLY

7911 FLOAT 10 - Stream 10_Mole %[19 - Component 19] RD_ONLY

7912 FLOAT 10 - Stream 10_Mole %[20 - Component 20] RD_ONLY

7913 FLOAT 10 - Stream 10_HV Gross BTU Dry RD_ONLY

7914 FLOAT 10 - Stream 10_GPA Real Rel Den Gas RD_ONLY

7915 FLOAT 10 - Stream 10_GPA Z Factor RD_ONLY

7916 FLOAT 10 - Stream 10_Total Unnormalized Conc RD_ONLY

7917 FLOAT Unused RD_ONLY

7918 FLOAT Unused RD_ONLY

7919 FLOAT Unused RD_ONLY

7920 FLOAT Unused RD_ONLY

7921 FLOAT 11 - Stream 11_Start Time RD_ONLY YYMMDD

7922 FLOAT 11 - Stream 11_Start Time RD_ONLY hhmmss

7923 FLOAT 11 - Stream 11_Mole %[1 - Component 1] RD_ONLY

7924 FLOAT 11 - Stream 11_Mole %[2 - Component 2] RD_ONLY

7925 FLOAT 11 - Stream 11_Mole %[3 - Component 3] RD_ONLY

7926 FLOAT 11 - Stream 11_Mole %[4 - Component 4] RD_ONLY
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7927 FLOAT 11 - Stream 11_Mole %[5 - Component 5] RD_ONLY

7928 FLOAT 11 - Stream 11_Mole %[6 - Component 6] RD_ONLY

7929 FLOAT 11 - Stream 11_Mole %[7 - Component 7] RD_ONLY

7930 FLOAT 11 - Stream 11_Mole %[8 - Component 8] RD_ONLY

7931 FLOAT 11 - Stream 11_Mole %[9 - Component 9] RD_ONLY

7932 FLOAT 11 - Stream 11_Mole %[10 - Component 10] RD_ONLY

7933 FLOAT 11 - Stream 11_Mole %[11 - Component 11] RD_ONLY

7934 FLOAT 11 - Stream 11_Mole %[12 - Component 12] RD_ONLY

7935 FLOAT 11 - Stream 11_Mole %[13 - Component 13] RD_ONLY

7936 FLOAT 11 - Stream 11_Mole %[14 - Component 14] RD_ONLY

7937 FLOAT 11 - Stream 11_Mole %[15 - Component 15] RD_ONLY

7938 FLOAT 11 - Stream 11_Mole %[16 - Component 16] RD_ONLY

7939 FLOAT 11 - Stream 11_Mole %[17 - Component 17] RD_ONLY

7940 FLOAT 11 - Stream 11_Mole %[18 - Component 18] RD_ONLY

7941 FLOAT 11 - Stream 11_Mole %[19 - Component 19] RD_ONLY

7942 FLOAT 11 - Stream 11_Mole %[20 - Component 20] RD_ONLY

7943 FLOAT 11 - Stream 11_HV Gross BTU Dry RD_ONLY

7944 FLOAT 11 - Stream 11_GPA Real Rel Den Gas RD_ONLY

7945 FLOAT 11 - Stream 11_GPA Z Factor RD_ONLY

7946 FLOAT 11 - Stream 11_Total Unnormalized Conc RD_ONLY

7947 FLOAT Unused RD_ONLY

7948 FLOAT Unused RD_ONLY

7949 FLOAT Unused RD_ONLY

7950 FLOAT Unused RD_ONLY

7951 FLOAT 12 - Stream 12_Start Time RD_ONLY YYMMDD

7952 FLOAT 12 - Stream 12_Start Time RD_ONLY hhmmss

7953 FLOAT 12 - Stream 12_Mole %[1 - Component 1] RD_ONLY

7954 FLOAT 12 - Stream 12_Mole %[2 - Component 2] RD_ONLY

7955 FLOAT 12 - Stream 12_Mole %[3 - Component 3] RD_ONLY

7956 FLOAT 12 - Stream 12_Mole %[4 - Component 4] RD_ONLY

7957 FLOAT 12 - Stream 12_Mole %[5 - Component 5] RD_ONLY

7958 FLOAT 12 - Stream 12_Mole %[6 - Component 6] RD_ONLY

7959 FLOAT 12 - Stream 12_Mole %[7 - Component 7] RD_ONLY

7960 FLOAT 12 - Stream 12_Mole %[8 - Component 8] RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-745 December 2019

MON2020 271



Register # Data Type Variable Record # Access Format

7961 FLOAT 12 - Stream 12_Mole %[9 - Component 9] RD_ONLY

7962 FLOAT 12 - Stream 12_Mole %[10 - Component 10] RD_ONLY

7963 FLOAT 12 - Stream 12_Mole %[11 - Component 11] RD_ONLY

7964 FLOAT 12 - Stream 12_Mole %[12 - Component 12] RD_ONLY

7965 FLOAT 12 - Stream 12_Mole %[13 - Component 13] RD_ONLY

7966 FLOAT 12 - Stream 12_Mole %[14 - Component 14] RD_ONLY

7967 FLOAT 12 - Stream 12_Mole %[15 - Component 15] RD_ONLY

7968 FLOAT 12 - Stream 12_Mole %[16 - Component 16] RD_ONLY

7969 FLOAT 12 - Stream 12_Mole %[17 - Component 17] RD_ONLY

7970 FLOAT 12 - Stream 12_Mole %[18 - Component 18] RD_ONLY

7971 FLOAT 12 - Stream 12_Mole %[19 - Component 19] RD_ONLY

7972 FLOAT 12 - Stream 12_Mole %[20 - Component 20] RD_ONLY

7973 FLOAT 12 - Stream 12_HV Gross BTU Dry RD_ONLY

7974 FLOAT 12 - Stream 12_GPA Real Rel Den Gas RD_ONLY

7975 FLOAT 12 - Stream 12_GPA Z Factor RD_ONLY

7976 FLOAT 12 - Stream 12_Total Unnormalized Conc RD_ONLY

7977 FLOAT Unused RD_ONLY

7978 FLOAT Unused RD_ONLY

7979 FLOAT Unused RD_ONLY

7980 FLOAT Unused RD_ONLY

7981 FLOAT Unused RD_ONLY

7982 FLOAT Unused RD_ONLY

7983 FLOAT Unused RD_ONLY

7984 FLOAT Unused RD_ONLY

7985 FLOAT Unused RD_ONLY

7986 FLOAT Unused RD_ONLY

7987 FLOAT Unused RD_ONLY

7988 FLOAT Unused RD_ONLY

7989 FLOAT Unused RD_ONLY

7990 FLOAT Unused RD_ONLY

7991 FLOAT Unused RD_ONLY

7992 FLOAT Unused RD_ONLY

7993 FLOAT Unused RD_ONLY

7994 FLOAT Unused RD_ONLY
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7995 FLOAT Unused RD_ONLY

7996 FLOAT GC Control_Auto Sequence RD_WR

7997 FLOAT GC Control_Halt RD_WR

7998 FLOAT GC Control_Calibration RD_WR

7999 FLOAT GC Control_Single Stream RD_WR

8000 FLOAT Current Stream RD_ONLY

8001 FLOAT GC Calibrating RD_ONLY

8002 FLOAT GC Running RD_ONLY

8003 FLOAT Unused RD_ONLY

8004 FLOAT Run Time RD_ONLY

8005 FLOAT Current Analysis Mode RD_ONLY

8006 FLOAT GC Control_Validation RD_WR

8007 FLOAT Unused RD_ONLY

8008 FLOAT Unused RD_ONLY

8009 FLOAT Unused RD_ONLY

8010 FLOAT Unused RD_ONLY

8011 FLOAT Unused RD_ONLY

8012 FLOAT Unused RD_ONLY

8013 FLOAT Unused RD_ONLY

8014 FLOAT Unused RD_ONLY

8015 FLOAT Unused RD_ONLY

8016 FLOAT Unused RD_ONLY

8017 FLOAT Unused RD_ONLY

8018 FLOAT Unused RD_ONLY

8019 FLOAT Unused RD_ONLY

8020 FLOAT Unused RD_ONLY

8021 FLOAT Unused RD_ONLY

8022 FLOAT Unused RD_ONLY

8023 FLOAT Unused RD_ONLY

8024 FLOAT Unused RD_ONLY

8025 FLOAT Unused RD_ONLY

8026 FLOAT Unused RD_ONLY

8027 FLOAT Unused RD_ONLY

8028 FLOAT Unused RD_ONLY
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8029 FLOAT Unused RD_ONLY

8030 FLOAT Unused RD_ONLY

8031 FLOAT Unused RD_ONLY

8032 FLOAT Unused RD_ONLY

8033 FLOAT Unused RD_ONLY

8034 FLOAT Unused RD_ONLY

8035 FLOAT Unused RD_ONLY

8036 FLOAT Unused RD_ONLY

8037 FLOAT Unused RD_ONLY

8038 FLOAT Unused RD_ONLY

8039 FLOAT Unused RD_ONLY

8040 FLOAT Unused RD_ONLY

8041 FLOAT Unused RD_ONLY

8042 FLOAT Unused RD_ONLY

8043 FLOAT Unused RD_ONLY

8044 FLOAT Unused RD_ONLY

8045 FLOAT Unused RD_ONLY

8046 FLOAT Unused RD_ONLY

8047 FLOAT Unused RD_ONLY

8048 FLOAT Unused RD_ONLY

8049 FLOAT Unused RD_ONLY

8050 FLOAT Unused RD_ONLY

8051 FLOAT Unused RD_ONLY

8052 FLOAT Unused RD_ONLY

8053 FLOAT Unused RD_ONLY

8054 FLOAT Unused RD_ONLY

8055 FLOAT Unused RD_ONLY

8056 FLOAT Unused RD_ONLY

8057 FLOAT Unused RD_ONLY

8058 FLOAT Unused RD_ONLY

8059 FLOAT Unused RD_ONLY

8060 FLOAT Unused RD_ONLY

8061 FLOAT Unused RD_ONLY

8062 FLOAT Unused RD_ONLY
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8063 FLOAT Unused RD_ONLY

8064 FLOAT Unused RD_ONLY

8065 FLOAT Unused RD_ONLY

8066 FLOAT Unused RD_ONLY

8067 FLOAT Unused RD_ONLY

8068 FLOAT Unused RD_ONLY

8069 FLOAT Unused RD_ONLY

8070 FLOAT Unused RD_ONLY

8071 FLOAT Unused RD_ONLY

8072 FLOAT Unused RD_ONLY

8073 FLOAT Unused RD_ONLY

8074 FLOAT Unused RD_ONLY

8075 FLOAT Unused RD_ONLY

8076 FLOAT Unused RD_ONLY

8077 FLOAT Unused RD_ONLY

8078 FLOAT Unused RD_ONLY

8079 FLOAT Unused RD_ONLY

8080 FLOAT Unused RD_ONLY

8081 FLOAT Unused RD_ONLY

8082 FLOAT Unused RD_ONLY

8083 FLOAT Unused RD_ONLY

8084 FLOAT Unused RD_ONLY

8085 FLOAT Unused RD_ONLY

8086 FLOAT Unused RD_ONLY

8087 FLOAT Unused RD_ONLY

8088 FLOAT Unused RD_ONLY

8089 FLOAT Unused RD_ONLY

8090 FLOAT Unused RD_ONLY

8091 FLOAT Unused RD_ONLY

8092 FLOAT Unused RD_ONLY

8093 FLOAT Unused RD_ONLY

8094 FLOAT Unused RD_ONLY

8095 FLOAT Unused RD_ONLY

8096 FLOAT Unused RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-745 December 2019

MON2020 275



Register # Data Type Variable Record # Access Format

8097 FLOAT Unused RD_ONLY

8098 FLOAT Unused RD_ONLY

8099 FLOAT Unused RD_ONLY

8100 FLOAT Unused RD_ONLY

8101 FLOAT Unused RD_ONLY

8102 FLOAT Unused RD_ONLY

8103 FLOAT Unused RD_ONLY

8104 FLOAT Unused RD_ONLY

8105 FLOAT Unused RD_ONLY

8106 FLOAT Unused RD_ONLY

8107 FLOAT Unused RD_ONLY

8108 FLOAT Unused RD_ONLY

8109 FLOAT Unused RD_ONLY

8110 FLOAT Unused RD_ONLY

8111 FLOAT Unused RD_ONLY

8112 FLOAT Unused RD_ONLY

8113 FLOAT Unused RD_ONLY

8114 FLOAT Unused RD_ONLY

8115 FLOAT Unused RD_ONLY

8116 FLOAT Unused RD_ONLY

8117 FLOAT Unused RD_ONLY

8118 FLOAT Unused RD_ONLY

8119 FLOAT Unused RD_ONLY

8120 FLOAT Unused RD_ONLY

8121 FLOAT Unused RD_ONLY

8122 FLOAT Unused RD_ONLY

8123 FLOAT Unused RD_ONLY

8124 FLOAT Unused RD_ONLY

8125 FLOAT Unused RD_ONLY

8126 FLOAT Unused RD_ONLY

8127 FLOAT Unused RD_ONLY

8128 FLOAT Unused RD_ONLY

8129 FLOAT Unused RD_ONLY

8130 FLOAT Unused RD_ONLY
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8131 FLOAT Unused RD_ONLY

8132 FLOAT Unused RD_ONLY

8133 FLOAT Unused RD_ONLY

8134 FLOAT Unused RD_ONLY

8135 FLOAT Unused RD_ONLY

8136 FLOAT Unused RD_ONLY

8137 FLOAT Unused RD_ONLY

8138 FLOAT Unused RD_ONLY

8139 FLOAT Unused RD_ONLY

8140 FLOAT Unused RD_ONLY

8141 FLOAT Unused RD_ONLY

8142 FLOAT Unused RD_ONLY

8143 FLOAT Unused RD_ONLY

8144 FLOAT Unused RD_ONLY

8145 FLOAT Unused RD_ONLY

8146 FLOAT Unused RD_ONLY

8147 FLOAT Unused RD_ONLY

8148 FLOAT Unused RD_ONLY

8149 FLOAT Unused RD_ONLY

8150 FLOAT Unused RD_ONLY

8151 FLOAT Unused RD_ONLY

8152 FLOAT Unused RD_ONLY

8153 FLOAT Unused RD_ONLY

8154 FLOAT Unused RD_ONLY

8155 FLOAT Unused RD_ONLY

8156 FLOAT Unused RD_ONLY

8157 FLOAT Unused RD_ONLY

8158 FLOAT Unused RD_ONLY

8159 FLOAT Unused RD_ONLY

8160 FLOAT Unused RD_ONLY

8161 FLOAT Unused RD_ONLY

8162 FLOAT Unused RD_ONLY

8163 FLOAT Unused RD_ONLY

8164 FLOAT Unused RD_ONLY
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8165 FLOAT Unused RD_ONLY

8166 FLOAT Unused RD_ONLY

8167 FLOAT Unused RD_ONLY

8168 FLOAT Unused RD_ONLY

8169 FLOAT Unused RD_ONLY

8170 FLOAT Unused RD_ONLY

8171 FLOAT Unused RD_ONLY

8172 FLOAT Unused RD_ONLY

8173 FLOAT Unused RD_ONLY

8174 FLOAT Unused RD_ONLY

8175 FLOAT Unused RD_ONLY

8176 FLOAT Unused RD_ONLY

8177 FLOAT Unused RD_ONLY

8178 FLOAT Unused RD_ONLY

8179 FLOAT Unused RD_ONLY

8180 FLOAT Unused RD_ONLY

8181 FLOAT Unused RD_ONLY

8182 FLOAT Unused RD_ONLY

8183 FLOAT Unused RD_ONLY

8184 FLOAT Unused RD_ONLY

8185 FLOAT Unused RD_ONLY

8186 FLOAT Unused RD_ONLY

8187 FLOAT Unused RD_ONLY

8188 FLOAT Unused RD_ONLY

8189 FLOAT Unused RD_ONLY

8190 FLOAT Unused RD_ONLY

8191 FLOAT Unused RD_ONLY

8192 FLOAT Unused RD_ONLY

8193 FLOAT Unused RD_ONLY

8194 FLOAT Unused RD_ONLY

8195 FLOAT Unused RD_ONLY

8196 FLOAT Unused RD_ONLY

8197 FLOAT Unused RD_ONLY

8198 FLOAT Unused RD_ONLY
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8199 FLOAT Unused RD_ONLY

8200 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

8201 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

8202 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

8203 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

8204 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

8205 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

8206 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

8207 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

8208 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

8209 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

8210 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

8211 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

8212 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

8213 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

8214 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

8215 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

8216 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

8217 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

8218 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

8219 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

8220 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

8221 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

8222 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

8223 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

8224 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

8225 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

8226 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

8227 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

8228 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

8229 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

8230 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

8231 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

8232 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY
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8233 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

8234 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

8235 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

8236 FLOAT Archive_Avg[37 - Average 37] 1 RD_ONLY

8237 FLOAT Archive_Avg[38 - Average 38] 1 RD_ONLY

8238 FLOAT Archive_Avg[39 - Average 39] 1 RD_ONLY

8239 FLOAT Archive_Avg[40 - Average 40] 1 RD_ONLY

8240 FLOAT Archive_Avg[41 - Average 41] 1 RD_ONLY

8241 FLOAT Archive_Avg[42 - Average 42] 1 RD_ONLY

8242 FLOAT Archive_Avg[43 - Average 43] 1 RD_ONLY

8243 FLOAT Archive_Avg[44 - Average 44] 1 RD_ONLY

8244 FLOAT Archive_Avg[45 - Average 45] 1 RD_ONLY

8245 FLOAT Archive_Avg[46 - Average 46] 1 RD_ONLY

8246 FLOAT Archive_Avg[47 - Average 47] 1 RD_ONLY

8247 FLOAT Archive_Avg[48 - Average 48] 1 RD_ONLY

8248 FLOAT Archive_Avg[49 - Average 49] 1 RD_ONLY

8249 FLOAT Archive_Avg[50 - Average 50] 1 RD_ONLY

8250 FLOAT Archive_Avg[51 - Average 51] 1 RD_ONLY

8251 FLOAT Archive_Avg[52 - Average 52] 1 RD_ONLY

8252 FLOAT Archive_Avg[53 - Average 53] 1 RD_ONLY

8253 FLOAT Archive_Avg[54 - Average 54] 1 RD_ONLY

8254 FLOAT Archive_Avg[55 - Average 55] 1 RD_ONLY

8255 FLOAT Archive_Avg[56 - Average 56] 1 RD_ONLY

8256 FLOAT Archive_Avg[57 - Average 57] 1 RD_ONLY

8257 FLOAT Archive_Avg[58 - Average 58] 1 RD_ONLY

8258 FLOAT Archive_Avg[59 - Average 59] 1 RD_ONLY

8259 FLOAT Archive_Avg[60 - Average 60] 1 RD_ONLY

8260 FLOAT Archive_Avg[61 - Average 61] 1 RD_ONLY

8261 FLOAT Archive_Avg[62 - Average 62] 1 RD_ONLY

8262 FLOAT Archive_Avg[63 - Average 63] 1 RD_ONLY

8263 FLOAT Archive_Avg[64 - Average 64] 1 RD_ONLY

8264 FLOAT Archive_Avg[65 - Average 65] 1 RD_ONLY

8265 FLOAT Archive_Avg[66 - Average 66] 1 RD_ONLY

8266 FLOAT Archive_Avg[67 - Average 67] 1 RD_ONLY
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8267 FLOAT Archive_Avg[68 - Average 68] 1 RD_ONLY

8268 FLOAT Archive_Avg[69 - Average 69] 1 RD_ONLY

8269 FLOAT Archive_Avg[70 - Average 70] 1 RD_ONLY

8270 FLOAT Archive_Avg[71 - Average 71] 1 RD_ONLY

8271 FLOAT Archive_Avg[72 - Average 72] 1 RD_ONLY

8272 FLOAT Archive_Avg[73 - Average 73] 1 RD_ONLY

8273 FLOAT Archive_Avg[74 - Average 74] 1 RD_ONLY

8274 FLOAT Archive_Avg[75 - Average 75] 1 RD_ONLY

8275 FLOAT Archive_Avg[76 - Average 76] 1 RD_ONLY

8276 FLOAT Archive_Avg[77 - Average 77] 1 RD_ONLY

8277 FLOAT Archive_Avg[78 - Average 78] 1 RD_ONLY

8278 FLOAT Archive_Avg[79 - Average 79] 1 RD_ONLY

8279 FLOAT Archive_Avg[80 - Average 80] 1 RD_ONLY

8280 FLOAT Archive_Avg[81 - Average 81] 1 RD_ONLY

8281 FLOAT Archive_Avg[82 - Average 82] 1 RD_ONLY

8282 FLOAT Archive_Avg[83 - Average 83] 1 RD_ONLY

8283 FLOAT Archive_Avg[84 - Average 84] 1 RD_ONLY

8284 FLOAT Archive_Avg[85 - Average 85] 1 RD_ONLY

8285 FLOAT Archive_Avg[86 - Average 86] 1 RD_ONLY

8286 FLOAT Archive_Avg[87 - Average 87] 1 RD_ONLY

8287 FLOAT Archive_Avg[88 - Average 88] 1 RD_ONLY

8288 FLOAT Archive_Avg[89 - Average 89] 1 RD_ONLY

8289 FLOAT Archive_Avg[90 - Average 90] 1 RD_ONLY

8290 FLOAT Archive_Avg[91 - Average 91] 1 RD_ONLY

8291 FLOAT Archive_Avg[92 - Average 92] 1 RD_ONLY

8292 FLOAT Archive_Avg[93 - Average 93] 1 RD_ONLY

8293 FLOAT Archive_Avg[94 - Average 94] 1 RD_ONLY

8294 FLOAT Archive_Avg[95 - Average 95] 1 RD_ONLY

8295 FLOAT Archive_Avg[96 - Average 96] 1 RD_ONLY

8296 FLOAT Archive_Avg[97 - Average 97] 1 RD_ONLY

8297 FLOAT Archive_Avg[98 - Average 98] 1 RD_ONLY

8298 FLOAT Archive_Avg[99 - Average 99] 1 RD_ONLY

8299 FLOAT Archive_Avg[100 - Average 100] 1 RD_ONLY

8300 FLOAT Archive_Avg[101 - Average 101] 1 RD_ONLY
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8301 FLOAT Archive_Avg[102 - Average 102] 1 RD_ONLY

8302 FLOAT Archive_Avg[103 - Average 103] 1 RD_ONLY

8303 FLOAT Archive_Avg[104 - Average 104] 1 RD_ONLY

8304 FLOAT Archive_Avg[105 - Average 105] 1 RD_ONLY

8305 FLOAT Archive_Avg[106 - Average 106] 1 RD_ONLY

8306 FLOAT Archive_Avg[107 - Average 107] 1 RD_ONLY

8307 FLOAT Archive_Avg[108 - Average 108] 1 RD_ONLY

8308 FLOAT Archive_Avg[109 - Average 109] 1 RD_ONLY

8309 FLOAT Archive_Avg[110 - Average 110] 1 RD_ONLY

8310 FLOAT Archive_Avg[111 - Average 111] 1 RD_ONLY

8311 FLOAT Archive_Avg[112 - Average 112] 1 RD_ONLY

8312 FLOAT Archive_Avg[113 - Average 113] 1 RD_ONLY

8313 FLOAT Archive_Avg[114 - Average 114] 1 RD_ONLY

8314 FLOAT Archive_Avg[115 - Average 115] 1 RD_ONLY

8315 FLOAT Archive_Avg[116 - Average 116] 1 RD_ONLY

8316 FLOAT Archive_Avg[117 - Average 117] 1 RD_ONLY

8317 FLOAT Archive_Avg[118 - Average 118] 1 RD_ONLY

8318 FLOAT Archive_Avg[119 - Average 119] 1 RD_ONLY

8319 FLOAT Archive_Avg[120 - Average 120] 1 RD_ONLY

8320 FLOAT Archive_Avg[121 - Average 121] 1 RD_ONLY

8321 FLOAT Archive_Avg[122 - Average 122] 1 RD_ONLY

8322 FLOAT Archive_Avg[123 - Average 123] 1 RD_ONLY

8323 FLOAT Archive_Avg[124 - Average 124] 1 RD_ONLY

8324 FLOAT Archive_Avg[125 - Average 125] 1 RD_ONLY

8325 FLOAT Archive_Avg[126 - Average 126] 1 RD_ONLY

8326 FLOAT Archive_Avg[127 - Average 127] 1 RD_ONLY

8327 FLOAT Archive_Avg[128 - Average 128] 1 RD_ONLY

8328 FLOAT Archive_Avg[129 - Average 129] 1 RD_ONLY

8329 FLOAT Archive_Avg[130 - Average 130] 1 RD_ONLY

8330 FLOAT Archive_Avg[131 - Average 131] 1 RD_ONLY

8331 FLOAT Archive_Avg[132 - Average 132] 1 RD_ONLY

8332 FLOAT Archive_Avg[133 - Average 133] 1 RD_ONLY

8333 FLOAT Archive_Avg[134 - Average 134] 1 RD_ONLY

8334 FLOAT Archive_Avg[135 - Average 135] 1 RD_ONLY
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8335 FLOAT Archive_Avg[136 - Average 136] 1 RD_ONLY

8336 FLOAT Archive_Avg[137 - Average 137] 1 RD_ONLY

8337 FLOAT Archive_Avg[138 - Average 138] 1 RD_ONLY

8338 FLOAT Archive_Avg[139 - Average 139] 1 RD_ONLY

8339 FLOAT Archive_Avg[140 - Average 140] 1 RD_ONLY

8340 FLOAT Archive_Avg[141 - Average 141] 1 RD_ONLY

8341 FLOAT Archive_Avg[142 - Average 142] 1 RD_ONLY

8342 FLOAT Archive_Avg[143 - Average 143] 1 RD_ONLY

8343 FLOAT Archive_Avg[144 - Average 144] 1 RD_ONLY

8344 FLOAT Archive_Avg[145 - Average 145] 1 RD_ONLY

8345 FLOAT Archive_Avg[146 - Average 146] 1 RD_ONLY

8346 FLOAT Archive_Avg[147 - Average 147] 1 RD_ONLY

8347 FLOAT Archive_Avg[148 - Average 148] 1 RD_ONLY

8348 FLOAT Archive_Avg[149 - Average 149] 1 RD_ONLY

8349 FLOAT Archive_Avg[150 - Average 150] 1 RD_ONLY

8350 FLOAT Archive_Avg[151 - Average 151] 1 RD_ONLY

8351 FLOAT Archive_Avg[152 - Average 152] 1 RD_ONLY

8352 FLOAT Archive_Avg[153 - Average 153] 1 RD_ONLY

8353 FLOAT Archive_Avg[154 - Average 154] 1 RD_ONLY

8354 FLOAT Archive_Avg[155 - Average 155] 1 RD_ONLY

8355 FLOAT Archive_Avg[156 - Average 156] 1 RD_ONLY

8356 FLOAT Archive_Avg[157 - Average 157] 1 RD_ONLY

8357 FLOAT Archive_Avg[158 - Average 158] 1 RD_ONLY

8358 FLOAT Archive_Avg[159 - Average 159] 1 RD_ONLY

8359 FLOAT Archive_Avg[160 - Average 160] 1 RD_ONLY

8360 FLOAT Archive_Avg[161 - Average 161] 1 RD_ONLY

8361 FLOAT Archive_Avg[162 - Average 162] 1 RD_ONLY

8362 FLOAT Archive_Avg[163 - Average 163] 1 RD_ONLY

8363 FLOAT Archive_Avg[164 - Average 164] 1 RD_ONLY

8364 FLOAT Archive_Avg[165 - Average 165] 1 RD_ONLY

8365 FLOAT Archive_Avg[166 - Average 166] 1 RD_ONLY

8366 FLOAT Archive_Avg[167 - Average 167] 1 RD_ONLY

8367 FLOAT Archive_Avg[168 - Average 168] 1 RD_ONLY

8368 FLOAT Archive_Avg[169 - Average 169] 1 RD_ONLY
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8369 FLOAT Archive_Avg[170 - Average 170] 1 RD_ONLY

8370 FLOAT Archive_Avg[171 - Average 171] 1 RD_ONLY

8371 FLOAT Archive_Avg[172 - Average 172] 1 RD_ONLY

8372 FLOAT Archive_Avg[173 - Average 173] 1 RD_ONLY

8373 FLOAT Archive_Avg[174 - Average 174] 1 RD_ONLY

8374 FLOAT Archive_Avg[175 - Average 175] 1 RD_ONLY

8375 FLOAT Archive_Avg[176 - Average 176] 1 RD_ONLY

8376 FLOAT Archive_Avg[177 - Average 177] 1 RD_ONLY

8377 FLOAT Archive_Avg[178 - Average 178] 1 RD_ONLY

8378 FLOAT Archive_Avg[179 - Average 179] 1 RD_ONLY

8379 FLOAT Archive_Avg[180 - Average 180] 1 RD_ONLY

8380 FLOAT Archive_Avg[181 - Average 181] 1 RD_ONLY

8381 FLOAT Archive_Avg[182 - Average 182] 1 RD_ONLY

8382 FLOAT Archive_Avg[183 - Average 183] 1 RD_ONLY

8383 FLOAT Archive_Avg[184 - Average 184] 1 RD_ONLY

8384 FLOAT Archive_Avg[185 - Average 185] 1 RD_ONLY

8385 FLOAT Archive_Avg[186 - Average 186] 1 RD_ONLY

8386 FLOAT Archive_Avg[187 - Average 187] 1 RD_ONLY

8387 FLOAT Archive_Avg[188 - Average 188] 1 RD_ONLY

8388 FLOAT Archive_Avg[189 - Average 189] 1 RD_ONLY

8389 FLOAT Archive_Avg[190 - Average 190] 1 RD_ONLY

8390 FLOAT Archive_Avg[191 - Average 191] 1 RD_ONLY

8391 FLOAT Archive_Avg[192 - Average 192] 1 RD_ONLY

8392 FLOAT Archive_Avg[193 - Average 193] 1 RD_ONLY

8393 FLOAT Archive_Avg[194 - Average 194] 1 RD_ONLY

8394 FLOAT Archive_Avg[195 - Average 195] 1 RD_ONLY

8395 FLOAT Archive_Avg[196 - Average 196] 1 RD_ONLY

8396 FLOAT Archive_Avg[197 - Average 197] 1 RD_ONLY

8397 FLOAT Archive_Avg[198 - Average 198] 1 RD_ONLY

8398 FLOAT Archive_Avg[199 - Average 199] 1 RD_ONLY

8399 FLOAT Archive_Avg[200 - Average 200] 1 RD_ONLY

8400 FLOAT Archive_Avg[201 - Average 201] 1 RD_ONLY

8401 FLOAT Archive_Avg[202 - Average 202] 1 RD_ONLY

8402 FLOAT Archive_Avg[203 - Average 203] 1 RD_ONLY
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8403 FLOAT Archive_Avg[204 - Average 204] 1 RD_ONLY

8404 FLOAT Archive_Avg[205 - Average 205] 1 RD_ONLY

8405 FLOAT Archive_Avg[206 - Average 206] 1 RD_ONLY

8406 FLOAT Archive_Avg[207 - Average 207] 1 RD_ONLY

8407 FLOAT Archive_Avg[208 - Average 208] 1 RD_ONLY

8408 FLOAT Archive_Avg[209 - Average 209] 1 RD_ONLY

8409 FLOAT Archive_Avg[210 - Average 210] 1 RD_ONLY

8410 FLOAT Archive_Avg[211 - Average 211] 1 RD_ONLY

8411 FLOAT Archive_Avg[212 - Average 212] 1 RD_ONLY

8412 FLOAT Archive_Avg[213 - Average 213] 1 RD_ONLY

8413 FLOAT Archive_Avg[214 - Average 214] 1 RD_ONLY

8414 FLOAT Archive_Avg[215 - Average 215] 1 RD_ONLY

8415 FLOAT Archive_Avg[216 - Average 216] 1 RD_ONLY

8416 FLOAT Archive_Avg[217 - Average 217] 1 RD_ONLY

8417 FLOAT Archive_Avg[218 - Average 218] 1 RD_ONLY

8418 FLOAT Archive_Avg[219 - Average 219] 1 RD_ONLY

8419 FLOAT Archive_Avg[220 - Average 220] 1 RD_ONLY

8420 FLOAT Archive_Avg[221 - Average 221] 1 RD_ONLY

8421 FLOAT Archive_Avg[222 - Average 222] 1 RD_ONLY

8422 FLOAT Archive_Avg[223 - Average 223] 1 RD_ONLY

8423 FLOAT Archive_Avg[224 - Average 224] 1 RD_ONLY

8424 FLOAT Archive_Avg[225 - Average 225] 1 RD_ONLY

8425 FLOAT Archive_Avg[226 - Average 226] 1 RD_ONLY

8426 FLOAT Archive_Avg[227 - Average 227] 1 RD_ONLY

8427 FLOAT Archive_Avg[228 - Average 228] 1 RD_ONLY

8428 FLOAT Archive_Avg[229 - Average 229] 1 RD_ONLY

8429 FLOAT Archive_Avg[230 - Average 230] 1 RD_ONLY

8430 FLOAT Archive_Avg[231 - Average 231] 1 RD_ONLY

8431 FLOAT Archive_Avg[232 - Average 232] 1 RD_ONLY

8432 FLOAT Archive_Avg[233 - Average 233] 1 RD_ONLY

8433 FLOAT Archive_Avg[234 - Average 234] 1 RD_ONLY

8434 FLOAT Archive_Avg[235 - Average 235] 1 RD_ONLY

8435 FLOAT Archive_Avg[236 - Average 236] 1 RD_ONLY

8436 FLOAT Archive_Avg[237 - Average 237] 1 RD_ONLY
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8437 FLOAT Archive_Avg[238 - Average 238] 1 RD_ONLY

8438 FLOAT Archive_Avg[239 - Average 239] 1 RD_ONLY

8439 FLOAT Archive_Avg[240 - Average 240] 1 RD_ONLY

8440 FLOAT Archive_Avg[241 - Average 241] 1 RD_ONLY

8441 FLOAT Archive_Avg[242 - Average 242] 1 RD_ONLY

8442 FLOAT Archive_Avg[243 - Average 243] 1 RD_ONLY

8443 FLOAT Archive_Avg[244 - Average 244] 1 RD_ONLY

8444 FLOAT Archive_Avg[245 - Average 245] 1 RD_ONLY

8445 FLOAT Archive_Avg[246 - Average 246] 1 RD_ONLY

8446 FLOAT Archive_Avg[247 - Average 247] 1 RD_ONLY

8447 FLOAT Archive_Avg[248 - Average 248] 1 RD_ONLY

8448 FLOAT Archive_Avg[249 - Average 249] 1 RD_ONLY

8449 FLOAT Archive_Avg[250 - Average 250] 1 RD_ONLY

8450 FLOAT Unused RD_ONLY

8451 FLOAT Unused RD_ONLY

8452 FLOAT Unused RD_ONLY

8453 FLOAT Unused RD_ONLY

8454 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

8455 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

8456 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

8457 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

8458 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

8459 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

8460 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

8461 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

8462 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

8463 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

8464 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

8465 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

8466 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

8467 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

8468 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

8469 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

8470 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY
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8471 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

8472 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

8473 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

8474 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

8475 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

8476 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

8477 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

8478 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

8479 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

8480 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

8481 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

8482 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

8483 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

8484 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

8485 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

8486 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

8487 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

8488 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

8489 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

8490 FLOAT Archive_Max[37 - Average 37] 1 RD_ONLY

8491 FLOAT Archive_Max[38 - Average 38] 1 RD_ONLY

8492 FLOAT Archive_Max[39 - Average 39] 1 RD_ONLY

8493 FLOAT Archive_Max[40 - Average 40] 1 RD_ONLY

8494 FLOAT Archive_Max[41 - Average 41] 1 RD_ONLY

8495 FLOAT Archive_Max[42 - Average 42] 1 RD_ONLY

8496 FLOAT Archive_Max[43 - Average 43] 1 RD_ONLY

8497 FLOAT Archive_Max[44 - Average 44] 1 RD_ONLY

8498 FLOAT Archive_Max[45 - Average 45] 1 RD_ONLY

8499 FLOAT Archive_Max[46 - Average 46] 1 RD_ONLY

8500 FLOAT Archive_Max[47 - Average 47] 1 RD_ONLY

8501 FLOAT Archive_Max[48 - Average 48] 1 RD_ONLY

8502 FLOAT Archive_Max[49 - Average 49] 1 RD_ONLY

8503 FLOAT Archive_Max[50 - Average 50] 1 RD_ONLY

8504 FLOAT Archive_Max[51 - Average 51] 1 RD_ONLY
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8505 FLOAT Archive_Max[52 - Average 52] 1 RD_ONLY

8506 FLOAT Archive_Max[53 - Average 53] 1 RD_ONLY

8507 FLOAT Archive_Max[54 - Average 54] 1 RD_ONLY

8508 FLOAT Archive_Max[55 - Average 55] 1 RD_ONLY

8509 FLOAT Archive_Max[56 - Average 56] 1 RD_ONLY

8510 FLOAT Archive_Max[57 - Average 57] 1 RD_ONLY

8511 FLOAT Archive_Max[58 - Average 58] 1 RD_ONLY

8512 FLOAT Archive_Max[59 - Average 59] 1 RD_ONLY

8513 FLOAT Archive_Max[60 - Average 60] 1 RD_ONLY

8514 FLOAT Archive_Max[61 - Average 61] 1 RD_ONLY

8515 FLOAT Archive_Max[62 - Average 62] 1 RD_ONLY

8516 FLOAT Archive_Max[63 - Average 63] 1 RD_ONLY

8517 FLOAT Archive_Max[64 - Average 64] 1 RD_ONLY

8518 FLOAT Archive_Max[65 - Average 65] 1 RD_ONLY

8519 FLOAT Archive_Max[66 - Average 66] 1 RD_ONLY

8520 FLOAT Archive_Max[67 - Average 67] 1 RD_ONLY

8521 FLOAT Archive_Max[68 - Average 68] 1 RD_ONLY

8522 FLOAT Archive_Max[69 - Average 69] 1 RD_ONLY

8523 FLOAT Archive_Max[70 - Average 70] 1 RD_ONLY

8524 FLOAT Archive_Max[71 - Average 71] 1 RD_ONLY

8525 FLOAT Archive_Max[72 - Average 72] 1 RD_ONLY

8526 FLOAT Archive_Max[73 - Average 73] 1 RD_ONLY

8527 FLOAT Archive_Max[74 - Average 74] 1 RD_ONLY

8528 FLOAT Archive_Max[75 - Average 75] 1 RD_ONLY

8529 FLOAT Archive_Max[76 - Average 76] 1 RD_ONLY

8530 FLOAT Archive_Max[77 - Average 77] 1 RD_ONLY

8531 FLOAT Archive_Max[78 - Average 78] 1 RD_ONLY

8532 FLOAT Archive_Max[79 - Average 79] 1 RD_ONLY

8533 FLOAT Archive_Max[80 - Average 80] 1 RD_ONLY

8534 FLOAT Archive_Max[81 - Average 81] 1 RD_ONLY

8535 FLOAT Archive_Max[82 - Average 82] 1 RD_ONLY

8536 FLOAT Archive_Max[83 - Average 83] 1 RD_ONLY

8537 FLOAT Archive_Max[84 - Average 84] 1 RD_ONLY

8538 FLOAT Archive_Max[85 - Average 85] 1 RD_ONLY
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8539 FLOAT Archive_Max[86 - Average 86] 1 RD_ONLY

8540 FLOAT Archive_Max[87 - Average 87] 1 RD_ONLY

8541 FLOAT Archive_Max[88 - Average 88] 1 RD_ONLY

8542 FLOAT Archive_Max[89 - Average 89] 1 RD_ONLY

8543 FLOAT Archive_Max[90 - Average 90] 1 RD_ONLY

8544 FLOAT Archive_Max[91 - Average 91] 1 RD_ONLY

8545 FLOAT Archive_Max[92 - Average 92] 1 RD_ONLY

8546 FLOAT Archive_Max[93 - Average 93] 1 RD_ONLY

8547 FLOAT Archive_Max[94 - Average 94] 1 RD_ONLY

8548 FLOAT Archive_Max[95 - Average 95] 1 RD_ONLY

8549 FLOAT Archive_Max[96 - Average 96] 1 RD_ONLY

8550 FLOAT Archive_Max[97 - Average 97] 1 RD_ONLY

8551 FLOAT Archive_Max[98 - Average 98] 1 RD_ONLY

8552 FLOAT Archive_Max[99 - Average 99] 1 RD_ONLY

8553 FLOAT Archive_Max[100 - Average 100] 1 RD_ONLY

8554 FLOAT Archive_Max[101 - Average 101] 1 RD_ONLY

8555 FLOAT Archive_Max[102 - Average 102] 1 RD_ONLY

8556 FLOAT Archive_Max[103 - Average 103] 1 RD_ONLY

8557 FLOAT Archive_Max[104 - Average 104] 1 RD_ONLY

8558 FLOAT Archive_Max[105 - Average 105] 1 RD_ONLY

8559 FLOAT Archive_Max[106 - Average 106] 1 RD_ONLY

8560 FLOAT Archive_Max[107 - Average 107] 1 RD_ONLY

8561 FLOAT Archive_Max[108 - Average 108] 1 RD_ONLY

8562 FLOAT Archive_Max[109 - Average 109] 1 RD_ONLY

8563 FLOAT Archive_Max[110 - Average 110] 1 RD_ONLY

8564 FLOAT Archive_Max[111 - Average 111] 1 RD_ONLY

8565 FLOAT Archive_Max[112 - Average 112] 1 RD_ONLY

8566 FLOAT Archive_Max[113 - Average 113] 1 RD_ONLY

8567 FLOAT Archive_Max[114 - Average 114] 1 RD_ONLY

8568 FLOAT Archive_Max[115 - Average 115] 1 RD_ONLY

8569 FLOAT Archive_Max[116 - Average 116] 1 RD_ONLY

8570 FLOAT Archive_Max[117 - Average 117] 1 RD_ONLY

8571 FLOAT Archive_Max[118 - Average 118] 1 RD_ONLY

8572 FLOAT Archive_Max[119 - Average 119] 1 RD_ONLY
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8573 FLOAT Archive_Max[120 - Average 120] 1 RD_ONLY

8574 FLOAT Archive_Max[121 - Average 121] 1 RD_ONLY

8575 FLOAT Archive_Max[122 - Average 122] 1 RD_ONLY

8576 FLOAT Archive_Max[123 - Average 123] 1 RD_ONLY

8577 FLOAT Archive_Max[124 - Average 124] 1 RD_ONLY

8578 FLOAT Archive_Max[125 - Average 125] 1 RD_ONLY

8579 FLOAT Archive_Max[126 - Average 126] 1 RD_ONLY

8580 FLOAT Archive_Max[127 - Average 127] 1 RD_ONLY

8581 FLOAT Archive_Max[128 - Average 128] 1 RD_ONLY

8582 FLOAT Archive_Max[129 - Average 129] 1 RD_ONLY

8583 FLOAT Archive_Max[130 - Average 130] 1 RD_ONLY

8584 FLOAT Archive_Max[131 - Average 131] 1 RD_ONLY

8585 FLOAT Archive_Max[132 - Average 132] 1 RD_ONLY

8586 FLOAT Archive_Max[133 - Average 133] 1 RD_ONLY

8587 FLOAT Archive_Max[134 - Average 134] 1 RD_ONLY

8588 FLOAT Archive_Max[135 - Average 135] 1 RD_ONLY

8589 FLOAT Archive_Max[136 - Average 136] 1 RD_ONLY

8590 FLOAT Archive_Max[137 - Average 137] 1 RD_ONLY

8591 FLOAT Archive_Max[138 - Average 138] 1 RD_ONLY

8592 FLOAT Archive_Max[139 - Average 139] 1 RD_ONLY

8593 FLOAT Archive_Max[140 - Average 140] 1 RD_ONLY

8594 FLOAT Archive_Max[141 - Average 141] 1 RD_ONLY

8595 FLOAT Archive_Max[142 - Average 142] 1 RD_ONLY

8596 FLOAT Archive_Max[143 - Average 143] 1 RD_ONLY

8597 FLOAT Archive_Max[144 - Average 144] 1 RD_ONLY

8598 FLOAT Archive_Max[145 - Average 145] 1 RD_ONLY

8599 FLOAT Archive_Max[146 - Average 146] 1 RD_ONLY

8600 FLOAT Archive_Max[147 - Average 147] 1 RD_ONLY

8601 FLOAT Archive_Max[148 - Average 148] 1 RD_ONLY

8602 FLOAT Archive_Max[149 - Average 149] 1 RD_ONLY

8603 FLOAT Archive_Max[150 - Average 150] 1 RD_ONLY

8604 FLOAT Archive_Max[151 - Average 151] 1 RD_ONLY

8605 FLOAT Archive_Max[152 - Average 152] 1 RD_ONLY

8606 FLOAT Archive_Max[153 - Average 153] 1 RD_ONLY
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8607 FLOAT Archive_Max[154 - Average 154] 1 RD_ONLY

8608 FLOAT Archive_Max[155 - Average 155] 1 RD_ONLY

8609 FLOAT Archive_Max[156 - Average 156] 1 RD_ONLY

8610 FLOAT Archive_Max[157 - Average 157] 1 RD_ONLY

8611 FLOAT Archive_Max[158 - Average 158] 1 RD_ONLY

8612 FLOAT Archive_Max[159 - Average 159] 1 RD_ONLY

8613 FLOAT Archive_Max[160 - Average 160] 1 RD_ONLY

8614 FLOAT Archive_Max[161 - Average 161] 1 RD_ONLY

8615 FLOAT Archive_Max[162 - Average 162] 1 RD_ONLY

8616 FLOAT Archive_Max[163 - Average 163] 1 RD_ONLY

8617 FLOAT Archive_Max[164 - Average 164] 1 RD_ONLY

8618 FLOAT Archive_Max[165 - Average 165] 1 RD_ONLY

8619 FLOAT Archive_Max[166 - Average 166] 1 RD_ONLY

8620 FLOAT Archive_Max[167 - Average 167] 1 RD_ONLY

8621 FLOAT Archive_Max[168 - Average 168] 1 RD_ONLY

8622 FLOAT Archive_Max[169 - Average 169] 1 RD_ONLY

8623 FLOAT Archive_Max[170 - Average 170] 1 RD_ONLY

8624 FLOAT Archive_Max[171 - Average 171] 1 RD_ONLY

8625 FLOAT Archive_Max[172 - Average 172] 1 RD_ONLY

8626 FLOAT Archive_Max[173 - Average 173] 1 RD_ONLY

8627 FLOAT Archive_Max[174 - Average 174] 1 RD_ONLY

8628 FLOAT Archive_Max[175 - Average 175] 1 RD_ONLY

8629 FLOAT Archive_Max[176 - Average 176] 1 RD_ONLY

8630 FLOAT Archive_Max[177 - Average 177] 1 RD_ONLY

8631 FLOAT Archive_Max[178 - Average 178] 1 RD_ONLY

8632 FLOAT Archive_Max[179 - Average 179] 1 RD_ONLY

8633 FLOAT Archive_Max[180 - Average 180] 1 RD_ONLY

8634 FLOAT Archive_Max[181 - Average 181] 1 RD_ONLY

8635 FLOAT Archive_Max[182 - Average 182] 1 RD_ONLY

8636 FLOAT Archive_Max[183 - Average 183] 1 RD_ONLY

8637 FLOAT Archive_Max[184 - Average 184] 1 RD_ONLY

8638 FLOAT Archive_Max[185 - Average 185] 1 RD_ONLY

8639 FLOAT Archive_Max[186 - Average 186] 1 RD_ONLY

8640 FLOAT Archive_Max[187 - Average 187] 1 RD_ONLY
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8641 FLOAT Archive_Max[188 - Average 188] 1 RD_ONLY

8642 FLOAT Archive_Max[189 - Average 189] 1 RD_ONLY

8643 FLOAT Archive_Max[190 - Average 190] 1 RD_ONLY

8644 FLOAT Archive_Max[191 - Average 191] 1 RD_ONLY

8645 FLOAT Archive_Max[192 - Average 192] 1 RD_ONLY

8646 FLOAT Archive_Max[193 - Average 193] 1 RD_ONLY

8647 FLOAT Archive_Max[194 - Average 194] 1 RD_ONLY

8648 FLOAT Archive_Max[195 - Average 195] 1 RD_ONLY

8649 FLOAT Archive_Max[196 - Average 196] 1 RD_ONLY

8650 FLOAT Archive_Max[197 - Average 197] 1 RD_ONLY

8651 FLOAT Archive_Max[198 - Average 198] 1 RD_ONLY

8652 FLOAT Archive_Max[199 - Average 199] 1 RD_ONLY

8653 FLOAT Archive_Max[200 - Average 200] 1 RD_ONLY

8654 FLOAT Archive_Max[201 - Average 201] 1 RD_ONLY

8655 FLOAT Archive_Max[202 - Average 202] 1 RD_ONLY

8656 FLOAT Archive_Max[203 - Average 203] 1 RD_ONLY

8657 FLOAT Archive_Max[204 - Average 204] 1 RD_ONLY

8658 FLOAT Archive_Max[205 - Average 205] 1 RD_ONLY

8659 FLOAT Archive_Max[206 - Average 206] 1 RD_ONLY

8660 FLOAT Archive_Max[207 - Average 207] 1 RD_ONLY

8661 FLOAT Archive_Max[208 - Average 208] 1 RD_ONLY

8662 FLOAT Archive_Max[209 - Average 209] 1 RD_ONLY

8663 FLOAT Archive_Max[210 - Average 210] 1 RD_ONLY

8664 FLOAT Archive_Max[211 - Average 211] 1 RD_ONLY

8665 FLOAT Archive_Max[212 - Average 212] 1 RD_ONLY

8666 FLOAT Archive_Max[213 - Average 213] 1 RD_ONLY

8667 FLOAT Archive_Max[214 - Average 214] 1 RD_ONLY

8668 FLOAT Archive_Max[215 - Average 215] 1 RD_ONLY

8669 FLOAT Archive_Max[216 - Average 216] 1 RD_ONLY

8670 FLOAT Archive_Max[217 - Average 217] 1 RD_ONLY

8671 FLOAT Archive_Max[218 - Average 218] 1 RD_ONLY

8672 FLOAT Archive_Max[219 - Average 219] 1 RD_ONLY

8673 FLOAT Archive_Max[220 - Average 220] 1 RD_ONLY

8674 FLOAT Archive_Max[221 - Average 221] 1 RD_ONLY
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8675 FLOAT Archive_Max[222 - Average 222] 1 RD_ONLY

8676 FLOAT Archive_Max[223 - Average 223] 1 RD_ONLY

8677 FLOAT Archive_Max[224 - Average 224] 1 RD_ONLY

8678 FLOAT Archive_Max[225 - Average 225] 1 RD_ONLY

8679 FLOAT Archive_Max[226 - Average 226] 1 RD_ONLY

8680 FLOAT Archive_Max[227 - Average 227] 1 RD_ONLY

8681 FLOAT Archive_Max[228 - Average 228] 1 RD_ONLY

8682 FLOAT Archive_Max[229 - Average 229] 1 RD_ONLY

8683 FLOAT Archive_Max[230 - Average 230] 1 RD_ONLY

8684 FLOAT Archive_Max[231 - Average 231] 1 RD_ONLY

8685 FLOAT Archive_Max[232 - Average 232] 1 RD_ONLY

8686 FLOAT Archive_Max[233 - Average 233] 1 RD_ONLY

8687 FLOAT Archive_Max[234 - Average 234] 1 RD_ONLY

8688 FLOAT Archive_Max[235 - Average 235] 1 RD_ONLY

8689 FLOAT Archive_Max[236 - Average 236] 1 RD_ONLY

8690 FLOAT Archive_Max[237 - Average 237] 1 RD_ONLY

8691 FLOAT Archive_Max[238 - Average 238] 1 RD_ONLY

8692 FLOAT Archive_Max[239 - Average 239] 1 RD_ONLY

8693 FLOAT Archive_Max[240 - Average 240] 1 RD_ONLY

8694 FLOAT Archive_Max[241 - Average 241] 1 RD_ONLY

8695 FLOAT Archive_Max[242 - Average 242] 1 RD_ONLY

8696 FLOAT Archive_Max[243 - Average 243] 1 RD_ONLY

8697 FLOAT Archive_Max[244 - Average 244] 1 RD_ONLY

8698 FLOAT Archive_Max[245 - Average 245] 1 RD_ONLY

8699 FLOAT Archive_Max[246 - Average 246] 1 RD_ONLY

8700 FLOAT Archive_Max[247 - Average 247] 1 RD_ONLY

8701 FLOAT Archive_Max[248 - Average 248] 1 RD_ONLY

8702 FLOAT Archive_Max[249 - Average 249] 1 RD_ONLY

8703 FLOAT Archive_Max[250 - Average 250] 1 RD_ONLY

8704 FLOAT Unused RD_ONLY

8705 FLOAT Unused RD_ONLY

8706 FLOAT Unused RD_ONLY

8707 FLOAT Unused RD_ONLY

8708 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY
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8709 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

8710 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

8711 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

8712 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

8713 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

8714 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

8715 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

8716 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

8717 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

8718 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

8719 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

8720 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

8721 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

8722 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

8723 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

8724 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

8725 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

8726 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

8727 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

8728 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

8729 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

8730 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

8731 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

8732 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

8733 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

8734 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

8735 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

8736 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

8737 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

8738 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

8739 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

8740 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

8741 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

8742 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY
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8743 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

8744 FLOAT Archive_Min[37 - Average 37] 1 RD_ONLY

8745 FLOAT Archive_Min[38 - Average 38] 1 RD_ONLY

8746 FLOAT Archive_Min[39 - Average 39] 1 RD_ONLY

8747 FLOAT Archive_Min[40 - Average 40] 1 RD_ONLY

8748 FLOAT Archive_Min[41 - Average 41] 1 RD_ONLY

8749 FLOAT Archive_Min[42 - Average 42] 1 RD_ONLY

8750 FLOAT Archive_Min[43 - Average 43] 1 RD_ONLY

8751 FLOAT Archive_Min[44 - Average 44] 1 RD_ONLY

8752 FLOAT Archive_Min[45 - Average 45] 1 RD_ONLY

8753 FLOAT Archive_Min[46 - Average 46] 1 RD_ONLY

8754 FLOAT Archive_Min[47 - Average 47] 1 RD_ONLY

8755 FLOAT Archive_Min[48 - Average 48] 1 RD_ONLY

8756 FLOAT Archive_Min[49 - Average 49] 1 RD_ONLY

8757 FLOAT Archive_Min[50 - Average 50] 1 RD_ONLY

8758 FLOAT Archive_Min[51 - Average 51] 1 RD_ONLY

8759 FLOAT Archive_Min[52 - Average 52] 1 RD_ONLY

8760 FLOAT Archive_Min[53 - Average 53] 1 RD_ONLY

8761 FLOAT Archive_Min[54 - Average 54] 1 RD_ONLY

8762 FLOAT Archive_Min[55 - Average 55] 1 RD_ONLY

8763 FLOAT Archive_Min[56 - Average 56] 1 RD_ONLY

8764 FLOAT Archive_Min[57 - Average 57] 1 RD_ONLY

8765 FLOAT Archive_Min[58 - Average 58] 1 RD_ONLY

8766 FLOAT Archive_Min[59 - Average 59] 1 RD_ONLY

8767 FLOAT Archive_Min[60 - Average 60] 1 RD_ONLY

8768 FLOAT Archive_Min[61 - Average 61] 1 RD_ONLY

8769 FLOAT Archive_Min[62 - Average 62] 1 RD_ONLY

8770 FLOAT Archive_Min[63 - Average 63] 1 RD_ONLY

8771 FLOAT Archive_Min[64 - Average 64] 1 RD_ONLY

8772 FLOAT Archive_Min[65 - Average 65] 1 RD_ONLY

8773 FLOAT Archive_Min[66 - Average 66] 1 RD_ONLY

8774 FLOAT Archive_Min[67 - Average 67] 1 RD_ONLY

8775 FLOAT Archive_Min[68 - Average 68] 1 RD_ONLY

8776 FLOAT Archive_Min[69 - Average 69] 1 RD_ONLY
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8777 FLOAT Archive_Min[70 - Average 70] 1 RD_ONLY

8778 FLOAT Archive_Min[71 - Average 71] 1 RD_ONLY

8779 FLOAT Archive_Min[72 - Average 72] 1 RD_ONLY

8780 FLOAT Archive_Min[73 - Average 73] 1 RD_ONLY

8781 FLOAT Archive_Min[74 - Average 74] 1 RD_ONLY

8782 FLOAT Archive_Min[75 - Average 75] 1 RD_ONLY

8783 FLOAT Archive_Min[76 - Average 76] 1 RD_ONLY

8784 FLOAT Archive_Min[77 - Average 77] 1 RD_ONLY

8785 FLOAT Archive_Min[78 - Average 78] 1 RD_ONLY

8786 FLOAT Archive_Min[79 - Average 79] 1 RD_ONLY

8787 FLOAT Archive_Min[80 - Average 80] 1 RD_ONLY

8788 FLOAT Archive_Min[81 - Average 81] 1 RD_ONLY

8789 FLOAT Archive_Min[82 - Average 82] 1 RD_ONLY

8790 FLOAT Archive_Min[83 - Average 83] 1 RD_ONLY

8791 FLOAT Archive_Min[84 - Average 84] 1 RD_ONLY

8792 FLOAT Archive_Min[85 - Average 85] 1 RD_ONLY

8793 FLOAT Archive_Min[86 - Average 86] 1 RD_ONLY

8794 FLOAT Archive_Min[87 - Average 87] 1 RD_ONLY

8795 FLOAT Archive_Min[88 - Average 88] 1 RD_ONLY

8796 FLOAT Archive_Min[89 - Average 89] 1 RD_ONLY

8797 FLOAT Archive_Min[90 - Average 90] 1 RD_ONLY

8798 FLOAT Archive_Min[91 - Average 91] 1 RD_ONLY

8799 FLOAT Archive_Min[92 - Average 92] 1 RD_ONLY

8800 FLOAT Archive_Min[93 - Average 93] 1 RD_ONLY

8801 FLOAT Archive_Min[94 - Average 94] 1 RD_ONLY

8802 FLOAT Archive_Min[95 - Average 95] 1 RD_ONLY

8803 FLOAT Archive_Min[96 - Average 96] 1 RD_ONLY

8804 FLOAT Archive_Min[97 - Average 97] 1 RD_ONLY

8805 FLOAT Archive_Min[98 - Average 98] 1 RD_ONLY

8806 FLOAT Archive_Min[99 - Average 99] 1 RD_ONLY

8807 FLOAT Archive_Min[100 - Average 100] 1 RD_ONLY

8808 FLOAT Archive_Min[101 - Average 101] 1 RD_ONLY

8809 FLOAT Archive_Min[102 - Average 102] 1 RD_ONLY

8810 FLOAT Archive_Min[103 - Average 103] 1 RD_ONLY
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8811 FLOAT Archive_Min[104 - Average 104] 1 RD_ONLY

8812 FLOAT Archive_Min[105 - Average 105] 1 RD_ONLY

8813 FLOAT Archive_Min[106 - Average 106] 1 RD_ONLY

8814 FLOAT Archive_Min[107 - Average 107] 1 RD_ONLY

8815 FLOAT Archive_Min[108 - Average 108] 1 RD_ONLY

8816 FLOAT Archive_Min[109 - Average 109] 1 RD_ONLY

8817 FLOAT Archive_Min[110 - Average 110] 1 RD_ONLY

8818 FLOAT Archive_Min[111 - Average 111] 1 RD_ONLY

8819 FLOAT Archive_Min[112 - Average 112] 1 RD_ONLY

8820 FLOAT Archive_Min[113 - Average 113] 1 RD_ONLY

8821 FLOAT Archive_Min[114 - Average 114] 1 RD_ONLY

8822 FLOAT Archive_Min[115 - Average 115] 1 RD_ONLY

8823 FLOAT Archive_Min[116 - Average 116] 1 RD_ONLY

8824 FLOAT Archive_Min[117 - Average 117] 1 RD_ONLY

8825 FLOAT Archive_Min[118 - Average 118] 1 RD_ONLY

8826 FLOAT Archive_Min[119 - Average 119] 1 RD_ONLY

8827 FLOAT Archive_Min[120 - Average 120] 1 RD_ONLY

8828 FLOAT Archive_Min[121 - Average 121] 1 RD_ONLY

8829 FLOAT Archive_Min[122 - Average 122] 1 RD_ONLY

8830 FLOAT Archive_Min[123 - Average 123] 1 RD_ONLY

8831 FLOAT Archive_Min[124 - Average 124] 1 RD_ONLY

8832 FLOAT Archive_Min[125 - Average 125] 1 RD_ONLY

8833 FLOAT Archive_Min[126 - Average 126] 1 RD_ONLY

8834 FLOAT Archive_Min[127 - Average 127] 1 RD_ONLY

8835 FLOAT Archive_Min[128 - Average 128] 1 RD_ONLY

8836 FLOAT Archive_Min[129 - Average 129] 1 RD_ONLY

8837 FLOAT Archive_Min[130 - Average 130] 1 RD_ONLY

8838 FLOAT Archive_Min[131 - Average 131] 1 RD_ONLY

8839 FLOAT Archive_Min[132 - Average 132] 1 RD_ONLY

8840 FLOAT Archive_Min[133 - Average 133] 1 RD_ONLY

8841 FLOAT Archive_Min[134 - Average 134] 1 RD_ONLY

8842 FLOAT Archive_Min[135 - Average 135] 1 RD_ONLY

8843 FLOAT Archive_Min[136 - Average 136] 1 RD_ONLY

8844 FLOAT Archive_Min[137 - Average 137] 1 RD_ONLY
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8845 FLOAT Archive_Min[138 - Average 138] 1 RD_ONLY

8846 FLOAT Archive_Min[139 - Average 139] 1 RD_ONLY

8847 FLOAT Archive_Min[140 - Average 140] 1 RD_ONLY

8848 FLOAT Archive_Min[141 - Average 141] 1 RD_ONLY

8849 FLOAT Archive_Min[142 - Average 142] 1 RD_ONLY

8850 FLOAT Archive_Min[143 - Average 143] 1 RD_ONLY

8851 FLOAT Archive_Min[144 - Average 144] 1 RD_ONLY

8852 FLOAT Archive_Min[145 - Average 145] 1 RD_ONLY

8853 FLOAT Archive_Min[146 - Average 146] 1 RD_ONLY

8854 FLOAT Archive_Min[147 - Average 147] 1 RD_ONLY

8855 FLOAT Archive_Min[148 - Average 148] 1 RD_ONLY

8856 FLOAT Archive_Min[149 - Average 149] 1 RD_ONLY

8857 FLOAT Archive_Min[150 - Average 150] 1 RD_ONLY

8858 FLOAT Archive_Min[151 - Average 151] 1 RD_ONLY

8859 FLOAT Archive_Min[152 - Average 152] 1 RD_ONLY

8860 FLOAT Archive_Min[153 - Average 153] 1 RD_ONLY

8861 FLOAT Archive_Min[154 - Average 154] 1 RD_ONLY

8862 FLOAT Archive_Min[155 - Average 155] 1 RD_ONLY

8863 FLOAT Archive_Min[156 - Average 156] 1 RD_ONLY

8864 FLOAT Archive_Min[157 - Average 157] 1 RD_ONLY

8865 FLOAT Archive_Min[158 - Average 158] 1 RD_ONLY

8866 FLOAT Archive_Min[159 - Average 159] 1 RD_ONLY

8867 FLOAT Archive_Min[160 - Average 160] 1 RD_ONLY

8868 FLOAT Archive_Min[161 - Average 161] 1 RD_ONLY

8869 FLOAT Archive_Min[162 - Average 162] 1 RD_ONLY

8870 FLOAT Archive_Min[163 - Average 163] 1 RD_ONLY

8871 FLOAT Archive_Min[164 - Average 164] 1 RD_ONLY

8872 FLOAT Archive_Min[165 - Average 165] 1 RD_ONLY

8873 FLOAT Archive_Min[166 - Average 166] 1 RD_ONLY

8874 FLOAT Archive_Min[167 - Average 167] 1 RD_ONLY

8875 FLOAT Archive_Min[168 - Average 168] 1 RD_ONLY

8876 FLOAT Archive_Min[169 - Average 169] 1 RD_ONLY

8877 FLOAT Archive_Min[170 - Average 170] 1 RD_ONLY

8878 FLOAT Archive_Min[171 - Average 171] 1 RD_ONLY
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Register # Data Type Variable Record # Access Format

8879 FLOAT Archive_Min[172 - Average 172] 1 RD_ONLY

8880 FLOAT Archive_Min[173 - Average 173] 1 RD_ONLY

8881 FLOAT Archive_Min[174 - Average 174] 1 RD_ONLY

8882 FLOAT Archive_Min[175 - Average 175] 1 RD_ONLY

8883 FLOAT Archive_Min[176 - Average 176] 1 RD_ONLY

8884 FLOAT Archive_Min[177 - Average 177] 1 RD_ONLY

8885 FLOAT Archive_Min[178 - Average 178] 1 RD_ONLY

8886 FLOAT Archive_Min[179 - Average 179] 1 RD_ONLY

8887 FLOAT Archive_Min[180 - Average 180] 1 RD_ONLY

8888 FLOAT Archive_Min[181 - Average 181] 1 RD_ONLY

8889 FLOAT Archive_Min[182 - Average 182] 1 RD_ONLY

8890 FLOAT Archive_Min[183 - Average 183] 1 RD_ONLY

8891 FLOAT Archive_Min[184 - Average 184] 1 RD_ONLY

8892 FLOAT Archive_Min[185 - Average 185] 1 RD_ONLY

8893 FLOAT Archive_Min[186 - Average 186] 1 RD_ONLY

8894 FLOAT Archive_Min[187 - Average 187] 1 RD_ONLY

8895 FLOAT Archive_Min[188 - Average 188] 1 RD_ONLY

8896 FLOAT Archive_Min[189 - Average 189] 1 RD_ONLY

8897 FLOAT Archive_Min[190 - Average 190] 1 RD_ONLY

8898 FLOAT Archive_Min[191 - Average 191] 1 RD_ONLY

8899 FLOAT Archive_Min[192 - Average 192] 1 RD_ONLY

8900 FLOAT Archive_Min[193 - Average 193] 1 RD_ONLY

8901 FLOAT Archive_Min[194 - Average 194] 1 RD_ONLY

8902 FLOAT Archive_Min[195 - Average 195] 1 RD_ONLY

8903 FLOAT Archive_Min[196 - Average 196] 1 RD_ONLY

8904 FLOAT Archive_Min[197 - Average 197] 1 RD_ONLY

8905 FLOAT Archive_Min[198 - Average 198] 1 RD_ONLY

8906 FLOAT Archive_Min[199 - Average 199] 1 RD_ONLY

8907 FLOAT Archive_Min[200 - Average 200] 1 RD_ONLY

8908 FLOAT Archive_Min[201 - Average 201] 1 RD_ONLY

8909 FLOAT Archive_Min[202 - Average 202] 1 RD_ONLY

8910 FLOAT Archive_Min[203 - Average 203] 1 RD_ONLY

8911 FLOAT Archive_Min[204 - Average 204] 1 RD_ONLY

8912 FLOAT Archive_Min[205 - Average 205] 1 RD_ONLY
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Register # Data Type Variable Record # Access Format

8913 FLOAT Archive_Min[206 - Average 206] 1 RD_ONLY

8914 FLOAT Archive_Min[207 - Average 207] 1 RD_ONLY

8915 FLOAT Archive_Min[208 - Average 208] 1 RD_ONLY

8916 FLOAT Archive_Min[209 - Average 209] 1 RD_ONLY

8917 FLOAT Archive_Min[210 - Average 210] 1 RD_ONLY

8918 FLOAT Archive_Min[211 - Average 211] 1 RD_ONLY

8919 FLOAT Archive_Min[212 - Average 212] 1 RD_ONLY

8920 FLOAT Archive_Min[213 - Average 213] 1 RD_ONLY

8921 FLOAT Archive_Min[214 - Average 214] 1 RD_ONLY

8922 FLOAT Archive_Min[215 - Average 215] 1 RD_ONLY

8923 FLOAT Archive_Min[216 - Average 216] 1 RD_ONLY

8924 FLOAT Archive_Min[217 - Average 217] 1 RD_ONLY

8925 FLOAT Archive_Min[218 - Average 218] 1 RD_ONLY

8926 FLOAT Archive_Min[219 - Average 219] 1 RD_ONLY

8927 FLOAT Archive_Min[220 - Average 220] 1 RD_ONLY

8928 FLOAT Archive_Min[221 - Average 221] 1 RD_ONLY

8929 FLOAT Archive_Min[222 - Average 222] 1 RD_ONLY

8930 FLOAT Archive_Min[223 - Average 223] 1 RD_ONLY

8931 FLOAT Archive_Min[224 - Average 224] 1 RD_ONLY

8932 FLOAT Archive_Min[225 - Average 225] 1 RD_ONLY

8933 FLOAT Archive_Min[226 - Average 226] 1 RD_ONLY

8934 FLOAT Archive_Min[227 - Average 227] 1 RD_ONLY

8935 FLOAT Archive_Min[228 - Average 228] 1 RD_ONLY

8936 FLOAT Archive_Min[229 - Average 229] 1 RD_ONLY

8937 FLOAT Archive_Min[230 - Average 230] 1 RD_ONLY

8938 FLOAT Archive_Min[231 - Average 231] 1 RD_ONLY

8939 FLOAT Archive_Min[232 - Average 232] 1 RD_ONLY

8940 FLOAT Archive_Min[233 - Average 233] 1 RD_ONLY

8941 FLOAT Archive_Min[234 - Average 234] 1 RD_ONLY

8942 FLOAT Archive_Min[235 - Average 235] 1 RD_ONLY

8943 FLOAT Archive_Min[236 - Average 236] 1 RD_ONLY

8944 FLOAT Archive_Min[237 - Average 237] 1 RD_ONLY

8945 FLOAT Archive_Min[238 - Average 238] 1 RD_ONLY

8946 FLOAT Archive_Min[239 - Average 239] 1 RD_ONLY
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Register # Data Type Variable Record # Access Format

8947 FLOAT Archive_Min[240 - Average 240] 1 RD_ONLY

8948 FLOAT Archive_Min[241 - Average 241] 1 RD_ONLY

8949 FLOAT Archive_Min[242 - Average 242] 1 RD_ONLY

8950 FLOAT Archive_Min[243 - Average 243] 1 RD_ONLY

8951 FLOAT Archive_Min[244 - Average 244] 1 RD_ONLY

8952 FLOAT Archive_Min[245 - Average 245] 1 RD_ONLY

8953 FLOAT Archive_Min[246 - Average 246] 1 RD_ONLY

8954 FLOAT Archive_Min[247 - Average 247] 1 RD_ONLY

8955 FLOAT Archive_Min[248 - Average 248] 1 RD_ONLY

8956 FLOAT Archive_Min[249 - Average 249] 1 RD_ONLY

8957 FLOAT Archive_Min[250 - Average 250] 1 RD_ONLY

8958 FLOAT Unused RD_ONLY

8959 FLOAT Unused RD_ONLY

8960 FLOAT Unused RD_ONLY

8961 FLOAT Unused RD_ONLY

8962 FLOAT Unused RD_ONLY

8963 FLOAT Clear All Alarms RD_WR

8964 FLOAT Acknowledge All Alarms RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY
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Register # Data Type Variable Record # Access Format

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyser Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

3001..3016/3017..3032 (Component Code): Component Codes for components whose
mole % results are available in Registers 7001..7016.
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3033 (Run Time in 1/30th Sec): Current GC Run Time. If Run Time = 200 seconds, then
this register reads 6000.

3034 (Last Analy_Stream Number): Stream that was analyzed last.

3035 (Last Analy_CDT Stream Mask):

• Bit 0: Holds 1 if Stream 1 uses CDT1, 0 otherwise

• Bit 1: Holds 1 if Stream 2 uses CDT1, 0 otherwise

• Bit 2: Holds 1 if Stream 3 uses CDT1, 0 otherwise

• ...

• Bit 15: Holds 1 if Stream 16 uses CDT1, 0 otherwise

3036..3040 (Current GC Time): Holds the current GC Time. Can be written to update GC
date/time.

3041..3045 (Last Analy_Start Time): Sample inject time for the stream that was analyzed
last.

3046..3047 (Alarm Bitmaps): Boolean alarm conditions. 1 – Alarm Active, 0 – Alarm
Inactive.

3046 Bit 14 (Analyzer Failure): This bit is set to 1 if any of the Carrier Pressure/Low
Pressure Limit Switch alarms are active.

3048 (Stream 1 Active Low Limit Alarms):

• Bit 0: Holds 1 if, User Limit Alarm 1 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 1 is not
associated with Stream 1 or no Low Limit alarm condition exists.

• Bit 1: Holds 1 if, User Limit Alarm 2 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 2 is not
associated with Stream 1 or no Low Limit alarm condition exists.

• ...

• Bit 15: Holds 1 if, User Limit Alarm 16 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 16 is not
associated with Stream 1 or no Low Limit alarm condition exists.

3049 (Stream 1 Active High Limit Alarms):

• Bit 0: Holds 1 if, User Limit Alarm 1 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 1 is not
associated with Stream 1 or no High Limit alarm condition exists.

• Bit 1: Holds 1 if, User Limit Alarm 2 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 2 is not
associated with Stream 1 or no High Limit alarm condition exists.

• ...

• Bit 15: Holds 1 if, User Limit Alarm 16 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 16 is not
associated with Stream 1 or no High Limit alarm condition exists.
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3050 .. 3057 (Stream 2..5 Active High/Low Limit Alarms): These registers hold limit
alarm status for Streams 2 through 5. The implementation of these registers is similar to
the Stream 1 Active Low/High Alarms (Registers 3048/3049).

3058 (New Data Flag): This flag is set to 1 when new data is available in the Last Analysis
Results registers. This is a read-write register, so a Modbus Master can clear the flag once
the new results are read.

3059 (Anly/Calib Flag): This flag is set to 1 to indicate the last analysis results were from
an Analysis run. This flag is set to 0 to indicate the last analysis results were from a
Calibration run. A Modbus Master can use Registers 3058 and 3059 to determine when
new analysis results are available on the GC.

5001 (Last Analy_Cycle Time (1/30th sec)): Cycle time for last analysis in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

5002 (Last Cal_Cycle Time (1/30th sec)): Cycle time for last calibration run in 1/30th
seconds. For example, if cycle time is 300 seconds, this register reads 9000.

7001..7016 (Last Analy Mole %): These registers hold the mole % Results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001..3016 which contain the component codes.

7017..7032 (Last Analy Weight %): These registers hold the weight % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001..3016 which contain the component codes.

7033..7039, 7054: Last analysis stream results

7040..7044: User calculation results 1..5

7055..7069: Current running average for Averages 1 through 15

7070..7084: Most recent archive average for Averages 1 through 15

7085..7086: Current analog input values for Analog Input 1 and 2

7087..7094: Last Calibration Stream Results

7095..7110/7111..7126: Response factors used for last analysis run

7127..7162: Current running average for Averages 1 through 36

7163..7198: Maximum sample value during current averaging period for Averages 1
through 36

7199..7234: Minimum sample value during current averaging period for Averages 1
through 36

7235..7270: Most recent archived average for Averages 1 through 36

7271..7306: Maximum sample value in the most recent archived average for Averages 1
through 36.

7307..7342: Minimum sample value in the most recent archived average for Averages 1
through 36.

7343..7378: Second most recent archived average for Averages 1 through 36
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7379..7414: Maximum sample value in the second most recent archived average for
Averages 1 through 36.

7415..7450: Minimum sample value in the second most recent archived average for
Averages 1 through 36.

7451..7486: Third most recent archived average for Averages 1 through 36

7487..7522: Maximum sample value in the third most recent archived average for
Averages 1 through 36.

7523..7558: Minimum sample value in the third most recent archived average for
Averages 1 through 36.

7560..7563/7564..7567: Analog Input Current Value for AI 1 through 4.

7621..7646: Stream 1 results

7651..7676: Stream 2 results

7681..7706: Stream 3 results

7711..7736: Stream 4 results

7741..7766: Stream 5 results

7771..7796: Stream 6 results

7801..7826: Stream 7 results

7831..7856: Stream 8 results

7861..7886: Stream 9 results

7891..7916: Stream 10 results

7921..7946: Stream 11 results

7951..7976: Stream 12 results

7996..8006: Remote control registers

8200..8449: Most recent archived average for Averages 1 through 250.

8454..8703: Maximum sample value in the most recent archived average for Averages 1
through 250.

8708..8957: Minimum sample value in the most recent archived average for Averages 1
through 250.

8963 (Clear All Alarms): Write 1 to this register to clear all active alarms.

8964 (Acknowledge All Alarms): Write 1 to this register to acknowledge all alarms.

9006..9011: GC System Date/Time Read/Write Registers.

9013 (Modbus Id[ Port 0]): Modbus ID for Serial Port 0.

9014 (Site ID): GC Site ID read/write register.

9022 (Analysis Time): Analysis time

9024 (Cycle Time): Cycle time
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9026 (Run Time): Run rime

9028 (Current Stream): Stream number

9030 (Analyzer Control): Read-write remote control register (9030)

9032 (GC Calibrating): Tells you if the GC is calibrating. A value of 1 means GC is
calibrating, 0 otherwise.

9034 (Active Alarm Flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck Alarm Flag): Tells you if the GC has any unacknowledged alarms. A value of
1 indicates that there are unacknowledged alarms, 0 otherwise.

9036..9040 (Hourly Average Reset Time): Date/time when hourly average results were
archived.

9041..9045 (Daily Average Reset Time): Date/time when daily average results were
archived.

9046..9047 (Weekly Average Reset Time): Date/time when weekly average results were
archived.

9051..9055 (Monthly Average Reset Time): Date/time when monthly average results
were archived.

9056..9060 (Variable Average Reset Time): Date/time when variable average results
were archived.
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B.3 SIM_2251 C9 + Hydrocarbon Dewpoint map
This map file is an extension of the SIM2251 map file with the following additional
registers.

Register # Data type Variable Access

3101 INT 1 - Stream 1_Dew Status 1 RD_ONLY

3102 INT 1 - Stream 1_Dew Status 2 RD_ONLY

3103 INT 1 - Stream 1_Dew Status 3 RD_ONLY

3104 INT 1 - Stream 1_Dew Status 4 RD_ONLY

3105 INT 1 - Stream 1_Cri Status RD_ONLY

3106 INT 2 - Calibration_Dew Status 1 RD_ONLY

3107 INT 2 - Calibration_Dew Status 2 RD_ONLY

3108 INT 2 - Calibration_Dew Status 3 RD_ONLY

3109 INT 2 - Calibration_Dew Status 4 RD_ONLY

3110 INT 2 - Calibration_Cri Status RD_ONLY

3111 INT 3 - Stream 3_Dew Status 1 RD_ONLY

3112 INT 3 - Stream 3_Dew Status 2 RD_ONLY

3113 INT 3 - Stream 3_Dew Status 3 RD_ONLY

3114 INT 3 - Stream 3_Dew Status 4 RD_ONLY

3115 INT 3 - Stream 3_Cri Status RD_ONLY

3116 INT 4 - Stream 4_Dew Status 1 RD_ONLY

3117 INT 4 - Stream 4_Dew Status 2 RD_ONLY

3118 INT 4 - Stream 4_Dew Status 3 RD_ONLY

3119 INT 4 - Stream 4_Dew Status 4 RD_ONLY

3120 INT 4 - Stream 4_Cri Status RD_ONLY

3121 INT 5 - Stream 5_Dew Status 1 RD_ONLY

3122 INT 5 - Stream 5_Dew Status 2 RD_ONLY

3123 INT 5 - Stream 5_Dew Status 3 RD_ONLY

3124 INT 5 - Stream 5_Dew Status 4 RD_ONLY

3125 INT 5 - Stream 5_Cri Status RD_ONLY

3126 INT 6 - Stream 6_Dew Status 1 RD_ONLY

3127 INT 6 - Stream 6_Dew Status 2 RD_ONLY

3128 INT 6 - Stream 6_Dew Status 3 RD_ONLY

3129 INT 6 - Stream 6_Dew Status 4 RD_ONLY

3130 INT 6 - Stream 6_Cri Status RD_ONLY

3131 INT 7 - Stream 7_Dew Status 1 RD_ONLY
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Register # Data type Variable Access

3132 INT 7 - Stream 7_Dew Status 2 RD_ONLY

3133 INT 7 - Stream 7_Dew Status 3 RD_ONLY

3134 INT 7 - Stream 7_Dew Status 4 RD_ONLY

3135 INT 7 - Stream 7_Cri Status RD_ONLY

3136 INT 8 - Stream 8_Dew Status 1 RD_ONLY

3137 INT 8 - Stream 8_Dew Status 2 RD_ONLY

3138 INT 8 - Stream 8_Dew Status 3 RD_ONLY

3139 INT 8 - Stream 8_Dew Status 4 RD_ONLY

3140 INT 8 - Stream 8_Cri Status RD_ONLY

8100 FLOAT Dewpoint Configuration 1_Pressure 1 RD_WR

8101 FLOAT Dewpoint Configuration 1_Pressure 2 RD_WR

8102 FLOAT Dewpoint Configuration 1_Pressure 3 RD_WR

8103 FLOAT Dewpoint Configuration 1_Pressure 4 RD_WR

8104 FLOAT Dewpoint Configuration 2_Pressure 1 RD_WR

8105 FLOAT Dewpoint Configuration 2_Pressure 2 RD_WR

8106 FLOAT Dewpoint Configuration 3_Pressure 1 RD_WR

8107 FLOAT Dewpoint Configuration 3_Pressure 2 RD_WR

8108 FLOAT Dewpoint Configuration 4_Pressure 1 RD_WR

8109 FLOAT Dewpoint Configuration 4_Pressure 2 RD_WR

8110 FLOAT 1 - Stream 1_Dewpoint Temp 1 RD_ONLY

8111 FLOAT 1 - Stream 1_Dewpoint Temp 2 RD_ONLY

8112 FLOAT 1 - Stream 1_Dewpoint Temp 3 RD_ONLY

8113 FLOAT 1 - Stream 1_Dewpoint Temp 4 RD_ONLY

8114 FLOAT 1 - Stream 1_Dewpoint Pres 1 RD_ONLY

8115 FLOAT 1 - Stream 1_Dewpoint Pres 2 RD_ONLY

8116 FLOAT 1 - Stream 1_Dewpoint Pres 3 RD_ONLY

8117 FLOAT 1 - Stream 1_Dewpoint Pres 4 RD_ONLY

8118 FLOAT 1 - Stream 1_CricondenTherm Temp RD_ONLY

8119 FLOAT 1 - Stream 1_CricondenTherm Pres RD_ONLY

8120 FLOAT 2 - Calibration_Dewpoint Temp 1 RD_ONLY

8121 FLOAT 2 - Calibration_Dewpoint Temp 2 RD_ONLY

8122 FLOAT 2 - Calibration_Dewpoint Temp 3 RD_ONLY

8123 FLOAT 2 - Calibration_Dewpoint Temp 4 RD_ONLY

8124 FLOAT 2 - Calibration_Dewpoint Pres 1 RD_ONLY
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Register # Data type Variable Access

8125 FLOAT 2 - Calibration_Dewpoint Pres 2 RD_ONLY

8126 FLOAT 2 - Calibration_Dewpoint Pres 3 RD_ONLY

8127 FLOAT 2 - Calibration_Dewpoint Pres 4 RD_ONLY

8128 FLOAT 2 - Calibration_CricondenTherm Temp RD_ONLY

8129 FLOAT 2 - Calibration_CricondenTherm Pres RD_ONLY

8130 FLOAT 3 - Stream 3_Dewpoint Temp 1 RD_ONLY

8131 FLOAT 3 - Stream 3_Dewpoint Temp 2 RD_ONLY

8132 FLOAT 3 - Stream 3_Dewpoint Temp 3 RD_ONLY

8133 FLOAT 3 - Stream 3_Dewpoint Temp 4 RD_ONLY

8134 FLOAT 3 - Stream 3_Dewpoint Pres 1 RD_ONLY

8135 FLOAT 3 - Stream 3_Dewpoint Pres 2 RD_ONLY

8136 FLOAT 3 - Stream 3_Dewpoint Pres 3 RD_ONLY

8137 FLOAT 3 - Stream 3_Dewpoint Pres 4 RD_ONLY

8138 FLOAT 3 - Stream 3_CricondenTherm Temp RD_ONLY

8139 FLOAT 3 - Stream 3_CricondenTherm Pres RD_ONLY

8140 FLOAT 4 - Stream 4_Dewpoint Temp 1 RD_ONLY

8141 FLOAT 4 - Stream 4_Dewpoint Temp 2 RD_ONLY

8142 FLOAT 4 - Stream 4_Dewpoint Temp 3 RD_ONLY

8143 FLOAT 4 - Stream 4_Dewpoint Temp 4 RD_ONLY

8144 FLOAT 4 - Stream 4_Dewpoint Pres 1 RD_ONLY

8145 FLOAT 4 - Stream 4_Dewpoint Pres 2 RD_ONLY

8146 FLOAT 4 - Stream 4_Dewpoint Pres 3 RD_ONLY

8147 FLOAT 4 - Stream 4_Dewpoint Pres 4 RD_ONLY

8148 FLOAT 4 - Stream 4_CricondenTherm Temp RD_ONLY

8149 FLOAT 4 - Stream 4_CricondenTherm Pres RD_ONLY

8150 FLOAT 5 - Stream 5_Dewpoint Temp 1 RD_ONLY

8151 FLOAT 5 - Stream 5_Dewpoint Temp 2 RD_ONLY

8152 FLOAT 5 - Stream 5_Dewpoint Temp 3 RD_ONLY

8153 FLOAT 5 - Stream 5_Dewpoint Temp 4 RD_ONLY

8154 FLOAT 5 - Stream 5_Dewpoint Pres 1 RD_ONLY

8155 FLOAT 5 - Stream 5_Dewpoint Pres 2 RD_ONLY

8156 FLOAT 5 - Stream 5_Dewpoint Pres 3 RD_ONLY

8157 FLOAT 5 - Stream 5_Dewpoint Pres 4 RD_ONLY

8158 FLOAT 5 - Stream 5_CricondenTherm Temp RD_ONLY
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Register # Data type Variable Access

8159 FLOAT 5 - Stream 5_CricondenTherm Pres RD_ONLY

8160 FLOAT 6 - Stream 6_Dewpoint Temp 1 RD_ONLY

8161 FLOAT 6 - Stream 6_Dewpoint Temp 2 RD_ONLY

8162 FLOAT 6 - Stream 6_Dewpoint Temp 3 RD_ONLY

8163 FLOAT 6 - Stream 6_Dewpoint Temp 4 RD_ONLY

8164 FLOAT 6 - Stream 6_Dewpoint Pres 1 RD_ONLY

8165 FLOAT 6 - Stream 6_Dewpoint Pres 2 RD_ONLY

8166 FLOAT 6 - Stream 6_Dewpoint Pres 3 RD_ONLY

8167 FLOAT 6 - Stream 6_Dewpoint Pres 4 RD_ONLY

8168 FLOAT 6 - Stream 6_CricondenTherm Temp RD_ONLY

8169 FLOAT 6 - Stream 6_CricondenTherm Pres RD_ONLY

8170 FLOAT 7 - Stream 7_Dewpoint Temp 1 RD_ONLY

8171 FLOAT 7 - Stream 7_Dewpoint Temp 2 RD_ONLY

8172 FLOAT 7 - Stream 7_Dewpoint Temp 3 RD_ONLY

8173 FLOAT 7 - Stream 7_Dewpoint Temp 4 RD_ONLY

8174 FLOAT 7 - Stream 7_Dewpoint Pres 1 RD_ONLY

8175 FLOAT 7 - Stream 7_Dewpoint Pres 2 RD_ONLY

8176 FLOAT 7 - Stream 7_Dewpoint Pres 3 RD_ONLY

8177 FLOAT 7 - Stream 7_Dewpoint Pres 4 RD_ONLY

8178 FLOAT 7 - Stream 7_CricondenTherm Temp RD_ONLY

8179 FLOAT 7 - Stream 7_CricondenTherm Pres RD_ONLY

8180 FLOAT 8 - Stream 8_Dewpoint Temp 1 RD_ONLY

8181 FLOAT 8 - Stream 8_Dewpoint Temp 2 RD_ONLY

8182 FLOAT 8 - Stream 8_Dewpoint Temp 3 RD_ONLY

8183 FLOAT 8 - Stream 8_Dewpoint Temp 4 RD_ONLY

8184 FLOAT 8 - Stream 8_Dewpoint Pres 1 RD_ONLY

8185 FLOAT 8 - Stream 8_Dewpoint Pres 2 RD_ONLY

8186 FLOAT 8 - Stream 8_Dewpoint Pres 3 RD_ONLY

8187 FLOAT 8 - Stream 8_Dewpoint Pres 4 RD_ONLY

8188 FLOAT 8 - Stream 8_CricondenTherm Temp RD_ONLY

8189 FLOAT 8 - Stream 8_CricondenTherm Pres RD_ONLY
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3101...3140 (Dewpoint status): Dewpoint calculation status for Streams 1 to 8 (read
only). Here are the possible values for these registers and their descriptions.

8100...8109 (Dewpoint pressure setpoints): Pressure setpoints at which dewpoint
calculation results are performed (read-write). The setpoint can be changed through a
Modbus Master.

8110...8189 (Dewpoint results): Dewpoint temperature and pressure, cricondentherm
temperature and pressure.

Value Description Remarks

0 OK Calculation is valid

1 Error 1 No valid solution to gas equation found

2 Error 2 Mole% values are all zero – if analysis is OK check Numeric data

3 Error 3 Calculated fugacities too large – probably unrealistic composition

4 Error 4 Single phase – no liquid phase at this pressure

5 Error 5 Pressure value (from operator or Modbus) is negative

6 Error 6 (Cricondentherm only) – no maximum found – next analysis
normally OK

7 Error 7 Single phase – no gas phase at this pressure

B.4 User Modbus mapping template
Register # Data type Variable Access Format

1 BOOLEAN Unused RD_ONLY

2 BOOLEAN Unused RD_ONLY

3 BOOLEAN Unused RD_ONLY

4 BOOLEAN Unused RD_ONLY

5 BOOLEAN Unused RD_ONLY

6 BOOLEAN Unused RD_ONLY

7 BOOLEAN Unused RD_ONLY

8 BOOLEAN Unused RD_ONLY

9 BOOLEAN Unused RD_ONLY

10 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 1 Out
Of Range

RD_ONLY

11 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 2 Out
Of Range

RD_ONLY

12 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 3 Out
Of Range

RD_ONLY

13 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 4 Out
Of Range

RD_ONLY
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Register # Data type Variable Access Format

14 BOOLEAN Unused RD_ONLY

15 BOOLEAN Unused RD_ONLY

16 BOOLEAN System Alarm_Alarm On - Current Analysis_Flame Out RD_ONLY

17 BOOLEAN System Alarm_Alarm On - Current Analysis_Warm Start
Failed

RD_ONLY

18 BOOLEAN Unused RD_ONLY

19 BOOLEAN Calibration Failed RD_ONLY

20 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Carrier
Pressure 1

RD_ONLY

21 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Carrier
Pressure 2

RD_ONLY

22 BOOLEAN System Alarm_Alarm On - Current Analysis_No Sample
Flow 1

RD_ONLY

23 BOOLEAN System Alarm_Alarm On - Current Analysis_No Sample
Flow 2

RD_ONLY

24 BOOLEAN System Alarm_Alarm On - Current Analysis_Maintenance
Mode

RD_ONLY

25 BOOLEAN Calibration Failed RD_ONLY

26 BOOLEAN Unused RD_ONLY

27 BOOLEAN Unused RD_ONLY

28 BOOLEAN Unused RD_ONLY

29 BOOLEAN Unused RD_ONLY

30 BOOLEAN Unused RD_ONLY

31 BOOLEAN System Alarm_Alarm On - Current Analysis_Detector 1
Scaling Factor Failure

RD_ONLY

32 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
1 High Signal

RD_ONLY

33 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
2 High Signal

RD_ONLY

34 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
3 High Signal

RD_ONLY

35 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
4 High Signal

RD_ONLY

36 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
5 High Signal

RD_ONLY

37 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
6 High Signal

RD_ONLY

38 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
7 High Signal

RD_ONLY
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Register # Data type Variable Access Format

39 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
8 High Signal

RD_ONLY

40 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
9 High Signal

RD_ONLY

41 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
10 High Signal

RD_ONLY

42 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
11 High Signal

RD_ONLY

43 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
12 High Signal

RD_ONLY

44 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
13 High Signal

RD_ONLY

45 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
14 High Signal

RD_ONLY

46 BOOLEAN Unused RD_ONLY

47 BOOLEAN Unused RD_ONLY

48 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
1 Low Signal

RD_ONLY

49 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
2 Low Signal

RD_ONLY

50 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
3 Low Signal

RD_ONLY

51 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
4 Low Signal

RD_ONLY

52 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
5 Low Signal

RD_ONLY

53 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
6 Low Signal

RD_ONLY

54 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
7 Low Signal

RD_ONLY

55 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
8 Low Signal

RD_ONLY

56 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
9 Low Signal

RD_ONLY

57 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
10 Low Signal

RD_ONLY

58 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
11 Low Signal

RD_ONLY

59 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
12 Low Signal

RD_ONLY

60 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
13 Low Signal

RD_ONLY
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Register # Data type Variable Access Format

61 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
14 Low Signal

RD_ONLY

62 BOOLEAN Unused RD_ONLY

63 BOOLEAN Unused RD_ONLY

64 BOOLEAN Analyzer Failure RD_ONLY

65 BOOLEAN System Alarm_Alarm On - Current Analysis_Power Failure RD_ONLY

66 BOOLEAN Unused RD_ONLY

67 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Battery
Voltage

RD_ONLY

68 BOOLEAN System Alarm_Alarm On - Current Analysis_GC Idle RD_ONLY

69 BOOLEAN Unused RD_ONLY

70 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 1
High Signal

RD_ONLY

71 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 2
High Signal

RD_ONLY

72 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 3
High Signal

RD_ONLY

73 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 4
High Signal

RD_ONLY

74 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 1
Low Signal

RD_ONLY

75 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 2
Low Signal

RD_ONLY

76 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 3
Low Signal

RD_ONLY

77 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 4
Low Signal

RD_ONLY

78 BOOLEAN Unused RD_ONLY

79 BOOLEAN Unused RD_ONLY

80 BOOLEAN Unused RD_ONLY

81 BOOLEAN Unused RD_ONLY

82 BOOLEAN Unused RD_ONLY

83 BOOLEAN Unused RD_ONLY

84 BOOLEAN Unused RD_ONLY

85 BOOLEAN Alarm On[1 - Alarm 1] RD_ONLY

86 BOOLEAN Alarm On[2 - Alarm 2] RD_ONLY

87 BOOLEAN Alarm On[3 - Alarm 3] RD_ONLY

88 BOOLEAN Alarm On[4 - Alarm 4] RD_ONLY
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Register # Data type Variable Access Format

89 BOOLEAN Alarm On[5 - Alarm 5] RD_ONLY

90 BOOLEAN Alarm On[6 - Alarm 6] RD_ONLY

91 BOOLEAN Alarm On[7 - Alarm 7] RD_ONLY

92 BOOLEAN Alarm On[8 - Alarm 8] RD_ONLY

93 BOOLEAN Alarm On[9 - Alarm 9] RD_ONLY

94 BOOLEAN Alarm On[10 - Alarm 10] RD_ONLY

95 BOOLEAN Alarm On[11 - Alarm 11] RD_ONLY

96 BOOLEAN Alarm On[12 - Alarm 12] RD_ONLY

97 BOOLEAN Alarm On[13 - Alarm 13] RD_ONLY

98 BOOLEAN Alarm On[14 - Alarm 14] RD_ONLY

99 BOOLEAN Alarm On[15 - Alarm 15] RD_ONLY

100 BOOLEAN Alarm On[16 - Alarm 16] RD_ONLY

101 BOOLEAN Alarm On[17 - Alarm 17] RD_ONLY

102 BOOLEAN Alarm On[18 - Alarm 18] RD_ONLY

103 BOOLEAN Alarm On[19 - Alarm 19] RD_ONLY

104 BOOLEAN Alarm On[20 - Alarm 20] RD_ONLY

105 BOOLEAN 1 - Stream 1_Stream Toggle RD_ONLY

106 BOOLEAN 2 - Stream 2_Stream Toggle RD_ONLY

107 BOOLEAN 3 - Stream 3_Stream Toggle RD_ONLY

108 BOOLEAN 4 - Stream 4_Stream Toggle RD_ONLY

109 BOOLEAN 5 - Stream 5_Stream Toggle RD_ONLY

110 BOOLEAN 6 - Stream 6_Stream Toggle RD_ONLY

111 BOOLEAN 7 - Stream 7_Stream Toggle RD_ONLY

112 BOOLEAN 8 - Stream 8_Stream Toggle RD_ONLY

113 BOOLEAN Current Value[1 - Discrete Output 1] RD_ONLY

114 BOOLEAN Current Value[2 - Discrete Output 2] RD_ONLY

115 BOOLEAN Current Value[3 - Discrete Output 3] RD_ONLY

116 BOOLEAN Current Value[4 - Discrete Output 4] RD_ONLY

117 BOOLEAN Current Value[5 - Discrete Output 5] RD_ONLY

118 BOOLEAN Switch[1 - Discrete Output 1] RD_WR

119 BOOLEAN Switch[2 - Discrete Output 2] RD_WR

120 BOOLEAN Switch[3 - Discrete Output 3] RD_WR

121 BOOLEAN Switch[4 - Discrete Output 4] RD_WR

122 BOOLEAN Switch[5 - Discrete Output 5] RD_WR
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Register # Data type Variable Access Format

123 INT Switch[1 - Discrete Output 1] RD_WR

124 INT Switch[2 - Discrete Output 2] RD_WR

125 INT Switch[3 - Discrete Output 3] RD_WR

126 INT Switch[4 - Discrete Output 4] RD_WR

127 INT Switch[5 - Discrete Output 5] RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyzer Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY
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Register # Data type Variable Access Format

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

10...13 (Heater 1...4 out of range): 1 if heater is out of range, 0 otherwise

16 (FID flame out): 1 if FID flame has gone out, 0 otherwise

17 (Warmstart failed): 1 if GC warmstart was unable to stabilize temperature/pressure in
analytical oven within pre-defined warmstart duration, 0 otherwise

19 (Calibration failed): 1 if last calibration sequence failed, 0 otherwise

20...21 (Low carrier pressure 1...2): 1 if the carrier pressure is low, 0 otherwise

22...23 (No sample flow 1...2): 1 if there is no sample flow in the sample conditioning
system, 0 otherwise

24 (Maintenance mode): 1 if a technician has put the GC into Maintenance mode to
perform repairs, 0 otherwise

25 (Calibration failed): 1 if last calibration sequence failed, 0 otherwise

31 (Preamp scaling factor): 1 if there is an electronics failure on the preamp board, 0
otherwise

32...45 (Analog output high signal 1...14): 1 if the variable associated with analog output
has a value that is greater than the zero scale value assigned to the analog output, 0
otherwise
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48...61 (Analog output low signal 1...14): 1 if the variable associated with analog output
has a value that is lesser than the zero scale value assigned to the analog output, 0
otherwise

64 (Analyzer failure): 1 indicates that the carrier pressure is either too low or the GC
cannot control the carrier pressure to the desired setpoint, 0 otherwise

65 (Power failure): 1 indicates that the GC lost power and is currently executing the
warmstart sequence, 0 otherwise

67 (Low battery voltage): 1 indicates that the battery used to back up configuration and
real-time clock on the main CPU board is low, 0 otherwise

68 (GC idle): 1 indicates that the GC is not performing an analysis, 0 otherwise

Note
If the GC is halted by the operator using MON2020, then the Idle alarm is not raised. It is
raised only if the GC goes into the Idle state due to alarm condition that has the Halt on
Alarm flag enabled.

Note
If the GC is halted by the operator using MON2020 and if he disconnects from the GC
without restarting normal operation, then the GC Idle alarm is raised.

70...77 (Analog input low signal 1...8): 1 indicates that the analog input is sensing a
current that is lower than 4 mA, 0 otherwise

85...104 (User limit alarm 1...20): 1 indicates that the user limit alarm is active, 0
otherwise

105...112 (Stream toggle 1...5): Each time new results are available for a particular
stream, this flag is toggled.

113...117 (Discrete output 1...5 current value): Current state of the discrete output, 1
indicates that it is On; 0 indicates it is Off.

118...122 (Switch discrete output 1...5): Read/write register for changing the state of the
discrete output. Write 1 to this register to set output state to On, 0 to set output state to
Off.

123...127 (Switch discrete output 1...5): Read/write register for changing the state of the
discrete output. Write 1 to this register to set output state to On, 0 to set output state to
Off, and 2 to set the register to Auto mode.

9006...9011: GC system date/time read-write registers

9013 (Modbus ID [Port 0]): Modbus ID for serial port 0

9014 (Site ID): GC site ID read/write register

9022 (Analysis time): Analysis time

9024 (Cycle time): Cycle time

9026 (Run time): Run time

9028 (Current stream): Stream number

9030 (Analyzer control): User Modbus mapping template
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9032 (GC calibrating): Tells you if the GC is calibrating. A value of 1 means GC is
calibrating, 0 otherwise.

9034 (Active alarm flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck alarm flag): Tells you if the GC has any unacknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036...9040 (Hourly average reset time): Date/time when hourly average results was
archived

9041...9045 (Daily average reset time): Date/time when daily average results was
archived

9046...9047 (Weekly average reset time): Date/time when weekly average result was
archived

9051...9055 (Monthly average reset time): Date/time when monthly average results was
archived

9056...9060 (Variable average reset time): Date/time when variable average results was
archived

B.5 SIM_2251 UK (with ISO results)
Register # Data type Variable Record # Access Format

1001 BOOLEAN Current Value[1 - Discrete Output 1] RD_ONLY

1002 BOOLEAN Current Value[2 - Discrete Output 2] RD_ONLY

1003 BOOLEAN Current Value[3 - Discrete Output 3] RD_ONLY

1004 BOOLEAN Current Value[4 - Discrete Output 4] RD_ONLY

1005 BOOLEAN Current Value[5 - Discrete Output 5] RD_ONLY

1006 BOOLEAN Current Value[1 - Discrete Input 1] RD_ONLY

1007 BOOLEAN Current Value[2 - Discrete Input 2] RD_ONLY

1008 BOOLEAN Current Value[3 - Discrete Input 3] RD_ONLY

1009 BOOLEAN Current Value[4 - Discrete Input 4] RD_ONLY

1010 BOOLEAN Current Value[5 - Discrete Input 5] RD_ONLY

3001 INT Last Analy_Component Code(UK)[1 - Component 1] RD_ONLY

3002 INT Last Analy_Component Code(UK)[2 - Component 2] RD_ONLY

3003 INT Last Analy_Component Code(UK)[3 - Component 3] RD_ONLY

3004 INT Last Analy_Component Code(UK)[4 - Component 4] RD_ONLY

3005 INT Last Analy_Component Code(UK)[5 - Component 5] RD_ONLY

3006 INT Last Analy_Component Code(UK)[6 - Component 6] RD_ONLY

3007 INT Last Analy_Component Code(UK)[7 - Component 7] RD_ONLY

3008 INT Last Analy_Component Code(UK)[8 - Component 8] RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-745 December 2019

MON2020 319



Register # Data type Variable Record # Access Format

3009 INT Last Analy_Component Code(UK)[9 - Component 9] RD_ONLY

3010 INT Last Analy_Component Code(UK)[10 - Component 10] RD_ONLY

3011 INT Last Analy_Component Code(UK)[11 - Component 11] RD_ONLY

3012 INT Last Analy_Component Code(UK)[12 - Component 12] RD_ONLY

3013 INT Last Analy_Component Code(UK)[13 - Component 13] RD_ONLY

3014 INT Last Analy_Component Code(UK)[14 - Component 14] RD_ONLY

3015 INT Last Analy_Component Code(UK)[15 - Component 15] RD_ONLY

3016 INT Last Analy_Component Code(UK)[16 - Component 16] RD_ONLY

3017 INT Last Analy_Component Code(UK)[1 - Component 1] RD_ONLY

3018 INT Last Analy_Component Code(UK)[2 - Component 2] RD_ONLY

3019 INT Last Analy_Component Code(UK)[3 - Component 3] RD_ONLY

3020 INT Last Analy_Component Code(UK)[4 - Component 4] RD_ONLY

3021 INT Last Analy_Component Code(UK)[5 - Component 5] RD_ONLY

3022 INT Last Analy_Component Code(UK)[6 - Component 6] RD_ONLY

3023 INT Last Analy_Component Code(UK)[7 - Component 7] RD_ONLY

3024 INT Last Analy_Component Code(UK)[8 - Component 8] RD_ONLY

3025 INT Last Analy_Component Code(UK)[9 - Component 9] RD_ONLY

3026 INT Last Analy_Component Code(UK)[10 - Component 10] RD_ONLY

3027 INT Last Analy_Component Code(UK)[11 - Component 11] RD_ONLY

3028 INT Last Analy_Component Code(UK)[12 - Component 12] RD_ONLY

3029 INT Last Analy_Component Code(UK)[13 - Component 13] RD_ONLY

3030 INT Last Analy_Component Code(UK)[14 - Component 14] RD_ONLY

3031 INT Last Analy_Component Code(UK)[15 - Component 15] RD_ONLY

3032 INT Last Analy_Component Code(UK)[16 - Component 16] RD_ONLY

3033 INT Run Time(1/30th Sec) RD_ONLY

3034 INT Last Analy_Stream Number RD_ONLY

3035 INT Last Analy_CDT Stream Mask RD_ONLY

3036 INT Current Time(time_t) RD_WR MM

3037 INT Current Time(time_t) RD_WR DD

3038 INT Current Time(time_t) RD_WR YY

3039 INT Current Time(time_t) RD_WR hh

3040 INT Current Time(time_t) RD_WR mm

3041 INT Last Analy_Start Time RD_ONLY MM

3042 INT Last Analy_Start Time RD_ONLY DD
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Register # Data type Variable Record # Access Format

3043 INT Last Analy_Start Time RD_ONLY YY

3044 INT Last Analy_Start Time RD_ONLY hh

3045 INT Last Analy_Start Time RD_ONLY mm

3046 Bitmap(INT) 0:Unused, 1:Unused, 2:System Alarm_Alarm On - Last
Analysis_Analog Input 1 Low Signal, 3:System
Alarm_Alarm On - Last Analysis_Analog Input 1 High
Signal, 4:System Alarm_Alarm On - Last Analysis_Analog
Input 2 Low Signal, 5:System Alarm_Alarm On - Last
Analysis_Analog Input 2 High Signal, 6:Unused, 7:Unused,
8:System Alarm_Alarm On - Last Analysis_Analog Output 1
Low Signal, 9:System Alarm_Alarm On - Last
Analysis_Analog Output 1 High Signal, 10:System
Alarm_Alarm On - Last Analysis_Analog Output 2 Low
Signal, 11:System Alarm_Alarm On - Last Analysis_Analog
Output 2 High Signal, 12:System Alarm_Alarm On - Last
Analysis_Analog Output 3 Low Signal, 13:System
Alarm_Alarm On - Last Analysis_Analog Output 3 High
Signal, 14:Analyzer Failure, 15:Unused

RD_ONLY

3047 Bitmap(INT) 0:System Alarm_Alarm On - Current Analysis_Power
Failure, 1:Calibration Failed, 2:Preamp Failure, 3:Unused,
4:Unused, 5:Unused, 6:Unused, 7:Unused, 8:Unused,
9:Unused, 10:Unused, 11:Unused, 12:Unused, 13:Unused,
14:Unused, 15:Unused

RD_ONLY

3048 INT 1 - Stream 1_Active Low Limit Alarms RD_ONLY

3049 INT 1 - Stream 1_Active High Limit Alarms RD_ONLY

3050 INT 2 - Stream 2_Active Low Limit Alarms RD_ONLY

3051 INT 2 - Stream 2_Active High Limit Alarms RD_ONLY

3052 INT 3 - Stream 3_Active Low Limit Alarms RD_ONLY

3053 INT 3 - Stream 3_Active High Limit Alarms RD_ONLY

3054 INT 4 - Stream 4_Active Low Limit Alarms RD_ONLY

3055 INT 4 - Stream 4_Active High Limit Alarms RD_ONLY

3056 INT 5 - Stream 5_Active Low Limit Alarms RD_ONLY

3057 INT 5 - Stream 5_Active High Limit Alarms RD_ONLY

3058 INT New Data Flag RD_WR

3059 INT Analy/Calib Flag RD_ONLY

3060 INT Daily Avg Updated RD_WR

3061 INT Last Stream RD_ONLY

3062 INT 2 - Stream 2_New Data Available RD_WR

3063 INT 3 - Stream 3_New Data Available RD_WR

3064 INT 4 - Stream 4_New Data Available RD_WR

3065 INT 5 - Stream 5_New Data Available RD_WR
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Register # Data type Variable Record # Access Format

3066 INT Component Data 1_Reference Code[1] RD_ONLY

3067 INT Component Data 1_Reference Code[2] RD_ONLY

3068 INT Component Data 1_Reference Code[3] RD_ONLY

3069 INT Component Data 1_Reference Code[4] RD_ONLY

3070 INT Component Data 1_Reference Code[5] RD_ONLY

3071 INT Component Data 1_Reference Code[6] RD_ONLY

3072 INT Component Data 1_Reference Code[7] RD_ONLY

3073 INT Component Data 1_Reference Code[8] RD_ONLY

3074 INT Component Data 1_Reference Code[9] RD_ONLY

3075 INT Component Data 1_Reference Code[10] RD_ONLY

3076 INT Component Data 1_Reference Code[11] RD_ONLY

3077 INT Component Data 1_Reference Code[12] RD_ONLY

3078 INT Component Data 1_Reference Code[13] RD_ONLY

3079 INT Component Data 1_Reference Code[14] RD_ONLY

3080 INT Component Data 1_Reference Code[15] RD_ONLY

3081 INT Component Data 1_Reference Code[16] RD_ONLY

3082 INT Component Data 2_Reference Code[1] RD_ONLY

3083 INT Component Data 2_Reference Code[2] RD_ONLY

3084 INT Component Data 2_Reference Code[3] RD_ONLY

3085 INT Component Data 2_Reference Code[4] RD_ONLY

3086 INT Component Data 2_Reference Code[5] RD_ONLY

3087 INT Component Data 2_Reference Code[6] RD_ONLY

3088 INT Component Data 2_Reference Code[7] RD_ONLY

3089 INT Component Data 2_Reference Code[8] RD_ONLY

3090 INT Component Data 2_Reference Code[9] RD_ONLY

3091 INT Component Data 2_Reference Code[10] RD_ONLY

3092 INT Component Data 2_Reference Code[11] RD_ONLY

3093 INT Component Data 2_Reference Code[12] RD_ONLY

3094 INT Component Data 2_Reference Code[13] RD_ONLY

3095 INT Component Data 2_Reference Code[14] RD_ONLY

3096 INT Component Data 2_Reference Code[15] RD_ONLY

3097 INT Component Data 2_Reference Code[16] RD_ONLY

3098 INT Calculations Configuration_Primary CV Units RD_ONLY

3099 INT Last Run Data Valid 1 RD_WR
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3100 INT Last Run Data Valid 2 RD_WR

3101 INT Last Run Data Valid 3 RD_WR

3102 INT Last Run Data Valid 4 RD_WR

3103 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3104 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3105 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3106 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3107 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3108 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3109 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3110 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3111 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3112 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3113 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3114 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3115 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3116 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3117 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3118 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3119 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3120 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3121 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3122 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3123 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3124 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3125 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3126 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3127 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3128 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3129 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3130 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3131 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3132 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3133 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY
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3134 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3135 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3136 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3137 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3138 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3139 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3140 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3141 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3142 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3143 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3144 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3145 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3146 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3147 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3148 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3149 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3150 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3151 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3152 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3153 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3154 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3155 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3156 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3157 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3158 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3159 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3160 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3161 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3162 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3163 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3164 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3165 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3166 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3167 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY
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3168 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3169 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3170 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3171 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3172 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3173 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3174 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3175 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3176 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3177 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3178 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3179 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3180 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3181 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3182 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

5001 LONG Last Analy_Cycle Time (1/30th sec) RD_ONLY

5002 LONG Last Calib_Calib Time(1/30th sec) RD_ONLY

7001 FLOAT Last Analy_Mole %[1 - Component 1] RD_ONLY

7002 FLOAT Last Analy_Mole %[2 - Component 2] RD_ONLY

7003 FLOAT Last Analy_Mole %[3 - Component 3] RD_ONLY

7004 FLOAT Last Analy_Mole %[4 - Component 4] RD_ONLY

7005 FLOAT Last Analy_Mole %[5 - Component 5] RD_ONLY

7006 FLOAT Last Analy_Mole %[6 - Component 6] RD_ONLY

7007 FLOAT Last Analy_Mole %[7 - Component 7] RD_ONLY

7008 FLOAT Last Analy_Mole %[8 - Component 8] RD_ONLY

7009 FLOAT Last Analy_Mole %[9 - Component 9] RD_ONLY

7010 FLOAT Last Analy_Mole %[10 - Component 10] RD_ONLY

7011 FLOAT Last Analy_Mole %[11 - Component 11] RD_ONLY

7012 FLOAT Last Analy_Mole %[12 - Component 12] RD_ONLY

7013 FLOAT Last Analy_Mole %[13 - Component 13] RD_ONLY

7014 FLOAT Last Analy_Mole %[14 - Component 14] RD_ONLY

7015 FLOAT Last Analy_Mole %[15 - Component 15] RD_ONLY

7016 FLOAT Last Analy_Mole %[16 - Component 16] RD_ONLY

7017 FLOAT Last Analy_Weight %[1 - Component 1] RD_ONLY
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7018 FLOAT Last Analy_Weight %[2 - Component 2] RD_ONLY

7019 FLOAT Last Analy_Weight %[3 - Component 3] RD_ONLY

7020 FLOAT Last Analy_Weight %[4 - Component 4] RD_ONLY

7021 FLOAT Last Analy_Weight %[5 - Component 5] RD_ONLY

7022 FLOAT Last Analy_Weight %[6 - Component 6] RD_ONLY

7023 FLOAT Last Analy_Weight %[7 - Component 7] RD_ONLY

7024 FLOAT Last Analy_Weight %[8 - Component 8] RD_ONLY

7025 FLOAT Last Analy_Weight %[9 - Component 9] RD_ONLY

7026 FLOAT Last Analy_Weight %[10 - Component 10] RD_ONLY

7027 FLOAT Last Analy_Weight %[11 - Component 11] RD_ONLY

7028 FLOAT Last Analy_Weight %[12 - Component 12] RD_ONLY

7029 FLOAT Last Analy_Weight %[13 - Component 13] RD_ONLY

7030 FLOAT Last Analy_Weight %[14 - Component 14] RD_ONLY

7031 FLOAT Last Analy_Weight %[15 - Component 15] RD_ONLY

7032 FLOAT Last Analy_Weight %[16 - Component 16] RD_ONLY

7033 FLOAT Last Analy_ISO CV Sup Dry - Pri RD_ONLY

7034 FLOAT Last Analy_ISO CV Sup Sat - Pri RD_ONLY

7035 FLOAT Last Analy_ISO Real Rel Den Gas - Pri RD_ONLY

7036 FLOAT Last Analy_ISO Z Factor - Pri RD_ONLY

7037 FLOAT Last Analy_ISO Wobbe Index Sup - Pri RD_ONLY

7038 FLOAT Last Analy_Total Unnormalized Conc RD_ONLY

7039 FLOAT Last Analy_ISO Avg Molar Mass RD_ONLY

7040 FLOAT Calc Result[1 - User Cal 1] RD_ONLY

7041 FLOAT Calc Result[2 - User Cal 2] RD_ONLY

7042 FLOAT Calc Result[3 - User Cal 3] RD_ONLY

7043 FLOAT Calc Result[4 - User Cal 4] RD_ONLY

7044 FLOAT Calc Result[5 - User Cal 5] RD_ONLY

7045 FLOAT Unused RD_ONLY

7046 FLOAT Last Analy_ISO CV Sup Dry - Sec RD_ONLY

7047 FLOAT Last Analy_ISO CV Sup Sat - Sec RD_ONLY

7048 FLOAT Last Analy_ISO CV Inf Dry - Sec RD_ONLY

7049 FLOAT Last Analy_ISO CV Inf Sat - Sec RD_ONLY

7050 FLOAT Last Analy_ISO Z Factor - Sec RD_ONLY

7051 FLOAT Last Analy_ISO Real Rel Den Gas - Sec RD_ONLY
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7052 FLOAT Last Analy_ISO Gas Den kg/m3 - Sec RD_ONLY

7053 FLOAT Last Analy_ISO Wobbe Index Sup - Sec RD_ONLY

7054 FLOAT Last Analy_ISO Wobbe Index Inf - Sec RD_ONLY

7055 FLOAT Avg[1 - Average 1] RD_ONLY

7056 FLOAT Avg[2 - Average 2] RD_ONLY

7057 FLOAT Avg[3 - Average 3] RD_ONLY

7058 FLOAT Avg[4 - Average 4] RD_ONLY

7059 FLOAT Avg[5 - Average 5] RD_ONLY

7060 FLOAT Avg[6 - Average 6] RD_ONLY

7061 FLOAT Avg[7 - Average 7] RD_ONLY

7062 FLOAT Avg[8 - Average 8] RD_ONLY

7063 FLOAT Avg[9 - Average 9] RD_ONLY

7064 FLOAT Avg[10 - Average 10] RD_ONLY

7065 FLOAT Avg[11 - Average 11] RD_ONLY

7066 FLOAT Avg[12 - Average 12] RD_ONLY

7067 FLOAT Avg[13 - Average 13] RD_ONLY

7068 FLOAT Avg[14 - Average 14] RD_ONLY

7069 FLOAT Avg[15 - Average 15] RD_ONLY

7070 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7071 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7072 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7073 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7074 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7075 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7076 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7077 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7078 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7079 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7080 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7081 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7082 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7083 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7084 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7085 FLOAT Current Value[1 - Analog Input 1] RD_ONLY
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7086 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7087 FLOAT Last Analy_ISO CV Inf Dry - Pri RD_ONLY

7088 FLOAT Last Analy_ISO CV Inf Sat - Pri RD_ONLY

7089 FLOAT Last Analy_ISO Wobbe Index Inf - Pri RD_ONLY

7090 FLOAT Last Analy_ISO Gas Den kg/m3 - Pri RD_ONLY

7091 FLOAT Last FCalib_Total Calibration Runs RD_ONLY

7092 FLOAT Last FCalib_Total Average Runs RD_ONLY

7093 FLOAT Auto Calibration Start Time RD_ONLY hhmm

7094 FLOAT GC Control_Stream Sequence Select RD_WR

7095 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7096 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7097 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7098 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7099 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7100 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7101 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7102 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7103 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7104 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7105 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7106 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7107 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7108 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7109 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7110 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7111 FLOAT Last FCalib_ISO CV Sup Dry - Pri RD_ONLY

7112 FLOAT Last FCalib_ISO CV Sup Sat - Pri RD_ONLY

7113 FLOAT Last FCalib_ISO CV Inf Dry - Pri RD_ONLY

7114 FLOAT Last FCalib_ISO CV Inf Sat - Pri RD_ONLY

7115 FLOAT Last FCalib_ISO Z Factor - Pri RD_ONLY

7116 FLOAT Last FCalib_ISO Real Rel Den Gas - Pri RD_ONLY

7117 FLOAT Last FCalib_ISO Gas Den kg/m3 - Pri RD_ONLY

7118 FLOAT Last FCalib_ISO Wobbe Index Sup - Pri RD_ONLY

7119 FLOAT Last FCalib_ISO Wobbe Index Inf - Pri RD_ONLY
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7120 FLOAT Last FCalib_ISO Avg Molar Mass RD_ONLY

7121 FLOAT Last FCalib_Total Unnormalized Conc RD_ONLY

7122 FLOAT Last Calib_Stream Number RD_ONLY

7123 FLOAT Last Analy_GS(M)R Incomp Combustion Factor RD_ONLY

7124 FLOAT Last Analy_GS(M)R Soot Index RD_ONLY

7125 FLOAT Last Analy_Ratio of Latent Heat Cap RD_ONLY

7126 FLOAT Avg[1 - Average 1] RD_ONLY

7127 FLOAT Avg[2 - Average 2] RD_ONLY

7128 FLOAT Avg[3 - Average 3] RD_ONLY

7129 FLOAT Avg[4 - Average 4] RD_ONLY

7130 FLOAT Avg[5 - Average 5] RD_ONLY

7131 FLOAT Avg[6 - Average 6] RD_ONLY

7132 FLOAT Avg[7 - Average 7] RD_ONLY

7133 FLOAT Avg[8 - Average 8] RD_ONLY

7134 FLOAT Avg[9 - Average 9] RD_ONLY

7135 FLOAT Avg[10 - Average 10] RD_ONLY

7136 FLOAT Avg[11 - Average 11] RD_ONLY

7137 FLOAT Avg[12 - Average 12] RD_ONLY

7138 FLOAT Avg[13 - Average 13] RD_ONLY

7139 FLOAT Avg[14 - Average 14] RD_ONLY

7140 FLOAT Avg[15 - Average 15] RD_ONLY

7141 FLOAT Avg[16 - Average 16] RD_ONLY

7142 FLOAT Avg[17 - Average 17] RD_ONLY

7143 FLOAT Avg[18 - Average 18] RD_ONLY

7144 FLOAT Avg[19 - Average 19] RD_ONLY

7145 FLOAT Avg[20 - Average 20] RD_ONLY

7146 FLOAT Avg[21 - Average 21] RD_ONLY

7147 FLOAT Avg[22 - Average 22] RD_ONLY

7148 FLOAT Avg[23 - Average 23] RD_ONLY

7149 FLOAT Avg[24 - Average 24] RD_ONLY

7150 FLOAT Avg[25 - Average 25] RD_ONLY

7151 FLOAT Avg[26 - Average 26] RD_ONLY

7152 FLOAT Avg[27 - Average 27] RD_ONLY

7153 FLOAT Avg[28 - Average 28] RD_ONLY
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7154 FLOAT Avg[29 - Average 29] RD_ONLY

7155 FLOAT Avg[30 - Average 30] RD_ONLY

7156 FLOAT Avg[31 - Average 31] RD_ONLY

7157 FLOAT Avg[32 - Average 32] RD_ONLY

7158 FLOAT Avg[33 - Average 33] RD_ONLY

7159 FLOAT Avg[34 - Average 34] RD_ONLY

7160 FLOAT Avg[35 - Average 35] RD_ONLY

7161 FLOAT Avg[36 - Average 36] RD_ONLY

7162 FLOAT Max[1 - Average 1] RD_ONLY

7163 FLOAT Max[2 - Average 2] RD_ONLY

7164 FLOAT Max[3 - Average 3] RD_ONLY

7165 FLOAT Max[4 - Average 4] RD_ONLY

7166 FLOAT Max[5 - Average 5] RD_ONLY

7167 FLOAT Max[6 - Average 6] RD_ONLY

7168 FLOAT Max[7 - Average 7] RD_ONLY

7169 FLOAT Max[8 - Average 8] RD_ONLY

7170 FLOAT Max[9 - Average 9] RD_ONLY

7171 FLOAT Max[10 - Average 10] RD_ONLY

7172 FLOAT Max[11 - Average 11] RD_ONLY

7173 FLOAT Max[12 - Average 12] RD_ONLY

7174 FLOAT Max[13 - Average 13] RD_ONLY

7175 FLOAT Max[14 - Average 14] RD_ONLY

7176 FLOAT Max[15 - Average 15] RD_ONLY

7177 FLOAT Max[16 - Average 16] RD_ONLY

7178 FLOAT Max[17 - Average 17] RD_ONLY

7179 FLOAT Max[18 - Average 18] RD_ONLY

7180 FLOAT Max[19 - Average 19] RD_ONLY

7181 FLOAT Max[20 - Average 20] RD_ONLY

7182 FLOAT Max[21 - Average 21] RD_ONLY

7183 FLOAT Max[22 - Average 22] RD_ONLY

7184 FLOAT Max[23 - Average 23] RD_ONLY

7185 FLOAT Max[24 - Average 24] RD_ONLY

7186 FLOAT Max[25 - Average 25] RD_ONLY

7187 FLOAT Max[26 - Average 26] RD_ONLY
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7188 FLOAT Max[27 - Average 27] RD_ONLY

7189 FLOAT Max[28 - Average 28] RD_ONLY

7190 FLOAT Max[29 - Average 29] RD_ONLY

7191 FLOAT Max[30 - Average 30] RD_ONLY

7192 FLOAT Max[31 - Average 31] RD_ONLY

7193 FLOAT Max[32 - Average 32] RD_ONLY

7194 FLOAT Max[33 - Average 33] RD_ONLY

7195 FLOAT Max[34 - Average 34] RD_ONLY

7196 FLOAT Max[35 - Average 35] RD_ONLY

7197 FLOAT Max[36 - Average 36] RD_ONLY

7198 FLOAT Min[1 - Average 1] RD_ONLY

7199 FLOAT Min[2 - Average 2] RD_ONLY

7200 FLOAT Min[3 - Average 3] RD_ONLY

7201 FLOAT Min[4 - Average 4] RD_ONLY

7202 FLOAT Min[5 - Average 5] RD_ONLY

7203 FLOAT Min[6 - Average 6] RD_ONLY

7204 FLOAT Min[7 - Average 7] RD_ONLY

7205 FLOAT Min[8 - Average 8] RD_ONLY

7206 FLOAT Min[9 - Average 9] RD_ONLY

7207 FLOAT Min[10 - Average 10] RD_ONLY

7208 FLOAT Min[11 - Average 11] RD_ONLY

7209 FLOAT Min[12 - Average 12] RD_ONLY

7210 FLOAT Min[13 - Average 13] RD_ONLY

7211 FLOAT Min[14 - Average 14] RD_ONLY

7212 FLOAT Min[15 - Average 15] RD_ONLY

7213 FLOAT Min[16 - Average 16] RD_ONLY

7214 FLOAT Min[17 - Average 17] RD_ONLY

7215 FLOAT Min[18 - Average 18] RD_ONLY

7216 FLOAT Min[19 - Average 19] RD_ONLY

7217 FLOAT Min[20 - Average 20] RD_ONLY

7218 FLOAT Min[21 - Average 21] RD_ONLY

7219 FLOAT Min[22 - Average 22] RD_ONLY

7220 FLOAT Min[23 - Average 23] RD_ONLY

7221 FLOAT Min[24 - Average 24] RD_ONLY
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7222 FLOAT Min[25 - Average 25] RD_ONLY

7223 FLOAT Min[26 - Average 26] RD_ONLY

7224 FLOAT Min[27 - Average 27] RD_ONLY

7225 FLOAT Min[28 - Average 28] RD_ONLY

7226 FLOAT Min[29 - Average 29] RD_ONLY

7227 FLOAT Min[30 - Average 30] RD_ONLY

7228 FLOAT Min[31 - Average 31] RD_ONLY

7229 FLOAT Min[32 - Average 32] RD_ONLY

7230 FLOAT Min[33 - Average 33] RD_ONLY

7231 FLOAT Min[34 - Average 34] RD_ONLY

7232 FLOAT Min[35 - Average 35] RD_ONLY

7233 FLOAT Min[36 - Average 36] RD_ONLY

7234 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7235 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7236 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7237 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7238 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7239 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7240 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7241 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7242 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7243 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7244 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7245 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7246 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7247 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7248 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7249 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7250 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7251 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7252 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7253 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7254 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7255 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

Pre-defined Modbus® Map Files Reference Manual
December 2019 2-3-9000-745

332 Rosemount Gas Chromatographs



Register # Data type Variable Record # Access Format

7256 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7257 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7258 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7259 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

7260 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7261 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7262 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7263 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7264 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7265 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7266 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7267 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7268 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7269 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7270 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

7271 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

7272 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

7273 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

7274 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

7275 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

7276 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

7277 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

7278 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

7279 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

7280 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

7281 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

7282 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

7283 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

7284 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

7285 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

7286 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

7287 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

7288 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

7289 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY
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7290 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

7291 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

7292 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

7293 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

7294 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

7295 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

7296 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

7297 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

7298 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

7299 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

7300 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

7301 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

7302 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

7303 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

7304 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

7305 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

7306 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

7307 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

7308 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

7309 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

7310 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

7311 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

7312 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

7313 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

7314 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

7315 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

7316 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

7317 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

7318 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

7319 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

7320 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

7321 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

7322 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

7323 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY
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7324 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

7325 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

7326 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

7327 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

7328 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

7329 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

7330 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

7331 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

7332 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

7333 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

7334 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

7335 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

7336 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

7337 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

7338 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

7339 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

7340 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

7341 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

7342 FLOAT Archive_Avg[1 - Average 1] 2 RD_ONLY

7343 FLOAT Archive_Avg[2 - Average 2] 2 RD_ONLY

7344 FLOAT Archive_Avg[3 - Average 3] 2 RD_ONLY

7345 FLOAT Archive_Avg[4 - Average 4] 2 RD_ONLY

7346 FLOAT Archive_Avg[5 - Average 5] 2 RD_ONLY

7347 FLOAT Archive_Avg[6 - Average 6] 2 RD_ONLY

7348 FLOAT Archive_Avg[7 - Average 7] 2 RD_ONLY

7349 FLOAT Archive_Avg[8 - Average 8] 2 RD_ONLY

7350 FLOAT Archive_Avg[9 - Average 9] 2 RD_ONLY

7351 FLOAT Archive_Avg[10 - Average 10] 2 RD_ONLY

7352 FLOAT Archive_Avg[11 - Average 11] 2 RD_ONLY

7353 FLOAT Archive_Avg[12 - Average 12] 2 RD_ONLY

7354 FLOAT Archive_Avg[13 - Average 13] 2 RD_ONLY

7355 FLOAT Archive_Avg[14 - Average 14] 2 RD_ONLY

7356 FLOAT Archive_Avg[15 - Average 15] 2 RD_ONLY

7357 FLOAT Archive_Avg[16 - Average 16] 2 RD_ONLY
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7358 FLOAT Archive_Avg[17 - Average 17] 2 RD_ONLY

7359 FLOAT Archive_Avg[18 - Average 18] 2 RD_ONLY

7360 FLOAT Archive_Avg[19 - Average 19] 2 RD_ONLY

7361 FLOAT Archive_Avg[20 - Average 20] 2 RD_ONLY

7362 FLOAT Archive_Avg[21 - Average 21] 2 RD_ONLY

7363 FLOAT Archive_Avg[22 - Average 22] 2 RD_ONLY

7364 FLOAT Archive_Avg[23 - Average 23] 2 RD_ONLY

7365 FLOAT Archive_Avg[24 - Average 24] 2 RD_ONLY

7366 FLOAT Archive_Avg[25 - Average 25] 2 RD_ONLY

7367 FLOAT Archive_Avg[26 - Average 26] 2 RD_ONLY

7368 FLOAT Archive_Avg[27 - Average 27] 2 RD_ONLY

7369 FLOAT Archive_Avg[28 - Average 28] 2 RD_ONLY

7370 FLOAT Archive_Avg[29 - Average 29] 2 RD_ONLY

7371 FLOAT Archive_Avg[30 - Average 30] 2 RD_ONLY

7372 FLOAT Archive_Avg[31 - Average 31] 2 RD_ONLY

7373 FLOAT Archive_Avg[32 - Average 32] 2 RD_ONLY

7374 FLOAT Archive_Avg[33 - Average 33] 2 RD_ONLY

7375 FLOAT Archive_Avg[34 - Average 34] 2 RD_ONLY

7376 FLOAT Archive_Avg[35 - Average 35] 2 RD_ONLY

7377 FLOAT Archive_Avg[36 - Average 36] 2 RD_ONLY

7378 FLOAT Archive_Max[1 - Average 1] 2 RD_ONLY

7379 FLOAT Archive_Max[2 - Average 2] 2 RD_ONLY

7380 FLOAT Archive_Max[3 - Average 3] 2 RD_ONLY

7381 FLOAT Archive_Max[4 - Average 4] 2 RD_ONLY

7382 FLOAT Archive_Max[5 - Average 5] 2 RD_ONLY

7383 FLOAT Archive_Max[6 - Average 6] 2 RD_ONLY

7384 FLOAT Archive_Max[7 - Average 7] 2 RD_ONLY

7385 FLOAT Archive_Max[8 - Average 8] 2 RD_ONLY

7386 FLOAT Archive_Max[9 - Average 9] 2 RD_ONLY

7387 FLOAT Archive_Max[10 - Average 10] 2 RD_ONLY

7388 FLOAT Archive_Max[11 - Average 11] 2 RD_ONLY

7389 FLOAT Archive_Max[12 - Average 12] 2 RD_ONLY

7390 FLOAT Archive_Max[13 - Average 13] 2 RD_ONLY

7391 FLOAT Archive_Max[14 - Average 14] 2 RD_ONLY
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7392 FLOAT Archive_Max[15 - Average 15] 2 RD_ONLY

7393 FLOAT Archive_Max[16 - Average 16] 2 RD_ONLY

7394 FLOAT Archive_Max[17 - Average 17] 2 RD_ONLY

7395 FLOAT Archive_Max[18 - Average 18] 2 RD_ONLY

7396 FLOAT Archive_Max[19 - Average 19] 2 RD_ONLY

7397 FLOAT Archive_Max[20 - Average 20] 2 RD_ONLY

7398 FLOAT Archive_Max[21 - Average 21] 2 RD_ONLY

7399 FLOAT Archive_Max[22 - Average 22] 2 RD_ONLY

7400 FLOAT Archive_Max[23 - Average 23] 2 RD_ONLY

7401 FLOAT Archive_Max[24 - Average 24] 2 RD_ONLY

7402 FLOAT Archive_Max[25 - Average 25] 2 RD_ONLY

7403 FLOAT Archive_Max[26 - Average 26] 2 RD_ONLY

7404 FLOAT Archive_Max[27 - Average 27] 2 RD_ONLY

7405 FLOAT Archive_Max[28 - Average 28] 2 RD_ONLY

7406 FLOAT Archive_Max[29 - Average 29] 2 RD_ONLY

7407 FLOAT Archive_Max[30 - Average 30] 2 RD_ONLY

7408 FLOAT Archive_Max[31 - Average 31] 2 RD_ONLY

7409 FLOAT Archive_Max[32 - Average 32] 2 RD_ONLY

7410 FLOAT Archive_Max[33 - Average 33] 2 RD_ONLY

7411 FLOAT Archive_Max[34 - Average 34] 2 RD_ONLY

7412 FLOAT Archive_Max[35 - Average 35] 2 RD_ONLY

7413 FLOAT Archive_Max[36 - Average 36] 2 RD_ONLY

7414 FLOAT Archive_Min[1 - Average 1] 2 RD_ONLY

7415 FLOAT Archive_Min[2 - Average 2] 2 RD_ONLY

7416 FLOAT Archive_Min[3 - Average 3] 2 RD_ONLY

7417 FLOAT Archive_Min[4 - Average 4] 2 RD_ONLY

7418 FLOAT Archive_Min[5 - Average 5] 2 RD_ONLY

7419 FLOAT Archive_Min[6 - Average 6] 2 RD_ONLY

7420 FLOAT Archive_Min[7 - Average 7] 2 RD_ONLY

7421 FLOAT Archive_Min[8 - Average 8] 2 RD_ONLY

7422 FLOAT Archive_Min[9 - Average 9] 2 RD_ONLY

7423 FLOAT Archive_Min[10 - Average 10] 2 RD_ONLY

7424 FLOAT Archive_Min[11 - Average 11] 2 RD_ONLY

7425 FLOAT Archive_Min[12 - Average 12] 2 RD_ONLY
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7426 FLOAT Archive_Min[13 - Average 13] 2 RD_ONLY

7427 FLOAT Archive_Min[14 - Average 14] 2 RD_ONLY

7428 FLOAT Archive_Min[15 - Average 15] 2 RD_ONLY

7429 FLOAT Archive_Min[16 - Average 16] 2 RD_ONLY

7430 FLOAT Archive_Min[17 - Average 17] 2 RD_ONLY

7431 FLOAT Archive_Min[18 - Average 18] 2 RD_ONLY

7432 FLOAT Archive_Min[19 - Average 19] 2 RD_ONLY

7433 FLOAT Archive_Min[20 - Average 20] 2 RD_ONLY

7434 FLOAT Archive_Min[21 - Average 21] 2 RD_ONLY

7435 FLOAT Archive_Min[22 - Average 22] 2 RD_ONLY

7436 FLOAT Archive_Min[23 - Average 23] 2 RD_ONLY

7437 FLOAT Archive_Min[24 - Average 24] 2 RD_ONLY

7438 FLOAT Archive_Min[25 - Average 25] 2 RD_ONLY

7439 FLOAT Archive_Min[26 - Average 26] 2 RD_ONLY

7440 FLOAT Archive_Min[27 - Average 27] 2 RD_ONLY

7441 FLOAT Archive_Min[28 - Average 28] 2 RD_ONLY

7442 FLOAT Archive_Min[29 - Average 29] 2 RD_ONLY

7443 FLOAT Archive_Min[30 - Average 30] 2 RD_ONLY

7444 FLOAT Archive_Min[31 - Average 31] 2 RD_ONLY

7445 FLOAT Archive_Min[32 - Average 32] 2 RD_ONLY

7446 FLOAT Archive_Min[33 - Average 33] 2 RD_ONLY

7447 FLOAT Archive_Min[34 - Average 34] 2 RD_ONLY

7448 FLOAT Archive_Min[35 - Average 35] 2 RD_ONLY

7449 FLOAT Archive_Min[36 - Average 36] 2 RD_ONLY

7450 FLOAT Archive_Avg[1 - Average 1] 3 RD_ONLY

7451 FLOAT Archive_Avg[2 - Average 2] 3 RD_ONLY

7452 FLOAT Archive_Avg[3 - Average 3] 3 RD_ONLY

7453 FLOAT Archive_Avg[4 - Average 4] 3 RD_ONLY

7454 FLOAT Archive_Avg[5 - Average 5] 3 RD_ONLY

7455 FLOAT Archive_Avg[6 - Average 6] 3 RD_ONLY

7456 FLOAT Archive_Avg[7 - Average 7] 3 RD_ONLY

7457 FLOAT Archive_Avg[8 - Average 8] 3 RD_ONLY

7458 FLOAT Archive_Avg[9 - Average 9] 3 RD_ONLY

7459 FLOAT Archive_Avg[10 - Average 10] 3 RD_ONLY
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7460 FLOAT Archive_Avg[11 - Average 11] 3 RD_ONLY

7461 FLOAT Archive_Avg[12 - Average 12] 3 RD_ONLY

7462 FLOAT Archive_Avg[13 - Average 13] 3 RD_ONLY

7463 FLOAT Archive_Avg[14 - Average 14] 3 RD_ONLY

7464 FLOAT Archive_Avg[15 - Average 15] 3 RD_ONLY

7465 FLOAT Archive_Avg[16 - Average 16] 3 RD_ONLY

7466 FLOAT Archive_Avg[17 - Average 17] 3 RD_ONLY

7467 FLOAT Archive_Avg[18 - Average 18] 3 RD_ONLY

7468 FLOAT Archive_Avg[19 - Average 19] 3 RD_ONLY

7469 FLOAT Archive_Avg[20 - Average 20] 3 RD_ONLY

7470 FLOAT Archive_Avg[21 - Average 21] 3 RD_ONLY

7471 FLOAT Archive_Avg[22 - Average 22] 3 RD_ONLY

7472 FLOAT Archive_Avg[23 - Average 23] 3 RD_ONLY

7473 FLOAT Archive_Avg[24 - Average 24] 3 RD_ONLY

7474 FLOAT Archive_Avg[25 - Average 25] 3 RD_ONLY

7475 FLOAT Archive_Avg[26 - Average 26] 3 RD_ONLY

7476 FLOAT Archive_Avg[27 - Average 27] 3 RD_ONLY

7477 FLOAT Archive_Avg[28 - Average 28] 3 RD_ONLY

7478 FLOAT Archive_Avg[29 - Average 29] 3 RD_ONLY

7479 FLOAT Archive_Avg[30 - Average 30] 3 RD_ONLY

7480 FLOAT Archive_Avg[31 - Average 31] 3 RD_ONLY

7481 FLOAT Archive_Avg[32 - Average 32] 3 RD_ONLY

7482 FLOAT Archive_Avg[33 - Average 33] 3 RD_ONLY

7483 FLOAT Archive_Avg[34 - Average 34] 3 RD_ONLY

7484 FLOAT Archive_Avg[35 - Average 35] 3 RD_ONLY

7485 FLOAT Archive_Avg[36 - Average 36] 3 RD_ONLY

7486 FLOAT Archive_Max[1 - Average 1] 3 RD_ONLY

7487 FLOAT Archive_Max[2 - Average 2] 3 RD_ONLY

7488 FLOAT Archive_Max[3 - Average 3] 3 RD_ONLY

7489 FLOAT Archive_Max[4 - Average 4] 3 RD_ONLY

7490 FLOAT Archive_Max[5 - Average 5] 3 RD_ONLY

7491 FLOAT Archive_Max[6 - Average 6] 3 RD_ONLY

7492 FLOAT Archive_Max[7 - Average 7] 3 RD_ONLY

7493 FLOAT Archive_Max[8 - Average 8] 3 RD_ONLY
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7494 FLOAT Archive_Max[9 - Average 9] 3 RD_ONLY

7495 FLOAT Archive_Max[10 - Average 10] 3 RD_ONLY

7496 FLOAT Archive_Max[11 - Average 11] 3 RD_ONLY

7497 FLOAT Archive_Max[12 - Average 12] 3 RD_ONLY

7498 FLOAT Archive_Max[13 - Average 13] 3 RD_ONLY

7499 FLOAT Archive_Max[14 - Average 14] 3 RD_ONLY

7500 FLOAT Archive_Max[15 - Average 15] 3 RD_ONLY

7501 FLOAT Archive_Max[16 - Average 16] 3 RD_ONLY

7502 FLOAT Archive_Max[17 - Average 17] 3 RD_ONLY

7503 FLOAT Archive_Max[18 - Average 18] 3 RD_ONLY

7504 FLOAT Archive_Max[19 - Average 19] 3 RD_ONLY

7505 FLOAT Archive_Max[20 - Average 20] 3 RD_ONLY

7506 FLOAT Archive_Max[21 - Average 21] 3 RD_ONLY

7507 FLOAT Archive_Max[22 - Average 22] 3 RD_ONLY

7508 FLOAT Archive_Max[23 - Average 23] 3 RD_ONLY

7509 FLOAT Archive_Max[24 - Average 24] 3 RD_ONLY

7510 FLOAT Archive_Max[25 - Average 25] 3 RD_ONLY

7511 FLOAT Archive_Max[26 - Average 26] 3 RD_ONLY

7512 FLOAT Archive_Max[27 - Average 27] 3 RD_ONLY

7513 FLOAT Archive_Max[28 - Average 28] 3 RD_ONLY

7514 FLOAT Archive_Max[29 - Average 29] 3 RD_ONLY

7515 FLOAT Archive_Max[30 - Average 30] 3 RD_ONLY

7516 FLOAT Archive_Max[31 - Average 31] 3 RD_ONLY

7517 FLOAT Archive_Max[32 - Average 32] 3 RD_ONLY

7518 FLOAT Archive_Max[33 - Average 33] 3 RD_ONLY

7519 FLOAT Archive_Max[34 - Average 34] 3 RD_ONLY

7520 FLOAT Archive_Max[35 - Average 35] 3 RD_ONLY

7521 FLOAT Archive_Max[36 - Average 36] 3 RD_ONLY

7522 FLOAT Archive_Min[1 - Average 1] 3 RD_ONLY

7523 FLOAT Archive_Min[2 - Average 2] 3 RD_ONLY

7524 FLOAT Archive_Min[3 - Average 3] 3 RD_ONLY

7525 FLOAT Archive_Min[4 - Average 4] 3 RD_ONLY

7526 FLOAT Archive_Min[5 - Average 5] 3 RD_ONLY

7527 FLOAT Archive_Min[6 - Average 6] 3 RD_ONLY
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7528 FLOAT Archive_Min[7 - Average 7] 3 RD_ONLY

7529 FLOAT Archive_Min[8 - Average 8] 3 RD_ONLY

7530 FLOAT Archive_Min[9 - Average 9] 3 RD_ONLY

7531 FLOAT Archive_Min[10 - Average 10] 3 RD_ONLY

7532 FLOAT Archive_Min[11 - Average 11] 3 RD_ONLY

7533 FLOAT Archive_Min[12 - Average 12] 3 RD_ONLY

7534 FLOAT Archive_Min[13 - Average 13] 3 RD_ONLY

7535 FLOAT Archive_Min[14 - Average 14] 3 RD_ONLY

7536 FLOAT Archive_Min[15 - Average 15] 3 RD_ONLY

7537 FLOAT Archive_Min[16 - Average 16] 3 RD_ONLY

7538 FLOAT Archive_Min[17 - Average 17] 3 RD_ONLY

7539 FLOAT Archive_Min[18 - Average 18] 3 RD_ONLY

7540 FLOAT Archive_Min[19 - Average 19] 3 RD_ONLY

7541 FLOAT Archive_Min[20 - Average 20] 3 RD_ONLY

7542 FLOAT Archive_Min[21 - Average 21] 3 RD_ONLY

7543 FLOAT Archive_Min[22 - Average 22] 3 RD_ONLY

7544 FLOAT Archive_Min[23 - Average 23] 3 RD_ONLY

7545 FLOAT Archive_Min[24 - Average 24] 3 RD_ONLY

7546 FLOAT Archive_Min[25 - Average 25] 3 RD_ONLY

7547 FLOAT Archive_Min[26 - Average 26] 3 RD_ONLY

7548 FLOAT Archive_Min[27 - Average 27] 3 RD_ONLY

7549 FLOAT Archive_Min[28 - Average 28] 3 RD_ONLY

7550 FLOAT Archive_Min[29 - Average 29] 3 RD_ONLY

7551 FLOAT Archive_Min[30 - Average 30] 3 RD_ONLY

7552 FLOAT Archive_Min[31 - Average 31] 3 RD_ONLY

7553 FLOAT Archive_Min[32 - Average 32] 3 RD_ONLY

7554 FLOAT Archive_Min[33 - Average 33] 3 RD_ONLY

7555 FLOAT Archive_Min[34 - Average 34] 3 RD_ONLY

7556 FLOAT Archive_Min[35 - Average 35] 3 RD_ONLY

7557 FLOAT Archive_Min[36 - Average 36] 3 RD_ONLY

7558 FLOAT Component Data 1_Multi-level Calib 'a'[1] RD_ONLY

7559 FLOAT Component Data 1_Multi-level Calib 'a'[2] RD_ONLY

7560 FLOAT Component Data 1_Multi-level Calib 'a'[3] RD_ONLY

7561 FLOAT Component Data 1_Multi-level Calib 'a'[4] RD_ONLY
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7562 FLOAT Component Data 1_Multi-level Calib 'a'[5] RD_ONLY

7563 FLOAT Component Data 1_Multi-level Calib 'a'[6] RD_ONLY

7564 FLOAT Component Data 1_Multi-level Calib 'a'[7] RD_ONLY

7565 FLOAT Component Data 1_Multi-level Calib 'a'[8] RD_ONLY

7566 FLOAT Component Data 1_Multi-level Calib 'a'[9] RD_ONLY

7567 FLOAT Component Data 1_Multi-level Calib 'a'[10] RD_ONLY

7568 FLOAT Component Data 1_Multi-level Calib 'a'[11] RD_ONLY

7569 FLOAT Component Data 1_Multi-level Calib 'a'[12] RD_ONLY

7570 FLOAT Component Data 1_Multi-level Calib 'a'[13] RD_ONLY

7571 FLOAT Component Data 1_Multi-level Calib 'a'[14] RD_ONLY

7572 FLOAT Component Data 1_Multi-level Calib 'a'[15] RD_ONLY

7573 FLOAT Component Data 1_Multi-level Calib 'a'[16] RD_ONLY

7574 FLOAT Component Data 1_Multi-level Calib 'b'[1] RD_ONLY

7575 FLOAT Component Data 1_Multi-level Calib 'b'[2] RD_ONLY

7576 FLOAT Component Data 1_Multi-level Calib 'b'[3] RD_ONLY

7577 FLOAT Component Data 1_Multi-level Calib 'b'[4] RD_ONLY

7578 FLOAT Component Data 1_Multi-level Calib 'b'[5] RD_ONLY

7579 FLOAT Component Data 1_Multi-level Calib 'b'[6] RD_ONLY

7580 FLOAT Component Data 1_Multi-level Calib 'b'[7] RD_ONLY

7581 FLOAT Component Data 1_Multi-level Calib 'b'[8] RD_ONLY

7582 FLOAT Component Data 1_Multi-level Calib 'b'[9] RD_ONLY

7583 FLOAT Component Data 1_Multi-level Calib 'b'[10] RD_ONLY

7584 FLOAT Component Data 1_Multi-level Calib 'b'[11] RD_ONLY

7585 FLOAT Component Data 1_Multi-level Calib 'b'[12] RD_ONLY

7586 FLOAT Component Data 1_Multi-level Calib 'b'[13] RD_ONLY

7587 FLOAT Component Data 1_Multi-level Calib 'b'[14] RD_ONLY

7588 FLOAT Component Data 1_Multi-level Calib 'b'[15] RD_ONLY

7589 FLOAT Component Data 1_Multi-level Calib 'b'[16] RD_ONLY

7590 FLOAT Component Data 1_Multi-level Calib 'c'[1] RD_ONLY

7591 FLOAT Component Data 1_Multi-level Calib 'c'[2] RD_ONLY

7592 FLOAT Component Data 1_Multi-level Calib 'c'[3] RD_ONLY

7593 FLOAT Component Data 1_Multi-level Calib 'c'[4] RD_ONLY

7594 FLOAT Component Data 1_Multi-level Calib 'c'[5] RD_ONLY

7595 FLOAT Component Data 1_Multi-level Calib 'c'[6] RD_ONLY
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7596 FLOAT Component Data 1_Multi-level Calib 'c'[7] RD_ONLY

7597 FLOAT Component Data 1_Multi-level Calib 'c'[8] RD_ONLY

7598 FLOAT Component Data 1_Multi-level Calib 'c'[9] RD_ONLY

7599 FLOAT Component Data 1_Multi-level Calib 'c'[10] RD_ONLY

7600 FLOAT Component Data 1_Multi-level Calib 'c'[11] RD_ONLY

7601 FLOAT Component Data 1_Multi-level Calib 'c'[12] RD_ONLY

7602 FLOAT Component Data 1_Multi-level Calib 'c'[13] RD_ONLY

7603 FLOAT Component Data 1_Multi-level Calib 'c'[14] RD_ONLY

7604 FLOAT Component Data 1_Multi-level Calib 'c'[15] RD_ONLY

7605 FLOAT Component Data 1_Multi-level Calib 'c'[16] RD_ONLY

7606 FLOAT Component Data 1_Multi-level Calib 'd'[1] RD_ONLY

7607 FLOAT Component Data 1_Multi-level Calib 'd'[2] RD_ONLY

7608 FLOAT Component Data 1_Multi-level Calib 'd'[3] RD_ONLY

7609 FLOAT Component Data 1_Multi-level Calib 'd'[4] RD_ONLY

7610 FLOAT Component Data 1_Multi-level Calib 'd'[5] RD_ONLY

7611 FLOAT Component Data 1_Multi-level Calib 'd'[6] RD_ONLY

7612 FLOAT Component Data 1_Multi-level Calib 'd'[7] RD_ONLY

7613 FLOAT Component Data 1_Multi-level Calib 'd'[8] RD_ONLY

7614 FLOAT Component Data 1_Multi-level Calib 'd'[9] RD_ONLY

7615 FLOAT Component Data 1_Multi-level Calib 'd'[10] RD_ONLY

7616 FLOAT Component Data 1_Multi-level Calib 'd'[11] RD_ONLY

7617 FLOAT Component Data 1_Multi-level Calib 'd'[12] RD_ONLY

7618 FLOAT Component Data 1_Multi-level Calib 'd'[13] RD_ONLY

7619 FLOAT Component Data 1_Multi-level Calib 'd'[14] RD_ONLY

7620 FLOAT Component Data 1_Multi-level Calib 'd'[15] RD_ONLY

7621 FLOAT Component Data 1_Multi-level Calib 'd'[16] RD_ONLY

7622 FLOAT Component Data 1_Rel Resp Factor[1] RD_ONLY

7623 FLOAT Component Data 1_Rel Resp Factor[2] RD_ONLY

7624 FLOAT Component Data 1_Rel Resp Factor[3] RD_ONLY

7625 FLOAT Component Data 1_Rel Resp Factor[4] RD_ONLY

7626 FLOAT Component Data 1_Rel Resp Factor[5] RD_ONLY

7627 FLOAT Component Data 1_Rel Resp Factor[6] RD_ONLY

7628 FLOAT Component Data 1_Rel Resp Factor[7] RD_ONLY

7629 FLOAT Component Data 1_Rel Resp Factor[8] RD_ONLY
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7630 FLOAT Component Data 1_Rel Resp Factor[9] RD_ONLY

7631 FLOAT Component Data 1_Rel Resp Factor[10] RD_ONLY

7632 FLOAT Component Data 1_Rel Resp Factor[11] RD_ONLY

7633 FLOAT Component Data 1_Rel Resp Factor[12] RD_ONLY

7634 FLOAT Component Data 1_Rel Resp Factor[13] RD_ONLY

7635 FLOAT Component Data 1_Rel Resp Factor[14] RD_ONLY

7636 FLOAT Component Data 1_Rel Resp Factor[15] RD_ONLY

7637 FLOAT Component Data 1_Rel Resp Factor[16] RD_ONLY

7638 FLOAT Component Data 2_Multi-level Calib 'a'[1] RD_ONLY

7639 FLOAT Component Data 2_Multi-level Calib 'a'[2] RD_ONLY

7640 FLOAT Component Data 2_Multi-level Calib 'a'[3] RD_ONLY

7641 FLOAT Component Data 2_Multi-level Calib 'a'[4] RD_ONLY

7642 FLOAT Component Data 2_Multi-level Calib 'a'[5] RD_ONLY

7643 FLOAT Component Data 2_Multi-level Calib 'a'[6] RD_ONLY

7644 FLOAT Component Data 2_Multi-level Calib 'a'[7] RD_ONLY

7645 FLOAT Component Data 2_Multi-level Calib 'a'[8] RD_ONLY

7646 FLOAT Component Data 2_Multi-level Calib 'a'[9] RD_ONLY

7647 FLOAT Component Data 2_Multi-level Calib 'a'[10] RD_ONLY

7648 FLOAT Component Data 2_Multi-level Calib 'a'[11] RD_ONLY

7649 FLOAT Component Data 2_Multi-level Calib 'a'[12] RD_ONLY

7650 FLOAT Component Data 2_Multi-level Calib 'a'[13] RD_ONLY

7651 FLOAT Component Data 2_Multi-level Calib 'a'[14] RD_ONLY

7652 FLOAT Component Data 2_Multi-level Calib 'a'[15] RD_ONLY

7653 FLOAT Component Data 2_Multi-level Calib 'a'[16] RD_ONLY

7654 FLOAT Component Data 2_Multi-level Calib 'b'[1] RD_ONLY

7655 FLOAT Component Data 2_Multi-level Calib 'b'[2] RD_ONLY

7656 FLOAT Component Data 2_Multi-level Calib 'b'[3] RD_ONLY

7657 FLOAT Component Data 2_Multi-level Calib 'b'[4] RD_ONLY

7658 FLOAT Component Data 2_Multi-level Calib 'b'[5] RD_ONLY

7659 FLOAT Component Data 2_Multi-level Calib 'b'[6] RD_ONLY

7660 FLOAT Component Data 2_Multi-level Calib 'b'[7] RD_ONLY

7661 FLOAT Component Data 2_Multi-level Calib 'b'[8] RD_ONLY

7662 FLOAT Component Data 2_Multi-level Calib 'b'[9] RD_ONLY

7663 FLOAT Component Data 2_Multi-level Calib 'b'[10] RD_ONLY
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7664 FLOAT Component Data 2_Multi-level Calib 'b'[11] RD_ONLY

7665 FLOAT Component Data 2_Multi-level Calib 'b'[12] RD_ONLY

7666 FLOAT Component Data 2_Multi-level Calib 'b'[13] RD_ONLY

7667 FLOAT Component Data 2_Multi-level Calib 'b'[14] RD_ONLY

7668 FLOAT Component Data 2_Multi-level Calib 'b'[15] RD_ONLY

7669 FLOAT Component Data 2_Multi-level Calib 'b'[16] RD_ONLY

7670 FLOAT Component Data 2_Multi-level Calib 'c'[1] RD_ONLY

7671 FLOAT Component Data 2_Multi-level Calib 'c'[2] RD_ONLY

7672 FLOAT Component Data 2_Multi-level Calib 'c'[3] RD_ONLY

7673 FLOAT Component Data 2_Multi-level Calib 'c'[4] RD_ONLY

7674 FLOAT Component Data 2_Multi-level Calib 'c'[5] RD_ONLY

7675 FLOAT Component Data 2_Multi-level Calib 'c'[6] RD_ONLY

7676 FLOAT Component Data 2_Multi-level Calib 'c'[7] RD_ONLY

7677 FLOAT Component Data 2_Multi-level Calib 'c'[8] RD_ONLY

7678 FLOAT Component Data 2_Multi-level Calib 'c'[9] RD_ONLY

7679 FLOAT Component Data 2_Multi-level Calib 'c'[10] RD_ONLY

7680 FLOAT Component Data 2_Multi-level Calib 'c'[11] RD_ONLY

7681 FLOAT Component Data 2_Multi-level Calib 'c'[12] RD_ONLY

7682 FLOAT Component Data 2_Multi-level Calib 'c'[13] RD_ONLY

7683 FLOAT Component Data 2_Multi-level Calib 'c'[14] RD_ONLY

7684 FLOAT Component Data 2_Multi-level Calib 'c'[15] RD_ONLY

7685 FLOAT Component Data 2_Multi-level Calib 'c'[16] RD_ONLY

7686 FLOAT Component Data 2_Multi-level Calib 'd'[1] RD_ONLY

7687 FLOAT Component Data 2_Multi-level Calib 'd'[2] RD_ONLY

7688 FLOAT Component Data 2_Multi-level Calib 'd'[3] RD_ONLY

7689 FLOAT Component Data 2_Multi-level Calib 'd'[4] RD_ONLY

7690 FLOAT Component Data 2_Multi-level Calib 'd'[5] RD_ONLY

7691 FLOAT Component Data 2_Multi-level Calib 'd'[6] RD_ONLY

7692 FLOAT Component Data 2_Multi-level Calib 'd'[7] RD_ONLY

7693 FLOAT Component Data 2_Multi-level Calib 'd'[8] RD_ONLY

7694 FLOAT Component Data 2_Multi-level Calib 'd'[9] RD_ONLY

7695 FLOAT Component Data 2_Multi-level Calib 'd'[10] RD_ONLY

7696 FLOAT Component Data 2_Multi-level Calib 'd'[11] RD_ONLY

7697 FLOAT Component Data 2_Multi-level Calib 'd'[12] RD_ONLY
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7698 FLOAT Component Data 2_Multi-level Calib 'd'[13] RD_ONLY

7699 FLOAT Component Data 2_Multi-level Calib 'd'[14] RD_ONLY

7700 FLOAT Component Data 2_Multi-level Calib 'd'[15] RD_ONLY

7701 FLOAT Component Data 2_Multi-level Calib 'd'[16] RD_ONLY

7702 FLOAT Component Data 2_Rel Resp Factor[1] RD_ONLY

7703 FLOAT Component Data 2_Rel Resp Factor[2] RD_ONLY

7704 FLOAT Component Data 2_Rel Resp Factor[3] RD_ONLY

7705 FLOAT Component Data 2_Rel Resp Factor[4] RD_ONLY

7706 FLOAT Component Data 2_Rel Resp Factor[5] RD_ONLY

7707 FLOAT Component Data 2_Rel Resp Factor[6] RD_ONLY

7708 FLOAT Component Data 2_Rel Resp Factor[7] RD_ONLY

7709 FLOAT Component Data 2_Rel Resp Factor[8] RD_ONLY

7710 FLOAT Component Data 2_Rel Resp Factor[9] RD_ONLY

7711 FLOAT Component Data 2_Rel Resp Factor[10] RD_ONLY

7712 FLOAT Component Data 2_Rel Resp Factor[11] RD_ONLY

7713 FLOAT Component Data 2_Rel Resp Factor[12] RD_ONLY

7714 FLOAT Component Data 2_Rel Resp Factor[13] RD_ONLY

7715 FLOAT Component Data 2_Rel Resp Factor[14] RD_ONLY

7716 FLOAT Component Data 2_Rel Resp Factor[15] RD_ONLY

7717 FLOAT Component Data 2_Rel Resp Factor[16] RD_ONLY

7718 FLOAT Avg[1 - Average 1] RD_ONLY

7719 FLOAT Avg[2 - Average 2] RD_ONLY

7720 FLOAT Avg[3 - Average 3] RD_ONLY

7721 FLOAT Avg[4 - Average 4] RD_ONLY

7722 FLOAT Avg[5 - Average 5] RD_ONLY

7723 FLOAT Avg[6 - Average 6] RD_ONLY

7724 FLOAT Avg[7 - Average 7] RD_ONLY

7725 FLOAT Avg[8 - Average 8] RD_ONLY

7726 FLOAT Avg[9 - Average 9] RD_ONLY

7727 FLOAT Avg[10 - Average 10] RD_ONLY

7728 FLOAT Avg[11 - Average 11] RD_ONLY

7729 FLOAT Avg[12 - Average 12] RD_ONLY

7730 FLOAT Avg[13 - Average 13] RD_ONLY

7731 FLOAT Avg[14 - Average 14] RD_ONLY
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7732 FLOAT Avg[15 - Average 15] RD_ONLY

7733 FLOAT Avg[16 - Average 16] RD_ONLY

7734 FLOAT Avg[17 - Average 17] RD_ONLY

7735 FLOAT Avg[18 - Average 18] RD_ONLY

7736 FLOAT Avg[19 - Average 19] RD_ONLY

7737 FLOAT Avg[20 - Average 20] RD_ONLY

7738 FLOAT Avg[21 - Average 21] RD_ONLY

7739 FLOAT Avg[22 - Average 22] RD_ONLY

7740 FLOAT Avg[23 - Average 23] RD_ONLY

7741 FLOAT Avg[24 - Average 24] RD_ONLY

7742 FLOAT Avg[25 - Average 25] RD_ONLY

7743 FLOAT Avg[26 - Average 26] RD_ONLY

7744 FLOAT Avg[27 - Average 27] RD_ONLY

7745 FLOAT Avg[28 - Average 28] RD_ONLY

7746 FLOAT Avg[29 - Average 29] RD_ONLY

7747 FLOAT Avg[30 - Average 30] RD_ONLY

7748 FLOAT Avg[31 - Average 31] RD_ONLY

7749 FLOAT Avg[32 - Average 32] RD_ONLY

7750 FLOAT Avg[33 - Average 33] RD_ONLY

7751 FLOAT Avg[34 - Average 34] RD_ONLY

7752 FLOAT Avg[35 - Average 35] RD_ONLY

7753 FLOAT Avg[36 - Average 36] RD_ONLY

7754 FLOAT Avg[37 - Average 37] RD_ONLY

7755 FLOAT Avg[38 - Average 38] RD_ONLY

7756 FLOAT Avg[39 - Average 39] RD_ONLY

7757 FLOAT Avg[40 - Average 40] RD_ONLY

7758 FLOAT Avg[41 - Average 41] RD_ONLY

7759 FLOAT Avg[42 - Average 42] RD_ONLY

7760 FLOAT Avg[43 - Average 43] RD_ONLY

7761 FLOAT Avg[44 - Average 44] RD_ONLY

7762 FLOAT Avg[45 - Average 45] RD_ONLY

7763 FLOAT Avg[46 - Average 46] RD_ONLY

7764 FLOAT Avg[47 - Average 47] RD_ONLY

7765 FLOAT Avg[48 - Average 48] RD_ONLY
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7766 FLOAT Avg[49 - Average 49] RD_ONLY

7767 FLOAT Avg[50 - Average 50] RD_ONLY

7768 FLOAT Avg[51 - Average 51] RD_ONLY

7769 FLOAT Avg[52 - Average 52] RD_ONLY

7770 FLOAT Avg[53 - Average 53] RD_ONLY

7771 FLOAT Avg[54 - Average 54] RD_ONLY

7772 FLOAT Avg[55 - Average 55] RD_ONLY

7773 FLOAT Avg[56 - Average 56] RD_ONLY

7774 FLOAT Avg[57 - Average 57] RD_ONLY

7775 FLOAT Avg[58 - Average 58] RD_ONLY

7776 FLOAT Avg[59 - Average 59] RD_ONLY

7777 FLOAT Avg[60 - Average 60] RD_ONLY

7778 FLOAT Avg[61 - Average 61] RD_ONLY

7779 FLOAT Avg[62 - Average 62] RD_ONLY

7780 FLOAT Avg[63 - Average 63] RD_ONLY

7781 FLOAT Avg[64 - Average 64] RD_ONLY

7782 FLOAT Avg[65 - Average 65] RD_ONLY

7783 FLOAT Avg[66 - Average 66] RD_ONLY

7784 FLOAT Avg[67 - Average 67] RD_ONLY

7785 FLOAT Avg[68 - Average 68] RD_ONLY

7786 FLOAT Avg[69 - Average 69] RD_ONLY

7787 FLOAT Avg[70 - Average 70] RD_ONLY

7788 FLOAT Avg[71 - Average 71] RD_ONLY

7789 FLOAT Avg[72 - Average 72] RD_ONLY

7790 FLOAT Avg[73 - Average 73] RD_ONLY

7791 FLOAT Avg[74 - Average 74] RD_ONLY

7792 FLOAT Avg[75 - Average 75] RD_ONLY

7793 FLOAT Avg[76 - Average 76] RD_ONLY

7794 FLOAT Avg[77 - Average 77] RD_ONLY

7795 FLOAT Avg[78 - Average 78] RD_ONLY

7796 FLOAT Avg[79 - Average 79] RD_ONLY

7797 FLOAT Avg[80 - Average 80] RD_ONLY

7798 FLOAT Avg[81 - Average 81] RD_ONLY

7799 FLOAT Avg[82 - Average 82] RD_ONLY
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7800 FLOAT Avg[83 - Average 83] RD_ONLY

7801 FLOAT Avg[84 - Average 84] RD_ONLY

7802 FLOAT Avg[85 - Average 85] RD_ONLY

7803 FLOAT Avg[86 - Average 86] RD_ONLY

7804 FLOAT Avg[87 - Average 87] RD_ONLY

7805 FLOAT Avg[88 - Average 88] RD_ONLY

7806 FLOAT Avg[89 - Average 89] RD_ONLY

7807 FLOAT Avg[90 - Average 90] RD_ONLY

7808 FLOAT Avg[91 - Average 91] RD_ONLY

7809 FLOAT Avg[92 - Average 92] RD_ONLY

7810 FLOAT Avg[93 - Average 93] RD_ONLY

7811 FLOAT Avg[94 - Average 94] RD_ONLY

7812 FLOAT Avg[95 - Average 95] RD_ONLY

7813 FLOAT Avg[96 - Average 96] RD_ONLY

7814 FLOAT Avg[97 - Average 97] RD_ONLY

7815 FLOAT Avg[98 - Average 98] RD_ONLY

7816 FLOAT Avg[99 - Average 99] RD_ONLY

7817 FLOAT Avg[100 - Average 100] RD_ONLY

7818 FLOAT Avg[101 - Average 101] RD_ONLY

7819 FLOAT Avg[102 - Average 102] RD_ONLY

7820 FLOAT Avg[103 - Average 103] RD_ONLY

7821 FLOAT Avg[104 - Average 104] RD_ONLY

7822 FLOAT Avg[105 - Average 105] RD_ONLY

7823 FLOAT Avg[106 - Average 106] RD_ONLY

7824 FLOAT Avg[107 - Average 107] RD_ONLY

7825 FLOAT Avg[108 - Average 108] RD_ONLY

7826 FLOAT Avg[109 - Average 109] RD_ONLY

7827 FLOAT Avg[110 - Average 110] RD_ONLY

7828 FLOAT Avg[111 - Average 111] RD_ONLY

7829 FLOAT Avg[112 - Average 112] RD_ONLY

7830 FLOAT Avg[113 - Average 113] RD_ONLY

7831 FLOAT Avg[114 - Average 114] RD_ONLY

7832 FLOAT Avg[115 - Average 115] RD_ONLY

7833 FLOAT Avg[116 - Average 116] RD_ONLY
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7834 FLOAT Avg[117 - Average 117] RD_ONLY

7835 FLOAT Avg[118 - Average 118] RD_ONLY

7836 FLOAT Avg[119 - Average 119] RD_ONLY

7837 FLOAT Avg[120 - Average 120] RD_ONLY

7838 FLOAT Avg[121 - Average 121] RD_ONLY

7839 FLOAT Avg[122 - Average 122] RD_ONLY

7840 FLOAT Avg[123 - Average 123] RD_ONLY

7841 FLOAT Avg[124 - Average 124] RD_ONLY

7842 FLOAT Avg[125 - Average 125] RD_ONLY

7843 FLOAT Avg[126 - Average 126] RD_ONLY

7844 FLOAT Avg[127 - Average 127] RD_ONLY

7845 FLOAT Avg[128 - Average 128] RD_ONLY

7846 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7847 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7848 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7849 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7850 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7851 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7852 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7853 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7854 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7855 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7856 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7857 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7858 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7859 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7860 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7861 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7862 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7863 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7864 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7865 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7866 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7867 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY
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7868 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7869 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7870 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7871 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

7872 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7873 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7874 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7875 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7876 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7877 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7878 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7879 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7880 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7881 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7882 FLOAT Archive_Avg[37 - Average 37] 1 RD_ONLY

7883 FLOAT Archive_Avg[38 - Average 38] 1 RD_ONLY

7884 FLOAT Archive_Avg[39 - Average 39] 1 RD_ONLY

7885 FLOAT Archive_Avg[40 - Average 40] 1 RD_ONLY

7886 FLOAT Archive_Avg[41 - Average 41] 1 RD_ONLY

7887 FLOAT Archive_Avg[42 - Average 42] 1 RD_ONLY

7888 FLOAT Archive_Avg[43 - Average 43] 1 RD_ONLY

7889 FLOAT Archive_Avg[44 - Average 44] 1 RD_ONLY

7890 FLOAT Archive_Avg[45 - Average 45] 1 RD_ONLY

7891 FLOAT Archive_Avg[46 - Average 46] 1 RD_ONLY

7892 FLOAT Archive_Avg[47 - Average 47] 1 RD_ONLY

7893 FLOAT Archive_Avg[48 - Average 48] 1 RD_ONLY

7894 FLOAT Archive_Avg[49 - Average 49] 1 RD_ONLY

7895 FLOAT Archive_Avg[50 - Average 50] 1 RD_ONLY

7896 FLOAT Archive_Avg[51 - Average 51] 1 RD_ONLY

7897 FLOAT Archive_Avg[52 - Average 52] 1 RD_ONLY

7898 FLOAT Archive_Avg[53 - Average 53] 1 RD_ONLY

7899 FLOAT Archive_Avg[54 - Average 54] 1 RD_ONLY

7900 FLOAT Archive_Avg[55 - Average 55] 1 RD_ONLY

7901 FLOAT Archive_Avg[56 - Average 56] 1 RD_ONLY
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7902 FLOAT Archive_Avg[57 - Average 57] 1 RD_ONLY

7903 FLOAT Archive_Avg[58 - Average 58] 1 RD_ONLY

7904 FLOAT Archive_Avg[59 - Average 59] 1 RD_ONLY

7905 FLOAT Archive_Avg[60 - Average 60] 1 RD_ONLY

7906 FLOAT Archive_Avg[61 - Average 61] 1 RD_ONLY

7907 FLOAT Archive_Avg[62 - Average 62] 1 RD_ONLY

7908 FLOAT Archive_Avg[63 - Average 63] 1 RD_ONLY

7909 FLOAT Archive_Avg[64 - Average 64] 1 RD_ONLY

7910 FLOAT Archive_Avg[65 - Average 65] 1 RD_ONLY

7911 FLOAT Archive_Avg[66 - Average 66] 1 RD_ONLY

7912 FLOAT Archive_Avg[67 - Average 67] 1 RD_ONLY

7913 FLOAT Archive_Avg[68 - Average 68] 1 RD_ONLY

7914 FLOAT Archive_Avg[69 - Average 69] 1 RD_ONLY

7915 FLOAT Archive_Avg[70 - Average 70] 1 RD_ONLY

7916 FLOAT Archive_Avg[71 - Average 71] 1 RD_ONLY

7917 FLOAT Archive_Avg[72 - Average 72] 1 RD_ONLY

7918 FLOAT Archive_Avg[73 - Average 73] 1 RD_ONLY

7919 FLOAT Archive_Avg[74 - Average 74] 1 RD_ONLY

7920 FLOAT Archive_Avg[75 - Average 75] 1 RD_ONLY

7921 FLOAT Archive_Avg[76 - Average 76] 1 RD_ONLY

7922 FLOAT Archive_Avg[77 - Average 77] 1 RD_ONLY

7923 FLOAT Archive_Avg[78 - Average 78] 1 RD_ONLY

7924 FLOAT Archive_Avg[79 - Average 79] 1 RD_ONLY

7925 FLOAT Archive_Avg[80 - Average 80] 1 RD_ONLY

7926 FLOAT Archive_Avg[81 - Average 81] 1 RD_ONLY

7927 FLOAT Archive_Avg[82 - Average 82] 1 RD_ONLY

7928 FLOAT Archive_Avg[83 - Average 83] 1 RD_ONLY

7929 FLOAT Archive_Avg[84 - Average 84] 1 RD_ONLY

7930 FLOAT Archive_Avg[85 - Average 85] 1 RD_ONLY

7931 FLOAT Archive_Avg[86 - Average 86] 1 RD_ONLY

7932 FLOAT Archive_Avg[87 - Average 87] 1 RD_ONLY

7933 FLOAT Archive_Avg[88 - Average 88] 1 RD_ONLY

7934 FLOAT Archive_Avg[89 - Average 89] 1 RD_ONLY

7935 FLOAT Archive_Avg[90 - Average 90] 1 RD_ONLY
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7936 FLOAT Archive_Avg[91 - Average 91] 1 RD_ONLY

7937 FLOAT Archive_Avg[92 - Average 92] 1 RD_ONLY

7938 FLOAT Archive_Avg[93 - Average 93] 1 RD_ONLY

7939 FLOAT Archive_Avg[94 - Average 94] 1 RD_ONLY

7940 FLOAT Archive_Avg[95 - Average 95] 1 RD_ONLY

7941 FLOAT Archive_Avg[96 - Average 96] 1 RD_ONLY

7942 FLOAT Archive_Avg[97 - Average 97] 1 RD_ONLY

7943 FLOAT Archive_Avg[98 - Average 98] 1 RD_ONLY

7944 FLOAT Archive_Avg[99 - Average 99] 1 RD_ONLY

7945 FLOAT Archive_Avg[100 - Average 100] 1 RD_ONLY

7946 FLOAT Archive_Avg[101 - Average 101] 1 RD_ONLY

7947 FLOAT Archive_Avg[102 - Average 102] 1 RD_ONLY

7948 FLOAT Archive_Avg[103 - Average 103] 1 RD_ONLY

7949 FLOAT Archive_Avg[104 - Average 104] 1 RD_ONLY

7950 FLOAT Archive_Avg[105 - Average 105] 1 RD_ONLY

7951 FLOAT Archive_Avg[106 - Average 106] 1 RD_ONLY

7952 FLOAT Archive_Avg[107 - Average 107] 1 RD_ONLY

7953 FLOAT Archive_Avg[108 - Average 108] 1 RD_ONLY

7954 FLOAT Archive_Avg[109 - Average 109] 1 RD_ONLY

7955 FLOAT Archive_Avg[110 - Average 110] 1 RD_ONLY

7956 FLOAT Archive_Avg[111 - Average 111] 1 RD_ONLY

7957 FLOAT Archive_Avg[112 - Average 112] 1 RD_ONLY

7958 FLOAT Archive_Avg[113 - Average 113] 1 RD_ONLY

7959 FLOAT Archive_Avg[114 - Average 114] 1 RD_ONLY

7960 FLOAT Archive_Avg[115 - Average 115] 1 RD_ONLY

7961 FLOAT Archive_Avg[116 - Average 116] 1 RD_ONLY

7962 FLOAT Archive_Avg[117 - Average 117] 1 RD_ONLY

7963 FLOAT Archive_Avg[118 - Average 118] 1 RD_ONLY

7964 FLOAT Archive_Avg[119 - Average 119] 1 RD_ONLY

7965 FLOAT Archive_Avg[120 - Average 120] 1 RD_ONLY

7966 FLOAT Archive_Avg[121 - Average 121] 1 RD_ONLY

7967 FLOAT Archive_Avg[122 - Average 122] 1 RD_ONLY

7968 FLOAT Archive_Avg[123 - Average 123] 1 RD_ONLY

7969 FLOAT Archive_Avg[124 - Average 124] 1 RD_ONLY
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7970 FLOAT Archive_Avg[125 - Average 125] 1 RD_ONLY

7971 FLOAT Archive_Avg[126 - Average 126] 1 RD_ONLY

7972 FLOAT Archive_Avg[127 - Average 127] 1 RD_ONLY

7973 FLOAT Archive_Avg[128 - Average 128] 1 RD_ONLY

7974 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

7975 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

7976 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

7977 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

7978 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

7979 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

7980 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

7981 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

7982 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

7983 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

7984 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

7985 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

7986 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

7987 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

7988 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

7989 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

7990 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

7991 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

7992 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

7993 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

7994 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

7995 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

7996 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

7997 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

7998 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

7999 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8000 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8001 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8002 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8003 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY
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8004 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8005 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8006 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8007 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8008 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8009 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8010 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8011 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8012 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8013 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8014 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

8015 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

8016 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

8017 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

8018 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

8019 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8020 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8021 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8022 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8023 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8024 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8025 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8026 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8027 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8028 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8029 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8030 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8031 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8032 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8033 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8034 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

8035 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

8036 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

8037 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-745 December 2019

MON2020 355



Register # Data type Variable Record # Access Format

8038 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

8039 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8040 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8041 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8042 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8043 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8044 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8045 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8046 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8047 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8048 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8049 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8050 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8051 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8052 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8053 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8054 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8055 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8056 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8057 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8058 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8059 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8060 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8061 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8062 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8063 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8064 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8065 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8066 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8067 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8068 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8069 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8070 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8071 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY
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Register # Data type Variable Record # Access Format

8072 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8073 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8074 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8075 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8076 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8077 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8078 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8079 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8080 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8081 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8082 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8083 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8084 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8085 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8086 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8087 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8088 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8089 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8090 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8091 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8092 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8093 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8094 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8095 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8096 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8097 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8098 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8099 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8100 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8101 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8102 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8103 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8104 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8105 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY
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8106 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8107 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8108 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8109 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8110 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8111 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8112 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8113 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8114 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8115 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8116 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8117 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8118 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8119 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8120 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8121 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8122 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8123 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8124 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8125 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8126 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8127 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8128 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8129 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8130 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8131 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8132 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8133 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8134 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8135 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8136 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8137 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8138 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8139 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY
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8140 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8141 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8142 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8143 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8144 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8145 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8146 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8147 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8148 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8149 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8150 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8151 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8152 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8153 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8154 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8155 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8156 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8157 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8158 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8159 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8160 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8161 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8162 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8163 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8164 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8165 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8166 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8167 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8168 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8169 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8170 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8171 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8172 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8173 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY
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8174 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8175 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8176 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8177 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8178 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8179 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8180 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8181 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8182 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8183 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8184 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8185 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8186 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8187 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8188 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8189 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8190 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8191 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8192 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8193 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8194 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8195 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8196 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8197 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8198 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8199 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8200 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8201 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8202 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8203 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8204 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8205 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8206 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8207 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY
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8208 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8209 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8210 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8211 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8212 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8213 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8214 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8215 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8216 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8217 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8218 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8219 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8220 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8221 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8222 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8223 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8224 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8225 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8226 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8227 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8228 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8229 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8230 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8231 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8232 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8233 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8234 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8235 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8236 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8237 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8238 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8239 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8240 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8241 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY
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8242 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8243 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8244 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8245 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8246 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8247 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8248 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8249 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8250 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8251 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8252 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8253 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8254 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8255 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8256 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8257 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8258 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8259 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8260 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8261 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8262 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8263 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8264 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8265 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8266 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8267 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8268 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8269 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8270 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8271 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8272 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8273 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8274 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8275 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY
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8276 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8277 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8278 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8279 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8280 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8281 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8282 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8283 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8284 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8285 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8286 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8287 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8288 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8289 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8290 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8291 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8292 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8293 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8963 FLOAT Clear All Alarms RD_WR

8964 FLOAT Acknowledge All Alarms RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY
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9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyser Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm
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3099...3102 (Valid data flags): This flag is set to 1 when new valid data is put into the
Modbus registers and set to 0 if an alarm is active. The 4 copies of this flag operate in the
same way; they are intended for use by up to 4 independent Modbus master devices
attached to the 4 serial ports. This is a read-write register, so the Modbus Master can clear
the flag once the new results are read.

3103...3182 (Calibration update flags): Set to 1 when response factors are updated
during a calibration.

5001 (Last Analy_Cycle Time (1/30th sec)): Cycle time for last analysis in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

5002 (Last Cal_Cycle Time (1/30th sec)): Cycle time for last calibration in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

7001...70016 (Last Analy Mole %): These registers hold the mole % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001...3016 which contains the component codes.

7017...7032 (Last Analy Weight %): These registers hold the weight % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001...3016 which contains the component codes.

7033...7039 : Last analysis stream results.

7040...7044: User calculation results 1...5.

7046...7054: Last analysis stream results.

7070...7084: Most recent archive averages for Averages 1...15.

7085...7086: Current analog input values for Analog Input 1 and 2.

7087...7090: Last analysis stream results.

7091: Number of total calibration runs.

7092: Number of averaged calibration runs.

7093: Auto calibration start time.

7094: (Stream Sequence Select): Read-write register. When read, returns currently
selected stream sequence. To change stream sequence, write sequence number.

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

7095...7110 (Last Analysis Response Factors): Response factor for Components 1...16
used on last run.

7111...7121: Results from last calibration.

7122: Calibration stream number.

7123...7125: Last analysis GS(M)R results.
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7126...7161: Current running averages for Averages 1...36.

7162...7197: Maximum sample value during current averaging period for Averages 1...36.

7198...7233: Minimum sample value during current averaging period for averages 1...36.

7234...7269: Most recent archived averages for Averages 1 through 36.

7270...7305: Maximum sample value in the second most recent archived average for
Averages 1...36.

7306...7341: Minimum sample value in the second most recent archived average for
Averages 1...36.

7342...7377: Second most recent archived averages for Averages 1...36.

7378...7413: Maximum sample value in the second most recent archived average for
Averages 1...36.

7414...7449: Minimum sample value in the second most recent archived average for
averages 1...36.

7450...7485: Third most recent archived averages for Averages 1...36.

7586...7621: Maximum sample value in the third most recent archived averages for
Averages 1...36.

7521...7557: Minimum sample value in the third most recent archived averages for
Averages 1...36.

7558...7573: Multi-level calibration coefficient a components 1...16.

7572...7589: Multi-level calibration coefficient b components 1...16.

7590...7605: Multi-level calibration coefficient c components 1...16.

7606...7621: Multi-level calibration coefficient d components 1...16.

7622...7637: Indirect calibration - relative response factors for components 1...16.

7638...7717: Repeat of 7558...7637 above for component table 2.

7718...7845: Current running averages for Averages 1...128.

7486..7973: Most recent archived averages for Averages 1...128.

7974...8053: Current response factors.

8054...8133: Current retention times.

8214...8293: Retention times from previous calibration.

8963 (Clear All Alarms): Write 1 to this register to clear all active alarms.

8964 (Acknowledge All Alarms): Write 1 to this register to acknowledge all alarms.

9006...9011: GC system date/time read-write registers.

9013 (Modbus ID [Port 0]): Modbus ID for Serial Port 0.

9014 (Site ID): GC site ID read-write register.

9022 (Analysis Time): Analysis time.
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9024 (Cycle Time): Cycle time.

9026 (Run Time): Run time.

9028 (Current Stream): Stream number.

9030 (Analyzer Control): Section B.6.

9032 (GC Calibrating): Tells you if the GC is calibrating. A value of 1 means the GC is
calibrating, 0 otherwise.

9034 (Active Alarm Flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck Alarm Flag): Tells you if the GC has any unaknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036...9040 (Hourly Average Reset Time): Date/time when hourly average results were
archived.

9041...9045 (Daily Average Reset Time): Date/time when daily average results were
archived.

9046...9047 (Weekly Average Reset Time): Date/time when weekly average results were
archived.

9051...9055 (Monthly Average Reset Time): Date/time when monthly averaged results
were archived.

9056...9060 (Variable Average Reset Time): Date/time when variable average results
were archived.

B.6 Remote control registers
Modbus register Description

GC Control_Auto Sequence Start chromatograph auto sequencing. Normally 0.0; write non-zero value to initiate
sequencing.
1.0 - start with purge

2.0 - start without purge

GC Control_Halt Halt chromatograph sequencing - Normally 0.0; write 1.0 to perform halt.

GC Control_Single Stream Start single stream run - Normally 0.0. Continuous Single Stream mode: Write the stream
number (in floating point) to start with a purge and the negative of the stream number to
start without a purge. Single Analysis Non-continuous Single Stream mode: Write (128.0 + the
stream number) (in floating point) to start with a purge, and the negative of (128.0 + the
stream number) to start without a purge.

GC Control_Calibration Start calibration sequence - Normally 0.0. For Normal Calibration: Write the stream number
of the calibration stream in floating point to start calibration sequence with a purge, or write
the negative of the stream number to start calibration sequence without a purge.
For Forced Calibration: Write (128.0 + stream number) of the cal stream in floating point to
start calibration sequence with a purge or writes the negative of (128 + stream number) of
the cal stream to start a calibration sequence without a purge.
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Modbus register Description

GC Control_Validation Start validation sequence - Normally 0.0. For Validation: Write the stream number of the
Validation stream in floating point to start validation sequence with a purge, or write the
negative of the stream number to start validation sequence without a purge.

GC Control -> Validation
Acknowledge

GC copies Start Validation command to this register; PLC can reset after confirming that
command was successfully issued.

GC Control_Stream Sequence
Select

Read-write register. When read, returns currently selected stream sequence. To change
stream sequence, write sequence number.

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

Stream Sequence - Default Stream
Sequence

Reads the sequence of streams. For example, if current Sequence is 1, 2, then this register
reads a value of 12. To change the sequence of streams: For example, to change the
Sequence to 2,3, write 23 to this register.

GC Status > GC Running GC is running.
0 - GC is idle

1 - GC is running (Auto Analysis, Single Stream, Calibration, Validation)

GC Status > Current Analysis Mode Indicates mode of operation:
0 - GC Idle

1 - Auto Sequence

2 - Single Stream

3 - Manual Calibration

4 - Manual Validation
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B.7 Read-write remote control register (9030)
9030 is a read-write register that can be used for controlling GC operation and for reading
current operating mode.

The mode values read from register 9030 are:

0 Idle

1 In automatic sequencing mode

2 Running in single stream mode

3 Calibrating

4 Warm starting, running confidence tests

5 Validating (added in Firmware Version 2.1.0 and higher)

The commands that can be written to register 9030 are:

0 Halt at the end of the current analysis

1 Start automatic sequencing mode

2 Start a normal calibration, on first calibration stream

3 Run single analysis on stream 1, then halt

4 Run continually on stream 1

5 Run a single analysis on stream 2, then halt

6 Run continually on stream 2

7 Run a single analysis on stream 3, then halt

8 Run continuously on stream 3

9 Run a single analysis on stream 4, then halt

10 Run continually on stream 4

11 Run a single analysis on stream 5, then halt

12 Run continually on stream 5

13 Run a single analysis on stream 6, then halt

14 Run continually on stream 6

15 Run a single analysis on stream 7, then halt

16 Run continuously on stream 7

17 Run a single analysis on stream 8, then halt

18 Run continuously on stream 8

19 Run validation on first validation stream (added in Firmware Version 2.1.0 and higher)

...

41 Run normal calibration on stream 1 (added in Firmware Version 2.1.0 and higher)

42 Run normal calibration on stream 2 (added in Firmware Version 2.1.0 and higher)

...
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60 Run normal calibration on stream 20 (added in Firmware Version 2.1.0 and higher)

...

81 Run validation on stream 1 (added in Firmware Version 2.1.0 and higher)

82 Run validation on stream 2 (added in Firmware Version 2.1.0 and higher)

...

100 Run validation on stream 20 (added in Firmware Version 2.1.0 and higher)

Commands 1-19, 41-60, and 81-100 above are with 60 seconds purge. Adding 20 to any
command means no purge if relevant. These writes are done using Modbus functions 6 or
16. Except for commands 0 and 2, the GC must be idle. If a command fails because the GC
was not idle or because the code is invalid or the stream is not used, a Modbus exception
illegal data value will be returned. All these commands are allowed without requiring a
password or the security switch to be unlocked. These commands are available to both
User Modbus ports and SIM_2251 Modbus ports.

B.8 Writable Modbus registers
The following list documents all the Modbus registers in the GC that can be written when
the GC is under legal metrology control with the security switch locked. Please note that
not all the registers in this table are available in the SIM_2251 mapping.

Modbus register Remarks

GC Status -> Current Month Set GC clock. All 5 registers can be written in a single
request, or individual registers can be written. The new
date/time is validated before the GC system clock is
changed.

GC Status -> Current Day

GC Status -> Current Year

GC Status -> Current Hour

GC Status -> Current Minute

GC Status -> New Data Flag Flags for synchronizing Master and Slave. The Slave (GC)
updates its result registers and then sets the flag to 1. The
Master (PLC/Flow Computer) reads the data and resets the
flag to 0.

GC Status -> Hourly Avg Updated

GC Status -> Weekly Avg Updated

GC Status -> Daily Avg Updated

GC Status -> Monthly Avg Updated

GC Status -> Last Run Data Valid 1

GC Status -> Last Run Data Valid 2

GC Status -> Last Run Data Valid 3

GC Status -> Last Run Data Valid 4
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Modbus register Remarks

GC Status -> Last Run Data Valid 5

GC Status -> Last Run Data Valid 6

GC Status -> Last Run Data Valid 7

GC Status -> Last Run Data Valid 8

GC Status -> Last Run Data Valid 9

GC Status -> Last Run Data Valid 10

Stream 1 -> New Data Available

Stream 2 -> New Data Available

Stream 3 -> New Data Available

Stream 4 -> New Data Available

Stream 5 -> New Data Available

Stream 6 -> New Data Available

Stream 7 -> New Data Available

Stream 8 -> New Data Available

Stream 9 -> New Data Available

Stream 10 -> New Data Available

Stream 11 -> New Data Available

Stream 12 -> New Data Available

Stream 13 -> New Data Available

Stream 14 -> New Data Available

Stream 15 -> New Data Available

Stream 16 -> New Data Available

Stream 17 -> New Data Available

Stream 18 -> New Data Available

Stream 19 -> New Data Available

Stream 20 -> New Data Available

Discrete Output 1 -> Switch Master can write the following values to this register -

0 - Sets the discrete output to Off.

1 - Sets the discrete output to On.

2 - Sets the discrete output to Automatic (DO controller by
GC's timed events).

Discrete Output 2 -> Switch

Discrete Output 3 -> Switch

Discrete Output 4 -> Switch

Discrete Output 5 -> Switch
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Modbus register Remarks

Dewpoint Configuration 1 -> Pressure 1 Pressure at which hydrocarbon dewpoint results are
computed. Used only for dual-detector C9+ hydrocarbon
dewpoint GCs. These registers are not used in C6+ custody
transfer applications.

Dewpoint Configuration 1 -> Pressure 2

Dewpoint Configuration 1 -> Pressure 3

Dewpoint Configuration 1 -> Pressure 4

Dewpoint Configuration 2 -> Pressure 1

Dewpoint Configuration 2 -> Pressure 2

Dewpoint Configuration 2 -> Pressure 3

Dewpoint Configuration 2 -> Pressure 4

Dewpoint Configuration 3 -> Pressure 1

Dewpoint Configuration 3 -> Pressure 2

Dewpoint Configuration 3 -> Pressure 3

Dewpoint Configuration 3 -> Pressure 4

Dewpoint Configuration 4 -> Pressure 1

Dewpoint Configuration 4 -> Pressure 2

Dewpoint Configuration 4 -> Pressure 3

Dewpoint Configuration 4 -> Pressure 4

GC Control_Auto Sequence Start chromatograph auto sequencing.

Normally 0.0; write non-zero value to initiate sequencing.

1.0 - Start with purge.

2.0 - Start without purge.

GC Control_Halt Halt chromatograph sequencing -

Normally 0.0; write 1.0 to perform halt.

GC Control_Single Stream Start single stream run.

Normally 0.0.

Continuous Single Stream mode:
Write the stream number (in floating point) to start with a
purge, and the negative of the stream number to start
without a purge.

Single Analysis Non-continuous Single Stream mode:
Write (128.0 + the stream number) (in floating point) to
start with a purge and the negative of (128.0 + the stream
number) to start without a purge.
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Modbus register Remarks

GC Control_Calibration Start calibration sequence.

Normally 0.0.

For normal calibration:
Write the stream number of the calibration stream in
floating point to start calibration sequence with a purge or
write the negative of the stream number to start
calibration sequence without a purge.

GC Control_Validation Start validation sequence.

Normally 0.0.

For validation:
Write the stream number of the validation stream in
floating point to start validation sequence with a purge or
write the negative of the stream number to start validation
sequence without a purge.

GC Control_Stream Sequence Select Read-write register. When read, returns currently selected
stream sequence. To change stream sequence, write the
sequence number.
Value stream sequence

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

GC Control_Analyser Control (Write Reg 9030) GC remote control register. Please refer to Read-write
remote control register (9030).

for details.

Acknowledge All Alarms Normally 0.0. Write 1 to acknowledge all alarms.

Component Data 1_Calib Conc[Component 1..15] Update calibration concentration from PLC before starting
calibration.

Component Data 1_Resp Fact %[ Component 1..15] Update response factors from PLC.

Stream Sequence - Default Stream Sequence Reads the sequence of streams. For example, if the current
Sequence is 1, 2, then this register reads a value of 12.

To change the sequence of streams:
For example, to change the Sequence to 2,3, write 23 to
this register.

GC Control_Auto Valve Timing Start auto valve timing. Normally 0.0. Write
• Calibration stream number: to start AVT from current

settings.

• Calibration stream number + 20 - to start AVT from
default settings.
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